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Phantom Camera Control User Manual
Last Updated: 10/19/2015

by Vision Research

Thank you for using Phantom! You chose the most powerful and easiest
camera to discover the potential of your ideas. Phantom is a totally digital
high-speed imaging system capable of recording of high resolution images. If
an ordinary photograph captures a moment in time, each high resolution
Phantom image explores a remarkably unpredictable moment in time.
The Phantom Camera Control Software, and the On-Camera Control Buttons
provides you with complete creative control over time. You can select any
frame rate in increments of one frame per second. Shift the frame rate a little
and move a scene to a slightly future viewpoint. Or shift the frame rate a lot
and move a scene to some long passing moment in time. You will enjoy the
ability of having seamless control of the duration, speed and time of every
element of the shot.
With its two main components of the system the Phantom imager with
advanced CMOS technology, and the Phantom Camera Control software,
they form a system that provides high speed. high resolution image capture in
digital cine format, with communications across multiple digital and analog
protocols. This operational guide has been meticulously designed to ease the
anxieties associated with learning how to use your Phantom camera and its
powerful features.
Enjoy the Phantom Experience!
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Welcome to Phantom Help
Thank you for using Phantom! You chose the most powerful and
easiest camera to discover the potential of your ideas. Phantom is a
totally digital high speed imaging system capable of recording
thousands of high resolution images per second. If an ordinary
photograph captures a moment in time, each high resolution
Phantom image explores a remarkably unpredictable moment in
time.
The new version of the Phantom Camera Control Software
application offers everything that the earlier versions included and
much more. Virtually, every aspect of the program has been
overhauled and improved, without sacrificing intuitive ease of use.
This Help file will reduce the learning curve, and ease the anxieties
associated with learning how to use your Phantom camera and its
powerful features quickly.

Enjoy the Phantom Experience!
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Getting Help
As you would expect the Phantom Help File provides you with plenty of help on every aspect of using
the Phantom Camera Control software application. In addition to this very comprehensive help file,
which are actually a complete user manual, the Help File also has extensive context-sensitive help
that you can access.

Using the help file
This help is designed to be used on-screen. It is extensively cross-linked so that you can find more
relevant information to any subject from any location. If you prefer reading printed manuals a PDF
version of the entire help has also been provided to you. This may be useful as a reference, but you
will probably find that the active hyperlinks, cross-references and active index make the on-screen
electronic version of the help much more useful.

Getting a printed help manual
Please don't try to print the HTML Help version of the help from the Microsoft help viewer, it would
look terrible. You can find a formatted PDF version of the entire documentation designed for printing
in the same directory the Phantom Camera Control application was installed.
As mentioned above, however, you will probably find that the on-screen version of the help is much
more useful because of the hyperlinks and cross-references.

Quick Start Guides
See Quick Start Guides in the help for some basic tutorials to get you started using your Phantom
camera.
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Other Useful Phantom Resources

If you have any questions not answered by this help system,
please don't hesitate to contact our support center!

Are you a member of the PhantomZone user forum? No, click the
PhantomZone logo or the following link to sign up now: http:\
\www.visionresearch.com/phantomzone.
This is a great source for additional information on Phantom
cameras in general, alerts and FAQ's, product news, software
and hardware suggestions, and various discussion groups in
particular.
Already a member, check out "What's New", just click the
PhantomZone logo to sign in.

This web site, http://focus.visionresearch.com, offers news about
Vision Research products and provides application notes,
technical tips, FAQ’s and general news of interest on the subject
of high speed digital photography.

Vision Research proudly offers a hands-on, instructor-led course
designed to expand your knowledge of Phantom Miro and vSeries camera operations using proven methodologies with
Vision Research’s award-winning Phantom Digital Imaging
Systems. This course covers a full range of training from the
basics of the Phantom system and its graphical user interface
(GUI) to many advanced analysis features.
After completing this course, you will have the knowledge and
practical understanding necessary to successfully utilize and
deploy the Phantom Digital Imaging System to meet your imaging
requirements. For more information please visit, http://www.
visionresearch.com/index.cfm?sector=htm/files&page=Training
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EULA (End User License Agreements)
Phantom Camera Control Software End User License Agreement (EULA)
This run-time copy of Phantom ("the Software Product") and accompanying documentation are licensed and
not sold. The Software Product is protected by copyright laws and treaties, as well as laws and treaties
related to other forms of intellectual property. Vision Research, Inc. or its subsidiaries, affiliates, and
suppliers (collectively "VRI") own intellectual property rights in the Software Product. The licensee's
("you" or "your") ability to download, use, or copy the Software Product is subject to and governed by
the terms and conditions of this End User License Agreement ("Agreement").
1. Acceptance
YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS
AGREEMENT BY SELECTING THE "ACCEPT" OPTION AND DOWNLOADING THE
SOFTWARE PRODUCT OR BY INSTALLING, USING, OR COPYING THE SOFTWARE
PRODUCT. YOU MUST AGREE TO ALL OF THE TERMS AND CONDITIONS OF THIS
AGREEMENT BEFORE YOU WILL BE ALLOWED TO DOWNLOAD THE SOFTWARE
PRODUCT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, YOU
MUST SELECT "DECLINE" AND YOU MUST NOT INSTALL, USE, OR COPY THE SOFTWARE
PRODUCT.
2. License Grant
Subject to the terms and conditions hereof, VRI grants you a non-exclusive and non-transferable right to (a)
install and execute on a single central processing unit within a computer one copy of the Software
Product and (b) make one additional copy of the Software Product for backup and archival purposes
only. The archival copy must be on a storage medium other than a hard drive, and may only be used for
the reinstallation of the Software Product. This Agreement does not permit the installation or use of
multiple copies of the Software Product, or the installation of the Software Product on more than one
computer at any given time, on a system that allows shared used of applications, on a multi-user network,
or on any configuration or system of computers that allows multiple users. Multiple copy use or
installation is only allowed if you obtain an appropriate licensing agreement for each user and each copy
of the Software Product. Except as expressly set forth herein or in a separate written agreement, you
shall be solely responsible for the entire installation, supervision, training, management, support,
maintenance and control of the Software Product, including all responsibility for installation and for
maintenance of hardware and proper machine configuration. The Software Product, including any and all
updates and upgrades, shall be deemed accepted by you immediately upon download, copying, or receipt
from VRI. The rights granted to you under this Agreement are rights that may be exercised solely by
you.
3. Restrictions
3.1 Restrictions on Transfer
Without first obtaining the express written consent of VRI, you shall not assign your rights or obligations
under this Agreement, or redistribute, encumber, sell, rent, lease, sublicense, or otherwise transfer your
rights to the Software Product. Subject to the foregoing, this Agreement will be binding upon and inure
to the benefit of the parties, their respective successors and permitted assigns.
3.2 Restrictions on Use
You may use the Software Product only as expressly provided in Section 2. Without limiting the foregoing,
you shall not: use, copy, or install the Software Product on any system with more than one computer, or
permit the use, copying, or installation of the Software Product by more than one user or on more than
one computer. If you hold multiple, validly licensed copies, you may not use, copy, or install the
Software Product on any system with more than the number of computers permitted by license, or permit
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the use, copying, or installation by more users, or on more computers than the number permitted by
license.
You shall not decompile, "reverse-engineer", disassemble, or otherwise attempt to derive the source code for
the Software Product.
You shall not use the database portion of the Software Product in connection with any software other than
the Software Product
3.3 Restrictions on Alteration
You shall not modify the Software Product, or any portion thereof, or create any derivative work of the
Software Product or its accompanying documentation. Derivative works include but are not limited to
translations. You may not alter any files or libraries in any portion of the Software Product. You may
not reproduce the database portion or create any tables or reports relating to the database portion. You
shall not change any proprietary rights notices which appear in the Software Product.
3.4 Restrictions on Copying
You shall not copy any part of the Software Product (digitally, electronically, in writing or otherwise),
except to the extent that licensed use inherently demands the creation of a temporary copy stored in
computer memory and not permanently affixed on a storage medium. You may make one archival copy
which must be stored on a medium other than a computer hard drive.
4. Proprietary Rights
You agree that the copyright(s), patent(s), trademark(s), trade secret(s) and all other intellectual proprietary
rights of whatever nature in the Software Product and related documentation, including derivative works,
are and shall remain the exclusive property of VRI and any third party suppliers. Nothing in this
Agreement should be construed as transferring any aspects of such rights to you or any third party. VRI
reserves any and all rights not expressly granted herein. PHANTOM is a trademark of Vision Research,
Inc., and shall not be used by you without VRI’s express written authorization.
5. Limited Software Product Warranty
For a period of sixty (60) days from the date of shipment, VRI warrants that when properly installed and
used under normal conditions, the Software Product will perform in accordance with VRI’s
specifications.
6. Limited Storage Medium Warranty
For a period of ninety (90) days from the date of shipment, VRI warrants that when properly installed and
used under normal conditions, the storage medium on which the Software Product is shipped will be free
of material defects in material and workmanship.
7. Disclaimer of Warranties and Limitation of Liability

UNLESS OTHERWISE EXPLICITLY AGREED TO IN WRITING BY VRI, NO ADDITIONAL
WARRANTIES WHATSOEVER ARE MADE BY VRI. AFTER EXPIRATION OF THE APPLICABLE WARR
SOFTWARE PRODUCT IS LICENSED "AS IS," WITHOUT ANY WARRANTIES
WHATSOEVER. VRI EXPRESSLY DISCLAIMS, AND YOU EXPRESSLY WAIVE, ALL
WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
NON-INFRINGEMENT, SYSTEM INTEGRATION, NON-INTERFERENCE AND ACCURACY
OF INFORMATIONAL CONTENT. VRI DOES NOT WARRANT THAT THE SOFTWARE
PRODUCT WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE
SOFTWARE PRODUCT WILL BE SECURE, UNINTERRUPTED OR ERROR-FREE, OR
THAT ERRORS WILL BE CORRECTED. THE ENTIRE RISK OF THE SOFTWARE
PRODUCT’S QUALITY AND PERFORMANCE IS WITH YOU.
UNDER NO CIRCUMSTANCES SHALL VRI, ITS DIRECTORS, OFFICERS, EMPLOYEES OR
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AGENTS BE LIABLE TO YOU OR ANY OTHER PARTY FOR INDIRECT,
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE, OR EXEMPLARY DAMAGES OF
ANY KIND (INCLUDING LOST REVENUES OR PROFITS OR LOSS OF BUSINESS)
ARISING FROM THIS AGREEMENT, WHETHER RESULTING FROM IMPAIRED OR LOST
DATA, SOFTWARE OR COMPUTER FAILURE, OR FROM THE FURNISHING,
PERFORMANCE, INSTALLATION, OR USE OF THE SOFTWARE PRODUCT, WHETHER
DUE TO A BREACH OF CONTRACT, BREACH OF WARRANTY, OR THE NEGLIGENCE
OF VRI OR ANY OTHER PARTY, EVEN IF VRI IS ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. TO THE EXTENT THAT THE APPLICABLE JURISDICTION LIMITS
VRI'S ABILITY TO DISCLAIM ANY WARRANTIES, THIS DISCLAIMER SHALL BE
EFFECTIVE TO THE MAXIMUM EXTENT PERMITTED BY LAW.
8. Limitation of Remedies and Damages
Your sole remedy for a breach of this Agreement or of any warranty hereunder is the correction or
replacement of the Software Product, at VRI’s option. VRI reserves the right to substitute a functionally
equivalent copy of the Software Product as a replacement. If VRI is unable to provide a replacement or
substitute the Software Product or corrections to the Software Product, your sole alternate remedy shall
be a refund of payment rendered by you to VRI for the Software Product, exclusive of any costs for
shipping and handling
Any claim must be made within the applicable warranty period. All warranties cover only defects arising
under normal use and do not include malfunctions or failure resulting from misuse, abuse, neglect,
alteration, problems with electrical power, acts of nature, unusual temperatures or humidity, improper
installation, or damage determined by VRI to have been caused by you. All warranties on the Software
Product are granted only to you and are non-transferable. You agree to indemnify and hold VRI
harmless from any and all claims, judgments, liabilities, expenses, and/or costs (including reasonable
attorneys' fees) arising from your breach of this Agreement and/or acts or omissions.
9. Export Law Assurances
You acknowledge and agree that the Software Product and accompanying camera(s) (collectively, the
“Products”) may be subject to U.S. Export Administration Regulations. Diversion of the Products
contrary to U.S. law is prohibited. You agree that the Products are not being or will not be acquired for,
shipped, transferred, or re-exported, directly or indirectly, to proscribed or embargoed countries or their
nationals, nor will they be used for nuclear activities, chemical or biological weapons, or missile projects
unless authorized by the U.S. government. Proscribed countries are set forth in U.S. Export
Administration Regulations. You certify that you are not on the U.S. Department of Commerce's Denied
Persons List and are not a citizen, national, or resident of, or under the control of the government of
Cuba, Iran, Iraq, Libya, North Korea, Syria or any other country to which the U.S. has prohibited export.
You are responsible for complying with any applicable local laws, including but not limited to the export
and import regulations of other countries.
10. U.S. Government Restricted Rights
If the Software Product is being acquired by or on behalf of the U.S. Government or by a U.S. Government
prime contractor or subcontractor (at any tier), in accordance with 48 C.F.R. 227.7202-4 (for Department
of Defense ("DOD") acquisitions) and 48 C.F.R. 2.101 and 12.212 (for non-DOD acquisitions), the
government's rights in the Software Product and any documentation, including its rights to use, modify,
reproduce, release, perform, display or disclose the Software Product or any documentation, will be
subject in all respects to the license rights and restrictions provided in this Agreement.
11. Termination
VRI may terminate this Agreement immediately if you breach any of its provisions. Upon expiration,
cancellation or other termination of this Agreement, you shall immediately destroy all copies of the
Software Product. Sections 3 through 10 shall survive the expiration or termination of this Agreement.
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12. Governing Law and Jurisdiction
This Agreement is governed by the laws of the State of New Jersey, without regard to its conflicts of law
provisions. In no event shall the United Nations Convention on Contracts for the International Sale of
Goods or any adopted version of the Uniform Computer Information Transactions Act apply to, or
govern, this Agreement. The parties consent to the exclusive jurisdiction of the courts of New Jersey.
13. Severability
If any provision of this Agreement shall be held to be invalid or unenforceable, the remainder of this
Agreement shall remain in full force and effect. To the extent any express or implied restrictions are not
permitted by applicable laws, these express or implied restrictions shall remain in force and effect to the
maximum extent permitted by such applicable laws.
14. Miscellaneous
VRI’s failure to exercise any right or remedy shall not be deemed a waiver of such right or remedy. Unless
otherwise agreed to in writing, any notice under this Agreement shall be delivered and addressed to you
at the address to which the Software Product is shipped, and to VRI at 100 Dey Road, Wayne, New
Jersey 07470. Notice shall be deemed received by any party: (a) on the day given, if personally delivered
or if sent by confirmed facsimile transmission, receipt verified; (b) on the third day after deposit, if
mailed by certified, first class, postage prepaid, return receipt requested mail, or by reputable, expedited
overnight courier; or (c) on the fifth day after deposit, if sent by reputable, expedited international
courier. Either party may change its address for notice purposes upon notice in accordance with this
Section. This Agreement comprises the entire agreement between the parties relating to the subject matter
hereof and may be amended or modified only in a writing executed by both parties. In addition, if you
are located in Quebec, Canada, the following clause applies: The parties hereby confirm that they
have requested this Agreement be drafted in English. Les parties contractantes confirment qu’elles
ont exigé quele présent contrat et tous les documents associés soient redigés en anglais.

1667200.2

© 2015 Vision Research - AMETEK Material Analysis Division

Welcome to Phantom Help

17

Vision Research Firmware End User License Agreement (EULA)
The software embedded in the accompanying camera and independently developed by or on behalf of Vision
Research, Inc. (the "Firmware"), and accompanying documentation, are licensed and not sold. The
Firmware is protected by copyright laws and treaties, as well as laws and treaties related to other forms of
intellectual property. Vision Research, Inc. or its subsidiaries, affiliates, and suppliers (collectively
"VRI") own intellectual property rights in the Firmware. The licensee's ("you" or "your") ability to
download, use, or copy the Firmware is subject to and governed by the terms and conditions of this End
User License Agreement ("Agreement").
1. Acceptance
YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS
AGREEMENT BY PURCHASING, RECEIVING, OR USING THE ACCOMPANYING CAMERA
(THE “CAMERA”).
2. License Grant
Subject to the terms and conditions hereof, VRI grants you a non-exclusive and non-transferable right to use
the Firmware only as it exists in the Camera at the time of shipping and for the sole purpose of operating
the Camera in accordance with manufacturer specifications. The Firmware, including any and all updates
and upgrades, shall be deemed accepted by you immediately upon receipt.
3. Restrictions
You may use the Firmware only as expressly provided in Section 2. Without limiting the foregoing, you
shall not: (a) copy the Firmware onto any multi-user, public or distributed network, or on any
configuration or system of computers that allows multiple users; (b) copy any part of the Firmware
(digitally, electronically, in writing or otherwise), except to the extent that licensed use inherently
demands the creation of a temporary copy stored in computer memory and not permanently affixed on a
storage medium; (c) change any proprietary rights notices which appear in the Firmware; (d) decompile,
"reverse-engineer", disassemble, or otherwise attempt to derive the source code for the Firmware; or (e)
modify the Firmware, or any portion thereof, or create any derivative work (including but not limited to
translations) of the Firmware or its accompanying documentation. The rights granted to you under this
Agreement are rights that may be exercised solely by you. Without first obtaining the express written
consent of VRI, you may not assign your rights or obligations under this Agreement, or redistribute,
encumber, sell, rent, lease, sublicense, or otherwise transfer your rights to the Firmware. Subject to the
foregoing, this Agreement will be binding upon and inure to the benefit of the parties, their respective
successors and permitted assigns.
4. Proprietary Rights
You agree that the copyright(s), patent(s), trademark(s), trade secret(s) and all other intellectual proprietary
rights of whatever nature in the Firmware and related documentation, including derivative works, are and
shall remain the exclusive property of VRI and any third party suppliers. Nothing in this Agreement
should be construed as transferring any aspects of such rights to you or any third party. VRI reserves any
and all rights not expressly granted herein. PHANTOM is a trademark of Vision Research, Inc., and shall
not be used by you without VRI’s express written authorization. Although the Firmware is proprietary to
VRI, certain other software contained in the Camera is subject to open source licenses, copies of which
are attached. These open source licenses shall continue to apply to any and all uses and distributions of
the applicable software undertaken by you, even if outside the scope of this Agreement. This Agreement
shall not be deemed to replace or otherwise amend any of your rights or obligations pursuant to any open
source license.
5. Warranties and Limitation of Liability
For a period of sixty (60) days from the date of shipment, VRI warrants that when properly installed and
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used under normal conditions, the Firmware will perform substantially in accordance with VRI’s
specifications. NO ADDITIONAL WARRANTIES WHATSOEVER ARE MADE BY VRI.
Warranty claims must be made within the applicable warranty period. Warranties cover only defects
arising under normal use and do not include malfunctions or failure resulting from misuse, abuse, neglect,
alteration, problems with electrical power, acts of nature, unusual temperatures or humidity, improper
installation, or damage determined by VRI to have been caused by you. Warranties on the Firmware are
granted only to you and are non-transferable. After expiration of the applicable warranty period, THE
FIRMWARE IS LICENSED "AS IS," WITHOUT ANY WARRANTIES WHATSOEVER. VRI
EXPRESSLY DISCLAIMS, AND YOU EXPRESSLY WAIVE, ALL WARRANTIES, WHETHER
EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, SYSTEM INTEGRATION,
NON-INTERFERENCE AND ACCURACY OF INFORMATIONAL CONTENT. VRI DOES
NOT WARRANT THAT THE FIRMWARE WILL MEET YOUR REQUIREMENTS OR THAT
THE OPERATION OF THE FIRMWARE WILL BE SECURE, UNINTERRUPTED OR
ERROR-FREE, OR THAT ERRORS WILL BE CORRECTED. THE ENTIRE RISK OF THE
FIRMWARE’S QUALITY AND PERFORMANCE IS WITH YOU.
UNDER NO CIRCUMSTANCES SHALL VRI, ITS DIRECTORS, OFFICERS, EMPLOYEES OR
AGENTS BE LIABLE TO YOU OR ANY OTHER PARTY FOR INDIRECT,
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE, OR EXEMPLARY DAMAGES OF
ANY KIND (INCLUDING LOST REVENUES OR PROFITS OR LOSS OF BUSINESS)
ARISING FROM THIS AGREEMENT, WHETHER RESULTING FROM IMPAIRED OR LOST
DATA, SOFTWARE OR COMPUTER FAILURE, OR FROM THE FURNISHING,
PERFORMANCE, INSTALLATION, OR USE OF THE FIRMWARE, WHETHER DUE TO A
BREACH OF CONTRACT, BREACH OF WARRANTY, OR THE NEGLIGENCE OF VRI OR
ANY OTHER PARTY, EVEN IF VRI IS ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. TO THE EXTENT THAT THE APPLICABLE JURISDICTION LIMITS VRI'S
ABILITY TO DISCLAIM ANY WARRANTIES, THIS DISCLAIMER SHALL BE EFFECTIVE
TO THE MAXIMUM EXTENT PERMITTED BY LAW. Your sole remedy for a breach of this
Agreement or of any warranty hereunder is the correction or replacement of the Firmware/Camera, at
VRI’s option. VRI reserves the right to substitute a functionally equivalent camera as a replacement. If
VRI is unable to provide a replacement or substitute the Firmware/Camera or corrections to the
Firmware, your sole alternate remedy shall be a refund of payment rendered by you to VRI for the
camera, exclusive of any costs for shipping and handling.
You agree to indemnify and hold VRI harmless from any and all claims, judgments, liabilities, expenses, and
costs (including reasonable attorneys' fees) arising from your breach of this Agreement and/or acts or
omissions.
6. Export Law Assurances
You acknowledge and agree that the Firmware and accompanying Camera(s) (collectively, the “Products”)
may be subject to U.S. Export Administration Regulations. Diversion of the Products contrary to U.S.
law is prohibited. You agree that the Products are not being or will not be acquired for, shipped,
transferred, or re-exported, directly or indirectly, to proscribed or embargoed countries or their nationals,
nor will they be used for nuclear activities, chemical or biological weapons, or missile projects unless
authorized by the U.S. government. Proscribed countries are set forth in U.S. Export Administration
Regulations. You certify that you are not on the U.S. Department of Commerce's Denied Persons List
and are not a citizen, national, or resident of, or under the control of the government of Cuba, Iran, Iraq,
Libya, North Korea, Syria or any other country to which the U.S. has prohibited export. You are
responsible for complying with any applicable local laws, including but not limited to the export and
import regulations of other countries.
7. U.S. Government Restricted Rights
If the Firmware or Camera is being acquired by or on behalf of the U.S. Government or by a U.S.
Government prime contractor or subcontractor (at any tier), in accordance with 48 C.F.R. 227.7202-4 (for
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Department of Defense ("DOD") acquisitions) and 48 C.F.R. 2.101 and 12.212 (for non-DOD
acquisitions), the government's rights in the Firmware and any documentation, including its rights to use,
modify, reproduce, release, perform, display or disclose the Firmware or any documentation, will be
subject in all respects to the license rights and restrictions provided in this Agreement.
8. Termination
VRI may terminate this Agreement immediately if you breach any of its provisions. Upon expiration,
cancellation or other termination of this Agreement, you shall immediately destroy all copies of the
Firmware. Sections 3 through 10 shall survive the expiration or termination of this Agreement.
9. Governing Law and Jurisdiction
This Agreement is governed by the laws of the State of New Jersey, without regard to its conflicts of law
provisions. In no event shall the United Nations Convention on Contracts for the International Sale of
Goods or any adopted version of the Uniform Computer Information Transactions Act apply to, or
govern, this Agreement. The parties consent to the exclusive jurisdiction of the courts of New Jersey.
10. Miscellaneous
If any provision of this Agreement shall be held to be invalid or unenforceable, the remainder of this
Agreement shall remain in full force and effect, and such provision shall be deemed modified to the
minimum extent necessary to make such provision consistent with applicable law and, in its modified
form, such provision shall be enforceable and enforced. VRI’s failure to exercise any right or remedy
shall not be deemed a waiver of such right or remedy. Unless otherwise agreed to in writing, any notice
under this Agreement shall be delivered and addressed to you at the address to which the Firmware is
shipped, and to VRI at 100 Dey Road, Wayne, New Jersey 07470. Notice shall be deemed received by
any party: (a) on the day given, if personally delivered or if sent by confirmed facsimile transmission,
receipt verified; (b) on the third day after deposit, if mailed by certified, first class, postage prepaid,
return receipt requested mail, or by reputable, expedited overnight courier; or (c) on the fifth day after
deposit, if sent by reputable, expedited international courier. Either party may change its address for
notice purposes upon notice in accordance with this Section. This Agreement comprises the entire
agreement between the parties relating to the subject matter hereof and may be amended or modified only
in a writing executed by both parties. In addition, if you are located in Quebec, Canada, the following
clause applies: The parties hereby confirm that they have requested this Agreement be drafted in
English. Les parties contractantes confirment qu’elles ont exigé quele présent contrat et tous les
documents associés soient redigés en anglais.
Files licensed pursuant to the GNU LGPL
pam_issue.c
libmemusage.so**
pam_mkhomedir.c
libnsl-2.2.3.so**
ldconfig.c
libnss_compatsysctl.c
2.2.3.so**
ld-2.2.3.so**
libnss_dns-2.2.3.so**
libresolv-2.2.3.so**
libc-2.2.3.so**
libnss_files-2.2.3.so**
libdl-2.2.3.so**
libnss_hesiodlibm-2.2.3.so**
2.2.3.so**

libnss_nis-2.2.3.so**
libnss_nisplus2.2.3.so**
libpthread-0.9.so**
libthread_db-1.0.so**

libBrokenLocale
-2.2.3.so**
libcrypt-2.2.3.so**
libpcprofile.so*

libSegFault.so**
libanl-2.2.3.so**

librt-2.2.3.so**
libutil-2.2.3.so**
libproc.so.2.0.7

**May contain components which are freely distributable under the BSD License and licenses from Carnegie Mellon
University and others.
Files licensed pursuant to the GNU GPL
bash-3.0 (various files)
touch.c
cat.c
true.c
chgrp.c
umount.c
chmod.c
uname.c
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fsck.c (and others)
genksyms.c
agetty.c

sulogin.c
swapon.c
tune2fs.c
gawk-3.1.5
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(various
chown.c
chown-core.c
files)
chroot.c
cp.c
cpio (various)
files)
date.c
,smbmnt
dd.c
,smbmount,smbumou
df.c
dmesg.c
echo.c
false.c
hostname.c
kill.c
ln.c
ls.c
mkdir.c
mknod.c
mv.c
ping.c
libconsole.so.0.0.0
pivot_root.c
pwd.c
readlink.c
rm.c
rmdir.c
sleep.c
stty.c
su.c
sync.c
?

fuser.c
grep, fgrep, egrep

halt.c
hwclock.c

files)
less-382 (various

(various files)
gzip/gunzip,uncompr
ess,zcat

ifconfig.c,ifdown,ifup
ifinit
insmod.c,

mesg.c
passwd.c
rgrep (various

loadkeys.c

insmod.static

smbclient

mount, umount

insmod_ksymoops_cle

(various files)
netstat.c
pstree.c
runparts.c
sed-4.1.4 (various
files)
setserial.c
tar-1.15.1 (various
files)
tempfile.c
ls-vdir.c
cut.c

an
install-info.pl
ipmaddr.c
iptunnel.c
kernelversion
killall5.c
klogd.c
lspci.c
mii-tool.c
mke2fs.c
mkfs.c
modinfo.c

nt(various files)
arp.c
exportfs.c
grpck.c
pwck.c
telnetd
lockd
mountd
nfsd
statd
kbdrate

du.c
find.c
id.c
su.c
badblocks.c
depmod.c
devfsd.c
dumpe2fs.c
e2fsck.c

plipconfig.c
rarp.c
resize2fs.c
route.c
runlevel.c
setpci.c
shutdown.c
slattach.c
sln.c

libcfont.so.0.0.0
libctutils.so.0.0.0
libe2p.a
losetup?
libe2p.so.2.3
libext2fs.a
libext2fs.so.2.4
mkswap.c

May contain components which are freely distributable under the BSD license.

Files Licensed Pursuant to the “Original BSD” License
pam_rhosts_auth.c (©
pmap_dump.c (© 1990
1992,
1983, 1993, 1994 Regents
Regents of Univ. of
1996
of Univ. of California)
California)
ash-0.2 (various files) (©
pmap_set.c (© 1990
(©2000
1991 Regents of Univ. of
Regents of Univ. of
Holland)
California)
California)
Files licensed pursuant to a BSD type license
pam_deny.c (© 1996
1996
pam_access.c (no ©
Andrew Morgan)
notice)
pam_env.c (© 1997 Dave
1996pam_cracklib.c (© 1996
Kinchlea, Andrew
Gafton)
Cristian Gafton)
Morgan)
pam_listfile.c (© 1996
libnss_nis-2.2.3.so (©
Elliot Lee, 1998

portmap.c (© 1990

California, 1991,

Regents of Univ. of

1993, 1994, 1995,

California)
nvi-1.79 (various files)

Keith Bostic)
telnetlogin.c

(© 1991, 1992, 1993, 1994

David A.

Regents of Univ. of

pam_filter.c (© Andrew

pam_lastlog.c (©

Morgan)
pam_ftp.c (© 1996

Andrew Morgan)
pam_limits.c (©

Andrew Morgan)

1997 Cristian

scp.c (© 1995 Timo

pam_group.c (© 1996
Andrew Morgan)
libuuid.so.1.2 (© 1999,

Rinne, Tatu Ylonen,

2000, 2003, 2004

1991Regents of

© 2015 Vision Research - AMETEK Material Analysis Division

Welcome to Phantom Help

Univ. of
Christopher McCrory)
pam_mail.c (© 1996
libnss_nisplus-2.2.3.so
Andrew Morgan, 1997
of Univ.
Dave Kinchlea, 1998
Chris Adams)
(©
pam_motd.c (© Ben
Univ. of
Collins)
pam_nologin.c (© 1996
libthread_db-1.0.so (©
Michael K. Johnson)
Univ. of
pam_permit.c (© 1996
Andrew Morgan)
pam_rootok.c (© 1996
Univ. of
Andrew Morgan)
pam_securetty.c (© 1996
Elliot Lee)
Univ. of
pam_shells.c (© 1996
Erik Troan)
libBrokenLocale-2.2.3.so
pam_stress.c (© 1996
of Univ.
Andrew Morgan)
pam_tally.c (© 1997 Tim
(©
Baverstock, 2005 Tomas
Univ. of
Mraz, 2005 Sebastien
Tricaud)
(©
pam_time.c (© 1996
Univ. of
Andrew Morgan)
pam_unix.so (no ©
(©
notice)
Univ. of
pam_userdb.h (© 1999
Cristian Gafton)
pam_warn.c (© 1996
Univ. of
Andrew Morgan)
pam_wheel.c (© 1996,
1997 Cristian Gafton)
Univ. of
login.c (© 1980, 1987,
1988 Regents of Univ. of
Dr. Brian
California)
Vozeler,
mktemp.c (©1996, 2000,
Brouwer, Frodo
2001 Todd C. Miller)
Richard
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1999 Theo de Raadt,
Aaron Campbell)

Theodore Ts’o)
libcrypto.a (©1998-1999

California)

telnet.c (© Regents of

The OpenSSL Project, ©

(© 1991Regents

Univ. of California)
ssh-keygen.c (© 1994

1995-1998 Eric Young,
Tim Hudson)

of California)
libpthread-0.9.so

Tatu Ylonen)

libssl.a 1998-1999 The

1991Regents of

sftp-server.c (© 2000,
2001, 2002 Markus

OpenSSL Project, ©
1995-1998 Eric Young,

California)

Friedl)

Tim Hudson)ld-2.2.3.so

1991Regents of

ssh-keysign.c (© 2002
Markus Friedl)
sshd.c c (© 1995 Tatu

(© 1991Regents of Univ.
of California)
libc-2.2.3.so (©

California)
libSegFault.so (©
1991Regents of

Ylonen, 2000, 2001, 2002
Markus Friedl, 2002
Niels Provos)

1991Regents of Univ. of
California)
libdl-2.2.3.so (©

California)
libanl-2.2.3.so (©
1991Regents of

unix_chkpasswd.c (©
1996 Andrew Morgan)

1991Regents of Univ. of
California)

California)

inetd.c (©1983, 1991,

libm-2.2.3.so (©

(© 1991Regents

1993, 1994, 2002 Regents
of Univ. of California)

1991Regents of Univ. of
California)

of California)
libcrypt-2.2.3.so

tftpd (© 1983, 1993

libmemusage.so (©

1991Regents of

Univ. of California)
libpamc.so.0.72 (no ©

1991Regents of Univ. of
California)

California)
libpcprofile.so

notice)

libnsl-2.2.3.so (©

1991Regents of

libpam_misc.so.0.72 (no
© notice)

1991Regents of Univ. of
California)

California)
libresolv-2.2.3.so

libpam.so.0.72 (no ©

libnss_compat-2.2.3.so

1991Regents of

notice)
libncurses.so.5.2 (© 1998
Free Software

(© 1991Regents of Univ
of California)
libnss_dns-2.2.3.so (©

California)
librt-2.2.3.so (©
1991Regents of

Foundation)
libcom_err.so.2.0 (© 1987,
1988 Student Information

1991Regents of Univ. of
California)
libnss_files-2.2.3.so (©

California)
libutil-2.2.3.so (©
1991Regents of

Processing Board of the
Massachusetts Institute of

1991Regents of Univ. of
California)

California)
losetup (©2001

Technology, Yann Dirson)

libnss_hesiod-2.2.3.so (©

Gladman, Max

libuuid.a (© 1999, 2000,

1991Regents of Univ. of

Andries

2003, 2004 Theodore

California)

Looijaard,

Ts’o)
Ruusu)
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Files Licensed Pursuant to a quasi —“Original BSD” Licenses
more.c
syslog.d
Files Licensed pursuant to the Sleepycat License
libdb-3.2.so
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright © 1991, 1999 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2,
hence the version number 2.1.]
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public
Licenses are intended to guarantee your freedom to share and change free software—to make sure the software is free for all its users.
This license, the Lesser General Public License, applies to some specially designated software packages—typically libraries—of the
Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the explanations
below.
When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure
that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you
can do these things.
To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them with the library after making changes to the library and recompiling
it. And you must show them these terms so they know their rights.
We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.
To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by
someone else and passed on, the recipients should know that what they have is not the original version, so that the original author’s
reputation will not be affected by problems that might be introduced by others.
Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent
license obtained for a version of the library must be consistent with the full freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those libraries into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire
combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the
library.
We call this license the “Lesser” General Public License because it does Less to protect the user’s freedom than the ordinary General
Public License. It also provides other free software developers Less of an advantage over competing non-free programs. These
disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license provides
advantages in certain special circumstances.
For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a
de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does
the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we
use the Lesser General Public License.
In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free
software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users’ freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a
“work based on the library” and a “work that uses the library”. The former contains code derived from the library, whereas the latter
must be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called “this License”).
Each licensee is addressed as “you”.
A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.
The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work based on
the Library” means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term “modification”.)
“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code
means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.
1. You may copy and distribute verbatim copies of the Library’s complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all
the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange
for a fee.
2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.
d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the facility still operates, and performs whatever part of its
purpose remains meaningful.
(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional:
if the application does not supply it, the square root function must still compute square roots.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and
can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work
based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other work under the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library.
To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License,
version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared,
then you can specify that version instead if you wish.) Do not make any other change in these notices.
Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.

© 2015 Vision Research - AMETEK Material Analysis Division

24

Phantom Camera Control Help File

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.
4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the
terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code,
which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.
If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the
source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to
copy the source along with the object code.
5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or
linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore
falls outside the scope of this License.
However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a “work that uses the library”. The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.
6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a
work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit
modification of the work for the customer’s own use and reverse engineering for debugging such modifications.
You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered
by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include
the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. Also, you must
do one of these things:
a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable “work that uses the Library”, as object code and/or source code,
so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is
understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile
the application to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user’s computer system, rather than copying library functions into the executable, and
(2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is
interface-compatible with the version that the work was made with.
c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the
above specified materials from the same place.
e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.
For an executable, the required form of the “work that uses the Library” must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating
system on which the executable runs, unless that component itself accompanies the executable.
It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany
the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you
distribute.
7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based
on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:
a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where
to find the accompanying uncombined form of the same work.
8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights
under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses
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terminated so long as such parties remain in full compliance.
9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying the Library or works based on it.
10.Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance by third
parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent
license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you,
then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented
by public license practices. Many people have made generous contributions to the wide range of software distributed through that
system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.
13.The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it
and “any later version”, you have the option of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version
ever published by the Free Software Foundation.
14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the sharing and reuse of software generally.
NO WARRANTY
15.BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.
16.IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR
THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of
the ordinary General Public License).
To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most
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effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice
is found.
<one line to give the library’s name and a brief idea of what it does.> Copyright © <year> <name of author>
This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details.
You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the library,
if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob’ (a library for tweaking knobs) written by James Random
Hacker.
<signature of Ty Coon>, 1 April 1990 Ty Coon, President of Vice
That’s all there is to it!

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991
Copyright © 1989, 1991 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free software—to make sure the software is free for all its users. This
General Public License applies to most of the Free Software Foundation’s software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.) You can
apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you
have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their
rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to
copy, distribute and/or modify the software.
Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the
original, so that any problems introduced by others will not reflect on the original authors’ reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program
will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent
must be licensed for everyone’s free use or not licensed at all.
The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a
portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included
without limitation in the term “modification”.) Each licensee is addressed as “you”.
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Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the
Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.
1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this
License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange
for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on the Program is not required to print an announcement.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program,
and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to
those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees
extend to the entire whole, and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on
a volume of a storage or distribution medium does not bring the other work under the scope of this License.
3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you also do one of the following:
a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of
physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you received the program in object code or executable form with such
an offer, in accord with Subsection b above.)
The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete
source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used
to control compilation and installation of the executable. However, as a special exception, the source code distributed need not
include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so
on) of the operating system on which the executable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.
4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this
License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying the Program or works based on it.
6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further
restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties
to this License.
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues),
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conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent
license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you,
then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended
to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is
implemented by public license practices. Many people have made generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License
incorporates the limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it
and “any later version”, you have the option of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any
version ever published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the
author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software
Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all
derivatives of our free software and of promoting the sharing and reuse of software generally.
NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR
THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey
the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.
<one line to give the program’s name and a brief idea of what it does.> Copyright © <year> <name of author>
This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as published
by the Free Software Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.
You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
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If the program is interactive, make it output a short notice like this when it starts in an interactive mode:
Gnomovision version 69, Copyright © year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w’.
This is free software, and you are welcome to redistribute it under certain conditions; type `show c’ for details.
The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, the
commands you use may be called something other than `show w’ and `show c’; they could even be mouse-clicks or menu items—
whatever suits your program.
You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the
program, if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision’ (which makes passes at compilers) written by
James Hacker.
<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice
This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine
library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the
GNU Library General Public License instead of this License.
Original BSD license
Copyright (c) <YEAR>, <OWNER>. All rights reserved.
This software was developed by the Computer Systems Engineering group at Lawrence Berkeley Laboratory under DARPA contract BG
91-66 and contributed to Berkeley.
All advertising materials mentioning features or use of this software must display the following acknowledgement: This product includes
software developed by the Universiy of California, Lawrence Berkeley Laboratory.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are
met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: This product
includes software developed by the University of California, Berkeley and its contributors.
4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
BSD license
Copyright (c) <YEAR>, <OWNER>
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are
met:
· Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
· Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or promote products derived
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from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Quasi-original BSD license
Copyright (C) 1980 The Regents of the University of California.
All rights reserved.
Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use
acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to
endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.
Carnegie Mellon license
Mach Operating System
Copyright (C) 1991,1990,1989 Carnegie Mellon University
All Rights Reserved.
Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided that both the copyright
notice and this permission notice appear in all copies of the software, derivative works or modified versions, and any portions thereof,
and that both notices appear in supporting documentation.
CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" CONDITION. CARNEGIE MELLON
DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS
SOFTWARE.
Carnegie Mellon requests users of this software to return to
Software Distribution Coordinator
School of Computer Science
Carnegie Mellon University
Pittsburgh PA 15213-3890
or <Software.Distribution@CS.CMU.EDU> any improvements or extensions that they make and grant Carnegie Mellon the rights to
redistribute these changes.
SLEEPYCAT LICENSE
Copyright (c) 1990-1999 Sleepycat Software. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are
met:
· Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
· Redistributions in any form must be accompanied by information on how to obtain complete source code for the DB software and any
accompanying software that uses the DB software. The source code must either be included in the distribution or be available for no
more than the cost of distribution plus a nominal fee, and must be freely redistributable under reasonable conditions. For an
executable file, complete source code means the source code for all modules it contains. It does not include source code for modules
or files that typically accompany the major components of the operating system on which the executable file runs.
THIS SOFTWARE IS PROVIDED BY SLEEPYCAT SOFTWARE ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT, ARE DISCLAIMED. IN NO EVENT SHALL SLEEPYCAT SOFTWARE
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
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PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1990, 1993, 1994, 1995 The Regents of the University of California. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are
met:
· Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
· Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1995, 1996 The President and Fellows of Harvard University. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are
met:
· Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
· Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY HARVARD AND ITS CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL HARVARD OR ITS CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
1668448
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Important Warnings and Cautions
Please review the following warnings and caution before using your Phantom camera.

Getting Started
1. When connecting to a Phantom camera do not open the Phantom Camera Control software
until all installation procedures have been completed.
2. Never use an outdated Serial Tag Number (,stg) file and never mix ,stg files. Using ,stg files
from other cameras may cause serious damage.
3. When connecting to a Phantom IEEE 1394 camera the IEEE 1394 card and drivers must be
installed before installing the Phantom Camera Control software on your computer.
4. Do not use the IEEE 1394 drivers supplied with the card. Do not use Window's Install
Wizards' feature.
5. If an IEEE 1394 Phantom camera does not appear in the Windows Device Manager>Sound,
video and game controllers list, do not start the Phantom Camera Control software.

Quick Starts
1. Ensure that the CompactFlash Card is PROPERLY oriented before seating it into a Phantom
Miro camera. DO NOT FORCE THE CARD INTO THE CAMERA. Failure to comply with this
instruction may result in a serious camera failure requiring it to be returned to Vision Research
for service.
2. Any cine files stored in the camera's memory must be deleted prior to powering down a
Phantom Miro camera. Failure to comply with this procedure will cause the camera to run on
battery power until the battery discharges completely.

Phantom (PCC) Camera Control Application
1. When using a monitor to apply Image Processing effects, the White Balance control, and all
brightness, contrast, gamma, and color adjustments should be changed only when using a
monitor that is in correct adjustment. Occasionally, an operator will over adjust the monitor
settings in extreme lighting conditions, such as in direct sunlight, in an attempt to get a better
look at what he is trying to image. "Correcting" the appearance of images on a poorly adjusted
monitor will have a negative result on cine file recordings that will later be viewed on a
properly adjusted monitor under normal conditions.
2. White Balance Adjustment cannot be performed over an area with any saturated pixels.
3. Removing a Group or Sub-Group with multiple groups, cameras, or cine files under it will
remove all the objects in the tree.
4. When utilizing the f-sync feature with this application, all cameras must be supplied an
external trigger. If a soft-trigger is used to trigger the cameras, Vision Research cannot
guarantee that the cameras will remain synchronized.
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Phantom CineMag
1. Be sure to Save all the cine files stored in Phantom CineMag you want to keep before erasing
the Phantom CineMag Flash memory. This is an all-or-nothing selection, the memory can only
be erased in its entirety, individual files cannot be purged separately.
2. To use the Phantom CineMag Erase Protect feature place the Erase Protect Switch, located
underneath the Phantom CineMag, into the locked position, indicating the CineMag is in
Erase Protect Mode. The Erase Protect Indicator will then be when locked.

Phantom Miro Control via "Touch-Sensitive" LCD Screens
1. If the battery charge indicator turns red, and you have an unsaved cine in memory you should
immediately connect the camera to the power supply and save the cine. If you lose camera
power you will lose any unsaved cine files.
2. Once a cine file is deleted it cannot be recovered. Be sure to save any cine file you wish to
keep before deleting the cine file.
3. All cine files must be deleted from the camera's memory buffer prior to performing the Power
Off Procedure. If you fail to comply with this caution, the camera will not power down, it will
continue to run until the life of the battery is exhausted.

Phantom Video Player Application
1. Running more than one instance of the Phantom Video Player application will reset the
application to live view only.

Image-Based Auto-Trigger
1. The Image-Based Auto-Trigger feature should never be used in applications where missed or
false triggers cannot be tolerated or where a false trigger could cause harm to people or
property.
2. The hardware signaling available in some Image-Based Auto-Trigger modes should be used
only to synchronize multiple Phantom cameras together and should never be used to trigger
or control any other external device or event.
3. CONSEQUENCES RESULTING FROM SYSTEM FAILURE, FALSE TRIGGERING OR
MISUSE OF THIS FEATURE ARE THE SOLE RESPONSIBILITY OF THE USER.

SAM-3, (Signal Acquisition Module-3), Installation
1. The Data Acquisition Omni CD - Installation CD provides WDM-compliant device drivers and
DLLs (version 5.0 or greater). Other Data Translation boards may not provide WDM-compliant
files.
2. Use of a DT9800 Series board is restricted from being used at the same time another Data
Translation board is in use, unless both devices provide WDM-compliant files.
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3. To prevent electrostatic damage that can occur when handling electronic equipment, use a
ground strap or similar device when performing module installation procedures.
4. Before removing the DT3010 module from its anti-static bag you will need to discharge any
static electricity by holding the wrapped board on one hand while placing your other hand
firmly on a metal portion of the computer chassis.
5. Do not force the DT3010 module into place. Moving the board from side to side during
installation may damage the bus connector. If you encounter resistance when inserting the
board, remove the board and try again.
6. Selecting either the External option will cause the Phantom camera to lock up if the respective
input signal is not available. If there is no external or IRIG-B clock source the Internal option
MUST BE selected.

Sync Imaging (Camera Network Options)
1. When utilizing the fsync feature, all cameras must be supplied an external trigger. If a softtrigger is used to trigger the cameras, Vision Research cannot guarantee that the cameras
will remain synchronized.

Connectors and Indicators
1. The connector references in this document are not intended, nor should they be used, as a
cable schematic to build connection cables. Building your own cables can cause serious
damage to the camera. Only connector cables provided by Vision Research should be used.

Phantom File Naming Convention
1. When saving your files as a series of still images, you must follow this naming convention or
the individual images will be overwritten every time the camera stores additional Images.

Phantom STG (Serial Tag Number) File
1. Never use an outdated ,stg file, or mix ,stg files. ,stg files from other cameras may cause
serious damage to the camera.
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Important Operational Notes and Safety Instructions
All Phantom cameras and peripherals have been designed and produced according to the relevant
safety standards. Although the mechanical design is extremely rugged and stable, the content hightech micro electronics deserves a careful handling.
Please review the following important facts about your Phantom camera.

Important Operational Notes
1. If the Phantom cameras are to run in Capture mode for an extended period of time at 1,000
pictures per second, or greater, at the full resolution, or when the capture time is longer than
30 minutes use the pre-trigger feature to place the camera into the stand-by "LIVE" mode.
This unique power management feature provides extended operation from battery packs,
cooler operation and improved image quality. When the camera is in Live mode, the camera
will return to full operation within in one picture after a trigger.
2. Phantom cameras can only store a finite number of images into the memory buffer based on
the resolution, sample rate, image bit depth settings, and the memory size.
3. For best image quality, Vision Research recommends performing a "Current Session
Reference" immediately before triggering if possible.
4. Cine files captured with this version can also be viewed with earlier versions of software. Still
it is recommended to update the Phantom Camera Control application.
5. It is important to note that making a single setup and recording parameter change via the
Phantom Camera Control application will change all the setup and recording parameters
displayed on a Phantom 65, Phantom HD, or Phantom Miro attached monitor or viewfinder, as
defined in the Phantom Camera Control>Live Control Panel.
6. Conversely making changes to the recording parameters via the On-Camera Control buttons,
or Touch-Sensitive LCD Screens, will not change the settings in the Phantom Camera
Control>Live Control Panel.
7. When using a Phantom CineMag the camera's Sample Rate will automatically be changed to
the maximum allowable frame rate based on the selected Resolution when operating in Run/
Stop Mode.
8. For a brief description of Run/Stop Mode operation, see: Functional Descriptions>Phantom
CineMag Operational Modes.
9. Only the entire contents of the Phantom CineMag can be erased, the system does not allow a
user to specify a single cine file to be erased.
10.Presently, both the Phantom 65 and Phantom HD only supports the use of a color
ViewFinder.
11.A Phantom HD or Phantom 65 camera has an operational attribute such that the fans will
start when the temperature is raised 5 degrees, then they will be turned off. As the camera
warms an additional five degrees the fan will automatically come back on.
12.You should never do a firmware upgrade when running on battery power. Ensure the camera
is connected to AC power.
13.If, for some reason, the firmware upgrade fails, the camera will likely need to be returned to
Vision Research for service.
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14.Vision Research highly recommends that you contact our Technical Support staff prior to
performing a firmware upgrade to a Phantom v9.0, v7.2, v7.1, v7.0, v5.1, v4.3, v4.2 camera
models.
15.The Firmware Upgrade Process should never be used to load an earlier version of firmware
that is already loaded into the camera, and must never be used with IEEE 1394 camera
models.
16.The Image-Based Auto-Trigger feature should never be used in applications where missed or
false triggers cannot be tolerated or where a false trigger could cause harm to people or
property.
17.The hardware signaling available in some Image-Based Auto-Trigger modes should be used
only to synchronize multiple Phantom cameras together and should never be used to trigger
or control any other external device or event.
18.CONSEQUENCES RESULTING FROM SYSTEM FAILURE, FALSE TRIGGERING OR
MISUSE OF THIS FEATURE ARE THE SOLE RESPONSIBILITY OF THE USER.
19.In order for a Phantom v4.0, v4.1, v5.0, v6.0, or v6.1 camera to communicate properly with
the Phantom Control Unit, over an IEEE 1394 connection, the controller unit must use the
following Microsoft IEEE 1394 drivers:
a. 1394bus.sys, dated: May-4, 2001
b. ochi 1394.sys, dated: May 4, 2001

Important Safety Instructions
General
Do not open the product; there is no user serviceable parts inside. All maintenance and
service work should be performed by qualified service personnel. The camera’s are
intended to be used in restricted access areas.
Installation
Do not expose your cameras and peripherals to excessive heat, moist and dirt. They are
intended to be used in a controlled environment, unless precautions have been taken for
outdoor use.
The cameras and peripherals should only be powered from an appropriate DC power
supply that fulfills the local safety and EMC demands or the appended AC adapter.
Do not install the camera in an excessively humid environment or near water.
Avoid liquids or any foreign object to get into the product.
The unit must be placed in a sufficiently ventilated area; the ambient temperature should
not exceed the specified temperature range.
It is important that ventilation air can move freely around the unit.
Operating Temperature
The Phantom cameras are designed to operate satisfactorily in an environment where the
ambient temperature is, for a:
Phantom v710, v640, v310, v210, v12.1; between 0°C and 40°C at 8% to 80% relative
humidity.
Phantom v10, v7.3, v5.2; between 10°C and 40°C at 80% relative humidity noncondensing at 5°C.
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Phantom 9.1; between -10°C and 50°C at 80% relative humidity non-condensing at 5°C.
Phantom Miro Airborne; between -30°c to 50°c; Mil-Std-810G Method 502.5, Proc III, MilStd-810G Method 501.5, Proc II, III at 95% non-condensing: Mil-Std-810G Method
507.5 Proc I, II.
Phantom Miro eX4, Miro eX2, Miro eX1; between 0°C and 50°C.
Phantom Miro 3; between 0°C and 40°C.
Storage Temperature
Store the camera in a dry location, storage temperature must be within, for a:
Phantom v710, v640, v310, v210, v12.1, v10, v9.1, v7.3, v5.2; between -10°C to 55°C.
Phantom Miro eX4, Miro eX2, Miro eX1; between 20°C and 70°C.
Altitude Operating
Phantom v12.1: Not specified.
Phantom Miro Airborne: Sea level to 40,000 feet; Mil-Std-810G Method 500.0 Proc III,
(Operating)
Phantom Miro Airborne: -500 to 50,000 feet; Mil-Std-810G Method 500.0; Proc III, (NonOperating)
Vibration
Phantom v710, v12.1: 0.25G, 5-500 Hz, all axes (operational).
Phantom v640, v310: 25G, 5-500 Hz, all axes without CineMag.
Phantom v210: 0.25G, 5-500 Hz, all axes without CineMag.
Phantom Miro Airborne: Functional: 0.20g2/Hz for 1 hour in each of the three orthogonal
axes; Endurance: 0.83g2/Hz for 1 hour in each of the three orthogonal axes; Mil-Std-810G
Method 514.6, Proc I
Operational Shock
Phantom v710, v640, v310, v210, v12.1: 30G, half sine wave, 11 ms, 10 times all axes
(without CineMag or lens) to Mil-Std-810 G
Non-Operational Shock
Phantom v210: 33G, half sine wave, 11ms, all axes without CineMag.
EMI/RFI
Phantom Miro Airborne: Passed; EN-55033A, IEC-61000-3-2 and 3-3, EN-55024, EN50082, IEC-61000-4-2
Acceleration
Phantom Miro Airborne: 6g for 1 minute on all axes; RTCA/DO-160E Section 7.3.3 Crash
Safety Sustained
Acoustic (Susceptibility)
Phantom Miro Airborne: 150 dBA operational, 170 dBA storage
Shipping
When shipping the Phantom cameras and accessories, use the carton in which the unit
was originally delivered. If you must frequently ship your imager, you may wish to purchase
an accessory carrying case that has been designed for this purpose.
Lasers Precautions
A laser beam focused on the sensor of a Phantom camera, either directly or by reflection,
can cause permanent damage to the sensor. Any laser powerful enough to produce
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localized heating at the surface of the sensor will cause damage, even if the camera power
is off. A sensor damaged by laser light is NOT covered by warranty.
FCC Declaration Not Obligatory for CE
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help
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Getting Started
Although the Phantom high speed imaging system comes with all the software installed, and ready
for use, if you purchased your Phantom Control Unit, PC/Laptop), from Vision Research. The topics
in this section provide recommendations and instructions if:
· You're upgrading to a new software version.
· You've purchased an additional software licence for installation on another computer,
· You've purchased a Phantom Control Unit from a vendor other than Vision Research.
These instructions detail the minimum system recommendations and preparation, program and
Serial Tag Number (,stg) file installations, and how to verify your controller is connecting properly to
the Phantom camera.

2.1

Phantom Camera Control Unit Requirements
In this topic we will detail the minimum system requirements:
FOR CONTROL OF
PHANTOM V710, V640, PHANTOM MIRO-SERIES, PHANTOM CAMERA
V310, V210, V12-SERIES, V7-SERIES, V6-SERIES, CONTROL SOFTWARE
V10, OR V9-SERIES CAMERA
V5-SERIES, OR V4-SERIES
SUPPORT ONLY
CAMERA
SYSTEM TYPE

IBM-PC or compatible

IBM-PC or compatible

IBM-PC or compatible

MICROPROCESSOR

Pentium-class 1.7GHz or
higher

Pentium-class 1.4GHz or
higher

Pentium-class 1.7GHz or
higher; (Phantom v9, v10,
and v12 Series, Phantom
v710, v640, v310, v210)
Pentium-class 1.4GHz or
higher; (Phantom Miro, v4,
v5, v6, and v7 Series)

OPERATING SYSTEM (1) Microsoft Windows 2000 + Microsoft Windows 2000 + Microsoft Windows 2000 +
Service Pack4
Service Pack4
Service Pack4
Microsoft Windows XP Pro Microsoft Windows XP Pro Microsoft Windows XP Pro
+ Service Pack3 (32 & 64 + Service Pack3 (32 & 64 + Service Pack3 (32 & 64
Bit)
Bit)
Bit)
Windows XP Tablet
Edition, Microsoft
Windows Vista Business
Edition (32 & 64 Bit)

Windows XP Tablet
Edition, Microsoft
Windows Vista Business
Edition (32 & 64 Bit)

Windows XP Tablet
Edition, Microsoft
Windows Vista Business
Edition (32 & 64 Bit)

Microsoft Windows Vista
Enterprise Edition (32 &
64 Bit)

Microsoft Windows Vista
Enterprise Edition (32 &
64 Bit)

Microsoft Windows Vista
Enterprise Edition (32 &
64 Bit)

Microsoft Windows Vista
Ultimate Edition (32 & 64
Bit)

Microsoft Windows Vista
Ultimate Edition (32 & 64
Bit)

Microsoft Windows Vista
Ultimate Edition (32 & 64
Bit)
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Microsoft Windows 7
(32 & 64 Bit)

Microsoft Windows 7
(32 & 64 Bit)

Microsoft Windows 7
(32 & 64 Bit)

ADMINISTRATIVE
PRIVILEGES

Required for all Microsoft
Operating Systems

Required for all Microsoft
Operating Systems

Required for all Microsoft
Operating Systems

RAM MEMORY

4.0GB

512MB

4.0 gigabytes
recommended; (Phantom
v9, v10, and v12 Series,
Phantomv710, v640,
v310, v210)
512MB (Phantom Miro,
v4, v5, v6, and v7 Series)

HARD DRIVE SIZE

80 Gigabytes Minimum

40 Gigabytes Minimum

80 gigabytes; (Phantom
v9, v10, and v12 Series,
Phantom v710, v640,
v310, v210)
40 gigabytes minimum
available space; (Phantom
Miro, v4, v5, v6, and v7
Series)

HARD DRIVE FORMAT (2) NTFS

NTFS

NTFS

CD-ROM DRIVE

Read/Write Any Speed

Read/Write Any Speed

Read/Write Any Speed

MONITORS

UltraXGA
1284x1024x24bit Large
Fonts

SVGA 1024x768x24bit
Small Fonts
(Phantom v4 Series)

UltraXGA 1284 x 1024 x
24bit large fonts;
(Phantom v5, v6, v9, v10,
v12 Series, v710, v640,
v310, and v210)

UltraXGA
1284x1024x24bit Large
Fonts
(Phantom v5 Series, v6
Series, and v7 Series
ETHERNET

IEEE 1394 (OBSOLETE)
(Phantom v4.0, 4.1, v5.0,
v6.0, and v6.1)

Gigabit Ethernet NIC with
Jumbo Frame Support

N/A

10/100Mb Ethernet NIC
(Phantom v4 Series, v5
Series, v6 Series, v7.0,
andv7.1)

Gigabit Ethernet Jumbo
Frame Support; (Phantom
v7.2, v7.3, v9, v10, and
v12 Series, v710, v640,
v310, v210)

Gigabit Ethernet NIC with
Jumbo Frame Support

NIC 10/100 or higher card
installed; (Phantom Miro,
v4, v5, v6 Series, v7.0,
v7.1)

OHCI IEEE 1394 Host
Controller with NEC
chipset, PCI card
(desktops) or PCMCIA
card (laptops)

OHCI IEEE 1394 Host
Controller with NEC
chipset, PCI card
(desktops) or PCMCIA
card (laptops

(1)

All Microsoft Windows Operating System must be English Versions.

(2)

Required for saving cine files over 4 gigabits.
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NOTE
A more powerful computer will deliver faster display and playback, as well as shorter save and
download times.

2.2

Preparing Your Computer
In this topic, we will be detail the recommended hardware preparations for:

Recommended for Desktop and Notebook Phantom Control Units
Maintenance of your system’s hard drive is recommended for all software installations. Cine files
captured by your Phantom camera are large. For best system performance, run the following
routine maintenance tasks before installing the Phantom software.
1. Backup all data files. Archive (off-load) cine files that are rarely accessed.
2. From Windows System Tool, run Disk Cleanup on all installed hard drives.
3. From Windows System Tool, run ScanDisk on all installed hard drives.
4. From Windows System Tool, run Disk Defrag on all installed hard drives.
5. From Windows Outlook, set a reminder to routinely run ScanDisk & Disk Defrag.
6. Disable virus protection software and close all open programs during the installation process.

Recommended for Recently Serviced Cameras
Are you re-installing your camera on your system after factory service, upgrade, or repair, if so, you
received the latest release version of software? Before you can use the new version of the
software, you must first completely remove all earlier versions of the Phantom Camera Control
Software, on all the computers used to control this camera.
1. From Windows Control Panel, run Add & Remove Programs.
2. Uninstall all earlier versions of Phantom software from all installed hard drives. If you've
created a Desktop shortcut for Phantom, delete it manually.
3. From Windows Explorer, find and delete the following files from all installed hard drives:
· ph1394.sys
· ph1394.dll
· ph1394.inf
· phcon.dll
· phint.dll
4. From Windows Explorer, find and delete all earlier ,stg files for this camera from all installed
hard drives. (*,stg). When the camera is first connected to the controller, it will automatically
download the updated ",stg" file.
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Recommended for Software Upgrades
Are you just upgrading from an earlier version of Phantom software? If so you must first completely
remove all earlier versions of the Phantom Camera Control Software.
1. From Windows Control Panel, run Add & Remove Programs.
2. Uninstall all earlier versions of Phantom software from all installed hard drives. If you've
created a Desktop shortcut for Phantom, delete it manually.
3. From Windows Explorer, find and delete the following files from all installed hard drives:
· ph1394.sys
· ph1394.dll
· ph1394.inf
· phcon.dll
· phint.dll

2.3

Installing the Phantom Camera Control Software
After verifying your system meets the system recommendations and preparing your computer
requirements, you are ready to install the Phantom Camera Control Software The Phantom
installation CD contains all the files required for installation and operation of the Phantom camera. It
also includes the 'stg' file for your camera.
1. Disable virus protection software and close all open programs during the installation process.
2. Place the Phantom installation CD in the CD-ROM drive. If AutoStart is enabled on your system,
the setup begins automatically. If AutoStart is not enabled, go to next step.
3. Using Windows Explorer browse to the CD and double-click autorun.exe.
4. The Phantom InstallShield will automatically start and guide you through the software installation
process.
5. If you are asked to add the Phantom Application to a list of firewall approved applications, do so,
or you will not be able to connect to a camera.
CAUTION
Do not open the Phantom Camera Control software until all installation procedures have been
completed.

2.4

Installing the Phantom STG (Serial Tag Number) File
Phantom cameras have been categorized into two types; ph16 and ph7 cameras.
The ph16 camera models include the Phantom v160, v1210, and Miro M-Series cameras, while the
ph7 camera models include all other Phantom cameras.
ph16 Camera Models
With the introduction of ph16 cameras, the Phantom .stg (Serial Tag Number) file is no longer
required for these cameras to operate. Therefore, there will be no Phantom .stg files associated
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with ph16 camera models. All of the factory settings, calibrations and all important system
operating settings will be stored into both an active non-volatile memory area of the camera, and
a backup non-volatile memory area.
ph7 Camera Models
The ph7 Phantom camera model still require a unique serial tag number file to operate. This file
is known as the camera's '.stg' file. The .stg file contains factory calibrations and settings
essential for the proper operation of your Phantom camera. The Phantom installation CD,
supplied with each new or newly serviced camera, includes the '.stg' file for your camera.
Serial Tag Files use the file extension .stg and reside in the Phantom directory on the controlling
computer's hard drive. These files are specific to each camera manufactured and store the
factory settings and various lookup tables for the image sensor based on the 4-Digit Camera ID
number. The information in this file is also stored (duplicated) in the camera's non-volatile flash
memory. Under normal camera operation, this information is read by the Phantom application
each time the software is started or each time a camera is accessed over the network. When
started, the application first tries to read the factory settings from the computer .stg file. If it
doesn't find the appropriate .stg file on the computer, it reads the settings from the camera.
On the flip side, if the Phantom application is started or if the camera is accessed over the
network and no .stg file resides on the hard drive, the Phantom application will automatically
create the .stg file on the controlling computer's hard drive using the information residing in the
camera flash memory.
If for any reason the Phantom application cannot read the .stg information from the camera flash
or from a file in the Phantom directory on the hard drive then the software will prompt the user for
intervention. If the proper .stg file is not available the application can load a default set of
information. If the default information is written to the flash the camera will still operate but the
image quality will be less than optimum.
CAUTION
Never use an outdated .stg file. Never mix .st files. Using ,stg files from other cameras may
cause serious damage.
Vision Research keeps copies of .stg files on record and if needed a copy can be obtained via
email by contacting us.
Vision Research recommends making a backup copy of your camera's ,stg file to store in a safe
place. We also recommend placing a copy of this file in a temporary folder somewhere on your
hard drive in the event you need to restore the camera's factory calibration settings quickly .
When the camera is first connected to the controller, it will automatically download the '.stg' file to
a default .stg file path, used by the Phantom Camera Control software. This path matches the
path used in by the Phantom (PCC) Camera Control application, CommonApplicationData, (see
the table below).
WINDOWS OS

.STG AND PHCON.LOG
COMMONAPPLICATIONDATA

USER SETTINGS
LOCALAPPLICATIONDATA

Windows 7

ProgramData\Phantom\Phantom
version

Users\Current user
name\AppData\Local\Phantom

Windows Vista

ProgramData\Phantom\Phantom
version

Users\Current user
name\AppData\Local\Phantom

Windows XP

C:\Documents and Settings\All
Users\Application

C:\Documents and Settings\User
name\Local Settings\Application
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Data\Phantom

Therefore, you should copy the file from the CD, and use Windows Properties to disable the
READ ONLY attribute of the ,stg file after it's copied to the hard drive.

2.5

Define the Phantom Control Unit IP Address
In this topic we will describe the process to:

Define an IP Address to the Phantom Control Unit
1. From Windows' Start button, go to Settings>Network and Dialup Connections.
2. Right-click Local Area Connections>Properties to view a list of components used by your
system.
3. Select Internet Protocol (TCP/IP).
4. Click the Properties button.
5. When the Internet Protocol (TCP/IP) properties' box opens:
a. Select Use the Following IP Address and enter the following:
1) IP Address: 100.100.100.1
NOTE
If multiple Phantom Control Units will be used to access the same Phantom cameras, each
controller unit requires a unique IP Address. For example: Controller 1: 100.100.100.1
(255.255.0.0); Controller Unit 2: 100.100.100.2 (255.255.0.0), etc.
1) Subnet mask: 255.255.0.0 or (255.255.255.0 for v7.0 only)
b. Select Use the Following DNS and leave the entry blank.
c. Click OK to complete the setup.

Connect the Phantom Camera to the Control Unit via Ethernet
1. Connect one end of the Ethernet cable to the 8- or 6-pin Ethernet connector on the camera's
rear panel.
NOTE
On a Phantom v7.0 camera this is a 6-pin connector is labeled IOIOI .
2. Connect the other end of the Ethernet cable to the RJ-45 Ethernet interface on the control
computer.
NOTE
Most Ethernet Hubs do not permit the use of crossover cables. Therefore, a straight-thru
cable is required. However, some Ethernet Layer 2 and Layer 3 switches have the capability
of automatically detecting the cable type and adjust their pin-outs internally.
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3. Connect 24-36VDC power to the camera. You may use the AC adapter supplied with your
camera, a battery pack, or other DC power supply. Wait for the Power LED and the Capture
LED on the camera's rear panel to stop flashing and remain lit.
4. Observe the Ethernet Link LED on the camera and the controller. They indicate the camera
and the controller are communicating.
5. You may now start the Phantom software by double-clicking the Phantom icon on the
Windows' Desktop.

Verify the Communication Between the Controller Unit and the Camera Over
Ethernet
1. Click the Windows Start button and select the Run command.
2. Type: cmd, and click the OK button.
3. Type: ping <IP Address of the camera> at the C:\ prompt in the
C:\Windows\system32\cmd.exe window.
4. Click Enter.
a. When properly installed the camera replies to the Ping Request.
b. Should Phantom Control Unit fail to detect the camera:
1) Unplug the Cat-5 cable from the Phantom Control Unit computer, and ensure the proper
cable type is being used.
2) Re-insert the proper cable.
3) Verify the TCP/IP Addressing information is correct.
4) Shutdown the Phantom Control Unit computer.
5) Remove power from the camera.
6) Restart the Phantom Control Unit computer, then
7) Re-apply power to the camera.
8) Ping the camera again to verify the Phantom camera replies to the Ping Request.
NOTE
If you still are unable to establish and verify the connection, please contact Vision Research
Technical Support.

2.6

IEEE 1394 Hardware and Driver Installation
For obsolete Phantom v4.0, v4.1, v5.0, v6.0, and v6.1 cameras only
Required Hardware for Desktop and Notebook Computers: If you plan to use an existing desktop or
notebook computer to control a Phantom camera, you must first install and configure an IEEE 1394
card into your desktop or notebook computer. Please contact Technical Support for the latest
compatible IEEE 1394card recommendations, and current drivers.
You may often hear IEEE 1394 referred to as FireWire™; Apple Inc.'s trademarked name for this
communication standard.
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CAUTION
The IEEE 1394 card and drivers must be installed before installing the Phantom Camera
Control software on your computer.
In this topic we will describe the process to:

Installing the IEEE 1394 Card
1. Following your computer manufacture's instructions for installing additional cards, insert a PCI
OHCI Compliant IEEE 1394 card in any open PCI card-slot on the motherboard, or insert the
PCI OHCI Compliant IEEE 1394 PCMCIA 2 card in the PCMCIA slot of your notebook
computer.
2. Click the Windows' Start button, and select Settings>Control Panel>System
Hardware>Device Manager option.
3. Scroll down through t Device Manager list to locate PCI OHCI Compliant IEEE 1394 Host
Controller.
4. Double-click Host Controller. From the display tabs, select the Driver tab, then click the
Update Driver button.
5. Locate and install the Windows' PCI OHCI Compliant IEEE 1394 Host Controller driver.
CAUTION
Do not use the drivers supplied with the card. Do not use Window's Install Wizards' feature.
6. Notebooks generally have two PCMCIA slots. Repeats Steps 3-5 for the second slot.

Installing the Phantom Camera Driver (IEEE 1394 Cameras Only)
1. Connect 24VDC power to the camera. Before proceeding, wait for the Power LED and the
Capture LED to stop flashing and stay lit.
2. Connect one end of the FireWire cable to the controller, then connect the other end of the
cable to the six-pin connector marked IEEE 1394 on the cameras rear panel. (Phantom v4.0,
v4.1, v5.0, v6.0, and v6.1 Cameras only)
3. From Windows, right click My Computer, select Properties.
4. Click Device Manager button.
5. Scroll down through the Device Manager list to locate: Other Device - Unknown Device.
6. Double-click Unknown Device. Select the Driver tab, from the display of tabs, then click the
Update Driver button.
7. When the Wizard opens, click Next.
a. From the list that appears, select: Display a list of all drivers in a specific location so you
can select the driver you want.
b. Click Next. From the list of hardware that appears, scroll down to select: Sound, video and
game controllers.
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c. Click Next. From the list that appears, click the Have Disk button.
d. For Windows 2000 Pro, when prompted for location, enter C:\Program
Files\Phantom\Win2K Drivers; click OK. For Windows XP Pro when prompted for location,
enter C:\Program Files\Phantom\WinXP Drivers; click OK.
e. Select PH1394.inf, from the list that appears, then click OK.
f. Select Phantom Camera when the Select Device opens, click OK.
g. Click Next to install the driver. When prompted, click Finished.
h. Reboot your computer.
NOTE
These Phantom Camera Driver must be installed via the Device Manger. If Windows autodetection of New Hardware starts, close the dialogue box and proceed with Step 3 above.

Verifying the IEEE 1394 Communication Connection
1. Open the Windows Device Manager and locate the “Sound, video and game controllers”
entry, and click on the Plus (+) sign to the left of the entry.
a. If the Phantom camera is in the “Sound, video and game controllers” list, then installation is
complete and the connection to the Phantom Control Unit has been verified. Exit the Device
Manager.
You can now start the Phantom Camera Control software by double-clicking the Phantom
icon on your windows desktop.
b. If the Phantom camera is not in the “Sound, video and game controllers” list, then
installation is not complete and the connection to the Phantom Control Unit has failed.
1) Unplug the network connection cable from the Phantom Control Unit computer, then
re-insert it.
2) Check the list again to verify if the Phantom camera appears.
c. If the Phantom camera is still not detected:
1) Shutdown the Phantom Control Unit computer.
2) Remove power from the camera.
3) Restart the Phantom Control Unit computer, then
4) Re-apply power to the camera.
5) Check the list again to verify if the Phantom camera appears.
CAUTION
If the Phantom Camera still does not appear on the list, do not start the Phantom Camera
Control software.
NOTE
If you are still unable to establish and verify the connection, please contact Vision Research
Technical Support.
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Verify Camera Connection
Ethernet Camera Models
1. Click the Windows Start button and select the Run command.
2. Type: cmd, and click the OK button.
3. Type: ping <IP Address of the camera> at the C:\ prompt, in the
C:\Windows\system32\cmd.exe window,
4. Click Enter.
NOTE
The camera will reply to the Ping Request if properly installed.
Phantom Camera Not Detected via Ethernet Connection
If the Phantom Control Unit fails to detect the camera:
1. Unplug the Cat-5 cable from the Phantom Control Unit computer, and ensure the proper
cable type is being used.
2. Re-insert the proper cable.
3. Verify the TCP/IP Addressing information is correct.
4. Shutdown the Phantom Control Unit computer.
5. Remove power from the camera.
6. Restart the Phantom Control Unit computer.
7. Re-apply power to the camera.
8. Ping the camera again to verify the Phantom camera replies to the Ping Request.
NOTE
If you still are unable to establish and verify the connection, please contact Vision Research
Technical Support.

IEEE 1394 Camera Models
1. Open the Windows Device Manager and locate the “Sound, video and game controllers”
entry, and click on the Plus (+) sign to the left of the entry.
Phantom Camera Detected via IEEE 1394 Connection
If the Phantom camera is in the “Sound, video and game controllers” list, then installation is
complete and the connection to the Phantom Control Unit has been verified.
You will now have to:
1. Exit the Device Manager.
2. Remove power from the Phantom camera.
3. Restart the Phantom Control Unit computer, then
4. Re-apply power to the camera.
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Phantom Camera Not Detected via IEEE 1394 Connection
If the Phantom camera is not in the “Sound, video and game controllers” list, then installation
is not complete and the connection to the Phantom Control Unit has failed.
You will now have to:
1. Unplug the network connection cable from the Phantom Control Unit computer, then
re-insert it.
2. Check the list again to verify if the Phantom camera appears.
3. Shutdown the Phantom Control Unit computer.
4. Remove power from the camera.
5. Restart the Phantom Control Unit computer.
6. Re-apply power to the camera.
NOTE
If Windows detects the Phantom camera as a “New Hardware Device Found” follow the
Phantom Camera Installation process.
7. Check the list again to verify if the Phantom camera appears.
NOTE
If you are still unable to establish and verify the connection, please contact Vision Research
Technical Support.
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Quick Start Guides
Updated: 7/24/2012

Welcome to the Quick Start Guides for your Phantom camera.
The Quick Start Guides in this section are designed to provide a quick introduction on using a
Phantom camera with the Phantom Camera Control application, Touch-Sensitive LCD Screens,
and On-Camera Control Buttons. They are intentionally kept brief so that you can start using your
camera as quickly as possible. The objective of these Quick Start Guides is not to teach you every
single detail of the Phantom Camera Control applications, Touch-Sensitive LCD Screens, or OnCamera Control Buttons, but familiarize you with the basic procedures necessary to use your
camera.

© 2015 Vision Research - AMETEK Material Analysis Division

Quick Start Guides

3.1

53

Phantom Cameras via Phantom Control Software
Expand All:

Collapse All:

Welcome to the Quick Start Guide for the Phantom camera. This Quick Start Guide aims to provide 7
easy steps to get started.

Pre-Installation Check
The Phantom v-Series cameras have a few requirements, which must be met before you are
able to use it.
1. Controller Unit must have Windows NT, Window XP Pro, or VISTA Business Edition.
2. Controller Unit Firewalls must be turned off. (Contact IT Group if necessary.)
3. Controller Unit TCP/IP must be set to IP Address: 100.100.h.h; (where h.h is a unique host
identifier, i.e., 100.100.100.1 with a Sub-network Mask set to: 255.255.0.0).
For step by step instructions to change IP Address, go to "Changing IP Address on
Controller Unit" in this topic.

Connecting Camera and Controller Unit Operation
1. Connect Power Supply to the camera.
2. Connect Ethernet to camera and Controller Unit.
3. Connect Capture Cable to the camera.
4. Attach the lens to the camera.
5. If using an external trigger, connect to “Trigger” BNC cable (Red),
6. Boot Up Phantom Camera Control Software on Controller Unit.
7. Wait for a notice on the Dialog Box “ Ethernet Connected”.

Capturing Video - On Phantom Software
1. Click Acquisition, then
2. Select the Setup and Recording command.
3. In the Setup and Recording dialogue window, then:
a. Set the Resolution, i.e., 800x600. (Selectable Pull Down Menu)
b. Set the Sample Rate, (Recording or Frame Rate), i.e., 200pps. (Selectable Pull Down
Menu)
c. Set the Exposure to Maximum. (Selectable Pull Down Menu)
d. Set the EDR to Zero. (Selectable Pull Down Menu)
e. Set the Post Trigger to 1. (Selectable Pull Down Menu)
f. Set the Zoom to 1. (Selectable Pull Down Menu)
g. Set the Sync mode to Internal. (Selectable Pull Down Menu)
4. View images on Control Unit Screen and adjust Resolution, Sample Rate and Exposure for
optimum viewing.
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NOTE
“Preview Waiting for pre-trigger” (Camera is NOT in RECORD Mode. It is in PREVIEW
Mode).
11.Click the Capture button to place the camera into the Capture, (Record), mode.
NOTE
Dialog Box Reading (On the bottom of Screen) indicates “Preview Recording Cine 1 ...
Waiting for trigger”
12.Click the Trigger button in the Setup and Recording dialogue window, or use External
Trigger to trigger camera and end recording.
13.Click “OK” button to go to Playback Mode.

Playback Operation
1. Use Playback controls to view recorded images, (forward, fast forward, reverse, etc)
2. Use “Mark Begin” and “Mark End” to select preferred video images.
3. Check “Endless Loop” button and “Limit to Range” to playback preferred video segment.
4. Use “Save” to download to the Phantom Unit.

Downloading Videos to Control Unit
1. Make a Windows Folder to Store videos.
2. Select a distinct/unique file name for each video.
3. Click the Border Data button, (Optional), to save border data on video.
4. Click the Save button to begin downloading from the camera to the Phantom Control Unit.
5. Make sure the file is stored in Phantom Control Unit. (Check the Windows directory before
erasing video from Command!)

Get Ready to Record Again
1. Click the Close button
2. Click on the Acquisition>Setup and Recording command.
3. Click on the Capture button.
4. Click the Delete Cine and Start New Recording button.(Are sure that the video has
successfully been downloaded to Windows directory?)
5. Camera is now in Capture, (Recording), Mode. (“Preview Recording Cine1 … Waiting for
Trigger” is visible in Dialog Box at the bottom.)
6. Go back and follow directions for Recording and Playback.

IMPORTANT OPERATIONAL NOTES
1. Do NOT disconnect the Ethernet cable from the Phantom Control Unit or the Phantom camera
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while in operation. If the Ethernet connection is disrupted, the camera may lock up. Be sure to
close the Phantom Camera Control application completely on the control unit before
disconnecting the Ethernet cable.
2. ALL images will be LOST in camera if power to the camera is removed.
3. Insure the lens is clean before recording.

RELATED PROCEDURE
Changing IP Address on Controller Unit
1. Click Start in Windows.
2. Click My Network Places.
3. Click View My Network Connection.
4. Right click on the appropriate Ethernet Connection, then
5. Click Properties.
6. Select the “Use the Following IP Address" radial button, then
7. Enter

IP Address : 100.100.100.1
Subnet:
255.255.0.0

8. Click OK.
9. Close all windows and return to Pre-Installation Check.
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Phantom Miro M-Series Cameras via Phantom Control Software
Welcome to the Quick Start Guide for a Phantom Miro M-Series camera. This Quick Start Guide aims
to provide 4 basic steps to get started.

Hardware Setup
1. Carefully unpack the contents of the camera package, and check the contents.
2. Insert The Phantom Camera Control Installation Disk into the Phantom Control Unit (lap/PC)
and follow the on-screen instructions.
3. Open the Phantom CineFlash compartment door, and then carefully insert the Phantom
CineFlash into the compartment, by aligning the CineFlash insertion guide slots, until it is
securely seated.
4. Attach the following cables: the
a. Ethernet
1) Insert the Ethernet cable, RJ45 connector, to the Ethernet interface of the Phantom
Control Unit (laptop/PC), then
2) Insert the Ethernet cable, Fischer connector, to the Ethernet port of the Phantom camera.
b. Phantom CineFlash Dock eSATA
1) Insert the eSATA connector to the Phantom CineFlash Card Reader docking station,
then
2) Insert the eSATA, and USB connectors to the PC/MAC computer’s eSATA and USB
interfaces.
c. Capture
The Capture Cable can be used to provide/access the following input/output signals;
Trigger (Red), Strobe/IRIG Out (Blue), Ready (Green), Image-Based Auto-Trigger (Black –
marked FSYNC), IRIG-In (White), and Video (Yellow).
1) Connect the appropriate Capture cable BNC connector to the BNC connector of the
connected device, i.e., trigger mechanism, video, Image-Based Auto-Trigger, IRIG clock,
etc. A BNC gender-bender, customer supplied, may be required to connect the two BNC
connectors together.
2) Connect the Capture cable BNC connector to the Capture port of the Phantom camera.
7. Carefully slide the rechargeable battery downward, onto the rear of the camera, to lock the
battery into place.
8. Use of the AC power adapter allows you to capture and playback cines without worrying
about depleting the battery.
a. Plug the AC power adapter connector into the Power port on the rear of the camera, then
b. Plug the AC power adapter cord into the power outlet.
9. Set the Power Mode
The Phantom Miro M-Series camera can be set to one of three power-up modes:
a. OFF - When the switch is in the OFF position, the camera is off.
b. AUTO - When the switch is set to AUTO, it works exactly like any previous Phantom
Camera. Providing power to the Primary DC Input will power up (boot) the camera and it
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will be ready for use.
c. ON - When the switch is moved to the ON position, the camera will power-up immediately
provided there is power connected to the primary power port OR a battery is connected to
the camera.

Capturing a Cine via the PCC (Phantom Camera Control) Software
1. Double mouse-click on the PCC (Phantom Camera Control) application icon.
2. Select the camera for use:
a. Click on the Manager tab, then
b. Double mouse-click on the Phantom camera to be used to record with from the Cameras
Group.
3. Set the required recording parameters and place the camera into the capture, recording,
mode:
a. Under Cine Settings define the required:
1) Resolution, by selecting an option from the pull-down selection list.
2) Sample Rate, (also referred to as the frame/recording rate), by selecting the option from
the pull-down selection list.
3) Exposure Time to the maximum available in the pull-down list.
4) EDR, (Extreme Dynamic Range), exposure time to zero by selecting the option from the
pull-down selection list.
5) Post-Trigger value, by selecting an value from the Last pull-down selection list, entering
a value into the Last data entry field, or sliding the T (Trigger) slider to the desire value.
The value defined determines the number of post-trigger frames to be recorded, for
example:
· 0 (zero) fills the DRAM with all pre-trigger frames.
· The maximum value fills the DRAM with post-trigger frames only.
· Any value between 0 and the maximum fills the buffer with both pre-and post-trigger
frames. This value equals the number of post-trigger frames to be recorded.
6) Perform a Current Session Reference by clicking on the CSR button in the PCC
software, or depressing the AUTOBREF button on the front of the camera.
b. At the bottom of the Live control panel, click on the Capture button.
c. Apply a trigger signal:
a) Click on the Trigger button located at the bottom of the Live control panel, or
b) Depress the Trigger button on the front of the camera, or
c) Apply a switch closure or TTL pulse via the Trigger BNC connector.

Edit, the Captured Cine
1. Click the Play control panel tab.
2. Click the Play Forward button, and

© 2015 Vision Research - AMETEK Material Analysis Division

58

Phantom Camera Control Help File

3. Locate the first image of the cine you wish to set as the Mark-In point of the cine, then
4. Click the Pause button.
5. Set the Mark-In point by clicking the Mark-In button.
6. Click the Play forward button, and
7. Locate the last image of the cine you wish to set as the Mark-Out point of the cine, then
8. Click the Pause button.
9. Set the Mark-Out point by clicking the Mark-Out button.
10.Under the Play Speed & Options selector, enable (check) the Limit to Range option, then
11.Click on the Jump to First Frame button to rewind the cine to the Mark-In point.
12.Click the Play Forward button to review the edited cine.

Save the Cine
1. Click the down-arrow in the Save Cine button to save the edited cine to:
a. A designated location on an external hard-drive, i.e., control unit laptop/PC, or
b. The Phantom CineFlash

© 2015 Vision Research - AMETEK Material Analysis Division

Quick Start Guides

3.3

59

Phantom Miro Touch-Sensitive LCD Cameras
This Quick Start Guide aims to provide 6 easy steps to get started using your Phantom Miro cameras
using the "Touch-Sensitive" LCD Screens.
For full details on the procedures described in the guides, please refer to the Phantom Miro Control
via "Touch-Sensitive" LCD Screens section.

STEP-BY-STEP PROCEDURES
Power Up the Phantom Camera
1. Connect Capture Cable to Phantom camera.
2. If using an external trigger, connect it to Trigger BNC, (Red), of the Capture Cable.
3. Attach the Power Supply connector to the Phantom Miro camera, then
4. Apply AC Power to the Power Supply Adapter.
5. Hold the Power-On/Trigger button in, on the Phantom Miro camera for approximately 2
seconds, then
6. Release the Power-On Trigger button.
NOTE
The start-up process takes approximately 15-seconds to complete. Once completed the
camera will be placed into the LIVE PRE, (Live Preview), Mode.

Prepare the Camera to Record a Cine File
1. From the LIVE PRE Display Screen:
a. Set the Resolution:
1) Press directly on the Resolution field to select the field.
2) Pressing directly on the value a second time increases the value.
3) Pressing approximately 1/3 the screen height above the value to decrease the value.
4) Repeat until the desired value is displayed.
NOTE
The Resolution of a Phantom Miro 1 is fixed at 640x480, and con not be changed.
b. Set the Sample Rate:
1) Press directly on the Sample Rate field to select the field.
2) Pressing directly on the value a second time increases the value.
3) Pressing approximately 1/3 the screen height above the value to decrease the value.
4) Repeat until the desired value is displayed.
c. Set the Exposure Time:
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1) Press directly on the Exposure field to select the field.
2) Pressing directly on the value a second time increases the value.
3) Pressing approximately 1/3 the screen height above the value to decrease the value.
4) Repeat until the desired value is displayed.
2. Perform a Black Reference Calibration:
a. Cover the lens with the lens cap.
b. If not already in the Power Off Display Screen, gently tap on the Phantom logo to access
the Power Off Display Screen.
c. From the Power Off Display:
1) Press the BREF (Black Reference) selector.
NOTE
The Black Reference adjustment process should be performed whenever your camera
settings are changed.
3. Perform a White Balance Adjustment (Color Cameras Only):
a. Point the camera at a white object.
b. Align the object to center of the frame.
NOTE
Ensure that the area to calculate the White Balance adjustment on is not saturated and is
completely over a white reference.
c. If not already in the Power Off Display Screen, gently tap on the Phantom logo to access
the Power Off Display Screen.
d. In the Power Off Display Screen:
1) Gently press the WBAL (White Balance) selector.
2) Examine the display, if you need to perform a White Balance again, simply repeat the
process until you are satisfied.
NOTE
The White Balance adjustment process should be performed whenever lighting conditions
change.
3) Gently press on the Back selector.

Capture Video via the LCD
1. Click on the Record selector in the LIVE PRE Display Screen.
2. Trigger the Phantom Camera via the:
a. LIVE WTR Display Screen
1) Press the Trigger selector to supply a soft-trigger signal to the camera.
b. Power-On/Trigger Button
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1) Depress the Power On/Trigger button to apply a hard-trigger to the camera.
c. Capture Cable Trigger Input Connector
1) Provide a hard trigger to the camera by supplying:
a) Dry switch closure, or
b) A low TTL pulse signal.

Playback Operation
1. Gently press on the Play selector in the LIVE CST Display Screen.
2. Use the Playback controls to review recorded images:
Reverse; to double the reverse playback speed hold down for approximately 1
seconds.
Reverse 1 Image.
Forward 1 Image.
Forward; to double the forward playback speed hold down for approximately 1
seconds.
NOTE
To Pause the playback process, gently press slightly below the Memory Buffer Graphical
Representation Bar at the top of the display screen.
3. Edit the record cine file:
a. Gently press the Edit/Save selector.
b. Locate the first frame the cine file is to begin with.
1) Press a little below the Memory Buffer Graphical Representation Bar, then
2) Hold down on the screen, and
3) Scrub in the direction you wish the cine file to go, (right - backwards, left - forwards).
c. Set the Mark In Point:
1) Press the Set In Selector.
d. Locate the last frame the cine file is to end with:
1) Press a little below the Memory Buffer Graphical Representation Bar, then
2) Hold down on the screen, and
3) Scrub in the direction you wish the cine file to go, (right - backwards, left - forwards).
e. Set the Mark Out Point:
1) Press the Set Out Selector.
NOTE
To scrub through the cine file:
a. Press slightly below the Memory Buffer Graphical Representation Bar, then
b. Gently hold down on the screen, and
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c. Scrub in the direction you wish the cine file to go, (right - backwards, left - forwards).
To reset the Mark In and Mark Out Points, press the Reset selector.
4. Press the Back selector, and Playback the preferred, (edited), file.
5. Save the edited file to the installed Type1 CompactFlashÒ Card.
a. Press the Save selector in the Edit/Save Display Screen.
b. Ensure that the Size of the Cine to be saved does not exceed the amount of available Free
Space on the Compact Flash card.
a) Press the Save Selector in the Save Display Screen if there is enough Free Space on
the CompactFlash Card.
b) If there is not enough room on the CompactFlash Card to save the cine file:
1) Replace the CompactFlash Card with one that has enough space available.
2) Press the Save Selector, or
3) Connect the camera to the Phantom Control Unit and use the Phantom Camera
Control application to save the cine file to an external storage device.
6. Ensure the cine file you just downloaded, has been stored in the Type1 Compact Flash Card,
and is not corrupted before deleting the cine file from the camera.
NOTE
A CompactFlash Card Reader connected to the Phantom Control Unit is required for this
portion of the process.
a. Carefully remove the CompactFlash Card from the camera.
b. Insert the CompactFlash Card into the Flash Card Reader.
c. Attach the CompactFlash Card Reader to the Phantom Control Unit.
d. From the Desktop of the Phantom Control Unit:
1) Click Start>My Computer.
2) Double-click on the CompactFlash Drive.
3) Double-click on the cine file just saved, then
4) Review the saved cine file in the Phantom Camera Control application.
a) If the cine file was not saved, or corrupted:
i. Carefully, re-install the CompactFlash Card into the camera, then
ii. Retry saving the edited cine file again.
CAUTION
Ensure that the CompactFlash Card is oriented properly before seating it in the camera. DO
NOT FORCE THE CARD INTO THE CAMERA. Failure to comply with this instruction may
result in a serious camera failure requiring it to be returned to Vision Research for service.
b) If the cine file was saved properly:
i. Carefully, re-install the CompactFlash Card into the camera, then
ii. Continue with Quick Start Process.
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Get Ready to Record Again
After ensuring the cine file you just downloaded, has been saved to the Type1 Compact Flash
Card, and was not corrupted:
1. Delete the recorded cine file from the camera's DRAM.
a. Click the Back selector in the Save Display Screen.
b. Click the Back selector in the Edit/Save Display Screen.
c. Click the Delete selector in the PL CST Display Screen, then
d. Click the Yes selector in the Delete Existing Recording Display Screen.
2. Go back and follow directions for Capturing Video via LCD and Playback Operations until all
required cine files have been recorded.

Power Down the Camera
1. From the Power Off Display:
a. Press Power Off selector.
2. In the Power Off Confirmation Screen:
a. Press the Yes selector to power off the camera, or
b. Press the No selector continue.
CAUTION
Any cine file stored in the camera's memory must be deleted prior to powering down the
camera. Failure to comply with this procedure will cause the camera to run on battery
power until the battery discharges completely.
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Phantom Cameras via Phantom Remote Control Unit
This Quick Start Guide aims to provide 6 easy steps to get started using your Phantom camera.
For full details on the procedures described in the guides, please refer to the Phantom Remote
Control Unit - Help File.

STEP-BY-STEP PROCEDURES
Connecting the Camera to the Remote Controller Unit
1. Connect the break-out box 19-pin Capture cable connector to the Capture interface of the
camera.
2. Connect the 9-pin male Power, Control, Video cable connector to the Remote interface of
the break-out box.
3. Connect the 9-pin female Power, Control, Video cable connector to the Power, Control,
Video interface on the Remote Control Unit.
4. Insert the AC power cord into the Phantom camera Power Supply Adapter.
5. Attach the Power Supply Adapter's 4-pin connector to the 20-36VDC/5A Max connector of
the break-out box.
6. Plug the Power Supply Adapter to the AC power source.
7. For Phantom cameras with HD-SDI interfaces connect one end of the HD cable to the HDSDI Video-In BNC connector on the Remote Control Unit and the other end of the HD cable
to the HD-SDI BNC connector of the camera.

Capturing Video via the Remote Control Unit
1. With power applied to the Phantom camera, power on the Remote Control Unit by
depressing the hardware MENU/PWR button on the Remote Control Unit.
RESULTS:
· RC LED on the unit activates white for approximately 25-seconds.
· RC LED flashes red and green for approximately 13-seconds.
· RC LED turns cyan, and the Phantom logo will appear on the display for approximately 25seconds.
· Camera LED activates Blue when the camera is started up in pre-trigger mode or Red when
the camera starts up in the recording mode, and the Home Menu displays on the LCD.
NOTE:
To view a live image while performing the following setup processes, or to restore the
display to the full menu display, gently press on the Menu tab located at the center-top of
the menu display.
2. From the Home Screen gently depress the Setup button.
3. From the Setup Screen gently depress the Acq, (Acquisition), button.
4. From the Acquisition Screen:
a. Gently depress the down-arrow to the right of the Aspect Ratio entry field and select an
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Aspect Ration, by gently pressing on the desired ratio from the pull-down selection list.
b. Gently press on the first entry window to the right of the Resolution to define the
Horizontal Resolution.
c. Use the Numerical Keypad to specify the desired Horizontal Resolution.
1) To overwrite the present value:
a) Gently tap on the entry field once, to turn the entry field yellow, then
b) Gently tap on the numerical key pad to enter the desired value.
c) When desired value has been specified, gently tap on the Enter key to set the value.
2) To append the value:
a) Gently tap on the entry field twice, to turn the entry filed white, then
b) Gently tap on the numerical key pad to append the value.
c) When desired value has been specified, gently tap on the Enter key to set the value.
d. Gently press on the second entry window to the right of the Resolution to define the
Vertical Resolution using the same method described in Step 4c.
e. Define the Frame Rate, Exposure, and Post Trigger settings using the same method
described in Step 4c.
, icon located in the upper-left hand corner of the
f. Gently press on the Return,
Acquisition Screen to return to the Setup Screen.
g. Gently press on the Adv Acq, (Advanced Acquisition), button.
h. From the Advanced Acquisition Screen:
1) Define the EDR settings using the same method described in Step 4c.
2) Select the desired Bit Depth, Exposure Units, and Post Trigger Units using the same
method described in Step 4a.
, icon located in the upper-left hand corner of the
i. Gently press on the Return,
Acquisition Screen to return to the Setup Screen.
j. Gently press on the HW Sigs, (Hardware Signals), button.
k. From the H/W Signals Screen:
1) Select the desired Trigger Edge using the same method described in Step 4a.
2) Define the Filter setting using the same method described in Step 4c.
3) Select the desired IRIG and Sync using the same method described in Step 4a.
, icon located in the upper-left hand corner of the H/W
l. Gently press on the Return,
Signals and Setup Screens to return to the Home Screen.
m.From the Home Screen gently press the Capture button, then
1) Gently press the CSR, (Current Session Reference), button.
2) When prompted gently press the Begin button.
3) Gently press the Rec, (Record), button to start the image capture process.
n. Apply a trigger to the camera by:
1) Depressing the hardware Trigger Button on the Remote Control Unit.
2) Apply a TTL Trigger-In signal to the Trigger connector of the break-out box.
o. Playback the recorded cine, (image data).
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Playback Operation
1. Open the Play Control Panel by clicking on the Play button.
2. Gently press on the Play Forward

button or Play Reverse

button.

3. Press the Pause button to halt the playback process, or press the Stop button to stop the
playback process and return to the first image of the cine.
NOTE
You can perform a Quick Search through the cine file by:
1. Gently press and hold down on the Image Location
just below the Cine Editor Bar.

Identifier Up-Arrow, located

The present image number will be displayed above the Cine Editor Bar.
2. Slide your finger to the right to quickly move forward in the stored cine, alternately
3. Slide your finger to the left to move backwards quickly in the stored cine.
You can also perform a quick search using the Jog/Scroll Dial by rotating the dial until the
desired point is achieved.
4. Edit the recorded cine.
a. Advance the cine file to the first image you desire to save for the cine clip via the:
1) Quick Search process described above.
2) Playback buttons:
a) Gently press on the Play Forward

button or Play Reverse

button.

b) Press the Pause button when the first image you desire to save for the cine clip has
been located.
b. Gently press the Mark In
RCU.

button, alternatively depress the A hardware button of the

c. Advance the cine file to the last image you desire to save for the cine clip via the:
1) Quick Search process described above.
2) Playback buttons.
a) Gently press on the Play Forward

button or Play Reverse

button.

b) Press the Pause button when the last image you desire to save for the cine clip has
been located.
d. Gently press the Mark Out
the RCU.

button, alternatively depress the B hardware button of

5. Save the edited cine to an attached Phantom CineMag.

Save Cine File to an Attached Phantom CineMag
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1. After completing the Playback Operations procedure,
2. Gently press the Save button in the Play Screen to save the captured cine file to the
camera's attached Phantom CineMag.
3. Review the saved cine files by:
a. Gently pressing the down-arrow to the right of the Source entry field, and
b. Gently pressing on the Cine Mag option in the pull-down selection list.
c. Gently press the plus or the minus button to the right of the Cine entry filed to scroll
through multiple cine files stored in the attached Phantom CineMag.
d. Use the Playback buttons to review the saved cine file.

Get Ready to Record Again
After ensuring the cine file you just reviewed, has been saved to the attached Phantom
CineMag, and was not corrupted:
1. Navigate back to the Capture Screen.
2. If the Messages option is turned On, gently press the Close button when the "Cine(s) are
recorded in volatile memory of this camera. Select 'Record' to delete the cine(s) & start a
new recording. Select 'Stop' to stop capture and wait for pretrigger, retaining the cine(s)"
window is displayed.
3. Gently press the Rec, (Record), button and repeat the process Capture and Save
processes described previously.

Power Off the Remote Control Unit
1. To power off the unit hold in the hardware MENU/PWR button for approximately 6-seconds.

IMPORTANT OPERATIONAL NOTES
1. ALL images will be LOST in camera if power to the camera is removed.
2. Insure the lens is clean before recording.

© 2015 Vision Research - AMETEK Material Analysis Division

68

3.5

Phantom Camera Control Help File

Phantom 65 or HD-Series Cameras via On-Camera Controls
This Quick Start Guide aims to provide the basic recording, playback and save-to-CineMag steps
when working with a Phantom HD-Series or Phantom 65, without being tethered to the Phantom
software.
For full details on the procedures described in the guides please refer to the Phantom 65 or Phantom
HD Control via "On-Camera" Control Buttons section.

STEP-BY-STEP PROCEDURES
Power Up the Phantom Camera
1. Attach the 3-pin power connector to the Phantom HD or P65 camera, then
2. Connect the power supply to AC power.
NOTE
The start-up process takes approximately 30-seconds to complete. Once completed the
camera will be placed into either LIVE PRE (Live Preview) Mode, or LIVE WTR (Waiting for
Trigger) Mode, depending on how it is set up in the Camera Options menu of the Phantom
software.
We recommend waiting at least 30 minutes when a camera is first plugged in before starting
to shoot, to enable the sensor to reach its optimal working temperature.

Connect an HD-SDI Monitor or Viewfinder
You must have either a HD-SDI monitor or a Viewfinder connected to preview and playback your
captured movies.
1. Using a BNC cable, connect a HD-SDI monitor to the HD-SDI jack on the back of the camera.
2. If you are using a Sony viewfinder, you must:
a. Mount the viewfinder to the optional Sony Viewfinder bracket on the front handle of the
camera.
b. Connect the viewfinder cable to the Fischer connector on the lower right side of the
camera.
NOTE
Your preferred 1080 or 720p signal can be specified in the Camera Options menu of the
Phantom software. The Sony viewfinder will only work with 1080i signals.

Connect the Phantom CineMag
In order to save raw Cine files without being tethered to a PC through Gigabit Ethernet, a Phantom
CineMag is required.
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1. Carefully remove the protective top cover of the camera.
a. Pull on the latch at the back of the camera, then
b. Lift up the cover carefully, be careful not to slide the cover over the pins on the top of the
camera.
c. Store the cover in a safe place.
2. Insert the CineMag with the LED lights facing the back of the camera.
a. Hold the CineMag under the handle, and wedge the front end of the CineMag securely into
the front of the CineMag compartment.
b. Gently press down on the back end of the Cinemag until the latch snaps back in place. If
the latch does not snap in place, be sure to push it to latch into the CineMag.

Understanding the Phantom CineMag
When connected, the LEDs on the back of the CineMag will illuminate, and the status on the
HD-SDI monitor and viewfinder will say, for example: “Mag Ready 0T, 0,268”. This indicates that
the CineMag is connected and ready to start recording Cine files. Currently there are 0Takes, and
0GB out of 268GB are used in the CineMag.
There are two modes for recording Cines to the CineMag, when in the standard, “Loop” mode, you
first record to the camera’s NV Ram, preview, trim, and quickly move the files to the CineMag. In
Run/Stop “R/S” mode, you record directly into the CineMag for longer record times but at lower
frame rates. The Cine files are safely in the CineMag, they cannot be deleted individually (its all or
nothing). The CineMag can be downloaded through the Phantom software from the camera body
or from on the Phantom CineStation.

Prepare the Camera to Record a Cine File
Here we will use the On-Camera Controls (OCC), which are located on the camera’s lower left side
of the camera, to set the camera’s resolution, frame rate and shutter angle, post trigger, as well as
do a black reference and white balance.
1. Set the Resolution.
a. Turn the Select knob to the resolution field on the lower left of the menu.
b. Hold in and turn the Select knob until you find your desired resolution, then let go of the
Select knob.
NOTE
If you want to set the resolution to 1920x1080, this must be done via the Phantom Software
Setup & Recording menu. The On-Screen Display (OSD) will still show 2048x1080.
2. Set the Sample Rate.
a. Scroll to the frame rate field (to the right of the resolution)
b. Select one of the available frame rates by holding in the knob and turning until you find the
desired frame rate, then release.
3. Set the Shutter angle.

© 2015 Vision Research - AMETEK Material Analysis Division

70

Phantom Camera Control Help File

a. Scroll to the Shutter angle / Exposure field.
b. Hold in the knob, turn, select your exposure angle (from 1 – 360 degrees), and release.
4. Set the post-trigger of the camera.
a. Scroll to the time-line on the bottom of the OSD menu, then
b. Hold in the knob and release where you want the post-trigger set. If you want the trigger be
at the end of the action, (equivalent post trigger = 1 frame) then set the trigger to the far
right. If you want the trigger at the beginning of the action, place the trigger point on the left
side of the bar.
NOTE
There is a frame count and recording time indicator on the lower left of the OSD. This will
come in handy when choosing where to set the trigger point of the camera.
Also, when in Run/Stop mode, the post-trigger is automatically set to the end of the
recording (or post trigger = 1 frame), as the Trigger is always what stops the recording to
CineMag.
5. Perform a Black Balance (known as Current Session Reference in the Phantom Software).
a. Cover the lens with the lens cap.
b. Scroll to the BB function on the top of the OSD menu, then
c. Hold in the knob, turn counter clock-wise and release. The camera will count down, when it
is done you can remove the lens cap.
NOTE
The Black Reference adjustment process should be performed whenever your camera
settings are changed and as the camera’s temperature changes.
6. Perform a White Balance Adjustment (Color Cameras Only).
a. Point the camera at a white object.
b. Align the object to center of the frame.
NOTE
Ensure that the area to calculate the White Balance adjustment on is not saturated, if it is
then stopping the lens down so there is a value to the white area.
c. Scroll to the WB function, located next to the BB selection on the OSD menu.
d. Hold in the knob, turn counter clock-wise and release. The image will show a square in the
middle, which should be filled with the white subject.
NOTE
The White Balance adjustment process should be performed whenever lighting conditions
change.

Understanding the Camera’s Status
The Phantom camera has three possible recording states:
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1. Live/PRE (Pretrigger) mode: The Phantom Icon on the upper left of the OSD is blue. In this
state, the camera is not writing to the camera’s NV Ram and is simply outputting a live
preview image.
2. Live/WTR (Waiting for Trigger) mode: The Phantom Icon appears red. In this state, the
camera is in ‘capture’ mode, it is actively writing to the camera RAM or CineMag, and is
waiting for a trigger.
3. Live/CST (Cine Stored) mode: The Phantom Icon appears yellow. In this state, the camera is
still outputting a live image, however there is a Cine stored in the RAM. You can now preview,
playback and save that Cine file, then overwrite it by placing the camera back in WTR.
When working with a CineMag, the camera has two overall states:
1. LOOP mode: The camera writes to the RAM first, then files are transferred to the CineMag.
2. R/S mode (run/stop): The camera records direct to the CineMag at reduced frame rates.
These states are easily selectable in the OSD menu.

Capture a Cine File
This is assuming the camera starts in Live/PRE.
1. Capture a Cine file in LOOP mode:
a. Hold down the “trigger” button (the larger button) for 5 seconds until the camera’s status
changes to Live/WTR and the status indicator turns red.
b. Trigger the camera by pressing the trigger button again, once (do not hold down). You can
also use a capture cable and handheld trigger switch to trigger the camera.
2. Capture a Cine file in R/S mode:
a. Push the on-camera control Trigger button to start recording directly into the Phantom
CineMag.
b. Notice that the Activity and Record indicators are on, and the Total Time Available and
Number of Frames Available fields, on the On-Screen Display, are decrementing.
c. Release the on-camera control Trigger button to stop recording.
d. Take note of the Phantom CineMag indicators, and the On-Screen Display information.

Playback Operation
1. Once a cine file has been recorded the camera will be placed into the LIVE CST mode.
2. Place the camera into the PLAY CST mode by depressing the Zoom button one time, this will
place the camera into the ViewCine state.
3. Select a cine for playback:
a. Hold the Zoom button in for 1 second to display the cine SELECT screen.
b. Hold in and rotate the Select Setup button until the desired cine is displayed.
c. Release the Select button.
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4. Play/Pause the selected cine (Forward):
a. Depressing the Zoom button a one time to instruct the camera to forward through the
memory buffer or play the images stored in the memory buffer one image at a time until the
end of the recording as been reach or the user pauses the playback process.
b. Depressing the button a second time to pause the playback process.
5. Play/Pause the select cine (Reverse):
a. Depressing the Trigger button one time instructs the camera to play the image in reverse,
continuously one image at a time.
b. Depressing the button a second time will pause the playback process.
6. Step through the selected cine:
a. Rotate the Select Setup button clockwise will step forward through the recorded images
one image at a time.
b. Rotating the button counter-clockwise will step backwards through the recorded images
one image at a time.

Editing a Cine File
NOTE
To mark the beginning and end of a recorded cine file, the camera must be in the PLAY CST
mode.
1. Set the Mark In Point:
a. Rotate the Select Setup button to the Memory Buffer Graphical Representation field, then
b. Hold in and rotate the Select Setup button until the desired starting image is displayed on
the monitor or in the viewfinder.
c. Release the Select Setup button.
d. Rotate the Setup Select button to the Edit field.
e. Hold in the Select Setup button, then
f. Rotate it until the Mark In option is displayed on the monitor or viewfinder.
g. Release.
2. Set the Mark Out Point:
a. Rotate the Select Setup button to the Memory Buffer Graphical Representation field, then
b. Hold in and rotate the Select Setup button until the desired ending image is displayed on
the monitor or in the viewfinder.
c. Release the Select Setup button.
d. Rotate the Setup Select button to the Edit field.
e. Hold in the Select Setup button, then
f. Rotate it until the Mark Out option is displayed on the monitor or viewfinder, then
g. Release.
NOTE

© 2015 Vision Research - AMETEK Material Analysis Division

Quick Start Guides

73

The memory buffer graphical representation will now display a vertical line marking the end
point of the cine file to be played back.
3. Save the selected cine file to the Phantom Control Unit.

Get Ready to Record Again
1. To return to the LIVE WTR, (Preview, Waiting for Trigger), mode hold in the Trigger button in
for 5 seconds.
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Phantom Flex, v641, v341 Cameras via On-Camera Controls
This Quick Start Guide aims to provide the basic recording, playback and save-to-CineMag steps
when working with a Phantom Flex camera without being tethered to the Phantom software.
For full details on the procedures described in the guides please refer to the Phantom Flex Control
via "On-Camera" Control Buttons section.

STEP-BY-STEP PROCEDURES
Power Up the Phantom Camera
1. Attach the power connector to the Phantom Flex, v641, or v341 camera, then
2. Connect the power supply to AC power.
NOTE
The start-up process takes approximately 30-seconds to complete. Once completed the
camera will be placed into either LIVE PRE (Live Preview) Mode, or LIVE WTR (Waiting for
Trigger) Mode, depending on how it is set up in the Phantom Camera Control software.
We recommend waiting at least 30 minutes when a camera is first plugged in before starting
to shoot, to enable the sensor to reach its optimal working temperature.

Connect an HD-SDI Monitor or Viewfinder
You must have either a HD-SDI monitor or a Viewfinder connected to preview and playback your
captured movies.
1. Using a BNC cable, connect a HD-SDI monitor to a HD-SDI jack on the back of the camera.
2. If you are using a Sony viewfinder, you must:
a. Mount the viewfinder to the optional Sony Viewfinder bracket on the front handle of the
camera.
b. Connect the viewfinder cable to the Fischer connector on the lower right side of the
camera.
NOTE
Your preferred 1080 or 720p signal can be specified in the Camera Options menu of the
Phantom software. The Sony viewfinder will only work with 1080i signals.

Connect the Phantom CineMag
In order to save raw Cine files without being tethered to a PC through Gigabit Ethernet, a Phantom
CineMag is required.
1. Carefully remove the protective top cover of the camera.
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a. Pull on the latch at the back of the camera, then
b. Lift up the cover carefully, be careful not to slide the cover over the pins on the top of the
camera.
c. Store the cover in a safe place.
2. Insert the CineMag with the LED lights facing the back of the camera.
a. Hold the CineMag under the handle, and wedge the front end of the CineMag securely into
the front of the CineMag compartment.
b. Gently press down on the back end of the Cinemag until the latch snaps back in place. If
the latch does not snap in place, be sure to push it to latch into the CineMag.

Understanding the Phantom CineMag
When connected, the LEDs on the back of the CineMag will illuminate, and the status on the
HD-SDI monitor and viewfinder will say, for example: “Mag Ready 0T, 0,268”. This indicates that
the CineMag is connected and ready to start recording Cine files. Currently there are 0Takes, and
0GB out of 268GB are used in the CineMag.
There are two modes for recording Cines to the CineMag, when in the standard, “Loop” mode, you
first record to the camera’s NV Ram, preview, trim, and quickly move the files to the CineMag. In
Run/Stop “R/S” mode, you record directly into the CineMag for longer record times but at lower
frame rates. The Cine files are safely in the CineMag, they cannot be deleted individually (its all or
nothing). The CineMag can be downloaded through the Phantom software from the camera body
or from on the Phantom CineStation.

Prepare the Camera to Record a Cine File
Here we will use the On-Camera Controls (OCC), which are located on the camera’s lower left side
of the camera, to set the camera’s resolution, frame rate and shutter angle, post trigger, as well as
do a black reference and white balance.
1. From any of the LIVE display screens:
a. Press the Settings button one time, then
b. Rotate the button to the desired Camera parameter to be specified. The field will change
from yellow to red indicating the field has been selected for changed.
2. Set the Resolution.
a. Hold in the Settings Setup button, then
b. Rotate the button to the desired operational setting and release.
c. To increase the Resolution hold in Settings button and rotate clockwise, to decrease the
Resolution hold in and rotate counter clockwise.
3. Set the Speed (Sample Rate).
a. Hold in the Settings Setup button, then
b. Rotate the button to the desired operational setting and release.
c. To increase the Speed, (Sample Rate), hold in Settings button and rotate clockwise, to
decrease the Speed, (Sample Rate) hold in and rotate counter clockwise.
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4. Set the Shutter (Angle).
a. Hold in the Settings Setup button, then
b. Rotate the button to the desired operational setting, (from 1 – 360 degrees), and release.
c. To increase the Shutter (Angle), hold in Settings button and rotate clockwise, to decrease
the Shutter (Angle) hold in and rotate counter clockwise.
5. Set the TP (Trigger Point).
a. Hold in the Settings Setup button, then
b. Rotate the button to the desired operational setting and release.
c. To move the TP, (Trigger Point), toward the end of the action (right), hold in Settings button
and rotate it clockwise to the desired location, to move the TP, (Trigger Point), toward the
beginning of the action (left), hold in Settings button and rotate it counter clockwise to the
desired location
NOTE
There is a Maximum Recording Time and a Maximum Recordable Frames field at the
bottom of Setting Display 1/4. These fields will come in handy when choosing where to set
the trigger point of the camera.
Also, when in Run/Stop mode, the post-trigger is automatically set to the end of the
recording (or post trigger = 1 frame), as the Trigger is always what stops the recording to
CineMag.
6. Enable the Auto BREF
a. Hold in the Settings Setup button, then
b. Rotate the button to the desired operational setting and release:
1) Off - Disables the Automatic Black Reference feature.
2) On - Enables the Automatic Black Reference feature.
7. Perform a Black Reference, (known as CSR (Current Session Reference) in the Phantom
Camera Control software).
a. Hold in the Settings Setup button, then
b. Rotate the button and select, (highlighted red), the Black Reference option, then
c. Hold in and rotate the Settings Setup button to OK.
Result: Approximately 6 seconds after OK has been selected the camera will perform the Black
Reference calibration adjustment automatically.
NOTE
Prior to performing a Black Reference Adjustment, the Auto BREF (Black Reference) option
should be enabled to ensure that the sensor is void of light. If the Auto BREF option is not
enabled the end-user will need to place the lens cover over the lens prior to depressing the
B-REF button to ensure the absence of light.
The Black Reference adjustment process should be performed whenever your camera
settings are changed and as the camera’s temperature changes.
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8. Perform an Automatic White Balance Adjustment.
a. Ensure that the center of the display are has an area that resembles white. Ensure that the
white area pixels are not 100% saturated.
b. Hold in the Settings Setup button and select, (highlighted red), the Auto White Bal option.
The image will show a square in the middle, which should be filled with the white subject,
then
c. Hold in and rotate the Settings Setup button to OK.
Result: Approximately 6 seconds after OK has been selected the camera will perform a White
Balance calibration adjustment.
NOTE
Ensure that the area to calculate the White Balance adjustment on is not saturated, if it is
then stopping the lens down so there is a value to the white area.
The White Balance adjustment process should be performed whenever lighting conditions
change.

Understanding the Camera’s Status
The Phantom camera has three possible recording states:
1. Live/PRE (Pretrigger) mode: The Phantom Icon on the upper left of the OSD is blue. In this
state, the camera is not writing to the camera’s NV Ram and is simply outputting a live
preview image.
2. Live/WTR (Waiting for Trigger) mode: The Phantom Icon appears red. In this state, the
camera is in ‘capture’ mode, it is actively writing to the camera RAM or CineMag, and is
waiting for a trigger.
3. Live/CST (Cine Stored) mode: The Phantom Icon appears yellow. In this state, the camera is
still outputting a live image, however there is a Cine stored in the RAM. You can now preview,
playback and save that Cine file, then overwrite it by placing the camera back in WTR.
When working with a CineMag, the camera has two overall states:
1. LOOP mode: The camera writes to the RAM first, then files are transferred to the CineMag.
2. R/S mode (run/stop): The camera records direct to the CineMag at reduced frame rates.
These states are easily selectable in the OSD menu.

Capture a Cine File
This is assuming the camera starts in Live/PRE.
1. Capture a Cine file in LOOP mode:
a. From the LIVE PRE Display Screen, depress the Trigger button to place the camera into
the LIVE WTR (Preview, Waiting for Trigger) or capture/recording mode.
b. From the LIVE CST(Cine Stored), PLAY CST Display Screens, depress and hold the
Trigger button in for approximately 6-seconds to place the camera into the LIVE WTR
(Preview, Waiting for Trigger) or capture/recording mode.
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c. From the Select Display Screen, depress the Trigger button to return to the LIVE CST
Display Screen then perform Step 1b to place the camera into the LIVE WTR (Preview,
Waiting for Trigger) or capture/recording mode.
NOTE
If the camera is set to record pre-trigger images the Memory Buffer Graphical Display will
show the memory allocation progress, indicating how much of the memory buffer has been
filled with image data or frames. It does not, however, display the camera's ability to
continuously re-allocate newer images into its scrolling buffer.
If a cine has previously been stored into the camera's DRAM you must hold in the Trigger
button for approx. 6-seconds to place the camera in the LIVE WTR state.
d. Depress the Trigger button when the camera is in the LIVE WTR mode to trigger to the
camera.
NOTE
If the camera was set to capture post trigger frames, (Loop Mode only), the camera will be
placed into the LIVE TRG (Recording, Cine Triggered) state. When the camera stops
recording the desired number of user defined post trigger frame into the camera's memory,
the camera will be placed into the LIVE CST (Cine Stored or ready for playback) state.
2. Capture a Cine file in R/S mode:
a. From the LIVE Display Screen, depress the Trigger button to place the camera into the
LIVE REC (recording), mode.
b. Hold in the Trigger button for approximately 2-seconds to start recording image data
directly into an attached Phantom CineMag.
c. Notice that the Activity and Record indicators are on, and the Total Time Available and
Number of Frames Available fields, on the On-Screen Display, are decrementing.
d. To stop recording to the Phantom CineMag, depress the Trigger button a second time.
e. Take note of the Phantom CineMag indicators, and the On-Screen Display information.
f. Repeat these steps until all required cines have been recorded.

Playback Operation
Once a cine file has been recorded:
1. Select a cine for playback:
a. Press the Select button to access the Select Display Screen.
b. From the Select Display Screen, rotate the Settings button to the cine to be reviewed, then
c. Depress the Select button again.
2. Play/Pause the selected cine (Forward):
a. Depress B-REF button one time to instruct the camera to play the images one image at a
time until the end of the recording as been reach or the user pauses the playback process.
b. To Fast Forward the cine playback hold in the B-REF button for approximately 2-seconds.
c. To pause the playback process depress the B-REF button a second time.
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3. Play/Pause the select cine (Reverse):
a. Depress Tools button one time to instruct the camera to play the images one image at a
time until the beginning of the recording as been reach or the user pauses the playback
process.
b. To Fast Reverse the cine playback hold in the Tools button for approximately 2-seconds.
c. To pause the playback process depress the Tools button a second time.
4. Scroll through the selected cine:
a. Rotate the Settings Setup button clockwise to scroll forward through the recorded images.
b. Rotate the button counter-clockwise to scroll backwards through the recorded images..

Editing a Cine File
NOTE
To mark the beginning and end of a recorded cine file, the camera must be in the PLAY CST
mode.
1. Set the Mark In Point:
a. Rotate the Settings button clockwise to scroll forward through the recorded images or
rotate the button counter-clockwise to scroll backwards through the recorded images until
the desired starting image is displayed on the monitor or in the viewfinder, then
b. Hold in and rotate the Settings button, clockwise, until the Set-In field is displayed in the
lower left-hand corner of the display screen, then
c. Release the Settings button.
RESULT: The memory buffer graphical representation will display a vertical line marking the new
starting point of the cine to be reviewed.
2. Set the Mark Out Point:
a. Rotate the Settings button clockwise to scroll forward through the recorded images or
rotate the button counter-clockwise to scroll backwards through the recorded images until
the desired starting image is displayed on the monitor or in the viewfinder, then
b. Hold in and rotate the Settings button, clockwise, until the Set-Out field is displayed in the
lower left-hand corner of the display screen, then
c. Release the Settings button.
NOTE
The memory buffer graphical representation will now display a vertical line marking the end
point of the cine file to be played back.
3. Save the selected cine file to the Phantom Control Unit.
a. From the PLAY CST Display Screen hold in and rotate the Settings button, counterclockwise, until the Save field is displayed in the lower left-hand corner of the display
screen, then
b. Release the Settings button.
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Get Ready to Record Again
1. To return to the LIVE WTR, (Preview, Waiting for Trigger), mode:
a. From the LIVE CST(Cine Stored), PLAY CST Display Screens, depress and hold the
Trigger button in for approximately 6-seconds to place the camera into the LIVE WTR
(Preview, Waiting for Trigger) or capture/recording mode.
b. From the Select Display Screen, depress the Trigger button to return to the LIVE CST
Display Screen then perform the step above to place the camera into the LIVE WTR
(Preview, Waiting for Trigger) or capture/recording mode.
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Phantom Camera Control Software - Help

Software Version 12.14.727.0-C
Updated: 08/15/2012

The Phantom (Legacy) Camera Control Software provides you with complete creative control over
time. You can shift the frame rate a little and move a scene to a slightly future viewpoint.
Alternatively, shift the sample rate a lot and move a scene to some long passing moment in time. You
will enjoy the ability of having seamless control of the duration, speed and time of every element of
the shot.
With its two main components of the system, the Phantom imager with advanced CMOS technology,
and the Phantom (Legacy) Camera Control Software, they form a system that provides high speed.
High resolution image capture in a digital cine format, with analytical cine playback, measurements,
and communications across multiple digital and analog protocols.
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The User Interface
The Phantom Camera Control user-friendly Windows based software application, supplied with each
camera, provides an intuitive graphical user interface. The software is built around a multi-layered
work area that includes the Main System Window, the Setup and Recording Window, and the
ViewCine Window.
It provides the user with controls to set up the cameras operating parameters while viewing the “live”
image on the Phantom Control Unit monitor, or an attached monitor for real-time image monitoring or
recording of the camera view.

4.1.1

Main System Window

The Phantom control software’s Main System Window provides the user with following pull-down
menu options:
· File Menu
· Acquisition Menu
· Edit Menu
· View Menu
· Image Menu
· Measurement Menu
· Window Menu
· Help Menu
The accessibility of these menus, and their related commands, vary based on the operational mode
determined by the user. The control software provides two primary modes of operation, the Setup
and Recording Mode and the ViewCine Mode. Depending on the mode the user can:
· Specify which camera to set up and record with.
· Save, open, or view recorded cine files and/or image files.
· Convert cine files to any of the various supported movie or image formats, or merge a series of
still image file into a cine file.
· Perform detailed image analysis measurement on cine files or image files.
4.1.1.1

File Pull-Down Menu Options
The File Pull-Down Menu commands are used to open, close, save and convert cine or image files. It
also provides access to a powerful compression tool that conserves space on the hard drive, and
tools that allow you to open or save images in other file formats, and print commands under this
window.

© 2015 Vision Research - AMETEK Material Analysis Division

84

Phantom Camera Control Help File

The File Pull-Down Menu commands include:

Open
Use the Open command to view a cine file or image file that has been saved on your system's
hard drive, a networked drive or on some peripheral drive such as a floppy drive, Zip drive, or
tape drive.

Save As
The Save As command used to save a cine or image to your system's hard drive, a networked
drive or to some peripheral drive such as a floppy drive, Zip drive, or tape drive.
One could also use the Save As command to save images and cine files that have had image
processing applied to them, or images that you want to save in any of the supported graphical
formats.

Close cine
The Close cine command is used to close a cine that has been opened from the hard drive. The
Close Cine command will be unavailable (grayed out) if the cine has been closed already or
never opened.
NOTE
Vision Research suggests that all cine files that are opened to be closed before performing
any File Conversion.

Convert&Process cine...
The Convert&Process command allows the user to compress original cine files using a variety of
video compression algorithms, expand previously compressed cine files, convert cine files to
supported formats, and convert cine files to a series of stills.
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Merge images to cine...
The Merge images to cine... command allows the user to import and convert a series of images
such as .tif, .bmp, etc. to the Phantom cine format. This can be very useful if you have an imaging
system manufactured by another manufacturer and want to use the many measurement and
image processing tools found in the Phantom software.

Page Setup...
The Page Setup... command is used to select the option that best suits the size of the printout
desired for an image that was extracted from a cine file, or opened from a file. This command is
only available when an image file is open.

Print...
The Print... command provides the standard Windows options for selecting which printer to send
the output to, setting the printer properties, paper size & source and paper orientations.

Exit
Exit terminates the Phantom Control Software application.
4.1.1.2

Acquisition Pull-Down Menu Options
The Acquisition Pull-Down Menu commands are used to select, setup, adjust, capture and record
images via a specified camera, and simulate various Phantom camera models.

The Acquisition Pull-Down Menu commands include:

Setup and Recording...
The Setup and Recording... command allows the user to enter, adjust, and view all image
acquisition settings and recording options, and provide a means for saving and opening
combinations of setup screen parameters that can be recalled at a later date.
Displays exactly what the Phantom camera is imaging in a live preview mode window and allows
the user to capture and trigger the images to be recorded.
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Camera clock...
The Camera clock... command provides controls for setting up and adjusting the camera's date
and time settings that are used as the time stamp reference for images.

Camera Options...
The Camera Options... command is used to specify Video Output, IRIG, Image3 and End of
Recording settings, etc.

Restore NV Memory...
The Restore NV Memory... command is used to restore a cameras' non-volatile memory back to
factory default settings, apply a secondary IP Address to a Phantom camera, or load both
firmware or FPGA's, (Field Programmable Gate Arrays), via one simple operation.

Camera pool...
The Camera pool... command is used to specify which camera is to be, or not to be, controlled via
the Phantom Controller Unit’s Camera Control software.

Add Simulated Cameras...
Use this command to simulate a Phantom camera model. This command can be very useful to
determine recording times and the number of images that can be recorded for various camera
models prior to purchasing a camera or memory upgrades.
4.1.1.3

Edit Pull-Down Menu Commands
The Edit Menu contains several convenient methods for duplicating images extracted from original
cine files. The Edit menu may also be used for exporting images for use in other programs such as
word processors, desktop publishers and paint programs.

The Edit Pull-Down Menu commands include:

Enable Select Rectangle
Select this command when you want to copy only part of the original image.
Move the cursor to the top, left corner of the area you want to select for copying; drag the cursor
to the bottom right corner. A window appears to show you what will be included.
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To accept the contents of the rectangle, select the Copy to Clipboard command under the Edit
menu. (To cancel the rectangle, click the mouse button once.)

Copy to Clipboard
Select this command to copy a single image or selected rectangle to the Windows: Clipboard
Viewer. Copying an image to Clipboard will erase the previous contents of Clipboard.
To save the image as a Clipboard file, select Save Image from the File menu in the Clipboard
Viewer.
To use the image just copied in another Windows program, open that program and the file the
image will be used in. Select Paste from the Edit menu of that program; Clipboard will
automatically insert the image or selected rectangle.

Paste from Clipboard
Use this command to import an image from the Clipboard.

Duplicate Image
Select this command to display a duplicate copy of the active image. You may duplicate the
image any number of times; each duplicated image is displayed in its own Window. Any
command that can be applied to an original image can be used with a duplicate image.
4.1.1.4

View Pull-Down Menu Commands
Use the View Pull-Down Menu to see an instant replay of the cine just recorded, or a full motion
playback of a previously recorded cine or to display single images extracted from an original cine.
NOTE
The View Menu commands are available when a cine file has been opened and the playback
window has been closed without closing the cine file with the File Menu - Close Cine
command, when a single image is open, or if there is a cine recorded in the camera.

The View Pull-Down Menu commands include:

© 2015 Vision Research - AMETEK Material Analysis Division

88

Phantom Camera Control Help File

Zoom
This command is only available when an image file is open. It allows up to a 16x digital
enlargement or reduction of the active image displayed in the Phantom Control window.

Single Image...
This command is only available when a cine file has been opened and the playback viewer has
been closed without closing the cine file with the File Menu - Close Cine command. It provides a
means for extracting a specific single image from a cine file.

Reduced Cine Images...
This command is only available when a cine file has been opened and the playback viewer has
been closed without closing the cine file with File Menu - Close Cine command. It provides a
smaller playback window for faster playback rates.

Cine Images...
Cine Images... opens a playback screen to provide an instant replay of the cine just recorded, or
playback of a previously recorded cine. This command is only available when a cine file has been
opened and the playback viewer has been closed without closing the cine file with the File Menu Close Cine command.

Video Out Control...
The Video Output Control feature provides the user with the ability to control any Phantom
Ethernet camera attached to a monitor. This feature will be extremely effective with the higher
resolution cameras since most computer monitors do not refresh the screen images quickly
enough to produce a smooth visual display.
By default the Video Output Control window will display a live image on the monitor. The user can
also place the camera into the capture mode and trigger it. The user may perform a quick-edit of
the recorded cine by easily selecting the range of images to be played back.
Once captured the user can play back the recorded cine file from the camera's memory, using the
video playback buttons along with adjusting the speed of the playback.
NOTE
This Video Output Control feature is only accessible with Ethernet model cameras, the
player has not been implemented for the IEEE 1394 camera models, or the Image3.

Image Histogram
The Image Histogram displays a graphical representation of the distribution of RGB, (Red/Green/
Blue), and/or luminance values in an image. This command is only available when an image file
is open.
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Image Pull-Down Menu Commands

The Image Menu allows the user to select the image Processing functions only when an image file is
open. However, Image Processing can be performed on preview images and on a captured cine file
via the Setup and Recording and View Cine playback windows.
The Processing options may be used alone or in combinations to bring out hidden features and
details. After selecting one of the image processing options the effect of the functions will be
displayed on the images.
The Image Processing functions may be opened by the Im. Proc... in the Setup and Recording
window, from the Image Processing button in the View Cine playback window (cine only), or from the
menu bar (Image file only).
Not all image-processing techniques are appropriate for every image. We recommend you
experiment to find the best enhancements for your image by first creating a duplicate image, then
applying the image enhancements to the duplicate. Compare your results with the original image.
To create a duplicate image, select Duplicate Image from the Edit menu; to view both the original and
the copy, select Tile from the Window menu.
4.1.1.6

Measurement Pull-Down Menu Commands
The Measurement Menu, is used to perform a measurement on a single image, while the Measure
button is used to perform measurements on an open cine file in the playback window, opens a
toolbox of motion analysis functions. You can use these motion analysis tools to quantify just a few
key measurements quickly, or to conduct a thorough analysis of the motion. Report files can be
constructed simultaneously, so when you're finished measuring, your report is finished too.
From this menu, you can find dimensions, population, speed, distance, acceleration, position, and
displacement. You can also measure angles and angular rotation.
Measurement functions may be applied to both single images and cine files. Certain measurements
such as those for speed and acceleration can only be applied to cine files.
NOTE
Single images extracted from cine files do not contain the timing information needed to
compute speed). While working with the various measurement features in the Phantom
software, refer to the lower left corner of the playback view window. The status bar will provide
prompts for the actions required.
Acceleration, speed, and point position files can be created with the collect point's function. These
files can be can be imported onto LOTUS 1-2-3 , Microsoft Excel or other spreadsheets for final
presentations or graphics for detailed reports.
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The Measurement Pull-Down Menu commands include:

Units...
Units... specifies the unit of measurement, metric (SI) or US units that will be used by the
software to calculate distance, speed, acceleration, angle and angular speed.
The units selected are displayed in the status bar at the bottom of the playback View window.

Scaling...
Cine files are typically recorded and viewed at some reduction in size to the original scene. To
measure actual distances, speeds, or accelerations you must first establish the reduction value or
scale.
The Phantom Control Software automatically applies this scale to the entire cine, and to any
single images extracted from the cine. Scaled dimensions are displayed in the status bar at the
bottom of the View window.

Report File...
Use this option to simultaneously create a data file as you measure position, distance, speed, or
angels.
The contents of a report file can be viewed in many text editors and word processor programs;
some additional formatting may be required.
In addition to measurement data files, a report file can include information about the test event
such as camera, camera position or station, lens and f-stop, the name of the analyst or team that
recorded the test, and the cine file name. The report file will also include the day, date, and time
of the test, unit of measurement, scale factors, and the (x,y) coordinates of the origin. Finally, the
report file format allows you to include a description or comment about each point selected for
measurement.
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Set Origin
The default origin for all images is in the top left corner of the image. To measure position,
distance, displacement, speed or acceleration, a reference point must be established. Any point
in the image may be selected as the reference point or point of origin. Your choice of origin will be
largely dependent on the subject and the type of motion being studied. Once selected, the (x,y)
coordinates of (0,0) will automatically be assigned to that point for each image in the cine.
Repeating the Set Origin command may reset the position of the coordinates axes.

Clear Origin
Clear Origin removes the coordinate axes from the display and resets the point of origin to its
default position at the top, left corner of the image. When selected the origin is reset for the entire
cine.

Coordinates
This option displays the (x,y) coordinates of selected points in the image. The coordinates are
displayed in the status bar at the bottom of the View window. You can also use the Coordinate
function to count populations, for example, the quantity of shot in a shotgun round.

Distance and Speed...
Used to measure displacement and speed of linear motions with respect to a fixed point of origin
(1-point + origin option), or measure displacement and speed of an object in one image with
respect to its new position in any subsequent image (2-points option).
Distance and speed measurements are displayed in the status bar at the bottom of the View
window.
All Distance and Speed functions can be used in conjunction with a Report File or without. With a
report file opened, the image number, elapsed time from trigger, unit of measurement, distance
(or dimension) speed and any comments are automatically saved in the open report file. Report
files are saved to the current directory and are identified by the file extension .rep

Angle and Angular Speed...
Measures angles and speed of rotational motions. Angle and Angular Speed measurements are
displayed in the status bar at the bottom of the View window.
All Angle and Angular Speed functions can be used in conjunction with a Report File or without.
With a report file opened, the image number, elapsed time from trigger, unit of measurement,
angle, angular speed, and any comments are automatically saved in the open report file. Report
files are saved to the current directory and are identified by the file extension .rep

Collect Points...
The Collect Points.. command is used whenever you plan to export motion analysis data for use
with other programs. Because the Collect Points function creates separate data files as you

© 2015 Vision Research - AMETEK Material Analysis Division

92

Phantom Camera Control Help File

collect measurements, other programs such as Louts 1-2-3 and Microsoft Excel can import these
files. You will also use Collect Points whenever you plan to measure acceleration. Collect Points
creates separate data files for point coordinates speed and acceleration values. At your
command, point position information may also be included in reports using the Report File
function.
Collect Points are displayed in the status bar at the bottom of the View window. The Point # box
in the Playback screen shows the point currently being selected starting with point 0.
NOTE
All points collected in the point position (.pps) file are listed in the order they are collected.
Any points, edited after the initial collection, are appended to the end of the .pps file.
Clicking Sort and Optimize button reorders the file according to the image number the points
were collected from.
4.1.1.7

Window Pull-Down Menu Commands

The Window Pull-Down Menu commands include:

Cascade
Select this command to display several single images one on top of the others. This displays a
larger view of a single image when several images are open at once.

Tile
Select this command to display several single images side-by-side. This display format is useful
when making comparisons of non-sequential images, judging the effectiveness of various
image-processing techniques, or when measuring the displacement of an object in sequential
images. Images will appear cropped on the screen: drag the scroll buttons to display more of the
image.

Arrange Icons
Selecting this command aligns any minimized images along the bottom edge of the display.

Close All
Select this function to close all open images at once. Changes made to files will not be saved.
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Open files are listed at the bottom of the menu with the active file checked.
4.1.1.8

Help Pull-Down Menu Commands

The Help Pull-Down Menu commands include:

Contents
Contents when selected opens this Help file.

Release Notes
Release Notes when selected opens the latest version of the Release Notes file.

Technical Support
Technical Support when selected opens a pop-up display window with information about how to
contact Vision Research for technical assistance.

How to use Help
How to use Help when selected open a pop-up window describing “How to Use Help”.

About...
The About window provides the following information:
· Phantom Camera Control Software Version Number
· PhCon and Firmware Versions
· Camera Type
· Windows Memory Information
· Selected Camera Memory Information
· CPU Information
· Color Interpolation
· Logging Button – Allows the end-user to specify which of the following should be included in
a system generated PhCon.log file:
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– Phantom (0 = not selected; ffffffff = selected)
– PhCon (0 = not selected; ffffffff = selected)
– PnInt (0 = not selected; ffffffff = selected)
– PhFile (0 = not selected; ffffffff = selected
– PhSig (0 = not selected; ffffffff = selected)
– PhSigV (0 = not selected; ffffffff = selected)
· Details Button – Used to display the Debug Log file
NOTE
Both the Logging and Details buttons are primarily used by Vision Research Engineers to
determine if there are any errors with the Phantom Camera Control software code.

4.1.2

Setup and Recording Window
The Camera Setup and Recording selection in the Acquisition menu pull-down list opens a dialogue
window displays exactly what the Phantom camera is imaging in a live preview mode. It also allows
the user to enter, adjust, and view all image acquisition settings and recording options in one
convenient window. Once the setup parameters is entered, the settings can be saved for future use.
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Setup and Recording Display Example (Phantom v12.0 camera)

Following is important operational information describing how and when the Phantom application
writes, stores, and recalls setup parameters to a cameras' internal flash memory and the attached
Phantom Camera Control computer hard drives.
The first thing to note is that all settings made in the Setup and Recording screen are written to the
camera's non-volatile internal flash memory when you select a value from the drop-down list or when
you introduce a custom value and press the Update button, or when the Setup and Recording screen
is closed using the OK button. Once the settings are stored to the camera flash, they will become the
default setup parameters, which will be recalled each time the camera, is powered on until they are
changed in the setup screen and the flash is overwritten.
When a camera is powered on, the setup parameters is read from the flash memory and the camera
can be set to automatically be placed into the capture mode with those settings. This means the user
can pre-load the camera settings, power down, move to the field and place the camera on a tripod or
other fixture, apply power, connect a trigger wire, and plug in a standard video monitor to perform the
photographic operations of framing, focusing and lighting. Once these photographic operations are
complete, the video monitor can be removed, (or left attached), leaving only power and trigger wires
attached. The camera continuously recording images and waiting for a trigger to end the recording
process.
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When the trigger is sent to the camera, the recording process ends and the images are stored in the
volatile DRAM (Image Memory) inside the camera. A loss of power at this point would result in the
loss of all images stored. It is very important to provide the camera with a reliable power source to
prevent the inadvertent loss of data.
The Setup and Recording window provides a means for saving and opening different combinations of
setup screen parameters. Selecting the Save option in the setup screen will open a file save dialog
box allowing the setup parameters to be saved to a file on the connected computer's hard drive. Use
this option when you want to save the setup screen parameters for recall at a later date.
NOTE
When you are controlling two or more cameras from the same Phantom Camera Control
computer and want to save the setup parameters for different cameras on the network, it is
useful to use the Camera's 4-Digit ID Number as a part of the filename the setup parameters
will be saved to. In this manner, you can recall the setup parameters for the camera being
accessed by using the Open option in the Setup and Recording display.
4.1.2.1

Preview Panel
As mentioned earlier the Setup and Recording Window, the Preview Panel displays exactly what the
Phantom camera is imaging in a live preview mode.
In the sample Preview Panels below, notice the Phantom Miro, v4, v5, v7, v9, v10, v12, v310, v640
cameras and Image3 will display the live images in the panel by default. However, since the
Phantom v6 series' cameras can support up to 4 imaging heads simultaneously, the panel divides
into 4 equally sized display panels, one for each imaging head.

Phantom Miro, v4, v5, v7, v9, v10, v12, v710, v640,
v310, v210 and Image3 Preview Panel Examples

4.1.2.2

Phantom v6

Status/Information Panel
When viewed in the Setup and Recording dialogue window, the status bar located just below the
preview panel display's status information about the state the camera is in.
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Below is a brief description of various status messages:

Preview, Waiting for pre-trigger...
The camera will be placed into the Preview, Waiting for pre-trigger... mode by default when the
Wait pre-trigger option has been enabled under the Acquisition>Camera Options>Start in
dialogue box.
The Preview, Waiting for pre-trigger.. status means that the camera is capturing only Preview
images. The camera can be in this status when there is no cine yet in the camera, and it is not
recording a cine in its RAM memory, or when you choose “Delete cine(s) and wait pre-trigger”
option when trying to record a new cine in the camera. In this status, the camera has a lower
power consumption.

Preview + Recording cine n... Waiting for trigger
Indicates the camera is in Capture mode, recording images, using these images for the Preview,
while storing these images in the camera's DRAM. The recording process will stop when a
Trigger happens and all the post trigger frames are stored in the camera.
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Preview
Preview status means that there is already a cine recorded in the camera, and now, the camera
is capturing only Preview images, not overwriting the cine images stored in the camera's DRAM.
The recorded cine can now be viewed via the ViewCine playback window.

Image Information
When the cursor is placed over the image displayed in the Preview Panel, the status bar will
indicate the location (x:y axis) of the cursor, the gray (scale) value of the pixel location
(monochrome images only), or the RGB (Red, Green, Blue) values for that location. It will also
display the HSV (Hue, Saturation, and Value), and the HLS ( Hue , Luminance, and Saturation)
values for that location (color images only).
4.1.2.3

Control Panel
Minor differences in the Setup and Recording dialogue windows, for the various camera models, will
be noted in this document for the various Phantom camera models.

Phantom 65, HD,
Phantom v5.1, v5.0
v710, v640, v310,
v210, v12.1, v10.0,
v5.2, v4.3, v4.2
Phantom v9, v7, Miro Series

Phantom v6.2

Phantom v6.1, v6.0

Image3
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4.1.2.3.1 Control Panel Components

The following is a brief description for each of the Control Panel components:

Histogram

Example of 8-bit pixel image depth Histogram

Example of 12-bit pixel image depth Histogram

The image histogram is a graph of the distribution of RGB and/or luminance values in an image.
Each of the values appear on the horizontal axis from dark to light (left to right), as shown in the
8-bit pixel image depth Histogram graphic. The vertical axis indicates the number of pixels of
that value at each point. At a point where there are many pixels of a value, the corresponding
line spikes; where there are no pixels, it lies at the bottom of the graph.
When you use a camera with more than 8 bits per pixel, the Histogram window will also display
a graphic illustrating the adjustments made in the Image Processing box for the “16 bit to 8 bit”
field. This 12-bit pixel image depth Histogram graphic shows the range defined by the minimum
and maximum values set with the “16 bit to 8 bit” slider via Im. Proc...

Description
The Description could be any name, project number, test sequence number, etc. It could be any
combination of letters, numbers, or spaces, up to a maximum of 4,096 characters.

Camera
The Phantom application is capable of supporting up to 63 cameras. This box displays the name
of the camera the Phantom Control Computer is presently connected to. Any changes made in
the setup screen will be applied only to the camera presently shown in the camera name box,
unless the "All connected cameras" option is selected via Options button, Multicamera control.
The list of available cameras can be displayed by clicking on the down-arrow to the right of the
camera name. To change to a different camera simply select the camera desired from the list.

Cine
The Cine field activates when the MultiCine feature is defined with a value greater than 1 via the
Setup and Recording>Options button. By default the system places the camera into Preview
mode, allowing the user to view a live image in the Preview Panel. Once the camera is placed
into the "Preview + Recording cine n... Waiting for Trigger" mode, the Cine field will automatically
change from the Preview to the Cine number. Initially the cine number will be 1 because the
system automatically writes the image data into the next free memory segment, unless
otherwise instructed by the user via a pull-down selection list.
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Selecting a cine number, from the list, places the camera into the "Preview + Recording cine n...
Waiting for Trigger" mode.
Selecting Preview will place the camera into the "Preview, Waiting for pre-trigger..." mode. It is in
this mode that you can specify setup parameters that can be applied to all memory segment
profiles when the Set to all option is selected. This command instructs the camera to send a live
image to the control unit and/or attached monitor, and set the camera to the idle state.
Selecting the Set to all option changes all settings for all cine files to the values currently
displayed in one of the cine files or in Preview. This option deletes the recorded cine files in the
camera. This system will, however, verify this process by displaying a Warning message for
every recorded cine prior to deleting the data.

Speed Options
Sample Rate
Sample Rate specifies the rate at which images are to be recorded. The Sample rate is
depended upon the defined Resolution (width x height) of the images being captured.
Exposure Time
The default setting is nominally, the reciprocal of the sample rate less 20 microseconds of
overhead. Click the down-arrow to display a drop down list box and select one of the preset
exposure times in the pull down list box. If the desired exposure time is not listed an exposure
time may be entered. The Phantom Camera Control application allows the user to enter
exposure times in one-microsecond increments between the minimum and maximum
exposure time within the drop down list.
EDR Exposure
EDR (Extreme Dynamic Range) Exposure is very useful when the subject contains very bright
areas as well as darker areas and both must be exposed properly throughout the cine. The
EDR function permits the user to expose for darker areas in the subject via the Sample rate
and Exposure time settings and then set a separate and independent pixel level EDR
Exposure for all the portions of the image that might become saturated The option is
automatically enabled when any value, other than zero, is entered in the EDR Exposure field.
NOTE
EDR Exposure times should be set at approximately 1/2 of the Exposure time as a starting
point. By setting the EDR Exposure to 1/2 of the Exposure time the brightest pixels in the
images will be exposed for one stop less than the darker pixels.
PostTrigger
Sets the number of images to be saved after a trigger has been detected. Setting the number
of post trigger pictures also determines the reciprocal number of pre-trigger images saved.
Enter the number of frames to be saved after a trigger in increments of one. Refer to the
Duration when determining the required number of frames to set.
Clicking on the down-arrow allows the user to select one of the preset Post Trigger values
conveniently from the pull down list box.
· To save only images acquired before the trigger (all Pre-Trigger), enter 1 (one).
· To save only images acquired after the trigger (all Post Trigger), enter the maximum
number of images for your system.

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

101

· Delay Start: The Post Trigger function can also be used to introduce a delay from the
trigger point to the start of image capture.

1. First, divide the desired delay time by the picture interval time.
2. Add the maximum number of pictures for your system as displayed under Duration to this
number.
3. Enter the sum as the Post Trigger: this number must be less than 4 billions. The camera
will discard all images acquired during the Post Trigger delay period, saving only the last
maximum number of pictures.
For example, if the maximum number of pictures is 1024, to set a two second Post Trigger
delay for a sample rate of 500 pictures per second, enter 2024 = (two seconds /
0.002seconds =1000) + 1024. (The picture interval time is the reciprocal of the sample rate.

Mode Options
Auto exposure
This mode is useful for any application where the influence of a constantly changing lighting
condition might result in either underexposed or overexposed images. This control is based
on a shutter priority limit, which permits the setting of an exposure time limit based on the
need to eliminate motion blur in the images. When the Exposure time is used to set the limit
and the Auto Exposure feature is enabled, the camera will automatically adjust the exposure
time of the images from the set exposure time limit downward to the shortest exposure time
available (10 microseconds).
As an example, set the Sample Rate to 1000pps, the Exposure time to 500 microseconds and
then check the Auto Exposure box. Next, set the lens aperture wide open. With these settings,
a camera outside under changing lighting conditions due to patchy cloud cover will produce
acceptable images of a test regardless of the changing conditions. It is important to note that
the exposure time limit should be set for an acceptable image under the dimmest lighting
condition that may be encountered.
Auto Exposure is a very powerful function not found in any other high speed camera and with
some experimentation can become an extremely powerful tool for use in many high speed
imaging applications. Use it and enjoy it!
Click on the Auto Exposure enable check box. The option is enabled when a check mark is
displayed in the enable box. To define the Auto Exposure parameters see; Defining and
Enabling the Auto Exposure Parameters.
NOTE
When Auto exposure is selected the EDR (Extreme Dynamic Range) feature will be disabled.
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Shutter Off
This feature has been designed for use in PIV (Particle Imaging Velocimetry) applications.
When enabled the Phantom v-series cameras are instructed to reduce the Frame Straddle
Time to an interval of 1.5µs. For a Phantom v710, v640, v310, v210 or v12 the Frame
Straddle time will be reduced to 300 nano-seconds.
Sync
This field instructs the system to utilize any of the following three clock sources:
Internal
Select this mode to use the cameras internal crystal oscillator to drive the camera's
sample rate.
External
Select this mode when an externally supplied pulse will drive the camera’s sample rate.
The external input must be a TTL pulse, with a frequency up to the maximum sample
rate. (Example: 1000Hz @ 512 x 512 resolution, 2000Hz @ 256 x 512 resolution.) The
TTL input pulse must be connected to the BNC (Bayonet Neill-Concelman) connector
marked Sync on the 19-pin Capture breakout cable.
NOTE
When External Sync Imaging is selected the Sample Rate option will be disabled.
IRIG
Select the mode when an IRIG-B signal is supplied through the marked IRIG Input BNC
connector on the 19-pin Capture breakout cable.
Refer to the Frame Rate Tables for a list of frame rates (fps) the camera will lock to.
NOTE
When IRIG mode is selected the Sample Rate option will be disabled.

Resolution
The Resolution setting allows the user to change the dimensions of the images. The Resolution
is the width to the height ratio of the image to be recorded. Each type of camera has a specific
maximum resolution. Changing the Resolution settings to match the dimensions of the subject of
interest allows the user the option of recording at higher sample rates, or longer recording times
at the same sample rate.
Phantom cameras can be mounted in any position allowing great flexibility in matching the
shape of the subject of interest.
To define the desired Resolution, click the down-arrow to the right of the Resolution field to view
a list of predefined aspect ratios. If the user wishes to use a resolution not displayed within the
list simply enter the desired Resolution, click the Update button, and the system will select the
closest, allowable, Resolution for the camera's sensor.
Using the CAR (Continuous Adjustable Resolution) feature, provides for resolution adjustments
between the minimum and maximum drop-down list values as follows:
· Phantom Flex in 256 x 8 pixel increments.
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· Phantom 65 in 4096 x 8 pixel increments.
· Phantom HD Gold, HD in 2048 x 8 pixel increments.
· Phantom v710, v640, v310, v210, and v12 Series in 128 x 8 pixel increments.
· Phantom v10 and v9.1 in 96 x 8 pixel increments.
· Phantom v9.0 in 48 x 8 pixel increments.
· Phantom v7.3 in 32 x 8 pixel increments.
· Phantom v7.2, v7.1, v7.0, v6.2e, v4.3, and v4.2 in 16 x 8 pixel increments.
· Phantom v5.1 in 64 x 4 pixel increments.
· Phantom v6.0, v5.0, v4.1, and v4.0 in 8 x 8 pixel increments.
· Phantom Miro eX4, Miro 4, Miro eX3, Miro 3, Miro Airborne, Miro eX2, Miro 2 in 32 x 8 pixel.

Zoom
Zoom allows up to a 16x enlargement or reduction of a single image. The image can be digitally
zoomed maintaining the original proportions, or stretched to fit the display.

Original Size (Zoom 1)

3x Zoom

When an image has been zoomed, slide bars, located on the right-hand side and bottom of the
image display window, can be used to adjust the image so the point of interest will be displayed
in the window.
When using a Phantom v6 camera, this feature can be used to magnify or reduce the size of a
single imaging head by clicking on the down-arrow next to the Head option and selecting the
appropriate imaging head from the list box.

Head (v6 Series Cameras Only)
A Phantom v6.2e, v6.1, and v6.0 Cameras support up to 4 imaging heads simultaneously, the
preview panel is divided into four equally sized display panels, one for each imaging head. This
option allows the user to select a specific imaging head to view the images from the select
imaging head only in the full panel.
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Preview Panel of v6 w/All Heads selected

Preview Panel of v6 w/Head 4 selected

Current Time (Information)
The Current Time provides an accurate time base for each image in the cine. The time displayed
in the Current Time box is derived directly from the camera's internal clock. If there is an IRIG-B
input to the camera the internal clock will lock on the IRIG signal and reset the clock to
correspond. When an external IRIG time code is connected to the camera the Current Time
displayed will have an "S" appended to the end of the time line designating that the IRIG signal
is locked and synchronized to the camera. All timing information is stamped to the images in the
cine files at the exact time each frame is recorded.
CAUTION
The cameras internal clock, while very accurate, has an approximate temperature
dependent lag of 50 milliseconds per hour and therefore, should not be relied upon as an
IRIG source alone. If the IRIG-B source is connected directly to the camera the internal
clock syncs to the external signal and is as accurate as the input being provided.

Duration (Information)
The Duration field reports the duration of the cine to be recorded in seconds and the total
number of frames that will be recorded, in parenthesis. These values are calculated and updated
dynamically based on the size of the camera memory, the Sample rate selected and the
Resolution settings selected. This field should be referred to when determining the required
number of Post Trigger frames to set.

Signals (Information)
The Signals field reports the number of binary/analog signals, via the SAM-3 (Signal Acquisition
Module – 3), to the Phantom control unit. These signals are used to report measurement
information, acquired via an external measuring device, at the time the image was captured.

Current Session Reference (Button)
The Current Session Reference button is featured with all Phantom Ethernet cameras, except the
Phantom v5.1, on the initial Setup and Recording screen.
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“Current Session Reference” is a calibration procedure similar to Black Reference except the fact
that it computes the pixel offsets only for the current image. This way, the offsets can be computed
for any frame rate, exposure or resolution, giving a more precise compensation of the pixel errors,
dependent on the acquiring parameters and on temperature. Of course, if the acquisition
parameters change, you may get worse results than using the universal Black Reference
procedure. The CSR is applied correctly only for the set of acquisition parameters used when this
reference was calculated.
Usually, you execute a black reference in the Options window. This black reference is available for
any image resolution. When the acquisition parameters, (resolution, frame rate, exposure time),
have certain values, (for example, the frame rate is high or the set of values' forces the camera
performances), it is recommended to do a CSR for that specific set of parameters in order to obtain
a better image.
After executing a CSR, if you change the acquisition parameters, the calibration calculated during
the Current Session Reference will apply partially correct on the new setup. For example, if you use
a bigger resolution than the one used when the CSR was calculated, the CSR adjustments will be
applied only on that part of image and for the rest of the image the black reference calibration
calculated in the Options window will be used.
The CSR calibration can be saved in a .STG file with the name containing the values of the specific
acquisition parameters.
For example: 1009_res256x256_rate80_exp12000_edr0..STG
Thus, you can easily choose a .STG according to the acquisition you are currently using. This .STG
file will be opened automatically at the program restart if you rename it by the serial number of the
camera: 1009.STG in this example.
To switch back to the normal Black Reference calibration you can:
1. perform a black reference or
2. restore the .STG file from the camera CD.
What to expect when performing a Current Session Reference
The CSR (Current Session Reference) processes is similar to Black Reference adjustment in the
Setup and Recording>Options window. While performing a Current Session Reference you will
receive some warning messages mentioning:
· It is advisable to avoid large exposure values (greater than 1ms).
· You have to cover the lenses of the camera before CSR is executed.
· These adjustments are correct only for that set of acquisition parameters.
· The name of the .STG file created on this occasion.
· Option to save the new calibration to the camera nonvolatile memory, too. Saving the CSR
to camera’s nonvolatile memory is necessary when you want to apply the new pixel
corrections to the analog/HDTV Video Output.
If the .STG file presently being used by the camera contains calibration values obtained by a
Current Session Reference operation, the user will get a message when starting Phantom
application, similar to this one:
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You will also see a “ * “ symbol on the Current Session Button in Preview window to remind you
that the calibration is not general, and that it is made for a certain set of parameters.

You should do a new Current Session Reference to get a better quality of the image if you
changed the acquisition parameters. Alternatively, you can load the factory .STG file or do a
black reference operation to have a general calibration.

Flash Mem. (Button)
NOTE
The Flash Mem... button is only accessible if your camera is equipped with a non-volatile
memory flash module.
Non-volatile Flash Memory is an optionally installed solid-state flash storage module located in a
Phantom camera. This feature helps protect data loss caused by a power interruption to the
camera after recording one or more cine files.
Images stored in volatile camera DRAM can be saved to non-volatile Flash memory using
manual control, or by using the Continuous Recording function.
When Continuous Recording is used multiple cine files can be saved automatically after
recording. This is especially useful for cameras being used in remote or inaccessible areas,
situations that may limit your access to the camera between tests.

Cont. rec... (Button)
The Continuous Recording feature can be used to automatically save cine file to the cameras
optional non-volatile flash memory storage, to an external storage device, or on the Phantom
Control Unit. Both options are briefly describe below:
Continuous Recording using the Non Volatile Flash Memory
The non-volatile Flash memory can be used in Continuous Recording mode. When
Continuous recording is enabled in the non-volatile Flash mem... control box the camera
will automatically save cine files to Flash after recording. No operator input is required for
the save, making this procedure ideal for remote camera operation.
Continuous Recording to External Storage
Use Continuous Recording when you need to record cine files automatically without user
intervention. By providing only a "hard" or "soft" trigger, the camera can record a cine, save
it to the hard drive and immediately put the camera back into the capture mode readying it
for the next trigger, where the cycle will begin again until it is stopped by the user.
For example, suppose the user wants to image a high speed packaging machine process
that has intermittent faults. The user can place the camera in continuous recording mode
and provide a trigger to the camera each time the machine stops due to the fault. The
camera will record the cine, save it to a designated drive, and then return to capture mode
waiting for the next machine fault/trigger. This cycle can continue as long as necessary,
even 24 hours a day, seven days a week.
Taking advantage of the Continuous Recording feature to immediately auto save the files
also provides a good degree of protection from an unexpected loss of power to the camera
that would cause a cine stored in volatile camera DRAM to be lost.
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NOTE
This feature is normally used for unmanned camera control. It is strongly suggested that
the Continuous Recording feature only be used with a "hard" trigger to the camera to start
recording. This hard trigger (closure or TTL pulse) is applied through the "Trigger"
connection of the breakout cable at the rear of the camera.

Im. proc... (Button)
The Image Processing controls are very useful when there is not enough light available to get a
proper exposure for the images to be recorded, and to apply various image processing
techniques to the images being displayed. The Im. proc... Button opens the Image Processing
dialogue window containing adjustments for Brightness, Contrast, Gamma, Saturation, White
Balance and Bit Depth 16-bit to 8-bit, depending on whether the camera is monochrome or
color, or it has 8- to 16-bits per color.

Options (Button)
The Options button will open the Options dialogue window with options that will vary based on
the camera model. To view examples of the various Options dialogue windows for the different
camera models, and a description of each of their options, click the following link; Setup and
Recording>Options Dialogue Window Examples.

Update (Button)
Use the Update Settings button to update any information that was typed into any of the setup
parameter fields.

Display (Button)
The Display button opens a single image window with an image capture of the image that was
being displayed in the Setup and Recording screen preview panel at the time the Display button
was selected.

Trigger (Button)
When the camera is in Capture mode selecting the Trigger button provides a “soft” trigger to the
camera that instructs the camera to stop capturing and recording images to the storage buffer. It
is just one of four possible ways to trigger the Phantom cameras, the other three, with the
camera in Capture mode, include:
· Press "Alt T" on the keyboard.
· Provide a dry switch closure.
· Provide a low TTL pulse to the BNC connector marked Trigger on the Capture breakout
cable attached to the rear panel of the camera.
When the camera is in Waiting for Pre-trigger mode, pressing the Capture button provides a
"soft" pre-trigger signal to the camera instructing the camera to start capturing and recording
images to the storage buffer.
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Capture (Button)
This button puts the camera into the recording mode. When the Capture button is clicked,
images are continuously recorded in an endless loop to an image storage area until the camera
has received one of the three different types of triggers.
Check the status bar, located in the lower left-hand corner of the Setup and Recording screen,
for the status message reading “Preview Recording… Waiting for trigger" indicating the camera
is in the Capture mode.
1. If not, click the Capture button.
2. If there is a cine recorded in the RAM memory of the camera, the Record New Cine box will
appear:

You can choose to delete the old cine and start recording a new one, to delete the old cine
and get the pre-trigger status or to give up the capture command. A similar box will also
appear when there are more cine images recorded in the RAM.
3. Click the Yes button to continue, No to cancel the instruction.

Open (Button)
The Open button is used to load previously saved Setup and Recording screen settings. This
feature is extremely useful to setup the camera quickly, especially when regression tests need to
be performed. It could also be used to open camera's .STG file to either reset the camera back
to its factory default calibration settings or change the operational mode of the camera .

Save (Button)
The Save button is used to save the setup screen settings to a setup file for recall at a later date.
All setup files saved to the hard drive can be recalled from the drive by using the Open button.

OK (Button)
The OK button may result in one of two actions as follows:
1. If there is a previously capture and recorded cine in the camera, selecting the OK button
will instruct the system to close the Setup and Recording screen and open the View Cine
screen.
2. If no previously captured and recorded cine is in the camera, selecting the OK button will
instruct the system to close the Setup and Recording screen.
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Cancel (Button)
Selecting the Cancel button will:
1. If there is a previously capture and recorded cine in the camera the system will be
instructed to disregard any changes the user may have made to any of the setup parameter
fields, close the Setup and Recording screen and open the View Cine screen.
2. If there is no previously capture and recorded cine in the camera selecting Cancel the
system will be instructed to disregard any changes the user may have made to any of the
setup parameter fields, and close the Setup and Recording screen.
4.1.2.3.2 Options Dialogue Window

The available Setup and Recording Options vary based on the camera type being used.

Phantom v710, v640, v310, v210, v12.1, v9.1, v7.3 Options Dialogue Window Example

The following is a brief description of the various option possibilities and their related parameters,
including:

Auto exposure
Level
Level defines the average level for the specified area, to be realized by the automatic
exposure system, for example, mid gray: 128 for an image with an 8-bit pixel image depth.
Lock at Trigger
Lock at Trigger when enabled, (checked), the auto exposure parameters will take effect when
the camera detects a trigger signal.
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Area
Area defines the region of interest where the auto-exposure measures the average pixel level.
Full
Full instructs software to apply the auto-exposure mechanism to entire image.

Signals
The Phantom v5.1, v7.3, v9.1, v10.0, v12.1, v210, v310, v640, and v710 cameras provide the
ability to gather analog signal information, binary signal information, or both. This information is
translated and stored to each image and can be displayed with the captured images.
Clicking this button opens the Signal definition dialogue window that allows the user to define the
parameters necessary for the Phantom Camera Control software to process the signal
information.
NOTE
This feature is not supported on the Phantom 65, HD, or Miro Series cameras.

Video Player
Video Player when this button is selected the Video Output Control window will be displayed.
The Video Output Control feature provides the user with the ability to control any Phantom
Ethernet camera attached to a monitor. This feature will be extremely effective with the higher
resolution, high-definition cameras since most computer monitors do not refresh the screen
images quickly enough to produce a smooth visual display.
By default the Video Output Control window will display a live image on the monitor. The user
can also place the camera into the capture mode and trigger it. The user may perform a quickedit of the recorded cine by easily selecting the range of images to be played back.
Once captured the user can play back the recorded cine file from the camera's memory, using
the video playback buttons along with adjusting the speed of the playback.
NOTE
This Video Output Control feature is only accessible with Ethernet model cameras, the
player has not been implemented for the IEEE 1394 camera models, or the Image3.

Black Reference
Black Reference initiates a Black Reference. Performing a Black Reference ensures the best
possible images are captured and recorded by the camera's sensor. A Black Reference
adjustment should be performed prior to capturing and recording the images whenever possible.

External Memory (i3)
Source
Source indicates the Phantom camera connected to the Image3.
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Devices
Devices indicate the Image3 slice(s) used as the cameras external memory.
The following diagram shows how the External Memory is connected.

Show format rectangles
This feature is accessible with the Phantom 65, Phantom HD, and Phantom v10.0 cameras only.
After selecting one of the supported rectangle formats the Setup and Recording Window will
overlay a rectangle in the Preview Panel. This rectangle to represent what will be the visible
areas for the recorded images when viewed on most television monitors.
Even though the Preview Panel displays the entire image frame the area inside the rectangle
marks the area of the image that would be visible on a television monitor. Most television
monitors will not display all the image data. The area outside the rectangle represents the area
that would not be displayed on the television monitor.
After verifying that your action is within the safe areas, you should test your project on the
destination television monitor.

Sound
This drop-down selection window is used to define if an internal PC speaker or sound card will
be used to generate an audible alarm, (beep), when a long operation is completed, a
measurement task has been executed, or an informational message is displayed via the control
software.

Default video mode for full screen
This drop-down selection list is used to specify the size a cine will be set to when viewed in Full
Screen Mode. This field should match the computer's display settings.

Display Options
Cross Hair
Cross-Hair will super-impose a horizontal line in the middle, and a vertical line in the center, of
the Setup and Recording screen preview panel.
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Grid
Grid will super-impose 7 horizontal lines and 7 vertical line, evenly spaced over the Setup and
Recording screen preview panel to form an 8-row; 8-column grid.
Enable Color
When selected, will display the images being previewed in the Setup and Recording screen
preview panel in color, otherwise in monochrome. This option is accessible in color cameras
only.

External Sync
These fields MUST be defined if you are synchronizing multiple cameras using one camera as
the primary clock source:
Master camera serial
Enter the serial number of the camera providing the clock source. If zero there is no external
sync.
Frame Delay
This field can be used in one of two ways:
· If the camera is being clocked via another camera the delay MUST be set to a minimum
of 1us greater than that defined in the clock source camera. or
· If a delay is required between the clock source pulse and the frame capture to provide a
phase shift in the timing.

Frame Rate Profile
This feature allows the user to define up to 4 different frame rates that automatically change, at
specified points, during the capturing process of post trigger frames.
NOTE
This feature is not available in all Phantom cameras, and the Frame Rate Profiles will only
be applied to PostTrigger frames.

MultiCine
MultiCine allows the user specify the number of segments the cameras DRAM memory will be
divided into. By default each segment will be evenly divided. However, you can change the
partitions' percentage in the Memory % list. The program will adjust the values considering the
parameters' values.
Selecting the View button opens a .txt file containing a list of parameters for all cameras
connected and all their recorded cine files.
NOTE
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Each cine from a MultiCine recording can have its own acquisition parameters.

Bit Depth (ADC:n)
RAM
RAM defines the pixel bit depth of the images stored in the camera RAM.
Save
Save specifies the pixel bit depth of images to be transferred from the cameras RAM into the
controller unit computer.
NOTE
This feature is not available in the Phantom Miro1 camera models.

Playback Cache Buffer
The Playback Cache Buffer field is used to define the buffer size for caching the images when
playing back from View window.

Color Bar Image
Color Bar Image when selected displays the color bar test pattern into the live image preview
area on an attached monitor.

Simulated memory size
Simulated memory size allows the user to specify the amount of simulated DRAM a simulated
camera should simulate. This will allow the user to determine the number of images the
simulated camera model will record for a specific resolution and frame rate, and the recording
time duration.
NOTE
This field will only be active in camera simulation mode.

Background
The Background Color field allows the user to customize the background color of the live image
display area by changing the RGB parameter(s) to the desired value(s).

Multi-camera control
This drop-down selection window instructs the Phantom Camera Control application to apply
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changes and updates to:
· Only selected camera.
· All connected cameras.
· Drop-down Menu: Update, Capture and Trigger buttons will be marked with an arrow and
when selected a drop-down menu will offer a list of two options – Selected Camera or All
Cameras.

Exp.
Allows the user to choose what the exposure unit will be displayed as:
µs - Microseconds
Values of Exposure and EDR are in microseconds. Maximum value of exposure depends on
the period of images, that is 1/Frame Rate value. EDR maximum value is equal to the
exposure value you set. Post Trigger Frames value is a number of pictures. The maximum
value of Post Trigger Frames in the drop down list depends on the resolution and bit depth
you set and on the memory capacity. If you set the maximum value in the list, all images in
camera’s memory will be post trigger frames. If you introduce a value greater than the
maximum in the list, the recording will be delayed by as many images as the difference
between your value and the maximum in the list.
o - Angle (common in cinematography)
Value of Exposure is in angels. It represents the degree of the open segment of the shutter.
The maximum value - 360° - corresponds to a full period of the frame. EDR is a percentage
from the exposure value you choose. Post Trigger Frames value is a percentage of its
maximum value described before.
% - Percentage
Value of Exposure, EDR and Post Trigger Frames are in percentage. 100% exposure value
means the frame period (1/Frame Rate). EDR is a percentage from the exposure value you
choose. Post Trigger Frames value is a percentage of its maximum value described before.
µs,% - Microseconds and Percentage
Value of Exposure is in microseconds. EDR is a percentage from the exposure value you
choose. Post Trigger Frames value is a percentage of its maximum value described before.

Update
Use the Update button to activate the parameter changes that the user applied to any of the
Options parameter fields.

Ok
The OK button not only closes the Options dialogue window, but it instructs the control software
to save the present setting as the new default values.

Cancel
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The Cancel button closes the Options dialogue window with applying any changes the user may
have made.

4.1.3

ViewCine Window
The ViewCine playback window can be used to:
· Provides an instant replay of the cine file(s) just recorded.
· Edit the cine file just recorded.
· Playback a previously recorded saved cine file.
· Apply various image processing techniques to the cine file.
· Perform various measurement operations.
· Convert a previously recorded cine file to any of the support file formats.

4.1.3.1

Playback Panel
The ViewCine Window – Playback Panel is used primary to display a recorded cine file for editing
and motion analysis.
In the sample Playback Panels below, notice the Phantom Miro, v4, v5, v7, v9, v10, v12, v310, and
v640 camera series and Image3 will display the recorded cine images in a single panel. However,
since the Phantom v6 series' cameras can support up to 4 imaging heads simultaneously, the panel
can be instructed to divide the playback window into 4 equally sized display segments, one for each
imaging head, or it can be instructed to display individual head recorded images in a single display
panel.

Phantom Miro, v4, v5, v7, v9, v10, v12, v210, v310,
v640, v710, and Image3
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Status Bar
The ViewCine window status bar, located just below the playback panel, displays information about
the image pixels, instructions when performing various Measurement options, and measurement
values as described under Measurement Analysis Processes.

4.1.3.3

Control Panel
Minor differences in the Setup and Recording dialogue windows, for the various camera models, will
be noted in this document for the various Phantom camera models.

Phantom 65, HD,
Phantom v6 Series Image3
v710, 640, v310,
v210, v12.1, v10.0,
v9, v7, v5, v4, Miro Series
4.1.3.3.1 Control Panel Components

Below is a brief description of the ViewCine playback window's components, including:

Cine Editor Bar
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Many recorded cine files contain a lot of unnecessary information both before and after the
actual motion of interest. The cine editor Bar is used to edit unnecessary images from the
beginning and the end of the recorded cine prior to saving the cine to the hard drive. Editing the
cine will create smaller files, reduce file save times and make cine playbacks more interesting.
The red area in the Cine Editor Bar represents the clip. The number displayed at the left end of
the Cine Editor Bar refers to the first image in the entire cine sequence. The number at the right
end of the bar refers to the last image in the entire cine sequence. The numbers in a parenthesis
the first and last image numbers in the cine clip.
NOTE
Frame number zero in the Playback screen Image box and Cine Editor bar always refers to
the moment in time when the trigger was received by the camera regardless of what sample
rate or resolution settings were made in the Setup screen. All negative numbers represent
Pre-trigger frames and all positive numbers represent Post Trigger frames. The total
number of Post Trigger frames is the value entered in the Setup and Recording screen.
For convenience, the cine clip information will be exported to the Save As Cine dialog box
automatically.

Im. (Image Number)
The Image field specifies the number of the image being displayed in the ViewCine playback
window. Zero represents the first image after the moment of trigger. This field can also be used
for a quick forward in the cine. Enter the number of the image you want to go to, and then press
Pause button. The cine will move directly to that image, and you will see it in the playback panel.

R (Rewind Button)
The "R" or rewind button to the right of the Im., (image), field is used to rewind the cine.

Limit to Range
When enabled, (checked), limit to range forces the playback controls to play only the images
between the Mark In and Mark Out entry points.

Endless Loop
Checking this enable box will allow the cine file to be played in an endless loop. If the Limit to
Range box is enabled, (checked), the loop will be limited to the range selected via the Edit a
Recorded Cine process.

Playback Buttons

Play Fast Reverse decrements images: the total number of cine frames/1000, no less
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than 10 frames, auto adjusting to cine size.
Play Fast Forward increments images: the total number of cine frames/1000, no less
than 10 frames, auto adjusting to cine size.
Standard Play Reverse decrements 1 image at a time.
Standard Play Forward increments 1 image at a time.
Pause Playback stops or pauses the playback process.
Play Single Frame Reverse rewinds 1 image only.
Play Single Frame Forward advances forward 1 image only.

Playback Slow --- Fast Slider
The Slow - - - Fast slider is used to adjust the speed of the cine playback. This adjustment only
applies when the Standard Play Forward and Standard Play Reverse buttons have been
selected. It also display the playback frame rate.
NOTE
If you want to set the playback speed to 1.0 frames per second, put the slider on the
maximum position and then press Page Up key on the keyboard five times to get to the
middle position of the slider where the speed is 1.0 fps.

Time (Information)
This informational field displays the date and time for the recorded cine. The time is shown with
nanosecond precision. If the camera had an IRIG input at the time of recording the IRIG time
base will be displayed here.
There are two tags that may be appended to the end of the time displayed as follows:
E - Provided as an event marker.
S - Designates that the time displayed was synchronized to an IRIG-B time source.
NOTE
If the IRIG source was not connected at the time of recording the "S" tag will not be
displayed.

Image (Information)
The Image information fields include:
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Interval
Displays the time between frames (in microseconds) for the recorded cine.
Exposure
Displays the image exposure (in microseconds) for the image presently being displayed in
the View Cine playback panel.

Elapse time from (Information)
The Elapsed time from information fields includes:
Trigger
Displays the elapsed time (in microseconds) from the trigger point to the image currently
being displayed in the playback window.
Image #
Displays the elapsed times (in microseconds) between the specified image number in this
box and the image currently being displayed.

Display (Button)
When selected the Display button opens a .bmp image window, in the background of the
ViewCine dialogue window. This .bmp image window captured the image that was in the
ViewCine playback panel at the time the Display button was selected. This process can be
repeated, to create multiple .bmp image files from the opened cine file, by clicking the forward
button in the ViewCine window and repeating the process.
To view the image you created, close the ViewCine display window and click the maximize
window icon in the created Image icon. If multiple images were created use the Cascade
command located under the Window Menu and select the desired image you wish to view.

Signals (Button)
The Phantom Miro3, Miro 3.1, Miro eX4, Miro 4, v5.1, v7 series, v9 series, v10, v12, v210, v310,
v640, v710 cameras provide the ability to gather analog signal information, binary signal
information, or both. This information is translated and stored for each image and can be
displayed with the captured images.
NOTE
When recording more than one cine using the MultiCine feature, only the last cine will
contain signal information.

New View (Button)
When the New View button is selected, a new instance of the Phantom application will be
created, with the View Cine window opened. This button can only be used if there is a cine file
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opened.

Flash Mem... (Button)
Non-volatile FLASH Memory is an optionally installed solid-state flash storage module located in
a Phantom camera. This feature helps protect data loss caused by a power interruption to the
camera after recording one or more cine files.
Images stored in volatile camera RAM can be saved to Flash memory using manual control, or
by using the automatic AutoSave, (Record once), or Continuous Recording functions.
When Continuous Recording to Flash Memory is used multiple cine files can be saved
automatically after recording. This is especially useful for cameras being used in remote or
inaccessible areas, situations that may limit your access to the camera between tests.
NOTE
The Flash Mem... button is only accessible if your camera is equipped with a non-volatile
memory flash module.

Measure (Button)
The Measure button opens a menu of motion analysis functions, which can also be found under
the Measurement pull-down menu. The user can use these motion analysis tools to quantify a
few key measurements quickly, or to conduct a thorough analysis of the motion. Report files can
be constructed simultaneously, so when the user is finished measuring, the report will also be
finished.
By clicking this button, the user can find dimensions, population, speed, distance, acceleration,
position, and displacement. The user can also measure angles and angular rotation.
Measurement functions may be applied to both single images and/or cine files. Certain
measurements such as those for speed and acceleration can only be applied to cine files.
NOTE
Single images extracted from cine files do not contain the timing information needed to
compute speed.
Acceleration, speed, and point position files can be created with the Collect Point function that
can be imported into LOTUS 1-2-3 , Microsoft Excel, or other spreadsheet applications for final
presentation and graphics.
While working with the various measurement features in the Phantom Control Software, refer to
the lower left corner of the playback view window. The status bar will provide prompts for the
actions required.

Cine Info (Button)
Clicking the Cine Info button displays the View Cine Information window which presents all of the
setup parameters for the cine being viewed.
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For a brief description of each of the informational fields click the following link: Cine Information
Display Window.

Image Processing... (Button)
The Image Processing options may be used alone or in combinations to bring out hidden
features and details. After selecting one of the image processing effects, the effect will be
displayed on the images. Not all image-processing techniques are appropriate for every image.
We recommend you experiment to find the best enhancements for your image. For a brief
description of the various image processing effect click the following link: Functional
Descriptions>Image Processing Effects and Filters.

Cine #
The Cine # drop-down selection window is used to select a specific cine to playback that is
stored in either a segmented area of the cameras' dynamic random access memory buffer
(when the MultiCine feature is used), or its' Flash non-volatile memory. A cine stored in Flash
memory is identified by the nomenclature Fn, where n is the cine number.

Point #
The Point # field displays the point currently being selected when performing Collect Points
Analysis, starting with point 00.

Zoom
Allows up to a 16x enlargement or reduction of a single image. The image can be digitally
zoomed maintaining the original proportions, or stretched to fit the display. When an image has
been zoomed, slide bars, located on the left-hand side and bottom of the image display window,
can be used to adjust the image so the point of interest will be displayed in the window.
By pressing the down-arrow you may conveniently select one of the preset magnification values
in the pull down list box allowing up to a 16x enlargement or reduction of a single image. The
image can be zoomed maintaining the original proportions, or stretched to fit the display.
When an image has been zoomed, slide bars, located on the right-hand side and bottom of the
image display window, can be used to adjust the image so the point of interest will be displayed
in the window.
When using a Phantom v6 series' camera, this feature can be used to magnify or reduce the
size of a single imaging head by clicking on the down-arrow next to the Head option and
selecting the appropriate imaging head from the list box.

Head
The Phantom v6.2e, v6.1, and v6.0 Cameras support up to 4 imaging heads simultaneously.
The preview panel is divided into four equally sized display panels, one for each imaging head.
This Head parameter allows the user to select a specific imaging head or heads to view the
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images the head recorded.
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Cine Source
The Cine Source fields allow the user to:
· View and/or save the cine file residing in a camera's memory buffer.
· Select which cameras memory buffer cine file to view/edit, in multiple camera
environments.
· Open and view, or convert, a previously saved cine file.
· Switch between cine files residing in the selected camera's memory and an opened
previously saved cine file.
The Cine Source fields include:
Camera Radio Button
Instructs the Phantom Camera Control Software to toggle to, and displays the recorded
cine stored in the selected cameras RAM in the View Cine playback window.
Save Button
Allows the user to save the recorded cine stored in the selected cameras RAM.
File Radio Button
This radio button becomes active after a saved cine file has been opened. It instructs the
Phantom Camera Control Software to toggle to, and displays the opened cine file,
mentioned below the radio button, in the View Cine playback window.
Open Button
Allows the user to select a previously saved cine file to open and view.
Convert Button
Allows you to convert or edit a previously saved file to any of the support file formats. For a
brief description of the numerous formats supported: Functional Descriptions>Supported
File Formats.

Close
Selecting this button closes the ViewCine dialogue window; however, it does not close the
opened cine file. To close the open cine file select the Close Cine option in the File Menu.
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4.1.3.3.1.1 Cine Information Display Window

CINE INFORMATION DESCRIPTIONS
General
Source: Camera/Source: File:
Source: Camera/Source: File: indicates the camera name or file path of the cine being viewed in
the View Cine window.
Description
Displays the information entered into the Description field in the Setup and Recording window.
Format:
Description displays the file format of the recorded file.
Saved Range:
Indicates the first and last image number of the images contained within the edited cine file.
Recorded Range:
Saved Range: indicates the first and last image number of all the images recorded.
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Color:
Color: indicates if the cine was captured using a color sensor (Yes) or a monochrome sensor
(No).
Signals:
Signals: indicates if any external analog or binary signal measurements have been tagged to the
recorded images via the SAM-3 (Signal Acquisition Module-3) unit.
Image Time:
Image Time: indicates that the timing information for the cine is available.
Image Exposure:
Image Exposure: indicates that the exposure information for the cine is available.
Camera:
Camera: specifies the camera model used to capture the cine file.
Serial:
Serial: specifies the serial number of the camera used to capture the cine file.

Acquisition Parameters
Resolution:
Resolution: displays the resolution, (width x height), of the images recorded.
Acquired Resolution:
Acquired Resolution: display the resolution the image cine file was acquired at.
PostTrigger:
PostTrigger: indicates the number of Post Trigger frames captured during the capture and
record process.
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Bits per color component:
Bits per color component: displays the active pixel's bit depth of the recorded images.
Frame Rate (fps):
Frame Rate (fps): displays the Frame Rate setting at the time the images were recorded. In
parentheses, net to the Frame Rate information is the Real and Period information fields; (Real:
indicates the actual frame rate the images were recorded, and Period: indicates the time
necessary to record each of the images).
Exposure (µs):
Exposure (µs): displays the Exposure setting, at the time, the images were recorded.
Frame Rate Profile
Frame Rate Profile displays the Frame Rate Profile setting defined by the user during the cine's
capture process. If the Frame Rate Profile feature was not used this field will be left blank.
EDR (µs)
EDR (µs) indicates the Extreme Dynamic Range Exposure time setting at the time the images
were recorded. Zero indicates the feature was disabled.
Frame Delay (µs)
Frame Delay (µs) fndicates the delay time each image was recorded as set under the Setup and
Recording>Options button.
Sync:
Sync:indicates the frame rate clock source.
Auto Exposure:
Auto Exposure: indicates whether or not the Auto Exposure feature was used during the
recording process.
Autoexp. Level:
Autoexp. Level: displays the Auto Exposure grayscale level defined by the user.
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Autoexp. Rect.:
Autoexp. Rect.: displays the area, in pixels, the user specified to automatically adjust exposure
for, by defining the Auto Exposure parameters.
Trigger Time:
Trigger Time: indicates the moment in time after the last pre-trigger image (-1) and before image
0.

Graphical representation of Trigger Time

Time Zone:
Time Zone: displays the time difference, in hours, from UTC (Universal Time Code, formally
referred to as GMT (Greenwich Means Time).
Time Translation:
Time Translation: this pull-down selection window specifies how the time information is to be
displayed. The user can specify if the time information is to be displayed using the local time or
UTC (Universal Time Code, formally referred to as GMT (Greenwich Means Time).

4.2

Step-by-Step Procedures
This section describes the most common tasks you will use when working with your Phantom
imaging system. It is designed as a "How-To" guide. You can use the table of contents as an index.
Although it is organized roughly in the order that you would perform the tasks, you don't need to
begin at the beginning and work your way through. Most of the topics contain comprehensive links to
background information and other relevant subjects so you can just pick out the task you need to
perform and begin.
The topics in this section are intentionally kept as brief as possible. The focus is on how to do
capture, view, and perform measurement analysis with your Phantom imaging system.

4.2.1

Start the Phantom Camera Control Software Application
From the Windows desktop click the Phantom (Legacy) Camera Control Software, Phnnn, (where
nnn is the version number), icon that was created during the Phantom Camera Control Software
(Legacy) Installation process.
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Acquisition Processes
Below are generic steps to define a camera's acquisition parameters. Only the camera selected via
the Camera Pool will be defined with any setting made during these processes. The parameters will
not be applied to any other camera, and therefore, must be configured independently for each
camera being used. The steps are as follows:
1. Access a Phantom camera for use.
2. Change the camera's name.
3. Add a secondary IP Address to the camera.
4. Perform a Firmware Upgrade to the camera.
5. Set/Synchronize the camera's Internal Clock.
6. Define the Acquisition Camera Options.
7. Add a simulated camera(s).

4.2.2.1

Access a Phantom Camera for Use

Overview
The Phantom Camera Control software uses a broadcast message mechanism to automatically
detect connected cameras and their IP addresses. In older version of the software only the
networked cameras that responded to the broadcast mechanism will be available for use by the
Phantom Control Unit. The broadcast mechanism utilizes is via UDP, (User Datagram Protocol),
packets, which are not supported by some encrypting systems.
This version of the software has been designed primarily to:
· Allow access to the cameras without using the UDP broadcast mechanism, by introducing a
“Connect only to” list, and
· Control the list of visible cameras for each control unit computer, especially when there are
more computers and more cameras in the network, and you want to dedicate them. We will
use the term “connect” referring to the logically connected cameras (visible) and not to the
physically connected cameras.
Additionally, you can now prepare configurations you will use in the future, by using the IP
addresses of the cameras, without having the cameras in the network at that moment. You can find
the IP addresses of cameras on the camera chassis, in Phantom Help About – Details menu, or in
the Camera Pool list.
When multiple Phantom Camera Control Units are networked together to control multiple Phantom
cameras each controller unit will display, in the Camera Pool List window all network Phantom
cameras which replied to the broadcast poll process, even if a camera has been added to the
Camera Pool's "Connect only to" list by another controller unit. The software will not give any
indication that another controller unit has already added the camera to its "Connect only to" list.
Therefore, multiple Phantom Control Units could essentially add the same camera to its own
"Connect only to" list.
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STEP-BY-STEP PROCEDURES
Building the Camera Pool List in a UDP Broadcast Supporting Network
In networking environments that allow UDP, (User Datagram Protocol), packets to be broadcast
across the network the Camera Pool Main List should automatically populate with the serial
number, IP address, and camera name of each of the cameras on the network.

NOTE
The Camera Pool Main List will only populate the list of detected cameras if the:
· “Connect only to” list is empty, or
· The camera(s) has been added to the “Do not connect to” list.
In either of these cases, the UDP broadcast mechanism will be used to detect the cameras
on the network.
If all networked cameras are not displayed in the Camera Pool Main List you can instruct the
Phantom Control Unit to poll for them by:
1. Clicking on the Search All button.
Use Search All button when you want to see all the cameras in the network of your
computer. The main list will be a complete list, and it will contain all these cameras.
2. Search Cameras button.

© 2015 Vision Research - AMETEK Material Analysis Division

130

Phantom Camera Control Help File

Use Search cameras to refresh the list of connected (visible) cameras when one or more
cameras have been powered off or on.
3. Enable, or check, the Continuous enable box just below the Search Cameras button.
Use this option to continuously search the network to find new cameras. Disable, uncheck,
the Continuous box to stop the search process or press Esc, on the keyboard, to stop
searching and exit out of the Camera Pool dialogue window.
NOTE
If there are cameras in the “Connect only to” list that are not powered on or not connected
to your network, the application will make a longer search and display an error message.
Try to avoid this situation and power on all the cameras in the “Connect only to” list or, if
you don’t want to work with the powered off camera, add it to the “Do not connect to list”.

Building the Camera Pool List in a Non-UDP Broadcast Supporting Network
Some networking environments prohibit UDP, (User Datagram Protocol), packets from being
broadcast across the network. When cameras are placed in this type of networking environment
the Camera Pool Main List will not be able to populate the Camera Poll Main List with the serial
number, IP address, and camera name of each of the cameras on the network. Therefore, you will
need to essentially build a static IP address list of the cameras within your network and add them
to the "Connect only to" or "Do not connect to" lists.
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Selecting a Phantom Camera (UDP Broadcast Supporting Networks Only)
NOTE
When you close the Camera Pool dialogue window, the visible cameras will be those in the
“Connect only to” list. If you include a camera IP in both lists (“Connect only to” and “Do
not connect to”) the “Connect only to” list will have the priority, so the camera(s) will be
connected to your computer. If “Connect only to” list is empty, all the cameras in your
network will be visible, except those in “Do not connect to” list. When you exit the Camera
Pool window, the application does a Search operation to update the list of visible cameras.
The lists will remain persistent on the computer, from one session to another.
1. Start the Phantom (Legacy) Camera Control Software.
2. Click on the Acquisition pull-down menu in the Phantom Camera Control main window.
3. Select the Camera Pool... command from the Acquisition menu.
4. Select the Phantom camera for use.
NOTE
The Camera Pool list, the main list, usually contains the camera's (serial number, IP
address, and assigned camera name) you are connected to, (visible to the control unit).
The cameras in the “Connect only to” list, or when you press Search All button, temporarily
contains all the cameras on the network visible to your control unit computer, no matter if
they are or not in any other list.
When the "Camera pool" dialogue window appears:
a. Highlight the desired camera you wish to connect to from the main list.
b. Click the Close button.

Selecting a Phantom Camera (UDP or Non-UDP Broadcast Networks)
NOTE
The “Connect only to IP Address” list contains the cameras you wish to be connected to,
no matter if they are or not on the network of your compute at that moment. When you close
the Camera Pool dialogue window, the visible cameras will be those in the “Connect only
to” list. If you include a camera IP in both lists (“Connect only to” and “Do not connect to”)
the “Connect only to” list will have the priority, so the camera(s) will be connected to your
computer. If “Connect only to” list is empty, all the cameras in your network will be visible,
except those in “Do not connect to” list. When you exit the Camera Pool window, the
application does a Search operation to update the list of visible cameras. The lists will
remain persistent on the computer, from one session to another.
1. Start the Phantom (Legacy) Camera Control Software.
2. Click on the Acquisition pull-down menu in the Phantom Camera Control main window.
3. Select the Camera Pool... command from the Acquisition menu.
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4. Select the Phantom camera(s) to be used.
NOTE
The Camera Pool list, the main list, usually contains the camera's (serial number, IP
address, and assigned camera name) you are connected to, (visible to the control unit).
The cameras in the “Connect only to” list, or when you press Search All button, temporarily
contains all the cameras on the network visible to your control unit computer, no matter if
they are or not in any other list.
a. Add a specific camera to the "Connect only to IP Address" list.
1) Highlight the desired camera displayed in the main list to specify a single camera, then
2) Click the Add button under the "Connect only to" area to place only the specified camera
into the "Connect only to IP Address" list.
NOTE
The “Connect only to IP Address” list is used only when you want to avoid the broadcast
mechanism from detecting cameras. The list is used if it contains at least one camera and
the broadcast is not proceeded. The computer connects only to the cameras in the
“Connect only to” list and will not connect to the cameras in the “Do not connect to” list.
3) Click the Search All button to refresh the Camera Pool Main List.
4) Repeat until all desired cameras have been assigned.
b. Add all cameras to the "Connect only to IP Address" list.
1) Click the Add All button under the "Connect only to" area to place all the cameras in the
main camera pool list into the "Connect only to IP Address" list.
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2) Click the Search All button to refresh the Camera Pool Main List.
c. Add a camera that is not visible, or not detected, during the UDP broadcast mechanism by
the Phantom Control Unit.
1) Click the Add this IP... button under the "Connect only to" area.
2) Enter the IP Address of the camera.
3) Click the OK button.

Restrict Connection to Phantom Camera(s)
NOTE
The “Do not connect to IP Address” list contains the cameras you do not wish to be
connected to, no matter if they are or not on the network of your compute at that moment.
When you close the Camera Pool dialogue window, the visible cameras will be those in the
“Connect only to” list. If you include a camera IP in both lists (“Connect only to” and “Do
not connect to”) the “Connect only to” list will have the priority, so the camera(s) will be
connected to your computer.
If “Connect only to” list is empty, all the cameras in your network will be visible, except
those in “Do not connect to” list.
When you exit the Camera Pool window, the application does a Search operation to update
the list of visible cameras. The lists will remain persistent on the computer, from one
session to another.
1. Start the Phantom (Legacy) Camera Control Software.
2. Click on the Acquisition pull-down menu in the Phantom Camera Control main window.
3. Select the Camera Pool... command from the Acquisition menu.
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4. Select the Phantom camera(s) to be restricted:
NOTE
The Camera Pool list, the main list, usually contains the camera's (serial number, IP
address, and assigned camera name) you are connected to, (visible to the control unit).
The cameras in the “Connect only to” list, or when you press Search All button, temporarily
contains all the cameras on the network visible to your control unit computer, no matter if
they are or not in any other list.
a. Add a specific camera to the "Do not connect to IP Address" list.
1) Highlight the desired camera displayed in the main list to specify a single camera, then
2) Click the Add button under the "Do not connect to" area to place only the specified
camera into the "Do Not Connect to IP Address" list.
3) Click the Search All button to refresh the Camera Pool Main List.
4) Repeat until all desired cameras have been assigned.
b. Add all cameras to the "Do not connect to IP Address" list.
1) Click the Add All button under the "Do not connect to" area to place all the cameras in
the main camera pool list into the "Do not connect to IP Address" list.
2) Click the Search All button to refresh the Camera Pool Main List.
c. Add a camera that is not visible, or not detected, during the UDP broadcast mechanism by
the Phantom Control Unit.
1) Click the Add this IP... button under the "Do not connect to" area.
2) Enter the IP Address of the camera.
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3) Click the OK button.

Removing a Camera from the Connect Only To/Do Not Connect To Lists
1. Start the Phantom (Legacy) Camera Control Software.
2. Click on the Acquisition pull-down menu in the Phantom Camera Control main window.
3. Select the Camera Pool... command from the Acquisition menu.

4. Select the Phantom camera(s) to removed from list.
a. Highlight the desired camera to be removed from either the "Connect only to IP Address" or
Do not connect to IP Address" lists.
b. Click the Remove button under the:
1) "Connect only to" area to remove the camera from the "Connect only to IP Address" list.
2) "Do no connect to" area to remove the camera from the "Do not connect to IP Address"
list.
NOTE
The IP you selected will be removed from this list and from the main list too.
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Change a Phantom Camera's Name

STEP-BY-STEP PROCESS
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Camera Pool... command from the Acquisition menu.
4. Select the Phantom camera for use.
5. Change the Phantom Camera Name.
The Camera Serial Number is stored in each camera and cannot be edited by the user. To
change the camera name of any camera in the Camera Pool main list:
a. Highlight the camera from the main list.
b. Click the Change Name button.
c. Type a new name when the "Change camera name" dialog box opens and click OK.
NOTE
The newly assigned name will be written and stored in the cameras internal non-volatile flash
memory.
4.2.2.3

Adding a Secondary IP Address to a Phantom Camera
Phantom Camera Control software allows the user to assign a user defined, static IP Address to an
Ethernet Phantom camera by performing the following steps:

STEP-BY-STEP PROCESS
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Camera Pool... command from the Acquisition menu.
4. Select the Phantom camera for use.
5. Add the Phantom Camera Secondary IP Address
a. Ensure that the Camera Control Unit has a dedicated IP Address of 100.100.100.1 with a
subnet mask of 255.255.0.0.
NOTE
If multiple Phantom Control Units will be used to access the same Phantom cameras, each
controller unit requires a unique IP Address. For example: Controller 1: 100.100.100.1
(255.255.0.0); Controller Unit 2: 100.100.100.2 (255.255.0.0), etc.
b. Ensure the camera is cabled properly and apply power to the camera.
c. Click Restore NV Memory.
d. With the Restore Non-Volatile Memory Setting dialogue window open:
1) Click the IP Address button to invoke the Set the Camera IP Addresses dialogue window,
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alternately
2) Simultaneously depressed the ALT-I keys on the computer keyboard.
e. In the Set the Camera IP Addresses dialogue window, enter the appropriate IP information for
your network.
NOTE
If you're not sure what to enter, check with your local network administrator.
f. Power down the camera.
g. Change the IP Address and subnet Mask information on the Camera Control Unit to ensure
that both the camera and the control unit have been assigned to the same network but have
different IP addresses.
h. Restart the control unit.
i. Re-apply power to the camera.
j. Restart the Phantom Camera Control application.
NOTE
If the control unit does not detect the camera, recheck the settings of the control unit.
Setting the IP Address of a camera does not remove its default IP address. In the event, you
need to verify the camera’s user defined IP Address, or made a mistake entering the
information, simply reset the control unit’s IP Address to 100.100.100.1, and reconnect to the
camera making any necessary changes using the steps above.
4.2.2.4

Performing a Firmware Upgrade
The Firmware upload button allows the end user to, in one simple operation, load firmware and
FPGA, (Field Programmable Gate Array), firmware. It allows the end user to load firmware files into
the selected visible camera, or in a camera which responds to ping command, by introducing its IP
address and a value for camera version.
Using this Firmware button provides for the upload firmware files to your camera. After loading the
firmware files, the program tries to reconnect the camera. It may be necessary to power the camera
off then on again for Phantom to reconnect to the camera.
NOTE
The necessary files can be obtained by contacting the Vision Research Technical Support
Staff.
If the application cannot identify automatically the camera, you have to introduce the IP address and
camera version.
Use the following table to find the camera version value of your camera:
CAMERA MODEL

SYNTAX

CAMERA MODEL

SYNTAX

Phantom Miro 1

81

Phantom v10
(standard mode)

10

Phantom Miro 2

82

Phantom v10
(enhanced mode)

101
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CAMERA MODEL

SYNTAX

CAMERA MODEL

SYNTAX

Phantom Miro 3
(max resolution 640 x
480)

83

Phantom v9.1

91

Phantom Miro 3
(max resolution 800 x
600)

831

Phantom v7.3

73

Phantom Miro 4

84

Phantom v6.2e

62

Phantom Flex

135

Phantom v5.1

51

Phantom 65

650

Phantom v4.3

43

Phantom HD

660

Phantom v4.2

42

Phantom v710

122

Image3 w/v10

31

Phantom v640

130

Image3 w/v9.1

n/a

Phantom v310

125

Image3 w/v7.3 or v9

n/a

Phantom v210

126

Phantom CineStation

39

Phantom v12

120

IMPORTANT NOTICES
1. You should never do a firmware upgrade when running on battery power. Ensure the
camera is connected to AC power.
2. If for some reason, the firmware upgrade fails, the camera will likely need to be returned
to Vision Research for service.
3. Vision Research highly recommends that you contact our Technical Support staff prior to
performing a firmware upgrade to a Phantom v9.0, v7.2, v7.1, v7.0, v5.1, v4.3, v4.2 camera
model.
4. This Firmware Upgrade Process should never be used to load an earlier version of
firmware that is already loaded into the camera, and must not ever be used with an IEEE
1394 camera model.

STEP-BY-STEP PROCEDURE
1. Contact Vision Research Technical Support for the latest version of the firmware.
2. Create and copy the files to a directory, (folder).
3. Apply AC power to the Phantom camera.
NOTE
You should never do a firmware upgrade when running on battery power.
4. Select the Restore NV Memory... command from the Acquisition pull-down menu.
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5. Click on the Firmware... button in the Restore the nonvolatile memory setting window.
6. In the Phantom Nucleus dialogue window:

a. Click the down-arrow next to the Camera field and select the camera the firmware upgrade is
to be performed on.
b. Select the File to Upload.
1) All In One.. (used to open and load the required Firmware, FPGA, and Kernel files within a
zip file)
a) Navigate to the directory, (folder), containing the zip file, then
b) Click the Open button.
2) Firmware.. (ph7.bin file)
a) Navigate to the directory, (folder), containing the ph7.bin file, then
b) Click the Open button.
RESULT: Path of file is displayed to the Firmware button.
3) FPGA.. (ph.bin file)
a) Navigate to the directory, (folder), containing the ph.bin file, then
b) Click the Open button.
RESULT: Path of file is displayed next to the FPGA button.
4) Flash FPGA..
a) Navigate to the directory, (folder), containing the file, then
b) Click the Open button.
5) Cinemag..
c) Navigate to the directory, (folder), containing the file, then
d) Click the Open button.
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6) Kernel..
e) Navigate to the directory, (folder), containing the file, then
f) Click the Open button.
RESULT: Path of file is displayed next to the Kernel button
c. Click the Upload button.
d. Click the OK button in the "Camera RAM cines will be deleted" warning message window.
e. Click the OK button in the "Proceed with uploading..." message window.
The system will now display a series of information windows indicating:
· Files are being uploaded.
· Wait for camera to re-boot and press OK.
· If camera has not yet rebooted message.
· Camera pool changed message.
f. In the Phantom Nucleus window, click the:
1) Refresh button to verify changes.
2) Close button.
g. In the Restore the nonvolatile memory setting window, click the Close button.
h. Close and restart the Phantom Camera Control software.
4.2.2.5

Set the Internal Clock of a Phantom Camera

STEP-BY-STEP PROCESS
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Camera Pool... command from the Acquisition menu.
4. Select the Phantom camera for use.
5. Re-open the Acquisition pull-down menu.
6. Set the Camera Internal Clock
a. From the Main System Window select the Acquisition Menu>Camera clock... command.
When the "Set the camera time" dialog box opens the default time displayed is computer time
derived from the local time set in the Windows operating system.
b. To change these settings select one of the following options:
Set Time
This option allows the user to edit the date and time fields manually. After the edits are
complete, click the Set Time button to write these values to update the camera's internal
clock.
Update and Set Time
Click this button to automatically set the camera's internal clock to the local date and time
reported by the Windows operating system on the local computer.
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Define the Camera's Acquisition Options

STEP-BY-STEP PROCESS
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Camera Pool... option from the Acquisition menu.
4. Select the Phantom camera for use.
5. Re-open the Acquisition pull-down menu.
6. Define the Camera Options.
NOTE
Camera options will vary based on the camera model.
a. From the Main System Window select the Acquisition Menu>Camera options... command and
specify the desired camera options, including:

Trigger (Options)
Rising/Falling Edge
When selected defines whether the leading edge or trailing edge of a TTL supplied input
trigger signal is to be used to trigger the camera. To select the leading or falling edge click the
Rising Edge or Falling Edge radio button respectively.
Filter Time (µs)
Instructs the Phantom camera to ignore a trigger signal if it is detected before the specified
Filter parameter. It also specifies the length of time the trigger signal must be held for to be a
valid trigger signal.
NOTE
The Acquisition>Camera Options>Trigger options are not available with Phantom v4.1, v5.0,
or v6.0 cameras.

IRIG (Option)
Allows the user to specify that a supplied IRIG-B input signal is a modulated signal, rather than
an unmodulated signal, which is the default setting, by placing a check mark in the Modulated
enable box.
NOTE
This field is only applicable with a Phantom v5.0 camera model. Special hardware is
required to accept a modulated IRIG-B signal.
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pre-trigger pin is: (Option)
Specifies whether a TTL supplied input signal is to be used to toggle the Memory Gate or be
used as a Pre-trigger input signal.
NOTE
The MemGate options are not available with Phantom v4.1, v5.0, or v6.0 cameras.

Ready sig, ends at (Option)
Instructs the connected-to camera to toggle off its READY signal either the moment a Trigger
signal has been detected by the camera, or when the allocated memory in the selected camera
has completed capturing all the images to be recorded.

Real time output (Option)
Provides an image data stream to an Image3.

Miro / Strobe pin is: (Option)
The option allows the user to specify the signal type to be activated on the Auxiliary pin of the
capture connector.
NOTE
This option will only be available when connected to a Miro 3, 3.1, eX4, or 4 cameras.

External memory (i3) (Options)
The parameters listed below are enabled depending on the camera or ExtMem (daisy-chained I
mage3 slices) selected via the Acquisition>Search Phantom Cameras... option. These
parameters include:
Show memory slices in camera list
When enabled (checked) all Image3 slices that are either connected to the selected camera
or make-up the ExtMem unit.
NOTE
The following three parameters will only be enabled when the "Show memory slices in
camera list" field is enabled, and an Image3 slice has been selected via the
Acquisition>Search Phantom Cameras... option.
Connected camera serial number
Specifies the camera's serial number the ExtMem (Image3) is connected to.
Slice number
Defines the unit number for the Image3 slice.
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Slice count
Specifies the number of Image3 slices daisy-chained together.

Start in: (Option)
Allows the user to specify the default operational state a camera should be placed into when the
user opens the Setup and Recording window. The possible states include:
Wait pre-trigger
When selected this radio button instructs the camera to start in the Preview + Recording…
waiting for trigger mode.
Record
When selected this radio button instructs the camera to start in the Preview mode only. The
user will have to click the Trigger button, in the Setup and Recording Window Control Panel
to place the camera into the Preview + Recording… waiting for trigger mode.
NOTE
The Start in options is not available with the Phantom v4.1, v5.0, or v6.0 cameras.

Range Data (Option)
Instructs the connected camera to accept either Az24EI24 or MLAIR range data protocol
information via the Range Data Connector.
NOTE
This feature does not apply to all Phantom camera models and must be special ordered.

End of Recoding Actions (Options)
The following options allow the user to save/playback a specified range of recorded cine images
in a NTSC or PAL video format:
Save cine to internal flash / Cinemag
When enabled (checked) the:
· Images captured in the cameras DRAM will automatically be stored into the camera’s
non-volatile memory, or
· Instructs the camera to write the images directly into its attached CineMag bypassing
the cameras internal DRAM.
Save to file HDD/CF (HardDrive Device/Compact Flash)
This feature has been designed to save the captured images:
· In the camera's DRAM, to the specified location defined in the entry box, or
· In a Miro cameras' DRAM to the Compact Flash card.
Playback to video
When enabled (checked) the video will automatically be displayed on an attached video
monitor for review.
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Repeat
Allows the user to specify the number of time the recorded cine will play back on an
attached monitor. Entering a zero (0) instructs the cine file to loop indefinitely when the
Playback to video feature is enabled.
Restart recording
When enabled the camera will automatically reset to the “Preview + Recording … Waiting
for Trigger” state.
Image range
The following options define the range of cine images used to create the video to be saved
or played backed to video:
Full Cine - When enabled, checked, the First and Count Image Range fields will be
disabled.
First - Used to define the first cine image to be used to create the cine file to be saved or
viewed.
Count - Used to define the total number of cine images used to create the cine file to be
saved or viewed, starting from the First image defined above.

Video Out (Options)
Allows the user to define the Video Output information. Click the following link for a description of
each of the Video Out options; Define the Camera's Acquisition Options>Video Out Options.

Time to display in this software and in the camera OSD (Option)
Allows the user to select how the current time reference should be displayed.
Local Time
Uses the attached Phantom Control Units; date and time settings as the timing reference.
Universal Time (utc, GMT)
Adjusts the date and time settings, used as the timing reference to Universal Time Clock
(utc), formally referred to as Greenwich Mean Time (GMT). The adjustment will be the time
difference from the date and time settings of the attached Phantom Control Unit to the
universal time clock. The Universal Time option will append "utc" text to the time line.
Allows the user to select how the current time reference should be displayed.
b. Click the Update button to accept Camera Option changes, or click the Cancel button to ignore
the changes.
c. Click OK when finished.
4.2.2.6.1 Video Out Options

The Video Out parameters only need to be configured when a Phantom camera is connected to an
external monitor. Setting these parameters will only affect what is displayed on the attached monitor.
Below is a brief description of each of the Video Out option, including:

Video Systems
Clicking the down-arrow allows the user to specify the type of video signal format the camera will
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transmit to a monitor. For a detailed description of the Video Systems supported see: Functional
Descriptions>Supported Video System Formats.

OSD
By clicking the down-arrow next to the OSD (On-Screen Display) field the user can select which
of the following is to be displayed:
Disable OSD
No information is displayed.
Name,status
Displays the name and current status of the camera.
+acqui params
Displays the setting specified via the Acquisition menu, along with the name and current
status of the camera.
+time,playback
Displays the absolute time and the playback rate, along with the name and current status of
the camera, and specified via the Acquisition menu.
+range data
Displays the camera name, current status of the camera, the acquisition parameters, and
all range data information.

No Digital OSD
When enabled, (checked), the OSD field will not be displayed on an attached monitor or
viewfinder.

Colors
Allows the user to change the OSD background color by selecting one of the options from the
pull-down selection list.

OSD Opaque
Removes the background color (black) from the OSD informational fields when disabled, not
checked.

Test Image
When selected the connected monitor will display a standard color bar.

Zoom 1
Forces the video to help focusing to zoom in one time.

Color
De-selecting this option effectively turns the attached color monitor into a monochrome monitor
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(active with color cameras only).

OSD Position
Allows the user to move the OSD informational fields upward (top), left, and/or right. Increasing
the number moves the displayed OSD information in the opposite direction. For example,
increasing the Top entry field moves the OSD information downward.

Image Position
Allows the user to center the image by adjusting the x and y axis.

Defaults
Resets the following adjustment sliders back to their default settings:
· Brightness
· Gain
· Gamma
· Saturation (color camera only)
· Hue (color camera only)

Video Player Button
When selected the Phantom Video Player application opens. The Phantom Video Player
provides the user with the ability to control any Phantom Ethernet camera attached to an
external monitor. This feature will be extremely effective with the higher resolution cameras
since most computer monitors do not refresh the screen images quickly enough to produce a
smooth visual display.
By default the Phantom Video Player window is et to display a live image on the monitor. The
user can quickly perform an edit of the recorded cine by easily selecting the range of images to
be played back.
Once captured the user can play back and save the recorded cine file from the camera's
memory, or attached Phantom CineMag, using the video playback buttons along with adjusting
the speed of the playback.

NOTE
This Video Output Control feature is only accessible with Ethernet model cameras, the
player has not been implemented for the IEEE 1394 camera models, or the Image3.
For step-by-step instructions on using the Phantom Video Player click on the following link:
Using the Phantom Video Player.

Pedestal R, G, B
Allows for separate video monitor (R)ed, (G)reen, (B)lue Brightness adjustment.
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Adding a Simulated Camera (Phantom Camera Simulation)
The Acquisition>Add Simulated Cameras... command is used to specify which Phantom camera
model the user wishes to simulate. This command can be very useful to determine recording times
and the number of images that can be recorded for various camera models prior to purchase of
camera or memory upgrades. You can simulate a camera with or without using an existing .STG file
resulted from a camera with the same serial.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Add the Simulated Camera(s).
a. Click the Add Simulated Cameras command.
b. In the Add simulated camera dialogue window enter the appropriate syntax of the Phantom
camera you wish to simulate. Use the table below to determine the syntax (number) to be
entered to simulate the desired Phantom camera(s) and or Image3 slice(s) connected to
various camera models.
NOTE
You can simulate multiple Phantom cameras and/or Image3s.
CAMERA MODEL

SYNTAX

CAMERA MODEL

SYNTAX

Phantom Miro 1

81

Phantom v10
(standard mode)

10

Phantom Miro 2

82

Phantom v10
(enhanced mode)

101

Phantom Miro 3
(max resolution 640 x
480)

83

Phantom v9.1

91

Phantom Miro 3
(max resolution 800 x
600)

831

Phantom v7.3

73

Phantom Miro 4

84

Phantom v6.2e

62

Phantom Flex

135

Phantom v5.1

51

Phantom 65

650

Phantom v4.3

43

Phantom HD

660

Phantom v4.2

42

Phantom v710

122

Image3 w/v10

31

Phantom v640

130

Image3 w/v9.1

n/a

Phantom v310

125

Image3 w/v7.3 or v9

n/a
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CAMERA MODEL

SYNTAX

Phantom v210

126

Phantom v12

120

CAMERA MODEL
Phantom CineStation

SYNTAX
39

c. Enter a 4-digit serial number, if desired. If the user does not specify a unique serial number the
software will automatically assign a number, that increments automatically every time a
camera is added to the camera pool list.

4.2.3

Setup and Recording Processes
NOTE
Selecting the proper parameters greatly depends on the type of camera being used, the
environmental conditions, (such as lighting), the type of lens attached, and the subject or
object being recorded, etc.
Below are generic steps to setup, and capture, (record), images using your Phantom camera system,
including:
1. Open the Setup and Recording Window.
2. Open a Saved Setup and Recording Configuration File.
3. Change the Connected to Camera, if desired. (Multiple camera environment only)
4. Enter a Description of the configuration setting (Optional).
5. Specify the camera's Sync imaging options, see; Accessories, Peripherals, and Miscellaneous
Features>Sync Imaging (Camera Network Options).
6. Define the Resolution.
7. Define the Sample Rate.
8. Adjust all imaging hardware.
9. Select a digital Zoom value (Optional).
10.Define the Exposure Time.
11.Perform a Current Session Reference or Black Reference Adjustment.
12.Perform a White Balance Adjustment (Color cameras only).
13.Specify the EDR Exposure value (Optional).
14.Determine and Specify the Post Trigger value.
15.Enable and define the camera to use Auto Exposure (Optional).
16.Define the cameras Setup and Recording Window Options (Optional).
17.Perform Image Processing adjustments (Optional).
18.Define Continuous Recording parameters (Optional).
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19.Define Flash Mem... (Non-Volatile Flash Memory) options (Optional).
20.Update the newly set configurations.
21.Save the Setup and Recording Window configuration settings (Optional).
22.Place the camera into the Capture mode.
23.Apply a Trigger signal to the camera.
24.Open the cine file you just recorded in the camera for viewing, editing, and saving.
4.2.3.1

Open the Setup and Recording Window

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4.2.3.2

Opening a Saved Setup and Recording Configuration File
The Setup and Recording>Open button is used to load a previously saved Setup and Recording
Window configuration settings. This feature is extremely useful to set up the camera quickly,
especially when repetitive testing needs to be performed.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Open the Setup and Recording configuration file.
a. Click on the Open button.
b. In the Load Camera Setting dialogue window:
1) Specify the destination directory (folder) where the configuration file has been saved.
2) Click the down-arrow to the right of the Files of type field.
3) From the pull-down selection list select the Setup Files (*.STP, *.STG) option.
4) Click on the .STP file to be opened.
5) Click the Open button.
4.2.3.3

Change the Connected to Camera (Multiple Camera Environment Only)

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
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3. Select the Setup and Recording... command from the Acquisition menu.
4. Change the Connected-to Camera.
a. Click the down-arrow, to the right of the Camera field, in the Setup and Recording dialogue
window, to display a drop down list box and select the desired camera from the list.
b. Alternatively, you can leave the Setup and Recording screen and choose a camera from the
Camera Pool... option under the Acquisition menu.
4.2.3.4

Specify the Setup and Recording Configuration Description

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the Setup and Recording Configuration File Description.
a. In the Description field enter any combination of letters, numbers, or spaces, up to a maximum
of 4,096 characters.
The Description entered will be displayed in the Cine Info window, and/or it can be added to
the user specified Border Data, and will be saved, together with the acquisition parameters, in
the settings file, when the:
· Setup and Recording window is closed using the OK button.
· Save button is selected.
· A Current Session Reference is executed.
4.2.3.5

Define the Resolution Parameter

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the Camera's Resolution Parameters.
a. Click the down-arrow to the right of the Resolution field to view a list of predefined aspect
ratios.
b. To use a resolution not displayed within the list simply enter the desired Resolution, then
c. Click the Update button, and the system will select the closest, allowable, resolution for the
camera's sensor.
NOTE
Reduced image resolution (aspect ratios) will result in longer recording times.
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CAR (Continuous Adjustable Resolution) Chart
CAMERA MODEL

1

4.2.3.6

CAR (IN PIXELS)

CAMERA MODEL

CAR (IN PIXELS)

Phantom 65

8 pixel vertical
increments

Phantom v9.0

48 x 8

Phantom HD/HD Gold

8 pixel vertical
increments

Phantom v7.3

32 x 8

Phantom Flex

256 x 8

Phantom v7.2, v7.1,
v7.0

16 x 8

Phantom v710

128 x 8

Phantom v6.2, v6.1,
v6.0

16 x 8

Phantom v640

128 x 8

Phantom v5.2

96 x 8

Phantom v310

128 x 8

Phantom v5.1, v5.0

64 x 8

Phantom v210

128 x 8

Phantom v4 Series

16 x 8

Phantom v12 Series

128 x 8

Phantom Miro2, 3, 4,
Airborne

32 x 8

Phantom v10.0

96 x 8

Phantom Miro11

N/A

Phantom v9.1

96 x 8

Very short focal-length lenses may exhibit some vignetting in the extreme corners at the maximum resolution.
An F-mount adapter is included to be used in these situations.

Define the Sample Rate

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the desired Sample Rate.
a. Click the down-arrow to display a drop down list box and select one of the preset sample
rates.
b. If the desired frame rate is not listed, simply enter a desired sample rate. The Phantom
Camera Control application allows the user to enter any sample rate between the minimum
and maximum rates displayed in the drop down list.
c. Click the Update button.
NOTE
The system will select the closest available sample rate. To increase the sample rates reduce
the selected Resolution (Width x Height).
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For actual Sample rates refer to: Functional Descriptions>Frame Rate Tables.
4.2.3.7

Adjust all Imaging Hardware
Adjust items such as the camera position, frame focus, the lighting setup, and the lens f/stop, etc. to
get the best image in the setup screen’s preview panel or attached monitor.

4.2.3.8

Select a Digital Zoom Value (Optional)

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Select a Digital Zoom Value.
a. Simply press the down-arrow to the right of the Zoom filed and select the desired zoom value.
NOTE
When an image has been zoomed, slide bars, located on the right-hand side and bottom of the
image display window, can be used to adjust the image so the point of interest will be
displayed in the window.
When using a Phantom v6 Series camera, this feature can be used to magnify or reduce the
size of a single imaging head by clicking on the down-arrow next to the Head option and
selecting the appropriate imaging head from the list box.
4.2.3.9

Define the Exposure Time

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the desired Exposure Time.
a. Click the down-arrow to display a drop down list box and select one of the preset exposure
times in the pull down list box.
b. If the desired exposure time is not listed, simply enter the exposure time required. The
Phantom Camera Control application allows the user to enter any exposure time between the
minimum and maximum times displayed in the drop down list, in 1µs increments, percentage,
or degrees.
c. Click the Update button.
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4.2.3.10 Perform a Current Session Reference or Black Reference Adjustment
NOTE
Before performing either a Black Reference or Current Session Reference Adjustment ensure
that the EDR Exposure setting is set to zero, and Auto Exposure is disabled.

STEP-BY-STEP PROCEDURES
Performing a Current Session Reference - Image Calibration
Use Current Session Reference (CSR) to calibrate the image for current acquisition parameters.
The application will compute the offsets specific to the current parameters, obtaining a more
precise compensation of the pixel errors. The CSR (Current Session Reference) processes is
similar to Black Reference adjustment in the Setup and Recording>Options window.
You use a CSR before recording a cine when you have a single cine configuration or a MultiCine
configuration with all cines having the same acquisition parameters. If the cines have different
setup values, you should perform CSR on each cine separately, after recording the cines.
While performing a Current Session Reference you will receive some warning messages
mentioning:
· it is advisable to avoid large exposure values (greater than 1ms)
· you have to cover the lenses of the camera before CSR is executed
· these adjustments are correct only for that set of acquisition parameters
· the name of the .STG file created on this occasion
· option to save the new calibration to the camera nonvolatile memory, too. Saving the CSR
to camera’s nonvolatile memory is necessary when you want to apply the new pixel
corrections to the analog/HDTV Video Output.
1. Make sure you have a backup of the factory-supplied STG file before doing a current
session reference.
2. Start the Phantom Control Software application.
3. Open the Acquisition pull-down menu.
4. Select the Setup and Recording... command from the Acquisition menu.
5. Set the acquisition parameters you need. The calibration will be done considering the
resolution, frame rate, exposure and EDR values. The current settings for Autoexposure
and for BitDepth are ignored.
6. Cover the lens with a lens cap to ensure the sensor is in complete darkness.
7. Perform a Current Session Reference Adjustment.
a. From the Setup and Recording screen, click on the Current Session Reference button.
b. If the "Calibration is not reliable at large exposure" warning message displays:
1) Press the Cancel button.
2) Reduce the exposure to less than 1000µs.
3) Re-select the Current Session Reference button, and continue.
c. When the Uniform Black Subject window appears, cover the lens so the camera sensor
is in complete darkness.
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d. Click the OK button. The system will now acquire a few images for calibration.
NOTE
You can force the automatic load of a CSR.STG file by renaming it to <serial>.STG after you
save it, or save it by pressing Save button and change its name to <serial>.STG. This can
also be accomplished by saving it to the nonvolatile memory of the camera, and deleting
the .STG file from the hard disk; the .STG is recreated from camera if it is not available on
the hard disk.
The default folder used to automatically load the camera's .STG file, at the start the
application can be found in the Start In folder; you can see or change it via the application’s
icon properties window.
With a CSR saved to the camera’s non-volatile memory, upon startup the software will
prompt you with a warning that the STG file in the camera is the result of a previous CSR.
Typically, you will either do a new CSR for the new session you are starting, or you reload
the factory . to revert back to the initial factory calibration.
After executing a CSR, if you change the acquisition parameters, the calibration calculated
during the Current Session Reference will apply partially correct onto the new setup. For
example, if you increase later the image resolution the pixels outside the previous
resolution used at CSR will be corrected differently.

Performing a Current Session Reference - After Recording One or More Cine Files
NOTE
This process is only applicable to cine files stored in the camera's memory.
1. In the ViewCine dialogue window:
a. Ensure Camera has been selected in the Cine Source field.
b. Click the down-arrow next to the Cine # field and select the cine file you wish to perform
a Current Session Reference to.
NOTE
You will need to set the same parameters as those used to record the cine you want to
calibrate.
c. Click the Cine Info button to view the parameters used to record the cine to be calibrated.
d. Click the Close button.
2. Open the Setup and Recording dialogue window:
a. Match the parameter settings, for the recorded cine to be calibrated, to the setting
information gathered from the Cine Information window.
b. Cover the lenses to get a completely black image.
c. Press Current Session Reference button. The application acquires a few images in the
darkness, averages them and saves them in an offsets table.
d. Click the OK button.
3. In the ViewCine dialogue window save the cine you just calibrated in a file on the computer.
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NOTE
If a new CSR follows, with new acquisition parameters, you will lose the calibration you just
performed.
4. Continue these steps for of each recorded cine you wish to calibrate.

Performing a Black Reference
To ensure the best possible images are captured and recorded, a Black Reference adjustment
should be performed prior to capturing and recording the images.
1. Make sure you have a backup of the factory-supplied STG file before doing a black
reference.
2. Start the Phantom Control Software application.
3. Open the Acquisition pull-down menu.
4. Select the Setup and Recording... command from the Acquisition menu.
5. Set the camera to full resolution and adjust the sample rate and exposure to the desired
settings.
6. Cover the lens with a lens cap to ensure the sensor is in complete darkness.
7. Perform a Black Reference Adjustment.
a. From the Setup and Recording screen, click on the Options>Black Reference button.
b. If the "Calibration is not reliable at large exposure" warning message displays:
1) Press the Cancel button.
2) Reduce the exposure to less than 1000µs.
3) Re-select the Black Reference button, and continue.
c. When the Uniform Black Subject window appears, cover the lens so the camera sensor
is in complete darkness.
d. Click the OK button. The system will now acquire a few images for calibration.
e. Upon completion of the calibration process, the system will prompt the user to save the
new calibration settings to the camera's non-volatile memory, click Yes.
4.2.3.11 Perform a White Balance Adjustment (Color Cameras Only)
Because of the different "colors" of various types of light sources, a color cameras' preview images
may have a color tint that may not appear quite right during setup. The Phantom camera has several
adjustment methods to assist in correcting image color. Using the fast and easy to use White
Balance control should be the first step in color adjustment.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Perform a White Balance Adjustment.
© 2015 Vision Research - AMETEK Material Analysis Division

156

Phantom Camera Control Help File

a. With a live camera image displayed on the Setup and Recording Window, move the cursor
onto the image displayed in the Preview Panel. Locate an area that resembles white, and note
the information in the Status Bar located below the Preview Panel.
NOTE
The dimensions of this area should be approximately 32x32 or 16x16 pixels (the cursor itself is
32x32 pixels in size) and the pixels should not be saturated.
With the cursor in the area you have chosen, look at the three RGB values separated by
commas listed to the right of "RGB:" listing in the Status Bar. These values represent the color
values of the red, green, and blue pixels under the cursor. Zero equals "no value," and 255
equals "saturation" for an image with an 8-bit pixel depth. A display of 0,0,0 would equal
black, and 255,255,255 would equal saturated white (no color).
b. With the cursor in the center region of your chosen white reference area pick a spot that gives
you the highest values for RGB, but one that had NO values that exceeded the near saturated
value of 254. Right click on this area.
CAUTION
White Balance Adjustment cannot be performed over an area with any saturated pixels.

c. Select the sample area size by clicking on the radio button to sample. Verify the pixel reads
"0".
1) If the Saturated pixel count equals "0", click the Adjust WB button at the bottom of the
control box. The box will close, and in a few seconds the screen image display will change
to the new white balance adjustment.
2) If the Saturated pixel count is greater than "0", f-stop down until the Saturated pixel equals
"0".
e. This method of adjusting the White Balance will also work in playback mode when you view
your cine files. Use the same procedure as described above on an image paused on the
playback screen display.
NOTE
Your choice for a white area can be greatly simplified if you can physically place a white object
in your scene during camera setup to make the white balance adjustment (the white, back side
of a Kodak 18% gray card, or a piece of poster board will work fine). Make sure the target card

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

157

is receiving full illumination from your primary light source. After making the adjustment,
remove the card or place it in an unimportant area of the scene for possible future reference. If
placing a white target in your field of view is impossible, try to pick a bright area in your scene
that is as close to white, or light neutral gray as possible for the adjustment, perhaps a bright
section of concrete or a white vehicle or target marker.
f. The application will modify the Red and Blue values in the White Balance so that the selected
area becomes white.
4.2.3.12 Specify an EDR Exposure Setting (Optional)

STEP-BY-STEP PROCEDURE
1. Start the Phantom Control Software application.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify an EDR Exposure Setting.
a. Click the down-arrow to display a drop down list box and select a preset value from the list.
b. Optionally you can enter any number in increments of 1 from the minimum to maximum value
displayed in the list box. These values can be in 1µs increments, or percentage.
c. Click the Update button.
NOTE
EDR Exposure times should be set at approximately 1/2 of the Exposure time as a starting
point. By setting the EDR Exposure to 1/2 of the Exposure time the brightest pixels in the
images will be exposed for one stop less than the darker pixels.
When selected the Auto exposure feature will be disabled.
4.2.3.13 Determine and Specify a PostTrigger Value

Overview
The Post Trigger value represents how many pictures will be recorded after the trigger signal is
detected by the Phantom camera. Since the memory is scrolling memory, the Post Trigger value
also sets the reciprocal number of pre-trigger images captured.
When a Post Trigger value is defined in the Phantom Camera Control software, the camera will
continue to record and store, to the camera’s DRAM buffer, image data after a trigger signal is
detected for n fames, where n is the number of post trigger frames specified.
After the trigger signal is detected by the camera, recording continues for an exact number of
frames, n, and stored in the image buffer, then recording stops; n will depend on the Resolution,
Sample Rate, Image Bit Depth settings, and the buffer, (amount of DRAM memory), size.
It’s important to note that the camera can only store a finite number of images into the memory
buffer based on the resolution, sample rate, image bit depth settings, and the memory size.
When a post trigger value has been defined the camera will only store the maximum image count
allowed, for the particular capture settings. The camera will only display the frames stored in the
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memory buffer, the last x images, where x is the total number of images recorded or stored in the
image buffer.
At this point, the recorded images can be viewed or saved into a file on the Phantom Control Unit
or, optionally saved to built-in non-volatile flash memory.

STEP-BY-STEP PROCEDURES
Determining a PostTrigger Value
To set a PostTrigger value properly, you must first determine if:
1. The maximum number of images written in the cameras DRAM prior to the trigger signal
being detected by the camera, (all Pre-Trigger frames), are to be saved; or
2. The maximum number of images the camera can write into DRAM after a trigger signal is
detected by the camera, (all PostTrigger frames), are to be saved; or
3. The PostTrigger function is to introduce a delay, continue to record for a period of time after
the trigger signal has been detected by the camera, before saving the total number of
images the camera's DRAM will allow.

PostTrigger Application Example
The user needs to record 35 seconds of event time at a required sample rate that will only allow
the camera to record 10 seconds of the event. The good news is the user has multiple cameras
that he/she can network together to record the event. The cameras are synchronized, and will
be provided with the same hard trigger, so that to will be the same for all cameras.

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

159

Specify a PostTrigger Value
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the Post Trigger Value.
a. Click the down-arrow to display a drop down list box and select one of the preset
PostTrigger frames in the pull down list box.
b. If the desired frame rate is not listed, enter the desired number of PostTrigger frames. The
Phantom Camera Control application allows the user to enter any PostTrigger value
between the minimum up to ten times the maximum displayed in the drop down list.
Setting for All Pre-Trigger Frames
Set the PostTrigger to 1.
Setting for All PostTrigger Frames
Set the PostTrigger to the maximum number images for your system, in other words,
the maximum number of images the camera can save. As mentioned earlier in the
manual the camera can only store a finite number of images into the camera's memory
buffer based on the Resolution, Sample Rate, Image Bit Depth settings, and the buffer,
(amount of DRAM memory), size.
Setting a PostTrigger to Introduce a Delay
1. First, divide the desired delay time by the picture interval time. (The picture interval
time is the reciprocal of the sample rate.)
2. Add the maximum number of pictures for your system as displayed under Duration
information field to this number.
3. Enter that sum as the Post Trigger; this number must be less than 65,536. The
camera will discard all images acquired during the Post Trigger delay period, saving
only the last maximum number of pictures.
For example, to set a two second Post Trigger delay for a sample rate of 500
pictures per second, enter 2024 = (two seconds / 0.002seconds =1000) + 1024.
(The picture interval time is the reciprocal of the sample rate.)
4.2.3.14 Define and Enable the Auto Exposure Parameters
The Auto Exposure feature is extremely useful when conditions adversely effect setting a cameras'
exposure to a fixed variable, such as capturing outdoors where clouds may change the light
conditions. The system will adjust the Exposure using the information from the defined area. The
defined pixel area should be the focus of interest or the area of interest, the subject matter.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Auto Exposure Parameters.
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a. Click on the Options button.
b. Enter the desired Auto Exposure parameters.
1) Level - Defines the average level for the specified area, to be realized by the automatic
exposure system. For example, an 8-bit pixel image depth a mid gray: 128
2) Lock at Trigger - When you select this option, and Auto Exposure is selected too, the Auto
Exposure procedure stops after the trigger. It resumes when the recording stops, or if you
press Capture button.
3) Area - Defines the region of interest where the auto-exposure measures the average pixel
level.
NOTE
A user-friendly technique as been incorporated into the Phantom Camera Control Software to
define the Area, simply identify the area of interest in the Setup and Recording live preview
display window.
c. In the Setup and Recording dialogue window:
1) Enable, check, the Auto exposure enable box.
2) Drag a box around the area of interest. This can be accomplished by placing the cursor just
above the upper left hand of the corner of the area of interest. While holding down the left
mouse button drag the cursor just below the lower-right-hand corner of the area of interest
(the subject matter to be auto-exposed).

3) Click on the Options button; the area parameters have automatically changed to the pixel
area just selected.
4) Click OK to close the Option dialogue window and perform a cine capture.
d. In the Setup and Recording dialogue window enable, (check), the Auto exposure feature.
4.2.3.15 Define the Setup and Recording Window Options
The available Setup and Recording Options vary based on the camera type being used. Each of the
following Setup and Recording Options contains associated links that will take you to either a brief
description of each of the options or the Step-by-Step Procedures to utilize the option.
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Auto exposure
For a brief description of the Auto Exposure option click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window Examples and
Parameters
For the Step-by-Step Procedure to define the Auto Exposure parameters, click the following
link: Step-by-Step Processes>Setup and Recording Processes>Define and Enable the Auto
Exposure Parameters

Signals
For a brief description of the Signals option click the following link: The User Interface>Setup and
Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to define the Signals parameters, click the following link:
Peripherals>SAM-3 (Signal Acquisition Module-3) Installation

Video Player
For a brief description of the Video Player option click the following link: The User Interface>Setup
and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to use the Video Player parameters, click the following link: Stepby-Step Processes>Miscellaneous Procedures>Using the Video Out Controls

Black Reference
For a brief description of the Black Reference option click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to perform a Black Reference adjustment, click the following link:
Step-by-Step Processes>Setup and Recording Processes>Perform a Black Reference or Current
Session Reference Adjustment

External memory (i3)
For a brief description of the External Memory (i3) option click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to define the Signals parameters, click the following link:
Accessories, Peripheral, and Miscellaneous Features>Image3 Installation, Setup, and Use

Show format rectangles
For a brief description of the Show Format Rectangle option click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
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For the Step-by-Step Procedure to select the Show Format Rectangle, click the following link:
Step-by-Step Processes>Setup and Recording Processes>Define the Setup and Recording
Window Options>Define the Show Format Rectangle

Display Options
For a brief description of the Display Options option click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to enable the desired Display Options, click the following link:
Step-by-Step Processes>Setup and Recording Processes>Define the Setup and Recording
Window Options>Select the Desired Display Options

External Sync
For a brief description of the External Sync options, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to select the External Sync parameters, click the following link:
Accessories, Peripheral, and Miscellaneous Features>Sync Imaging (Camera Network Options)

Frame Rate Profile
For a brief description of the Frame Rate Profile option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to define a Frame Rate Profile, click the following link: Step-byStep Processes>Setup and Recording Processes>Define the Setup and Recording Window
Options>Define a Frame Rate Profile

MultiCine
For a brief description of the MultiCine option, click the following link: The User Interface>Setup
and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to define MultiCine usage, click the following link: Step-by-Step
Processes>Setup and Recording Processes>Define the Setup and Recording Window
Options>Specify the MultiCine Parameters

Bit Depth (ADC: n)
For a brief description of the Bit Depth (ADC:n) option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to define an image pixel Bit Depth, click the following link: Stepby-Step Processes>Setup and Recording Processes>Define the Setup and Recording Window
Options>Defining the Image Pixel Bit Depth
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Playback Cache Buffer
For a brief description of the Playback Cache Buffer option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Playback Cache Buffer parameter, click the
following link: Step-by-Step Processes>Setup and Recording Processes>Specify the Playback
Cache Buffer

Color Bar Image
For a brief description of the Color Bar Image option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window

Simulated memory size
For a brief description of the Simulated Memory Size option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Simulated Memory Size parameter, click the
following link: Step-by-Step Processes>Setup and Recording Processes>Specify the Simulated
Memory Size

Sound
For a brief description of the Sound option, click the following link: The User Interface>Setup and
Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Sound device, click the following link: Step-by-Step
Processes>Setup and Recording Processes>Specify the Audible Alarm Device

Default video mode for full screen
For a brief description of the Default Video Mode for Full Screen option, click the following link: The
User Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Default Video Mode for Full Screen parameters,
click the following link: Step-by-Step Processes>Setup and Recording Processes>Define the
Default Video Mode for Full Screen

Background
For a brief description of the Background option, click the following link: The User Interface>Setup
and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Background color, click the following link: Step-byStep Processes>Setup and Recording Processes>Change the Background Color
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Multi-camera control
For a brief description of the Multi-camera control option, click the following link: The User
Interface>Setup and Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Multi-camera control option, click the following link:
Step-by-Step Processes>Setup and Recording Processes>Specify the Multi-Camera Control
Option

Exp.
For a brief description of the Exp. option, click the following link: The User Interface>Setup and
Recording Window>Control Panel>Option Dialogue Window
For the Step-by-Step Procedure to specify the Exp. option, click the following link: Step-by-Step
Processes>Setup and Recording Processes>Specify the Multi-Camera Control Option
4.2.3.15.1 Define the Show Format Rectangle

This feature is accessible with the Phantom 65, Phantom HD, Phantom v710, v640, v310, v210, v12Series, and v10 cameras only.

STEP-BY-STEP PROCEDURE
1. Start the Phantom Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the desired format rectangle.
a. Click on the Options button.
b. Enable, (check), the desired format rectangle size.

After selecting one of the supported rectangle formats the Setup and Recording Window will
overlay a rectangle in the Preview Panel. This rectangle to represent what will be the visible
areas for the recorded images when viewed on most television monitors.
Even though the Preview Panel displays the entire image frame the area inside the rectangle
marks the area of the image that would be visible on a television monitor. Most television
monitors will not display all the image data. The area outside the rectangle represents the area
that would not be displayed on the television monitor.
c. Click the Ok button.
5. Verify that your action is within the safe areas, test your project on the destination television
monitor.
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4.2.3.15.2 Select the Desired Display Options

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the desired Display Option.

a. Click on the Options button.
b. Enable, (check) the Display Options desired Display Options.
c. Click the OK button.
4.2.3.15.3 Define a Frame Rate Profile

This feature allows the user to define up to 4 different frame rates that automatically change, at
specified points, during the capturing process of post trigger frames.
NOTE
This feature is not available in all Phantom cameras, and the Frame Rate Profiles will only be
applied to PostTrigger frames.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Frame Rate Profile.
a. Click on the Options button.
b. Specify the following Frame Rate Profile parameters:

1) Enter the number of Steps, or number of profiles to be used during the capture process.
Changing the step value generates a uniform distribution of the profile steps (in image
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count).
2) Select the desired header variable to define the profile(s) by click on the down-arrow to
display a pull-down selection list including the following options:
a) Image # - specifies the first frame or image number the defined profile will change.
b) Time (s) - specifies the time from trigger.
c) Image % - specifies the image number percent from post trigger frames.
d) Time % - specifies the time percent from post trigger duration.
e) Rate – specifies the frame rate the images will be captured.
NOTE
If the header variable is changed for the first column the remaining values will be updated
according to selected variable. Small changes can occur, because of the rounding process,
when switching from, then back to Image #.
3) Place the cursor over the first field to be edited.
a) Double-click the mouse.
b) Enter the desired setting.
4) Click the Update button.
5) Note the PT Duration.
6) Repeat Steps 3, 4 and 5 until all the profile steps have been defined.
c. Click the OK button.
4.2.3.15.4 Using the MutiCine Option

The MultiCine feature allows the user to:
1. Specify the number of memory segments, or partitions, a camera's DRAM memory will be, by
default, evenly divided into. You can change the memory allocation percentage for each segment
in the Cine/Memory % field.
2. Adjust memory allocation segments to meet the recording requirements. The Phantom Camera
Control Software application will automatically adjust the memory allocation percentages, for all
the segments, based on the parameter value or values specified.
3. Define a unique configuration profile for each of the memory segments.
4. View how the memory segments are configured.
5. Select which memory segment to capture or record image data into.
6. Delete the recorded cine file, (image data), stored in a specific memory segment, without deleting
recorded image data in any of the other memory segments, to free up that memory to perform
another capture.
NOTE
Each cine from a MultiCine recording can have its own acquisition parameters. This feature is
not available in the Phantom v4.1, v4.2, v5.0, v6.0, or v6.1 camera models.
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STEP-BY-STEP PROCEDURES
It is important to note that all the following steps build upon the step before it.

Initial Steps
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.

Specifying the Number of Memory Segments
1. Define the MultiCine Parameters.
a. Click on the Options button.
b. In the Options dialogue window:
1) Click the down-arrow to the right of the Cine field.

2) Select the number of memory segments required.
3) Click the Update button.
4) Click the Yes button, when the "You changed the memory partition size or count. This
will delete any cine stored in the camera RAM memory. Would you like to re-partition the
camera memory?" warning message appears.

Reallocating the Segmented Memory
1. Click the down-arrow next the Cine/Memory % field to reallocate the amount of memory that
will be allocated to each segment.
2. Select the memory segment to be changed.
3. Double-click on the percentage value under Memory %.
4. Enter in the percentage of memory to be allocated for this segment.
5. Click the Update button.
6. Click the Yes button, when the "You changed the memory partition size or count. This will
delete any cine stored in the camera RAM memory. Would you like to re-partition the camera
memory?" warning message appears.
7. Repeat Steps 5 through 10 until all memory segments that need to be changed.
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8. Click the OK button when finished.

Defining the Cine (Memory Segment) Configuration Profile
1. Define the Setup and Recording window configuration profile(s).
a. Determine if the configuration profile will be the same for all the cine segments, or whether
they will have a unique configuration profile.
1) If all the cine segments will be configured with identical parameters, or profile:
a) Click the down-arrow next to the Cine field.
b) Select the Preview option from the pull-down list.
c) Define the Setup and Recording parameters as required.
d) Click the down-arrow next to the Cine field.
e) Select the Set to All option from the pull-down list.
f) Click the Update button.
2) If a cine segment will be configured with its unique parameters, or profile:
a) Click the down-arrow next to the Cine field.
b) Select the Cine to be configured for the pull-down selection list.
c) Define the Setup and Recording parameters as required that cine.
d) Click the Update button.
e) Repeat Steps a) through e) until all the cine profiles have been configured to meet
your requirements.

Viewing the Memory Segment Configuration Profiles
1. Click the Options button in the Setup and Recording Window.
2. In the Options dialogue window, click the View button under MultiCine.
RESULT The system opens a text file displaying information for each of the memory segments.

Selecting a Cine (Memory Segment) to Capture Image Data
When the camera is placed into the capture or recording mode, the system will start recording
image data to the first available memory segment that does not have a cine file, or image data,
stored in it. By default this will be Cine 1, or memory segment 1.
If a memory segment has been used to store a cine file, the camera will bypass its memory
locations and find the next available, or image free, memory segment to store the image data.
To choose a particular memory segment you wish to use to store your cine file, (image data),
into:
1. Return to the Setup and Recording Window.
a) Click the down-arrow next to the Cine field.
b) Select the Cine you wish to use to store the cine file for the pull-down selection list.

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

169

c) If the Cine or memory segment you just selected contains a cine file within it already, the
system will display warning message indicating "Cine: n is already in the RAM memory of
this camera. Would you like to delete it and start a new recording?" If this occurs,
d) Press Yes to delete the cine and use that memory segment for the new recording or click
No to cancel.

Using the MultiCine Feature with a Phantom Miro Camera
For details on using the MultiCine feature with a Phantom Miro cameras click the following link:
Phantom Miro Control via "Touch-Sensitive" LCD Display>Step-by-Step Procedures>Using the
Multicine feature with a Miro camera.
4.2.3.15.5 Defining the Image Pixel Bit Depth

A variety of the Phantom camera sensors have the ability to record and save 8-, 10-, 12-, or 14-bit
values, (gray scale level images), that are transferred to the computer as either 16-bit or 8-bit words.
By default these Phantom cameras display 8-bit, (256 gray scale level), images. The 8-bits used to
display these images are the most significant, or high order, bits of 14-bit values.
Enabling the Pixel Depth feature makes it possible to increase contrast and see images with less
light simply by selecting which region of the total dynamic range of the image to display on-screen.
The display outputs 8-bits even though the image has up to 14-bits. This is because each of the 8bits of data selected, by the user, is split into 16-bits where the high order bits are used with well lit
subjects and the low order bits for dimly lit subjects.
NOTE
Both 8-bit to 14-bit images need exactly the same amount of light to saturate the sensor. What
differs is the fineness in the number of levels recorded.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Image Pixel Bit Depth.
a. Click on the Options button.
b. In the Options dialogue window:
1) Define the Bit Depth (ADC: 14) selection fields.
a) Select the bit depth for the acquisition from the RAM pull down selection list.
i. Click on the RAM down-arrow and select the bit depth images will be recorded at to the
cameras dynamic Random Access Memory (RAM).
b) Select the bit depth for the transfer image data to the Phantom Control Unit from the Save
pull down selection list.
i. Click on the Save down-arrow to specify whether the recorded images will be saved
with the Same bit depth they were stored into RAM at, or saved with an 8-bit image
pixel depth.
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c) Click the OK button to close the Options dialogue window.
c. Click on the Img.proc ... button in the Setup & Recording Window.
1) In the Image Processing dialogue window:
a) Select the dynamic range of the image, (the desired number of bits per pixel), to be
displayed on-screen by moving the Min and Max sliders.
i. To select the low order, the least significant bits slide the Max slider to the left.
ii. To select the high order, most significant bits, slide the Min slider to the right.
iii. To select a range somewhere in the middle simply adjust the slider to the desired gray
scale range.
b) Once the dynamic range of the image, (the desired bits), has been defined, click the OK
button.
4.2.3.15.6 Specify the Playback Cache Buffer

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Help>About window.
a. Locate and note the memory totals in the Window Memory box.
b. Close the About window.
3. Open the Acquisition pull-down menu.
4. Select the Setup and Recording... command from the Acquisition menu.
5. Specify the Playback Cache Buffer size.
a. Click on the Options button.
1) Type the amount of memory to be allocated as Playback Cache memory into the Playback
Cache Buffer entry field, (in Megabytes).
NOTE
Do not exceed the amount of available memory noted in Step 2 of this process.
2) Click the Update button.
3) Click the OK button.
4.2.3.15.7 Specify the Simulated Memory Size

NOTE
This option will only be enabled when connected to a simulate Phantom camera.
To learn how to simulate various Phantom camera models click on the following link: Step-by-Step
Processes>Acquisition Processes>Adding a Simulated Phantom Camera.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
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2. Select the Setup and Recording... command from the Acquisition menu.
3. Specify the Simulated Memory size.
a. Click on the Options button.
1) Click on the down-arrow the right of the Simulated memory size field, then
2) Select the amount of memory for simulation.
3) Click the OK button.
4.2.3.15.8 Specify the Audible Alarm Device

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Select the Setup and Recording... command from the Acquisition menu.
3. Specify the Audible Alarm Device.
a. Click on the Options button.
1) Click on the down-arrow the right of the Sound field, then
2) Select the device that is going to generate the audible alarms.
3) Click the OK button.
4.2.3.15.9 Define the Default Video Mode for Full Screen

STEP-BY-STEP PROCEDURES
Determining the Proper Value to Set the Default Video Mode for Full Screen
1. Right-mouse click on a blank area of the Phantom Control Unit's desktop.
2. Locate and click the Properties command in the pop-up window.
3. In the Display Properties dialogue window, click on the Setting tab, and note the following:
a. Screen Resolution.
b. Color Quality.
c. Click the OK button.

Defining the Default Video Mode for Full Screen
1. Start the Phantom (Legacy) Camera Control Software.
2. Select the Setup and Recording... command from the Acquisition menu.
3. Specify the Default Video Mode for Full Screen.
a. Click on the Options button.
1) Click on the down-arrow the right of the Default video mode for full screen field, then
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2) Locate and select the settings noted while performing the "Determining the Proper Value
to Set the Default Video Mode for Full Screen" procedure above.
3) Click the OK button.
4.2.3.15.10 Change the Background Color

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Change the Background Color.
a. Click on the Options button.
1) Type the Red, Green, Blue values desired into the Background field.
2) Click the Update button.
3) Click the OK button.
NOTE
The Setup and Recording>Options dialogue window must be closed before the changes will
take effect.
4.2.3.15.11 Specify the Multi-Camera Control Option

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Select the Multi-Camera Control option.
a. Click on the Options button.
1) Click on the down-arrow the right of the Multi-camera control field, then
2) Select the method the Phantom Camera Control application will apply changes and
updates to when used in a multi-camera environment.
3) Click the OK button.
4.2.3.15.12 Define the Exposure, EDR Exposure, and PostTrigger Exponent

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
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3. Select the Setup and Recording... command from the Acquisition menu.
4. Select the Exp. option.
a. Click on the Options button.
1) Click on the down-arrow the right of the Exp. (Exponent) field, then
2) Select the desired exponent.
3) Click the OK button.
4.2.3.16 Define the Image Processing Effects
When Image processing adjustments are defined in the Setup and Recording Window a captured
cine file, in the camera's memory buffer, will retain the effects specified in the Image Processing
dialogue window. If the cine file is saved in the Cine RAW file format the saved file will keep the
original image information, (the images without the applied image processing effects), yet the saved
file will also retain the effect values selected and applies them during playback in the ViewCine
Window. Other saved file formats, however, will lose the original image information and apply the
image processing adjustment effects to the saved file.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Perform Image Processing adjustments.
a. Click the Im. proc... button.
b. In the Image Processing dialogue window:
1) Select the effect(s) desired.
c. There are four ways to Crop the images being displayed in either the active Preview or
Playback panel:
1) Enter the X Y coordinates. These coordinate represent the rectangle’s coordinates of the
top leftmost pixel.
2) Select the desired the Crop Width and Height using the up/down arrows next to the entry
fields, then enable, check the Crop enable box.
3) Enter the desire Crop Width and Height into the entry fields, then enable, check the Crop
enable box.
4) Place the cursor over the image, hold down the left mouse key, to draw a rectangle over the
image. Release the mouse key and select the Crop option from the pop-up selection
window.
d. There are three ways to Resample the images being displayed in either the active Preview or
Playback panel:
1) Select the desired the Resample Width and Height using the up/down arrows next to the
entry fields, then enable, check the Resample enable box.
2) Enter the desire Resample Width and Height into the entry fields, then enable, check the
Resample enable box.
3) Click the down arrow to the right of the custom entry field and select a predefined resample
size from the pull-down selection list.
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2) Click the OK button.
For details on the various effect click the following link: Functional Descriptions>Image Processing
Effects and Filters.
4.2.3.16.1 Select the Color Interpolation Algorithms

You can choose one of five color interpolation algorithms, (Best, Good, Medium, Fast, Fastest), for
the live images and for the cine played from the camera in ViewCine window.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Specify the desired Color Interpolation Algorithms.
a. Click on the Im. Proc. button.
b. Click the down-arrow to the right of the Live and ViewCine fields in the Color Interpolation
Algorithms box, and
c. Select the desired algorithm to be applied.
NOTE
The Phantom application remembers the settings you made for each Color Interpolation
Algorithm, Live, and ViewCine, even after you close and reopen the application.
d. Click the OK button.
4.2.3.17 Using the Continuous Recording Option
The Continuous Recording feature can be used to automatically capture, trigger, edit, and save
image data into the cameras optional non-volatile Flash memory, or to a specified external storage
device. The Continuous Recording setup process varies slighted depending on the tasks you want
the system to automatically perform.

STEP-BY-STEP PROCEDURES
Waiting for Trigger Mode
When the Once Only (Manual Capture Restart), and AutoTrigger options are not enabled the
system will automatically save the capture cine file or files to the specified destinations, (Cine file
path and save parameters), and place the camera into the "Preview, Recording Cine n ...
Waiting for Trigger" mode once the trigger signal is detected by the camera. To record and save
a second cine file the camera simply needs to detect a trigger signal.
CAUTION
Before using Continuous Recording you must first set all operating parameters in the Setup
& Recording screen.
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1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Continuous Recording Waiting for Trigger parameters.
a. Click on the Continuous Recording button.
b. In the Continuous Recording dialogue window specify the first Cine file paths and save
parameters.
1) Clicking the 1... button.
2) When the Save Cine dialogue window appears.
a) Specify the destination folder.
b) In the File Name field type in the
<root_file_name><special_character><single_digit_range>, where <root_file_name>
is the root filename portion of the file or file being created. This root file name portion
of the filename will remain the consistent with all files created during the Continuous
Recording session. The <special character> portion of the filename is determined by
the type of file or files being created. (Refer to the Functional Descriptions>Using the
Phantom's File Naming Convention.) The <single_digit_range> portion of the file name
specifies the number of digits or file counters that will be appended to the end of the
root file name.
c) Select the desired cine type from Save As Type drop-down list. It is possible to save
the captured images in any of the available formats found in the Save as pull-down
selection list. This includes saving the captured images in various cine formats, an .
avi, .mxf, multipage tiff, or QuickTime.mov format, or a series of any one of a host of
image formats. (Refer to the Functional Descriptions>Supported File Formats to
determine the file format that best meets your requirements.)
NOTE
If the Cine JPEG (*.cci) file format is selected you need to specify a percentage the file will
be compressed by entering the compression value in the Lossy Compression>Quality field.
If the camera is one of the Phantom v6 series' cameras you will also need to specify if the
system is to create files for a specific imaging head or heads, or All heads in one cine. Click
the Multi-Head Options... button, which will only be active with the a Phantom v6 Series'
camera, to access the Multi-Head Option dialogue window.
d) Specify which images will constitute the saved file by defining the Range of Images to
Save fields.
i. If you do not wish to edit the file check the No Range (full cine always) enable box.
ii. If you wish to edit the number of images, eliminating unwanted captured images
from the final product, and reduce the file size being saved.
· Specify the First image, from the Range of images to save, then
· Enter the Image count, or the number of images from the First image to be saved.
e) If you wish to create an XML Header File, enable (check) the XML header file enable
box.
f) If you wish to add Border Data, (information about the recorded image), click the
Border Data... button.
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g) If you wish to add Image Processing effects to the recorded images, click the Image
Processing... button and apply the desired effect(s).
3) Repeat these steps for the 2..., 3..., and 4... buttons to define multiple storage locations.
c. Enable, check, the Minimal GUI Refresh enable box.
Enabling this option will reduce the cine save time by instructing the software not to display
live images in the Preview Panel during the save procedure, and disabling the save
progress indicator.
d. Apply a trigger to the camera.
NOTE
When a trigger is detected the system will automatically save the file(s) to the destination
folder specified and place the camera back into the "Preview, Recording Cine n ... Waiting
for Trigger" mode.
d. To automatically save subsequent cine files simply apply a trigger to the camera.
e. When the recording session is complete:
1) Browse the File Menu>Open Cine File window.
2) Navigate to the destination directory.
3) Verify the file listings.

Auto Trigger
When the AutoTrigger option is enabled the system will automatically save the capture cine file
to the specified destination, (Cine file path and save parameters), once the trigger signal is
detected by the camera. Once the cine is saved the camera will automatically return to the
capture mode. Once the camera memory buffer is full the camera automatically triggers itself,
and saves the file to the specified destination. This process will continue until you disable,
(uncheck), the AutoTrigger option.
CAUTION
Before using Continuous Recording you must first set all operating parameters in the Setup
& Recording screen.
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Continuous Recording AutoTrigger parameters.
a. Click on the Continuous Recording button.
b. Enable (check) the AutoTrigger enable box.
c. In the Continuous Recording dialogue window specify the first Cine file paths and save
parameters.
1) Click the 1... button.
2) When the Save Cine dialogue window appears:
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a) Specify the destination folder.
b) In the File Name field type in the
<root_file_name><special_character><single_digit_range>, where <root_file_name>
is the root filename portion of the file or file being created. This root file name portion
of the filename will remain the consistent with all files created during the Continuous
Recording session. The <special character> portion of the filename is determined by
the type of file or files being created. (Refer to the Functional Descriptions>Using the
Phantom's File Naming Convention.) The <single_digit_range> portion of the file name
specifies the number of digits or file counters that will be appended to the end of the
root file name.
c) Select the desired cine type from Save As Type drop-down list. It is possible to save
the captured images in any of the available formats found in the Save as pull-down
selection list. This includes saving the captured images in various cine formats, an .
avi, .mxf, multipage tiff, or QuickTime.mov format, or a series of any one of a host of
image formats. (Refer to the Functional Descriptions>Supported File Formats to
determine the file format that best meets your requirements.)
NOTE
If the Cine JPEG (*.cci) file format is selected you need to specify a percentage the file will
be compressed by entering the compression value in the Lossy Compression>Quality field.
If the camera is one of the Phantom v6 series' cameras you will also need to specify if the
system is to create files for a specific imaging head or heads, or All heads in one cine. Click
the Multi-Head Options... button, which will only be active with the a Phantom v6 Series'
camera, to access the Multi-Head Option dialogue window.
d) Specify which images will constitute the saved file by defining the Range of Images to
Save fields.
i. If you do not wish to edit the file check the No Range (full cine always) enable box.
ii. If you wish to edit the number of images, eliminating unwanted captured images
from the final product, and reduce the file size being saved.
· Specify the First image, from the Range of images to save, then
· Enter the Image count, or the number of images from the First image to be saved.
e) If you wish to create an XML Header File, enable (check) the XML header file enable
box.
f) If you wish to add Border Data, (information about the recorded image), click the
Border Data... button.
g) If you wish to add Image Processing effects to the recorded images, click the Image
Processing... button and apply the desired effect(s).
3) Repeat these steps for the 2..., 3..., and 4... buttons to define multiple storage locations.
d. Apply a trigger to the camera.
NOTE
When a trigger is detected the system will automatically save the file(s) to the destination
folder specified and place the camera into the "Capture" mode, store the new images into
the cameras DRAM until it fills the memory buffer one time, then automatically trigger the
camera and save the newly recorded cine file.
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e. To stop the AutoTrigger option, disable (uncheck) the AutoTrigger enable box.
f. When the recording session is complete:
1) Browse the File Menu>Open Cine File window.
2) Navigate to the destination directory.
3) Verify the file listings.

To Non-volatile Flash Memory
For details on step-by-step instruction on continuous recording to non-volatile Flash memory
click on the following link: Step-by-Step Processes>Setup and Recording Processes>Using
Flash Memory Continuous Recording to Flash Memory.
4.2.3.18 Using Flash Memory
The Flash Memory feature can be used to save a cine recorded in the cameras RAM to Flash
manually, automatically capture, edit, and save the cine file image data into the cameras optional
non-volatile Flash memory, or automatically send the images out to an attached video monitor. The
Flash Memory setup process will vary slighted depending on the tasks you want the system to
automatically perform.

STEP-BY-STEP PROCEDURES
Manually Saving Cine Images Store in Camera RAM to Flash Memory
Use this option when you wish to edit and save a cine file stored in the cameras RAM to the
cameras optional non-volatile Flash memory module manually .
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Place the camera in to capture mode and trigger the camera.
5. In the ViewCine window:
a. Manually Save the camera stored cine file to Flash.
1) Click on the Flash Mem... button to open the Flash Memory dialogue window after a
cine has been recorded to the dynamic memory of the camera.
a) Specify the image range to be saved to Flash.
i. Enter the image number of the first image to be saved in the First field.
ii. Enter the number of images to be saved in the Count field.
b) Click on the Save button.
NOTE
After clicking the Save button a status window will pop up and a status bar will show the
progress and estimated time remaining in the save.
When the save is complete the Flash Memory dialogue window will list the file(s) stored in
non-volatile flash memory identified by the trigger time of each file. There will also be a
small box that displays the Flash Cine Count; the number of files stored in Flash memory.
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The file stored in the camera's memory buffer will remain untouched in the camera's
memory buffer until power is removed from the camera, or the instructed by you to delete
the cine file.
c) Click the Close button to exit the Flash Memory dialogue window.

AutoSave to Flash Memory
Use this option when you want the camera to automatically a captured cine file to both the
cameras non-volatile Flash, and DRAM memory modules.
NOTE
The AutoSave to Flash option can be used in conjunction with the AutoPlayback to Video
option.
CAUTION
Before using the AutoSave to Flash option ensure all Setup and Recording parameters are
configured to meet your imaging requirements.
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. AutoSave the captured cine file to Flash.
a. Click on the Flash Mem... button to open the Flash Memory dialogue.
1) Specify the image range to be saved to Flash.
a) Enter the image number of the first image to be saved in the First field.
b) Enter the number of images to be saved in the Count field.
2) Enable, (check), the AutoSave to Flash enable box.
3) If you want the cine file to automatically be displayed on an attached video monitor,
enable (check) the AutoPlayback to Video enable box.
4) Click the Close button to exit the Flash Memory dialogue window.
b. In the Setup and Recording Window:
1) Click the Capture button.
2) If the Record New Cine dialogue window appears, click the "Delete cine(s) and start
new recording" button to start capturing images to the cameras DRAM memory
immediately.
c. Apply a Trigger signal.

NOTE
A hard trigger applied through the trigger connection will now cause the camera to record a
cine into camera DRAM, then automatically download the file from camera DRAM to nonvolatile Flash memory. The file stored in the camera's memory buffer will remain untouched
in the camera's memory buffer until power is removed from the camera, or the instructed by
you to delete the cine file.
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When the save is complete the Flash Memory dialogue window will list the file(s) stored in
non-volatile flash memory identified by the trigger time of each file. There will also be a
small box that displays the Flash Cine Count; the number of files stored in Flash memory.
The camera will go into the Preview mode.
The number of cine files you are able record using this procedure is limited by the size of
your non-volatile Flash memory module.
d. To automatically record subsequent cine files to the camera non-volatile Flash memory
you will need to repeat Steps b and c.
e. To stop the AutoSave to Flash option:
1) In the Setup and Recording Window, click the Flash mem... button.
2) In the Flash Memory dialogue window:
a) Disable (uncheck) the Continuous Recording to Flash enable box.
b) Click the Close button.

AutoPlayback to Video from Flash Memory
The AutoPlayback to Video option instructs the camera to automatically send the captured cine
file to an attached monitor once the cine is stored in the camera's DRAM, not the Flash module.
You will need to enable either the AutoSave to Flash, or Continuous Recording to Flash enable
boxes if you want to save the cine file to the Flash memory.
NOTE
The AutoPlayback to Video option can be selected in conjunction with either the AutoSave
to Flash, or Continuous Recording to Flash options.
CAUTION
Before using the AutoPlayback to Video option ensure all Setup and Recording parameters
are configured to meet your imaging requirements, and the video monitor is connected to
the camera.
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Enable the AutoPlayback to Video option.
a. Click on the Flash Mem... button to open the Flash Memory dialogue.
1) Enable, (check), the AutoPlayback to Video enable box.

Continuous Recording to Flash Memory
The non-volatile Flash memory can be used in Continuous Recording mode. When Continuous
recording is enabled in the non-volatile Flash mem... control box the camera will automatically
save cine files to Flash after recording. No operator input is required for the save, making this
procedure ideal for remote camera operation.

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

181

CAUTION
Before using the Continuous Recording to Flash option you must first set all operating
parameters in the Setup & Recording screen.
NOTE
The AutoPlayback to Video option can be used in conjunction with the Continuous
Recording to Flash option.
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define the Continuous Recording to Non-Volatile Flash Memory parameters.
a. Click the Flash Mem... button.
b. In the Flash Memory dialogue window:
1) Specify the image range to be saved to Flash.
a) Enter the image number of the first image to be saved in the First field.
b) Enter the number of images to be saved in the Count field.
2) If you want the recorded cine file to automatically be displayed on an attached video
monitor enable, (check), the AutoPlayback to Video enable box.
3) Click on the enable box labeled "Continuous recording to flash" to enable, (check), this
box.
c. If a cine file is residing in the camera's DRAM, you will be presented with an alert box
asking if you would like to save the file to the flash memory?, if not go to the NOTE
below.
1) If do not wish to save the recording cine jump to the NOTE below.
2) If you wish to save the recorded cine continue with the next step.
a) Click the Yes button to save the recorded cine.
d. In the Flash Memory dialogue window click the Close button.
e. In the Setup and Recording Window click the Capture button.
f. In the Record New Cine dialogue window, click the "Delete cine(s) and start new
recording" button to start capturing images to the cameras DRAM buffer immediately.
NOTE
After selecting to use the Continuous Recording to Flash option, a dialog at the bottom
right of the monitor display will inform you that the camera is now in the "Preview
Recording Cine n ... Waiting for Trigger" mode. The Capture led indicator on the rear of the
camera will be on steadily (not flashing) to notify you that it is capturing images and is
waiting for a trigger signal.
The camera is now ready for operation and the Phantom Control Unit can now be
disconnected from the IEEE 1394 or Ethernet connection if desired.
g. Apply a Trigger signal.
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NOTE
A hard trigger applied through the trigger connection will now cause the camera to record a
cine into camera DRAM, then automatically download the file from camera DRAM to nonvolatile Flash memory. The camera will automatically go back into the "Preview Recording
cine n ... Waiting for Trigger [ Continuous recording to Flash ] state and wait for the next
trigger to repeat the process. The number of cine files you are able record using this
procedure is limited by the size of your non-volatile Flash memory module.
h. To end the Continuous Recording to Flash session:
1) In the Setup and Recording Window, click the Flash mem... button.
2) In the Flash Memory dialogue window:
a) Disable (uncheck) the Continuous Recording to Flash enable box.
b) Click the Close button.
NOTE
The camera can only communicate with one controller or storage device at a time, and this
is the reason the camera requires "hard" external triggers for this procedure. The camera
will function as described and continue to save images to Flash memory with no problems
and without user intervention.
For example, a 512 MB flash module would store two 256MB cine files. Using this example,
the camera could record a maximum of three files with no user intervention. The first and
second files would be transferred to secure flash storage, and the third would be stored in
VOLATILE camera RAM, and subject to loss in the event of a power interruption.
TECH TIP
You should run through a few tests to familiarize yourself with the process before using
this feature on an important assignment, especially one that will require multiple cine
recordings. It is helpful to check the total time needed by the camera for recording and
saving the file to non-volatile Flash memory before it is ready to accept the next trigger.
During the time, the camera is recording and saving a file the Capture led will flash, and
attempting to trigger the camera before it is reset and waiting for the next trigger (indicated
by a continuously illuminated Capture led) will result in lost data.

Viewing a Cine File Stored in Flash Memory
To view or save cine files stored in non-volatile Flash memory:
1. Open the ViewCine playback display window.
2. Click the Camera radio button located in the Cine Source fields.
3. Click the down-arrow to the right of the Cine# field, and select the cine #, stored in flash, to
be viewed. The file stored in non-volatile flash will be indicated by the letter “F” preceding
the cine file count, i.e., F1.
4. Edit the selected cine file.
5. If the camera is an:
a. Ethernet camera model, click the Save button to save the selected cine, or an
b. IEEE 1394 camera model, press Flash Mem button and then Restore. The system will

© 2015 Vision Research - AMETEK Material Analysis Division

Phantom Camera Control Software - Help

183

display an alert if there is a cine residing in camera RAM.
4.2.3.19 Update the Configuration Settings
You only need to perform an update to the newly defined parameter when you type in any of the
setup parameters. If you specified a parameter using one of the user friendly pull-down selection
windows, you do not need to perform an Update.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define all the desired capture settings and Setup and Recording Options.
5. Update the newly defined configuration:
a. Click on the Update button.
4.2.3.20 Save the Setup and Recording Configuration Settings
Used to save the setup screen settings to a setup file for recall at a later date. All setup files saved to
the hard drive can be recalled from the drive by using the Open button.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Define all the desired capture settings and Setup and Recording Options.
5. Update the newly defined configuration.
6. Save the Setup and Recording parameters:
a. Click on the Save button.
b. In the Save Camera Setting dialogue window:
1) Specify the destination directory (folder) where the configuration file or files are to be saved.
2) Click the down-arrow to the right of the Save as type field.
3) From the pull-down selection list select the Setup Files (*.STP) option.
4) Specify the Filename.
5) Append the extension .stp to the end of the filename.

NOTE
You must append the extension .stp to the end of the file name, i.e., set up example.stp. The
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system will not save your configuration file, unless you add the .stp extension.
c. Click the Save button.
d. Click the No button if the Save to camera window prompts you to "Save the settings and the
new calibrations to the camera nonvolatile memory?".
4.2.3.21 Place the Phantom Camera into Capture Mode
The Capture button, when selected, will place the camera into the recording mode. When the
Capture button is clicked, images are continuously recorded in an endless loop to the cameras
DRAM until the camera has received one of the three different types of triggers. When the camera is
placed into the Capture mode the status bar, located in the lower left-hand corner of the Setup and
Recording Window, will display the following status message; “Preview Recording Cine n… Waiting
for trigger" indicating the camera is in the Capture mode.
When the camera is in the Waiting for Pre-trigger mode, pressing the Capture button provides a
"soft" pre-trigger signal to the camera instructing the camera to start capturing and recording images
to the storage buffer.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Ensure that all Setup and Recording parameters and options have been configured to meet your
recording requirement.
5. Update any newly defined configuration.
6. Save the Setup and Recording parameters.
7. Start the Capture process:
a. Click the Capture button in the Setup and Recording dialogue window.
1) If there is a cine recorded in the DRAM memory of the camera, the Record New Cine box
will appear:

2) Click the appropriate button:
a) Delete Cine(s) and Start New Recording.
This option will delete the cine file stored in the cameras DRAM and start recording, or
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writing new images into the camera's memory.
b) Delete Cine(s) and Wait pre-trigger.
Selecting this option will delete the cine file stored in the camera's DRAM and place the
cameras into the idle state. No new images will be written into the camera's memory until
the camera receives a Pre-Trigger signal or the Capture button, in the Setup and
Recording Window is clicked.
c) Ignore the Capture Command.
Choosing this option informs the camera that you do not wish to delete the cine file
presently stored in the camera's DRAM and remain in whatever operational state it is
presently in.
b. Gently tap the Record indicator on the "touch-sensitive" LCD screen on a Phantom Miro eX1,
Miro 1, Miro eX2, Miro 2, Miro eX4, or Miro 4 camera, or
c. Depress the Trigger button on the Phantom 65 or HD camera.
4.2.3.22 Trigger the Phantom Camera
Triggering a camera can be accomplished either by applying a "soft" trigger or "hard" trigger to the
camera. Upon detection of the Trigger signal the camera will stop recording images into the cameras
DRAM immediately, unless otherwise configured to capture a user specified number of Post Trigger
frames.

STEP-BY-STEP PROCEDURE
1. Start the Phantom (Legacy) Camera Control Software.
2. Open the Acquisition pull-down menu.
3. Select the Setup and Recording... command from the Acquisition menu.
4. Ensure that all Setup and Recording parameters and options have been configured to meet your
recording requirement.
5. Update any newly defined configuration.
6. Save the Setup and Recording parameters.
7. Start the Capture process.
8. Trigger the camera:
a. Apply a "soft" trigger by:
1) Clicking the Trigger button in the Setup and Recording Window, then
2) Depressing the Alt+T keys simultaneously.
3) Gently tapping the Trigger indicator on the "touch-sensitive" LCD screen on a Phantom Miro
eX1, Miro 1, Miro eX2, Miro2, Miro eX4 or Miro 4 cameras.
NOTE
You should never use a "soft-trigger" when in a synchronized camera network environment.
b. To apply a "hard" trigger to the BNC connector marked Trigger on the 19-Pin Capture
breakout cable attached to the rear panel of the camera by providing a:
1) Dry switch closure:
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1) Use of a pickle switch all cameras.
2) Depressing the Power On/Trigger button on a Phantom Miro eX1, Miro 1, Miro eX2,
Miro2, Miro eX4 or Miro 4 camera.
3) Depressing the Trigger button on a Phantom 65 or HD camera.
2) Alternately, applying a Low TTL pulse signal.

4.2.4

ViewCine Procedures
The following is the generic steps to utilize the Playback, Image Processing, and Measurement
Analysis features associated with the Phantom Camera Control ViewCine Window:
1. Open a Cine File or Image File
Multiple methods can be used to open file(s), including:
a. From the Setup and Recording Window.
b. From the ViewCine Window.
c. From the Phantom Camera Control Software Main screen.
2. Perform a Quick Search Through a Cine File (optional)
Learning how to perform a Quick Search through a cine file will greatly reduce your postproduction time when editing a cine file.
3. Edit the Cine File
Many recorded cine files contain a lot of unnecessary information both before and after the actual
point of interest. Editing the cine will create smaller files, reduce the save times, and make cine
playbacks more interesting.
4. Perform Image Processing Adjustments (optional)
Image processing is performed on the entire cine once the desired effect has been specified.
You can apply image processing in the Setup and Recording Window>Im. Proc..., in the
ViewCine Window>Image Processing windows, or when performing a Convert&Process
procedure.
The cine recorded in the camera, or a cine file saved in the Cine RAW format, will not be affected
by this process. The RAW format keeps the original images and also remembers the values of
the image processing parameters and applies them in the view mode. Other saved formats
include the image processing and lose the original.
5. Save the Cine File
There are several ways to save the image data stored in the selected cameras RAM to a
specified destination. These methods of saving files include:
a. Saving a cine file.
b. Saving an image file.
c. Saving all cine files from the RAM of all cameras.
d. Saving all cine files from the RAM of the selected camera.
e. Saving all cine files from the Flash of the selected camera.
6. Convert&Process Cine to a Desired Format (optional)
You will need to perform this step if you want to compress the original cine file(s) using a variety
of video compression algorithms, expand previously compressed cine files, convert cine files to
any of the supported file formats, and/or convert cine files to a series of still images. Conversion
process includes:
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a. Converting a Cine File to Another Supported File Format.
b. Converting Multiple Cine File to Still Images.
c. Merging a Series of Still Images Into a Cine File.
d. Compressing a Cine File.
e. Expanding a Compressed Cine File.
7. Perform Measurement Analysis (optional).
The Measurement Menu, (used to perform a measurement on a single image), and the Measure
button, (used to perform measurements on an open cine), in the ViewCine window opens a
toolbox of motion analysis functions. You can use these motion analysis tools to quantify just a
few key measurements quickly, or to conduct a thorough analysis of the motion. Report files can
be constructed simultaneously, so when you're finished measuring, your report is finished too.
From this menu, you can find dimensions, population, speed, distance, acceleration, position,
and displacement. You can also measure angles and angular rotation.
Measurement functions may be applied to both single images and cine files. Certain
measurements such as those for speed and acceleration can only be applied to cine files.
NOTE
Single images extracted from cine files do not contain the timing information needed to
compute speed). While working with the various measurement features in the Phantom
software, refer to the lower left corner of the playback view window. The status bar will provide
prompts for the actions required.
Acceleration, speed, and point position files can be created with the collect point's function.
These files can be imported onto LOTUS 1-2-3 , Microsoft Excel or other spreadsheets for final
presentations or graphics for detailed reports.
4.2.4.1

Opening a Cine File
There are several methods to open a cine file. The following describes the steps required for these
various methods.

STEP-BY-STEP PROCEDURES
Via the Setup and Recording Window
In method will allow you to playback, edit, or perform measurement analysis on a cine file stored
in the cameras DRAM.
After the recording process has completed, simply click the OK button in the Setup and Record
dialogue window to open and display the cine captured and recorded in the cameras DRAM.

Via the ViewCine Window
By default the ViewCine window will display the cine file stored in the selected cameras DRAM.
You can instruct the application to open a previously saved cine file and, if you so desire to, and
switch back-and-forth between the cine file you open and the cine file stored in the camera's
DRAM.
1. To open a previously saved cine file:
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a. Click on the Cine Source>File>Open button.
b. When the Open Cine File dialogue window displays:
1) Navigate to the destination folder.
2) Select the cine file to be opened.
3) Click the open button.
1. To switch back to the file stored in the cameras DRAM:
a. Click the Cine Source>Camera radio button.

Via the Phantom Camera Control Software Main Screen
This method also allows you to specified a previously saved cine file to open in the ViewCine
window.
1. To open a previously saved cine file:
a. Click on the File>Open Cine option.
b. When the Open Cine File dialogue window displays:
1) Navigate to the destination folder.
2) Select the cine file to be opened.
3) Click the open button.

Via CompactFlash Card Reader (Phantom Miro ex1, Miro 1, Miro eX2, Miro 2, Miro
eX4, Miro 4 , or Miro Airborne)
This method can be used to view cine files, using the Phantom Camera Control software, stored
on a Phantom Miro eX1 Miro 1, Miro eX2, Miro 2, Miro eX4, Miro 4, or Miro Airborne
CompactFlash Card.
1. Remove the CompactFlash Card from the Phantom Miro camera.
2. Insert the CompactFlash Card into the CompactFlash Card reader.
3. Attach CompactFlash reader to the Phantom Control Unit computer.
4. Open File:
a. Via Phantom Camera Control software.
1) Start the Phantom Camera Control application.
NOTE
If no Phantom cameras are connected to the control unit, click the OK button in the
following warning message window. This will put the software into Demonstration Mode.
2) Click on the File>Open Cine option.
3) When the Open Cine File dialogue window displays:
a) Navigate to the CompactFlash drive.
b) Select the cine file to be opened.
c) Click the open button.
b. Via Phantom Control Unit Desktop:
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1) Right-mouse click on the My Computer Icon, or click Start>My Computer.
2) Double-click the CompactFlash Card Reader Drive.
3) Right-Mouse click on the cine file to be open.
a) Select the Open with command in the pop-up window.
b) In the Open With dialogue window:
i. Locate and highlight "Control program for Phantom cameras.
ii. Click the OK button.

Via Phantom Video Player on an External Monitor or LCD Display
This method can be used to open cine files stored in the:
· Phantom camera DRAM.
· Phantom camera internal Flash memory.
· Phantom Miro eX1, Miro , Miro eX2, Miro 2, Miro eX4 or Miro 4 CompactFlash Card.
· Phantom CineMag.
For Step-by-Step procedure click the following link: Phantom Video Player - Help>Using the
Phantom Video Player.
4.2.4.2

Opening an Image File
There are several methods to open an image file. The following describes the steps required for
these various methods.

STEP-BY-STEP PROCEDURES
Via the Setup and Recording Window
Using the following method creates or opens an image file, of the image being displayed in the
Preview Panel, the moment the Display button is selected. The image you have just chosen to
create an image file of can be viewed in the Phantom Control Software Main Screen display.
You can view, perform image processing adjustments, or perform measurement analysis on the
image file.
1. To open or create an image file:
a. Click the Display button.
b. Close the Setup and Recording Window by clicking the OK button.
c. Close the ViewCine Window if open by clicking the Close button.

Via the ViewCine Window
The ViewCine Window uses the same technique used in the Setup and Recording Window to
open an image file.
1. To open or create an image file:
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a. Click the Display button.
b. Close the ViewCine Window if open by clicking the Close button.

Via the Phantom Camera Control Software Main Screen
There are two methods to open an image file via the Phantom Camera Control Software Main
Screen:
Opening a Specified Image from an Open Cine File
1. Open the cine file with the image to be extracted as an image file.
2. When the ViewCine playback window opens, click the Close button.
3. From the View menu select the Single Image command.
4. Enter the desired image number into the Image Number entry field.
5. Click the OK button.
NOTE
This method will be only available when a cine file has been opened and the ViewCine
Window has been closed without closing the cine file via the File Menu>Close Cine
command.

Opening a Previously Saved Image File
1. To open a previously saved cine file:
a. Click on the File>Open Image option.
b. When the Open Image File dialogue window displays:
1) Navigate to the destination folder.
2) Select the image file to be opened.
3) Click the open button.
4.2.4.3

Performing a Quick Search Through a Cine File
As mentioned earlier in this file, performing a Quick Search through a cine file will greatly reduce your
post-production time when editing a cine file.

STEP-BY-STEP PROCEDURE
1. Open a Cine File.
2. Perform a Quick Search.
There are two methods that can be used to perform a quick search:
a. Click anywhere on the red area in the Cine Editor Bar. Each click will create a jump to that
section of the recorded cine, alternately
b. Enter the number of the image you want to go to in the Im, (image), field, located just below
the Cine Editor Bar, then press Pause button.
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NOTE
The cine will jump to that image and display it in the playback panel using either method.
4.2.4.4

Editing the Cine File
Many recorded cine files contain a lot of unnecessary information both before and after the actual
motion of interest. The cine editor Bar is used to edit unnecessary images from the beginning and the
end of the recorded cine prior to saving the cine to the hard drive. Editing the cine will create smaller
files, reduce the save times, and make cine playbacks more interesting.

STEP-BY-STEP PROCEDURES
Initial Cine Edit
1. Open a Cine File.
2. Edit the Cine File.
a. In the ViewCine Window:
1) Advance the cine file to the first image you desire to save for the cine clip via the
Playback buttons, by performing a Quick Search or by entering the image number you
want to go to in the Image field, and press Pause button.
2) Press the Pause button.
3) Click the Mark In button.
4) Advance the cine forward until you reach the last image of the cine you wish to save of
the cine clip.
5) Press the Pause button.
6) Click the Mark Out button.
NOTE
The red area in the Cine Editor Bar represents the clip. The number displayed at the left end
of the Cine Editor Bar refers to the first image in the entire cine sequence. The number at
the right end of the bar refers to the last image in the entire cine sequence. The numbers in
a parenthesis are the first and last image numbers in the cine clip.
Frame number zero in the Playback screen Image box and Cine Editor bar always refers to
the moment in time when the trigger was received by the camera regardless of what sample
rate or resolution settings were defined at in the Setup screen. All negative numbers
represent Pre-trigger frames and all positive numbers represent Post Trigger frames. The
total number of Post Trigger frames is the value entered in the Setup and Recording screen.
For convenience, the cine clip information will be exported to the Save As Cine dialog box
automatically.

Review the Edited Cine
1. Enable, (check), the Limit to Range feature.
2. Click the R(ewind) button.
3. Play the edited cine file using the playback buttons.

© 2015 Vision Research - AMETEK Material Analysis Division

192

Phantom Camera Control Help File

4. If edit is correct, save the edited cine file, if not re-edit the cine file.

Re-Editing the Cine
If you need to re-edit the cine file:
1. Disable, (uncheck), the Limit to Range feature.
2. Click the R(ewind) button.
3. Advance the cine file to the first image you desire to save for the cine clip via the Playback
buttons, by performing a Quick Search or by entering the image number you want to go to
in the Image field, and press Pause button.
4. Press the Pause button.
5. Click the Mark In button.
6. Advance the cine forward until you reach the last image of the cine you wish to save of the
cine clip.
7. Press the Pause button.
8. Click the Mark Out button.
9. Review the new edit.
4.2.4.5

Saving Files
There are several ways to save the image data. Although these methods will be very similar there
are some minor differences in the processes.

STEP-BY-STEP PROCEDURES
Saving a Cine File
To save a captured cine file that has been recorded into the camera's memory buffer to your
system's hard drive, a networked drive, or to some peripheral device:
1. Edit the Cine File (optional).
2. Perform Image Processing Adjustments (optional).
3. Save the Cine File.
There are two ways you can Save the cine file, one is from the ViewCine Window, the other
is from the Main Screen File Menu.
a. To save the cine using the Main Screen File Menu:
1) Close the ViewCine Window.
2) Select Save As command from the Main Screen File menu.
3) Go to Step 3c.
b. To save the cine without exiting the ViewCine Window:
1) Click the Cine Source>Save button.
c. In the Save Cine dialogue window:
1) Navigate to the destination drive and directory (folder).
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2) Enter the filename in the File name field, (the system will automatically add the
appropriate filename extension for you).
3) Click the down-arrow next to the Save as type field.
4) Select the file format, from the pull-down list, you want the file to be saved as; for a
description of the various formats, click the following link: Functional
Descriptions>Supported File Formats.
TECH TIP
Vision Research recommends that you save the cine file in the Cine RAW format.
NOTE
The software allows the user select how much of the original cine will be saved to the cine
file. Each image in the cine is numbered with the number displayed in the Image box on the
playback screen. Discarding images that contain non-useful information allows smaller
files, maximizes the use of space on the hard drive, and creates a more interesting cine for
viewing.
5) If you have not edited the cine file using the Playbar feature, you can edit the cine file
by defining the Range of Images to Save.
a) Enter the number of the First Image in the sequence you want to save.
For example, the event begins at image number 72 in the cine just recorded. By
entering 72, all images recorded prior to image 72 will be discarded and will not be
saved to this file.
b) Enter the Image Count representing the total number of images to be saved in this
cine.
For example, the event that begins at the image number 72 and ends at image 171,
enter 100 to discard all images after 171.
6) Define the desired Save Options:
a) Enable 16 bpp.
This feature will automatically be enabled, (checked), when the Bit Depth (ADC:n)
options are set to RAM greater than 8-bits, and the Save option is set to Same.
b) Split Quarters - Presently disabled.
c) Check the XML header file enable box to obtain, along with the cine or image files,
an XML file describing the header information in XML language. You can open this
XML file afterwards by a double-click on the file name in Windows Explorer. The
XML file can be a source of data for other applications.
d) Define the Advance Options.
i. Select the desired Color Interpolation Algorithm; for a description of the Color
Interpolation Algorithm feature, click the following link: Step-by-Step
Processes>Setup and Recording Processes>Define Image Processing
Effects>Select the Color Interpolation Algorithm.
NOTE
Once you selected a color interpolation algorithm and saved cine file in a non-raw,
interpolated format you cannot apply another algorithm on the same saved cine by saving it
again. In this case, the algorithm's options will be ignored.
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e) Click the Border Data button and select the information you want to be added to the
cine or to the image, specified in the Border data dialogue window. Depending on the
type of Outside Image information you choose, the cine or images will get a border
containing the data selected by you. Click the following link for the process to Add
Border Data: Step-by-Step Processes>ViewCine Procedures>Adding Border Data.
f) Specify the Lossy Compression Quality. (This option is only available when saving as
a Cine JPEG, LEAD, LEAD JFIF, LEAD JTIF, JPEG, or JTIF file type.)
g) Click the Multi-Head Options button (Phantom v6 Series camera models only).
When saving cine files from a Phantom v6 camera the system will, by default, save the
images from all four imaging heads into a single cine file.
i. To save a unique cine file for each of the Phantom v6 imaging heads:
· Select the camera Head or Heads to save in the Multihead Options dialogue
window.
· Click the OK button.
7) Click the Save button to save the cine file.
NOTE
To convert a cine file, select Convert&Process cine from the File menu. In the Open Cine
window, choose the cine file you wish to convert, check the properties of the cine by
pressing the Cine Info button and then press Open. Proceed now the same way as when
saving a cine file.

Saving an Image File
To save an image to your system's hard drive, a networked drive or to some peripheral drive:
1. Open a Image File.
There are two ways an image file can be opened:
a. Click the Display button in either the Setup and Recording or ViewCine dialogue
windows to create an IMG.bmp file of the image displayed in either the Preview or
Playback windows, alternately
b. Open a previously saved image file via the File>Open>Image command.
TECH TIP
Vision Research recommends that you create a duplicate image prior to performing any
image processing adjustments to an image. This will insure that the original image is not
changed or modified in any way.
2. Duplicate the Image File:
a. Select Duplicate Image from the Edit menu.
3. Perform Image Processing Adjustments (optional):
a. Click on the Image menu.
1) Select the Image Processing command.
2) Apply the desired Image Processing Effects; for details on each of the possible effects
click the following link: Functional Descriptions>Image Processing Effects and Filters.
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3) Click the OK button.
4. Save the Image File:
a. Select Save As from the File menu.
1) Select the Image option from the pull-down selection list to save the active image
displayed in the Phantom Camera Control main screen.
b. In the Save Image dialogue window:
1) Navigate to the destination drive and directory (folder).
2) Enter the filename in the File name field, (the system will automatically add the
appropriate filename extension for you).
3) Click the down-arrow next to the Save as type field.
a) Select the file format, from the pull-down list, you want the file to be saved as; for a
description of the various formats, click the following link: Functional
Descriptions>Supported File Formats.
4) Click the Save button to save the image file.

Saving All Cine Files from the RAM of the Selected Camera
This following process allows a user to save all the cine files that are stored in the selected
cameras RAM. This option is used in conjunction with the MultiCine feature.
1. Save the Cine Files.
Once the camera has been triggered, and the cine file has been recorded into the memory
buffer:
a. Click the All cine files from the RAM of the selected camera... option located under the
File>Save As command.
b. Click on the Saving a Cine File process described earlier.
RESULT: The Phantom Camera Control software will save the cine files from each of the memory
segments, of the selected camera, with the specified file name along with an appended extension
(Cine#) for each of the cine files.

Saving All Cine Files from the Flash of the Selected Camera
This following process allows a user to save all the cine files that are stored in the selected
camera's non-volatile Flash memory. This option can be used in conjunction with the MultiCine
feature.
1. Save the Cine Files.
Once the camera has been triggered, and the cine file or files have been recorded into the
Flash memory:
a. Click the All cines from the Flash of the selected camera... option located under the
File>Save As command.
b. Click on the Saving a Cine File process described earlier.
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Manually Saving Cine Images Stored in Camera RAM to Flash Memory
For a detailed step-by-step process click on the following link: Step-by-Step Processes>Setup
and Recording Processes>Using Flash Memory>Manually Saving Cine Images Stored in
Camera RAM to Flash Memory.
4.2.4.6

Adding Border Data
Whenever you Save or Convert&Process cine files you can display additional image related
information that will be displayed, with the images, when viewed by either the ViewCine Window, an
Image Display Window, or a third party application that supports the saved format. This topic will
describe the procedures to add Border Data effectively.

NOTE
This border data can be removed via a Remove button when you execute a Convert&Process
operation on the file.

STEP-BY-STEP PROCEDURE
Accessing the Border Data Dialogue Window
The Border Data dialogue window is accessible in the Save Cine dialogue window.
1. Press Border Data button.
2. Determine if the information is to be displayed:
a. Outside the image, in a border, alternately
b. Inside, in the lower left-hand corner of the image(s) being displayed.
3. Select the information you want to be added to the cine or to the image, specified in the
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Border data dialogue window.
NOTE
The information displayed inside the image cannot be removed.

BORDER DATA DESCRIPTIONS
Outside Image
None - When selected the user may specify the Inside Image options.
Standard - When selected the user may define the following Common Options, and Optional
Lines, that will be displayed just below the recorded cine, along with any Inside Image
information fields specified:
Common Options
Font Size - Specifies the font size the information will be displayed at.
Optional Lines
Time Format - Indicates the type of time stamp information to be displayed, including:
No time stamp - When selected no time stamp information will be displayed.
Absolute Time - When selected the date and time, down to the micro-second), the image
was recorded is displayed.
From Trigger - When selected the time difference from when the image being displayed
was recorded and the moment the camera was triggered will be displayed.
From Image 0 - When selected the time difference from when the image being displayed
was recorded and the moment the first full image after a trigger was recorded will be
displayed.
From First Image - When selected the time difference from when the image being displayed
was recorded and the moment the first image of the cine was recorded will be displayed.
File Name -Displays the name of the file specified during the save process.
Image Number - Specifies the number of the image, starting with the first image in the cine.
Image Number From Zero - Specifies the number of the image, starting with the first image in
the cine, after the trigger.
Camera Version - Indicates the camera model or CineStation used to record the cine.
Acquired Resolution - Displays the width x height the cine was recorded at.
Rate - Indicates the Frame Rate setting at the time the images were recorded.
Exposure - Indicates the exposure setting for the image being displayed.
EDR Exposure - Indicates the Extreme Dynamic Range Exposure time setting at the time the
images were recorded.
First and Last Image - Indicates the first and last image number of the images contained
within the edited cine file.
Duration - Indicates the duration of the file.
Signals
Displays the values of all signals for each frame, captured via an attached Data Acquisition
Unit.
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Range Data - Displays range data information supplied by a tracking mount system to the
camera via the Range Data connector.
Description - Indicates the information entered into the Description field in the Setup and
Recording window of Phantom Camera Control software.
NOTE
All the optional lines, if selected, will also be displayed below the cine.
Military - When selected the user may define the following Outside Image fields, that will be
displayed outside the recorded cine area, along with the Common Options, and Optional Lines,
described above, and any Inside Image information selected.
Header - This editable field will be displayed just above the recorded cine.
Footer - This editable field will be displayed just below the recorded cine.
NOTE
All the optional lines, if selected, will also be displayed to the right of the cine.
Car Engine - When selected the user may define the following Outside Image fields, that will be
displayed outside and below the recorded cine area, along with the Common Options, and
Optional Lines, described above, and any Inside Image information selected.
Engine Speed
Spark
Spark Crank Angle
Reset Angle (deg)
Cyl. Pressure (bar)
Text
NOTE
All the optional lines, if selected, will be displayed above the cine.

Inside Image
Time Stamp - Where each image is tagged with the absolute date and time the image was
recorded. Enabling this option will display the time stamp information when the file is played
back.
From Trigger - When this option is selected the exact time the image was recorded from the time
the trigger input was detected will be displayed.
Draw Signals - When available the user can define which analog signal sample information will
be displayed in the corners of each image, up to four signals, (only available if the cine file was
captured using an attached Data Acquisition Unit and SAM-3 for signal Acquisitions).
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Saving in Packed Cine Raw Format
Cine files stored on a Phantom CineMag can be saved in Packed Cine Raw format.

STEP-BY-STEP PROCEDURE
1. From the ViewCine dialogue window:
a. Select a cine from the Phantom CineMag.
b. Click the Save button.
1) Enable, (check) the Packed option to save the cine in a packed format.
NOTE
When you playback a Packed Cine Raw file, the CineInfo will display the BitDepth value with a
“p” added, (for example, 16/ used 10p).
In order to get a cine file compatible with previous versions of the software or to use the cine
in another software package, leave the Packed option unchecked.
When you open a Packed Cine Raw file, you can use the Convert command to save an edited,
and still packed cine file. You cannot convert a Packed Cine Raw file into a different format.
4.2.4.8

Converting Cine Files
CAUTION
Saving a newly recorded movie as any other format than the cine format will lose all setup and
timing data. For this reason Vision Research recommends saving the cine file using the Save
As command first, then use the Convert&Process Cine... function to create a movie in another
format from the saved cine. In this manner, all setup and timing information is retained in the
original cine file and can be easily accessed in the future.
There are several ways to save the recorded image data. Although these methods will be very
similar, there are some minor differences in the processes as we will describe here.

STEP-BY-STEP PROCEDURES
Converting a Single Cine File Into Another Supported File Format
1. Open the Cine File to be Converted.
There are three methods of opening the cine file to be converted, including:
a. From the Main dialogue window.
1) Click the File menu.
2) Select the Convert&Process Cine... command.
3) Go to Step 1c.
b. From the ViewCine window:
1) Click the Open button in the Cine Source box.
2) Go to Step 1c.
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c. In the Open Cine dialogue window:
1) Navigate to the source drive and directory, (folder), containing the cine file to be
converted.
2) Click on the cine file(s) to be converted.
3) Click the Open button.
2. Convert the Cine File.
In the Save Cine dialogue window:
a. Navigate to the destination drive and directory (folder).
b. Enter the filename in the File name field, (the system will automatically add the appropriate
filename extension for you when you select the Save as type).
NOTE
When converting to one of the supported image formats, you will need to append from 1 to
8 digits to the filename. For details on how to do this click the following link: Functional
Descriptions>Phantom File Naming Convention.
c. Click the down-arrow next to the Save as type field.
d. Select the file format, from the pull-down list, you want the file to be saved as; for a
description of the various formats, click the following link: Functional
Descriptions>Supported File Formats.
NOTE
If converting to one of the supported image formats the are a few items to consider:
· You will need to know the bit-depth the cine file being converted was saved at if you wish
to retain the same bit-depth during the conversion process. Many of the image formats
have more than one bit-depth choice, for example, here is a TIFF 1 image, TIFF 8,24
image, TIFF 12,36 image, and a TIFF 16,48 image format. If you select the TIFF 1 image
format, the image created during the conversion process will be 1-bit image depth
resulting in each image being photocopy, black and white. If a TIFF 8,24 image format is
selected, the resulting images will be 8-bit image depth, 8-bit for monochrome images, or
if they are color images the conversion process requires 8-bits for red, 8-bits for green,
and 8-bits for blue, (24-bits).
· The conversion process cannot make an 8-bit image depth cine into a 10-, 12-, or 14-bit
image depth image. However, you can reduce the bit-depth if you so desire.
· The images created during the conversion process should be placed into their own
dedicated directory or folder.
The software allows the user select how much of the original cine will be saved to the cine file.
Each image in the cine is numbered with the number displayed in the Image box on the playback
screen. Discarding images that contain non-useful information allows smaller files, maximizes
the use of space on the hard drive, and creates a more interesting cine for viewing.
e. If you have not edited the cine file using the ViewCine window's Editor Bar, you can edit the
cine file by defining the Range of Images to Save:
1) Enter the number of the First Image in the sequence you want to save.
For example, the event begins at image number 72 in the cine just recorded. By entering
72, all images recorded prior to image 72 will be discarded and will not be saved to this
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file.
2) Enter the Image Count representing the total number of images to be saved in this cine.
For example, the event that begins at the image number 72 and ends at image 171,
enter 100 to discard all images after 171.
f. Define the desired Save Options
1) Enable 16 bpp - This feature will automatically be enabled, (checked), when the Bit
Depth (ADC:n) options are set to RAM greater than 8-bits, and the Save option is set to
Same.
2) Split Quarters - Presently disabled.
3) Check the XML header file enable box to obtain, along with the cine or image files, an
XML file describing the header information in XML language. You can open this XML file
afterwards by a double-click on the file name in Windows Explorer. The XML file can be
a source of data for other applications.
4) Define the Advance Options:
a) Select the desired Color Interpolation Algorithm; for a description of the Color
Interpolation Algorithm feature, click the following link: Functional Descriptions>Image
Processing Effects and Filters.
NOTE
Once you selected a color interpolation algorithm and saved cine file in a non-raw,
interpolated format you cannot apply another algorithm on the same saved cine by saving it
again. In this case, the algorithm's options will be ignored.
5) Click the Border Data button and select the information you want to be added to the cine
or to the image, specified in the Border data dialogue window. Depending on the type of
Outside Image information you choose, the cine or images will get a border containing
the data selected by you. Click the following link for the process to Add Border Data:
Step-by-Step Processes>ViewCine Procedures>Saving Files>Adding Border Data.
6) Specify the Lossy Compression Quality. (This option is only available when saving as a
Cine JPEG, LEAD, LEAD JFIF, LEAD JTIF, JPEG, or JTIF file type.)
7) Click the Multi-Head Options button, (Phantom v6 Series camera models only).
When saving cine files from a Phantom v6 camera the system will, by default, save the
images from all four imaging heads into a single cine file.
i. To save a unique cine file for each of the Phantom v6 imaging heads:
· Select the camera Head or Heads to save in the Multihead Options dialogue
window.
· Click the OK button.
g. Click the Save or Convert button to save the cine file.
h. If converting to the AVI format you will be asked to:
1) Specify the Frame Rate the converted file will play at.
2) Select a Video Compressor, CODEC to create the AVI file. Some Video Compressors
might not be available in some Windows configurations. If the CODEC used to convert
the file is not installed in the computer trying to view the converted cine the end user will
not be able to view the file. Some of the Video Compressors allow you to perform further
configurations. When one of these compressors is selected both the Configure and
About buttons will be enabled.
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3) Specify the Compression Quality.
4) Click the OK button.
NOTE
The original cine (.cine) files will remain unchanged.

Converting Multiple Cine Files to Still Images
Many third party imaging applications can import a series of individual images for use in the
image analysis process. This option provides a means to convert multiple cine files created with
Phantom cameras to any of the supported image formats such as .bmp, tif, .gif, etc. that will be
written to separate directory folders.
NOTE
If a third party imaging application requires a format that VRI does not currently support,
please contact us. In most cases, we can provide a conversion to the format needed at little
or no cost. The original cine (.cine) files will remain unchanged.
To convert multiple original cine files to a series of individual still images such as .bmp, .tif, .gif,
etc. into separate folders:
1. Open the Cine Files to be Converted
a. From the Main dialogue window:
1) Click the File menu.
2) Select the Convert&Process Cine... command.
b. In the Open Cine dialogue window:
1) Navigate to the source drive and directory, (folder), containing the cine files to be
converted.
2) Highlight the cine files to be converted.
3) Click the Open button.
2. Convert the Cine Files
a. In the Multifile Convert Destination dialogue window:
1) Navigate to the destination drive and directory, (folder).
2) Click the down-arrow next to the Save as type field.
3) Select the cine file format, from the pull-down list, you want the file to be saved as; for a
description of the various formats, click the following link: Functional
Descriptions>Supported File Formats.
NOTE
If converting to one of the supported image formats, there are a few items to consider:
· You will need to know the bit-depth the cine file being converted was saved at if you wish
to retain the same bit-depth during the conversion process. Many of the image formats
have more than one bit-depth choice, for example, here is a TIFF 1 image, TIFF 8,24
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image, TIFF 12,36 image, and a TIFF 16,48 image format. If you select the TIFF 1 image
format, the image created during the conversion process will be 1-bit image depth
resulting in each image being photocopy, black and white. If TIFF 8,24 image format is
selected, the resulting images will be 8-bit image depth, 8-bit for monochrome images, or
if they are color images the conversion process requires 8-bits for red, 8-bits for green,
and 8-bits for blue, (24-bits).
· The conversion process cannot make an 8-bit image depth cine into a 10-, 12-, or 14-bit
image depth image. However, you can reduce the bit-depth if you so desire.
4) In the File Name entry field enter the destination <drive letter>:\<destination
directory>\<special character><1 through8> the number of digits to append to the image
files being created.
For example: C:\Temp\+4
b. Define the desired Save Options
1) Enable 16 bpp - This feature will automatically be enabled, (checked), when the Bit
Depth (ADC:n) options are set to RAM greater than 8-bits, and the Save option is set to
Same.
2) Split Quarters - Presently disabled.
3) Check the XML header file enable box to obtain, along with the cine or image files, an
XML file describing the header information in XML language. You can open this XML file
afterwards by a double-click on the file name in Windows Explorer. The XML file can be
a source of data for other applications.
4) Define the Advance Options:
a) Select the desired Color Interpolation Algorithm; for a description of the Color
Interpolation Algorithm feature, click the following link: Functional Descriptions>Image
Processing Effects and Filters.
NOTE
Once you selected a color interpolation algorithm and saved cine file in a non-raw,
interpolated format you cannot apply another algorithm on the same saved cine by saving it
again. In this case, the algorithm's options will be ignored.
5) Click the Border Data button and select the information you want to be added to the cine
or to the image, specified in the Border data dialogue window. Depending on the type of
Outside Image information you choose, the cine or images will get a border containing
the data selected by you. Click the following link for the process to Add Border Data:
Step-by-Step Processes>ViewCine Procedures>Saving Files>Adding Border Data.
6) Specify the Lossy Compression Quality (This option is only available when saving as a
Cine JPEG, LEAD, LEAD JFIF, LEAD JTIF, JPEG, or JTIF file type.)
7) Click the Multi-Head Options button (Phantom v6 Series camera models only).
When saving cine files from a Phantom v6 camera the system will, by default, save the
images from all four imaging heads into a single cine file.
a) To save a unique cine file for each of the Phantom v6 imaging heads:
i. Select the camera Head or Heads to save in the Multihead Options dialogue
window.
ii. Click the OK button.
c. Click the Convert button to save the cine file.
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Merging a Series of Still Images Into a Cine File
CAUTION
The image file names must be sequentially numbered from first to last for the Phantom
application to merge the images to a cine file correctly . If they are not sequential they will
be merged in the order they are shown in the directory listing.
To merge a series of individual image files to the cine format:
1. From the Main Menu:
a. Click on the File Menu .
b. Select the Convert&Process Cine... option.
2. In the Open Image dialogue window:
a. Navigate to the directory with the image files to be merged.
b. Click on the first image file in the sequence once.
c. Click the Open button.
3. The system now prompts the user to specify whether or not to merge all image files (Yes) in
the directory to the new cine file, or only the images numbered in succession (No).
If you choose Yes, to merge all image files in the directory, the order of images in the new
cine file is not controlled.
a. Click the Yes button to proceed to the Merge and Resample Images dialog box.
4. In the Merge and Resample Images dialogue window:
a. Define the Merge and Resample Images dialog box parameters including:
1) All Files Count - Indicates the number of individual files in the directory to be merged.
2) Width & Height - Reports the dimensions of images in the selected directory.
3) BPP (Bits Per Pixel) - Reports the bit depth of the images in the directory, usually 8bpp
or 24bpp.
4) Output File Name (uncompressed cine) - Indicates where the path to the first image
being merged.
5) Clip - Allows the user to perform batch crop to all the images.
6) Resample - Specifies the width x height size of the file being created.
7) 8 bits per pixel (256 gray levels) - Select this option if the images being merged are to be
monochrome.
8) 24 bits per pixel (true color) - Select the image to maintain color values to the color
images being merged.
b. Click the OK button
5. If a header (.chd) file already exists within the specified directory the system prompts the user
to specify if the existing header file is to be used. This .chd file contains pertinent cine
information, such as the setting when recorded, timing information, etc.
a. Click Yes to include the data stored in the .chd file, alternately
b. No to disregard the data. The system will then create the new cine file.
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Expanding a Compressed Cine File
1. Open the Cine File to be Converted,
There are three methods of opening the cine file to be converted, including:
a. From the Main dialogue window:
1) Click the File menu.
2) Select the Convert&Process Cine... command.
3) Go to Step 1c.
b. From the ViewCine window:
1) Click the Open button in the Cine Source box.
2) Go to Step 1c.
c. In the Open Cine dialogue window:
1) Navigate to the source drive and directory, (folder), containing the cine file to be
converted.
2) Click on the cine file(s) to be converted.
3) Click the Open button.
2. Save the Cine File.
In the Save Cine dialogue window:
a. Navigate to the destination drive and directory (folder).
b. Enter the filename in the File name field, (the system will automatically add the appropriate
filename extension for you when you select the Save as type).
c. Click the down-arrow next to the Save as type field.
d. Select the Cine file format, from the pull-down list, you want the file to be saved as; for a
description of the various formats, click the following link: Functional
Descriptions>Supported File Formats.
The software allows the user select how much of the original cine will be saved to the cine
file. Each image in the cine is numbered with the number displayed in the Image box on the
playback screen. Discarding images that contain non-useful information allows smaller files,
maximizes the use of space on the hard drive, and creates a more interesting cine for
viewing.
e. If you have not edited the cine file using the ViewCine window's Editor Bar, you can edit the
cine file by defining the Range of Images to Save.
1) Enter the number of the First Image in the sequence you want to save.
For example, the event begins at image number 72 in the cine just recorded. By entering
72, all images recorded prior to image 72 will be discarded and will not be saved to this
file.
2) Enter the Image Count representing the total number of images to be saved in this cine.
For example, the event that begins at the image number 72 and ends at image 171,
enter 100 to discard all images after 171.
f. Define the desired Save Options
1) Enable 16 bpp - This feature will automatically be enabled, (checked), when the Bit
Depth (ADC:n) options are set to RAM greater than 8-bits, and the Save option is set to
Same.
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2) Split Quarters - Presently disabled.
3) Check the XML header file enable box to obtain, along with the cine or image files, an
XML file describing the header information in XML language. You can open this XML file
afterwards by a double-click on the file name in Windows Explorer. The XML file can be
a source of data for other applications.
4) Define the Advance Options:
a) Select the desired Color Interpolation Algorithm; for a description of the Color
Interpolation Algorithm feature, click the following link: Functional Descriptions>Image
Processing Effects and Filters.
NOTE
Once you selected a color interpolation algorithm and saved cine file in a non-raw,
interpolated format you cannot apply another algorithm on the same saved cine by saving it
again. In this case, the algorithm's options will be ignored.
5) Click the Border Data button and select the information you want to be added to the cine
or to the image, specified in the Border data dialogue window. Depending on the type of
Outside Image information you choose, the cine or images will get a border containing
the data selected by you. Click the following link for the process to Add Border Data:
Step-by-Step Processes>ViewCine Procedures>Saving Files>Adding Border Data.
6) Specify the Lossy Compression Quality (This option is only available when saving as a
Cine JPEG, LEAD, LEAD JFIF, LEAD JTIF, JPEG, or JTIF file type.)
7) Click the Multi-Head Options button (Phantom v6 Series camera models only).
When saving cine files from a Phantom v6 camera the system will, by default, save the
images from all four imaging heads into a single cine file.
a) To save a unique cine file for each of the Phantom v6 imaging heads:
i. Select the camera Head or Heads to save in the Multihead Options dialogue
window.
ii. Click the OK button.
g. Click the Convert button to save the cine file.
NOTE
The original cine (.cine) files will remain unchanged.

4.2.5

Measurement Analysis Procedures
The Measurement pull-down menu, in the main Phantom Camera Control window, is used to perform
analysis on an opened single image file, while the Measure button in the ViewCine playback window
is used to perform measurements on the opened cine file.
NOTE
The following steps must be performed prior to performing any analysis measurements;
· Define the Units of Measure
· Define the Measurement Scale
In this section, we will provide the steps to:
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· Define the Unit of Measurement. (Required)
· Define the Measurement Scale. (Required)
· Create/Open a Report File. (Optional)
· Set/Clear the Origin. (Dependent on the type of analysis being performed)
· Perform Coordinate Analysis.
· Perform Distance and Speed Dimension Analysis.
· Perform Angle and Angular Speed Analysis.
· Perform Collect Point Analysis.
4.2.5.1

Define the Units of Measurement

STEP-BY-STEP PROCEDURE
1. Open the cine or image file the measurement analysis being performed on.
2. Select the Units command to begin the motion analysis process by either:
a. Clicking on the Measure button in the View Cine playback window to set the unit of measure
for an opened cine file, alternately
b. Select the Units option from the pull-down selection window by selecting Measurement>Units
in the Phantom Camera Control main screen to define the unit of measure for a single image
file.
3. When the Set Units dialog box opens, select the desired unit of measurement for distance,
speed, acceleration, angle and angular speed. The user may choose either metric (SI) or US
units.

NOTE
Using the units selected, all co-ordinates and measurements will be displayed, with the
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specified unit of measure nomenclatures, in the status bar at the bottom of the ViewCine
playback window.
4. Select OK to accept the units designated, or click Cancel to exit without saving any changes.
4.2.5.2

Defining a Measurement Scale
Since cine files are typically recorded and viewed at some reduction in size to the original scene the
user must establish the reduction value or scale to measure actual distances, speeds, or
accelerations.

STEP-BY-STEP PROCEDURE
1. Select the Scaling function by clicking on the Measure button in the View Cine playback window
to set the scale for an entire cine file or select the Scaling option from the pop-up selection
window, by selecting Measurement>Scaling in the Phantom Camera Control main screen to set
the scale for a single image file.
2. When the Scaling dialog box appears, enter the Gauge Length. The gauge length is a known
dimension of any object or space in the image. It is always better to select a larger object in the
image for the gauge process. The gauge length must be entered in the same unit of
measurement selected using the Units command.

3. Click OK.
4. The status bar at the bottom left of the ViewCine playback window will prompt the user to click
one end of the object to be selected as the gauge. Click the point. Basically, what the system is
asking for is for the user to mark, on a known given scale, one end of the scale.
It may be necessary to use the Zoom function for accuracy.
5. Next, the status bar will prompt the to click the other end of the object. Click the point. This time
the system is asking the user to mark the opposite end of the known scale.
NOTE
The Phantom Camera Control software automatically applies this scale to the entire cine, and
to any single image extracted from the cine. Scaled dimensions are displayed in the status bar
at the bottom of the ViewCine playback window.
4.2.5.3

Create/Open a Report File
You can create a Report File to simultaneously create a data file as you measure position, distance,
speed, or angles that can be viewed in many text editors and word processor programs; some
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STEP-BY-STEP PROCEDURE
1. Select the Report File function by either clicking on the Measure button in the View Cine
playback window to perform analysis on the opened cine file, or select the Report File option
from the pop-up selection window by selecting Measurement>Report File in the Phantom
Camera Control main screen to perform measurements on an opened image file.

2. When the Setup for Measurement Report File dialog box opens, click Open File.
3. When the Open Report File dialog box appears, enter a file name for this new report; the file
extension is .rep.
NOTE
It is helpful to give this new report file the same name as the cine file that's being measured.
For example, crashtest.rep would be the report file for the cine crashtest.cin.
4. Check that the file is being saved in the correct directory and drive. Click Open to accept the new
file name and return to the Setup window, or click Cancel to return to the Setup window without
saving any changes.
5. When the - Setup for Measurement Report File dialog box re-appears, specify the following
information:
a. Query for comments
Check this box when you want to include a description or comment about each point as it’s
selected for measurement. This comment may be any description of your choice. Any
combination of letters numbers and spaces is allowed up to a maximum of 250 characters.
b. Include Collected Points
Check this box when you want your report to include the (x,y) coordinates for each point
selected when you use the Collect Points function.
c. Title
Enter the title of your report in this box. This may be any title, project name, test sequence, etc.
of your choice. Any combination of letters, numbers and spaces is allowed up to a maximum
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for 250 characters.
d. Analyst
Enter the name of the person or team that recorded the test.
e. Station
When recording a test with more than one camera, assign a position name and station number
to each camera. Enter that information in this box. For example: Overhead Camera, No.2
f. Camera
Enter the name and serial number of the camera used to record the test.
g. Lens
Enter information about the lens used to record the cine, such as, the focal length and f-stop
used to record the test.
6. Click OK to accept the new report file setup, or click Cancel to exit without saving any changes.
4.2.5.4

Setting/Clearing an Origin Point
By default the Phantom control software identifies the first pixel, located in the top left-hand corner of
the ViewCine playback window, as the origin point for all measurements. To measure position,
distance, displacement, speed or acceleration, a reference point must be established. Any point in
the image may be selected as the reference point or point of origin. Your choice of origin will be
largely dependent on the subject and the type of motion being studied. Once selected, the (x,y)
coordinates of (0,0) will automatically be assigned to that point for each image in the cine file.

STEP-BY-STEP PROCEDURE
1. There are several methods to select Set Origin function, including:
a. From the Phantom Camera Control main screen click the Measurement menu and select the
Set Origin option (applicable for an opened image file only).
b. Click on the Measure button, in the View Cine playback window, and select the Set Origin
option (cine only).
Place the cursor cross hair, into the View Cine Playback Panel, at the desired point-of-origin
and click the right mouse button and selects the Set Origin option from the popup selection
window (cine only).
2. For both methods in Step 1, the status bar will prompt the user to click a point of origin in the
image by moving the cursor cross hair to that point and click once.
3. Once the image displays the larger cross hair in the image, move the cursor to the move the
cursor on the position you want the origin to be and click once.
NOTE
The position of the coordinates axes may be reset by simply repeating the Set Origin
command. The default position for the point of origin (0, 0) is the top left corner of the image.
4. When you wish to remove the coordinate axes from the display, clear the current origin. Click the
Clear Origin option from the Measurement pull-down menu or the Measure pop-up window once
to reset the origin. This resets the point of origin to its default position at the top, left corner of the
image or cine file respectively.
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Coordinate Analysis
The Coordinates function is used to display the (x,y) coordinates of selected points in the image. The
coordinates are displayed in the status bar at the bottom of the ViewCine window. You can also use
the Coordinate function to count populations, for example, the quantity of shot in a shotgun round.
When using the Coordinates function with a report file opened the image number, point coordinates,
unit of measurement, and any comments are saved to the report file that is identified by the file
extension .rep. When using Coordinates function without opening a report file you can use the
Coordinates function without opening a report file whenever you want to measure just a few key
points in a cine file or image quickly. It will not be possible to attach comments and these
measurements will not be saved to a file.
NOTE
Before using this function, check that you have already assigned units of measurements, and
established a scale for your cine file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have completed
the report file setup.

STEP-BY-STEP PROCEDURE
1. Open the file the analysis measurements are to be performed on.
2. Select Coordinates function by either clicking on the Measure button in the View Cine playback
window and select the Coordinates option from the pop-up selection window to perform
measurements on an open cine file, or select the Measurement>Coordinates option from the
Phantom Camera Control main screen to perform measurements on an opened image file.
3. When the cursor appears on the image, the status bar will display the (x,y) coordinates of the
cursors current position. The coordinates are shown with respect to the point of Origin in the
Units of measurement defined.
Move the cursor to a point of interest and click once to select it. The coordinates of this selected
point will be displayed at the left edge of the status bar.
4. If the Query for Comments instruction was checked in the Report File Setup, the Comments
dialog box will appear as each point is selected. Enter the description or comment in the box.
Any combination of letters, numbers, or spaces up to 250 characters (approximately 40 words)
can be used.
5. After entering a comment, click OK to accept the comment, or Cancel to exit without saving a
comment.
6. Repeat the steps above until all additional points of interest for the current image have been
selected and measured.
7. Advance the View Cine playback screen to the next image and continue to select the appropriate
points of interest to be measured.
4.2.5.6

Distance and Speed Dimension Analysis
The Distance and Speed function measures the displacement and speed of linear motions, or you
can use this function to measure the dimensions of any object or spaces in the image.
Depending on the desired analysis you will need to select the appropriate Distance Measurement
option, either:
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1 point+origin
Check this option to measure the distance and speed of linear motions with respect to a fixed
point of origin.
2 points
Check this option to measure the dimensions of an object or space. Or, use this option to
measure displacement and speed of an object in one image with respect to its new position in
any subsequent image.
Distance and speed measurements are displayed in the status bar at the bottom of the ViewCine
window.
NOTE
Before using this function, check that you have already assigned units of measurements, and
established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have completed
the report file setup.
All Distance and Speed functions can be used in conjunction with a Report File or without. With a
report file opened, the image number, elapsed time from trigger, unit of measurement, distance (or
dimension) speed and any comments are automatically saved in the open report file. Report files are
saved are identified by the file extension .rep. You can use the Distance and Speed functions without
opening a report file whenever you want to measure just a few key points in a cine file or image
quickly. It will not be possible to attach comments and these measurements will not be saved to a
file.

STEP-BY-STEP PROCEDURES
Distance and Speed Measurement from a Fixed Origin
1. To measure the distance and speed of linear motions with respect to a fixed point of origin,
begin by selecting Set Origin from the Measurement menu.
2. Move the cursor to a point of origin in the image relevant to the motion being measured and
click once.
3. Next, select the Distance and Speed option from the Measurement menu.
4. When the Distance dialog box appears, check the option 1 point + origin.
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5. Click OK.
6. When the cursor appears in the image, the status bar will prompt you to select one point.
Move the cursor to the point to be measured and click once.
RESULT: The status bar will display the distance of the selected point to the point of origin as d=.
For example, d=2.625 in.
NOTE
You may want to use the zoom function to enlarge the image. This will aid in making your
point selections more accurate.
7. If you checked the Query for Comments instructions in the Report file Setup, the Comments
dialog box will appear now. Enter your description or comment in the box (approximately 40
words). Click OK to accept the command.
8. Repeat these steps until all additional distances for the current image have been measured.
Then advance the View screen to the next image to continue.
As subsequent images are measured, the status bar will also return speed measurements for
the selected points. Speed is displayed as s=. For example, s=240.555ips.

Displacement Measurements
1. Open the file the analysis measurements are to be performed on.
2. Select Distance and Speed function by either clicking on the Measure button in the View Cine
playback window and select the Distance and Speed option from the pop-up selection window
to perform measurements on the opened cine file, or select Measurement> Distance and
Speed in the Phantom Camera Control main screen to perform measurements on an opened
image file.
3. When the Distance dialog box appears, check the option box marked 2 points.

4. Click OK to return to the View window.
5. When the cursor appears in the image, the status bar will prompt you to select one end, (first
point), of the object to be measured. Move the cursor to that point and click once.
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NOTE
Using the zoom function to enlarge the image. This will aid in making your point selections
more accurate.
6. Advance the cine to any subsequent image either forward or reverse.
7. Next, the status bar will prompt you to select the other end, (second point), of the object.
Move the cursor to the beginning, (first point), position of the object and click once.
RESULT: The status bar will display the displacement as d= and the speed as s=. For example, d=
1.210 in and s= 29.512 in/s.
8. If the Query for Comments instruction was checked in the Report File Setup, the Comments
dialog box will appear as each point is selected.
Enter the description or comment in the box. Any combination of letters, numbers, or spaces
up to 250 characters (approximately 40 words) can be used.
9. Repeat these steps 6 to 10 until all additional measurements have been completed.
4.2.5.7

Angle and Angular Speed Measurements
Use the Angle and Angular Speed functions to measure angles and speed of rotational motions.
These measurements are displayed in the status bar at the bottom of the ViewCine window.
All Angle and Angular Speed analysis functions can be used in conjunction with a Report File or
without. With a report file opened, the image number, elapsed time from trigger, unit of
measurement, angle, angular speed, and any comments are automatically saved in the open report
file. Report files are saved to the current directory and are identified by the file extension .rep

STEP-BY-STEP PROCEDURES
One Point Angle and/or One Point Angular Speed Measurement
One Point measurements are used to measure the angle formed with respect to the x-axis (as
shown in the figure below), or the speed of a rotational motion (computed with respect to the
horizontal axis of the picture screen), when only one point is known.

NOTE
Before using this function, check that you have already assigned units of measurements,
and established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have
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completed the report file setup.
One Point Angle Measurement
1. Open the cine file the analysis measurements are to be performed on.
2. Begin by setting an Origin point.
3. Select Angle and Angular Speed from the Measurement menu to perform analysis on an
opened image file or click on the Measure button in the View window and select the Angle
and Angular Speed option to perform measurements on an open cine file.
4. When the Angle Measurements dialog box appears, check the option box marked 1
point+origin+axis, and then Click OK to return to the View Cine playback window.
5. The status bar will prompt you to select one end of the object to be measured. Move the
cursor to that point and click (Pt.1).
RESULT The status bar will display the angle as a=. For example, a= 0.000 deg.
6. If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
(approximately 40 words) can be used.
7. Repeat the steps until all additional angles for the current image have been measured.
One Point Angular Speed Measurement
8. To perform One Point Angular Speed Measurements, advance the View Cine playback
window screen to the next image by selecting the Play Singe Frame Forward button to
continue measuring angles.
All subsequent measurements will display the angle as a= and the speed as s=. For
example, a= -56.592 deg s= -125.760 rpm.
9. If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
(approximately 40 words) can be used.
10.Repeat Step 8 and 9 until all measurements have been completed.

Two Point Angle or Two Point Angular Speed Measurement
The angular speed is computed with respect to the horizontal axis of the picture screen. To
measure the speed of a rotational motion, when two points are known.

NOTE
Before using this function, check that you have already assigned units of measurements,
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and established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have
completed the report file setup.
Two Point Angle Measurement
1. Open the file the analysis measurements are to be performed on.
2. Begin by selecting Angle and Angular Speed from the Measurement menu to perform
analysis on an opened image file or click on the Measure button in the View window and
select the Angle and Angular Speed option to perform measurements on an open cine file.
3. When the Angle Measurements dialog box appears, check the option box marked 2 point +
x-axis, and then Click OK to return to the View Cine playback window.
4. The status bar will prompt you to select one end of the object to be measured. Move the
cursor to that point and click (Pt.1), referred to as the reference point.
5. The status bar will prompt you to select the second point referred to as the point. Move the
cursor to the end point object and click (Pt.2).
RESULT: The status bar will display the angle as a=. For example, a= 18.646 deg.
6. If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
(approximately 40 words) can be used.
Two Point Angular Speed Measurement
7. To perform Two Point Angular Speed Measurements, advance the cine to the next image
by selecting the Play Single Frame Forward button. The status bar will again prompt you to
select a point of the object.
8. Move the cursor to that point and click (Pt.1).
9. Advance the cine to the next image by selecting the Play Single Frame Forward button.
The status bar will again prompt you to select a point of the object. Click on that point.
RESULT: The status bar will display the angle as a=, and the speed as s=. For example, a= -4.376
deg and s= -67.328 deg/s.
10.If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
(approximately 40 words) can be used.
11.Repeat until all additional measurements have been completed.

Three Point Angle or Three Point Angular Speed Measurement
When the vertex and the two end points of the angle are visible (the most common angle
description), use the following procedure to measure the angles.
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NOTE
Before using this function, check that you have already assigned units of measurements,
and established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have
completed the report file setup.
Three Point Angle Measurement
1. Open the file the analysis measurements are to be performed on.
2. Begin by selecting Angle and Angular Speed from the Measurement menu to perform
analysis on an opened image file or click on the Measure button in the View window and
select the Angle and Angular Speed option to perform measurements on an open cine file.
3. When the Angle dialog box appears, check the option box marked 3 points. Click OK to
return to the View Cine playback window.
4. When the cursor appears in the image, the status bar will prompt you to select a reference
point. Move the cursor to this first point and click (Reference).
5. Next, the status bar will prompt you to select one end point of the angle. Move the cursor to
the end point and click (Pt.1).
6. The status bar will prompt you to select the second point of the angle. Move the cursor to
the second end point and click (Pt.2). Result: The status bar will display the angle as a=.
For example, a= -85.679 deg.
7. If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
(approximately 40 words) can be used.
8. Repeat these steps until all additional angles for the current image have been measured.
Three Point Angular Speed Measurement
9. To perform Three Point Angular Speed Measurements advance the View Cine playback
screen to the next image by selecting the Play Single Frame Forward button.
10.Move the cursor to this first point and click (Reference).
11.Move the cursor to the end point and click (Pt.1).
12.Advance the View Cine playback screen to the next image and move the cursor to the end
point and click (Pt.2).
RESULT: The status bar will display the angle as a=, and the speed as s=. For example, a= 27.078 deg and s= -541.596 rpm.
13.If the Query for Comments instruction was checked in the Report File Setup, the
Comments dialog box will appear as each point is selected. Enter the description or
comment in the box. Any combination of letters, numbers, or spaces up to 250 characters
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(approximately 40 words) can be used.
14.Repeat these steps until all additional angles for the current image have been measured.

Four Point Angle or Four Point Angular Speed Measurement
When the vertex or the center point of rotation are unknown or lay outside the image area, the
angular speed can be found by comparing the position of an object in one image to its position in
the next image.

NOTE
Before using this function, check that you have already assigned units of measurements,
and established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have
completed the report file setup.
1. Open the file the analysis measurements are to be performed on.
2. Begin by selecting Angle and Angular Speed from the Measurement menu to perform
analysis on an opened image file or click on the Measure button in the View window and
select the Angle and Angular Speed option to perform measurements on an open cine file.
3. When the Angle dialog box appears, check the option box marked 4 points.
4. Click OK to return to the View Cine playback window.
5. When the cursor appears in the image, the status bar will prompt you to select a reference
point (Ref.1). Move the cursor to a point somewhere along the edge of the first object and
click (Ref.1).
6. If the Query for Comments instruction was checked in the Report File Setup, th Comments
dialog box will appear as each point is selected. Enter the description or comment in the
box. Any combination of letters, numbers, or spaces up to 250 characters (approximately
40 words) can be used.
7. Next, the status bar will prompt you to select one end point of the object (Pt.1) Move the
cursor to this first point and click (Pt.1).
8. When performing Four Point Angle Measurements the status bar will prompt you to select a
second reference point (Ref 2). Move the cursor to a reference point on the second object
and click (Ref.2).
9. Four Point Angle Measurement result: You have marked a total of four points in the image.
The status bar will display the angle as a=. For example, a= 62.500 deg.
Four Point Angular Speed Measurements
10.When performing Four Point Angular Speed Measurements the status bar will prompt you
to select a reference point (Ref.1). Move the cursor to a point somewhere along the edge of
the first object and click (Ref.1).
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11.Next, the status bar will prompt you to select one end point of the object (Pt.1) Move the
cursor to this first point and click (Pt.1).
12.Advance the cine to the next image.
13.Next, the status bar prompts you to select a second end point (Pt.2.) Move the cursor to
the end points new position in this image and click (Pt.2).
Four Point Angular Speed Measurement results: The status bar will display the angle as a=
and the speed as s=.
For example, a= 45.500 deg and s= 120.00 rpm.
14.For Four Point Angle Measurements repeat the process, starting from Step 5, until all
additional Four Point angles for the current image have been measured.
4.2.5.8

Collect Point Analysis
Select the Collect Points function whenever you plan to export motion analysis data for use with
other programs. Because the Collect Points function creates separate data files as you collect
measurements, these files can be imported by other programs such as Louts 1-2-3 and Microsoft
Excel. You will also use Collect Points whenever you plan to measure acceleration.
Collect Points creates separate data files for point coordinates, speed and acceleration values. At
your command, point position information may also be included in reports using the Report File
function.
NOTE
Before using this function, check that you have already assigned units of measurements, and
established a scale for your file or single images. If a report file will be generated from
measurements collected during the motion analysis session, check that you have completed
the report file setup.

STEP-BY-STEP PROCEDURE
1. Open the file the analysis measurements are to be performed on.
2. Define the Origin point.
3. Begin by selecting Collect Points from the Measurement menu to perform Collect Point analysis
on an opened image file, or click on the Measure button in the View window and select the
Collect Points option to perform Collect Points measurements on an open cine file.
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4. When the Collect and Process Data dialogue window opens click on the Open File button.
5. When the Point Position File dialog window appears, enter a file name for the selected points;
the file extension is .pps. You may find it helpful to give this point file the same name as the cine
file that's being measured. For example, spinner.pps would be the point file for the cine spinner.
cin.
6. Check that the file is being saved in the directory and drive of your choice. To open a previously
saved point file, select it from the list of files.
7. Click OK to accept the new file name or open the previously saved file. This system will return to
the Collect and Process Data dialog window.
8. When the Collect and Process Data dialog window appears, move the pointer to the Points per
frame entry field and enter the number of points you plan to collect for measurement in each
image. You may collect up to 100 points per image; the selected points are numbered 00 through
99.
9. Click OK to return to the View Cine playback window.
10.Collect Points are displayed in the status bar at the bottom of the View Cine playback window.
The Point # box in the View Cine playback panel displays the point currently being selected
starting with point 00. Move the cursor to the first point and click once to select it for
measurement. A numbered marker (00) appears in the image and the (x,y) coordinates of this
point are displayed in the status bar.
11.If the Query for Comments instruction was checked in the Report File Setup, a comments dialog
box will appear as each point is selected. Enter the description or comment in the box. Any
combination of letters, numbers, or spaces up to 250 characters (approximately 40 words) can
be used.
12.Collect all remaining points in the image by moving the cursor to each point and clicking once to
select it.
After collecting the number of points designated in the Collect dialog box, the numbered markers
(00 through 99) appear in the image and the (x,y) coordinates of the point are displayed in the
status bar, and the cine automatically advances to the next image. You may collect points for
measurement from each image in the cine, or just selected images.
13.When you have finished collecting all of the collect points, select Collect Points from the
Measurement menu or by using the Measure button again.
14.When the Collect and Process Data dialog window appears, move the pointer to the Sort and
Optimize button and click once.
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NOTE
All points collected in the point position (.pps) file are listed in the order they are collected.
Any points edited after the initial collection will be appended to the end of the .pps file.
Clicking Sort and Optimize reorders the file according to the image number the points were
collected from.
15.Click the Compute Speed File to create a .psp file and compute the speed of each point.
16.Click the Compute Acceleration File to create a .pac file and compute the acceleration of each
point.
17.Click Close File to save the collected points in the point position file.
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Functional Descriptions
The purpose of this module is to specify the functionality of various features and options associated
with a Phantom camera, and all related the Phantom Camera Control applications.

5.1

Black Reference/Current Session Reference Adjustments
After a camera comes up to its operating temperature, or after changing camera settings, calibrating
the camera to a black reference will help ensure you get the best possible images from your
Phantom camera.
A black reference measures the value of each pixel with no light on it (black) and stores the values in
a calibration file (called an “STG”). Later, the camera firmware can use those values to ensure that all
sensor pixels are providing the same value for equivalent amounts of light.
There are two types of black references on Phantom cameras, they are a:

Current Session Reference (CSR)
Current Session Reference” is a calibration procedure similar to Black Reference except the fact
that it computes the pixel offsets only on the part of the sensor that is the next greater value after
the resolution set in acquisition parameters.
This way, the offsets can be computed for any frame rate, exposure or resolution, giving a more
precise compensation of the pixel errors, dependent on the acquiring parameters and on
temperature. Of course, if the acquisition parameters change, you may get worse results than
using the universal Black Reference procedure. The CSR is applied correctly only for the set of
acquisition parameters used when this reference was calculated.
This black reference is available for any image resolution. When the acquisition parameters,
(resolution, frame rate, exposure time), have certain values, (for example, the frame rate is high
or the set of values forces the camera performances), it is recommended to do a CSR for that
specific set of parameters in order to obtain a better image.
After executing a CSR, if you change the acquisition parameters, the calibration calculated
during the Current Session Reference will apply partially correct on the new setup. For example,
if you use a bigger resolution than the one used when the CSR was calculated, the CSR
adjustments will be applied only on that part of image and for the rest of the image the black
reference calibration calculated in the Options window will be used.
The CSR calibration can be saved in a ,stg file, for example:
1009_res256x256_rate80_exp12000_edr0.,stg.
Thus, you can easily choose a ,stg according to the acquisition you are currently using. This ,stg
file will be opened automatically at the program restart if you rename it by the serial number of
the camera: 1009.STG in this example.
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Black Reference (BR).
Performing a Black Reference ensures the best possible images are being captured and
recorded by the camera's sensor.
AREA EFFECTED

USE WHEN

SAVES TO

Black Reference (BR)

Entire sensor.

Shooting at full
resolution and after
adjusting frame rate or
exposure. Any time the
operating temperature
of the camera changes
more than a few
degrees.

Default STG file on the
computer and/or in the
camera non-volatile
memory.

Current Session
Reference (CSR)

The part of the sensor
that is the next greater
value after the
resolution set in
acquisition parameters.

When shooting at less
than full resolution and
after adjusting
resolution, frame rate or
exposure.

Separate, re-loadable,
STG file and/or the
camera non-volatile
memory.

NOTE
Before performing either a Black Reference or Current Session Reference Adjustment ensure
that the EDR, Extreme Dynamic Range), Exposure setting is set to zero, and the Auto
Exposure and Image-Based Auto-Trigger features are disabled.
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Burst Mode Acquisition
The best way to understand burst mode is that it allows the end-user to increase the effective frame
rate of the camera for a short duration by having the camera take multiple exposures within one
FSYNC cycle. Burst mode works in internal and external SYNC modes, as well as in shutter off
modes. Probably, the best implementation of the feature involves providing the camera an external
FSYNC pulse, thereby triggering a specific number of images at a frame rate greater than the
external FSYNC rate.
Naturally, the user wants to maintain good image quality, so there are rules for how burst mode
operates. The rules involve the camera’s maximum frame rate, the burst count and the burst period.
Let’s start with some definitions.
· Burst Period is defined as the time between successive falling edges of STROBE signal.
· Burst Count is the number of images that can be taken between successive falling edges of
FSYNC.
Let's say I have a Phantom v12.1 camera set as follows:
· Resolution: 1280 x 800
· Frame Rate: 1000 fps
· Exposure: 50 usec
The maximum frame rate for this camera at 1280 x 800 is 6273 fps.
So, the first rule for understanding burst mode is that for any given resolution, the burst period cannot
exceed a camera’s maximum frame rate.
Max Frame Rate or Min Burst Period = 1/6273 = 159.41 usec
The second rule is that maximum burst count for a given frame rate is the integer value of the max
frame rate of the camera resolution divided by FSYNC rate.
As a result of these rules, burst mode only works at frame rates that are less than or equal to ½ of
the maximum frame rate for a given resolution because you cannot get a burst count of less than 1.
In the example above, burst mode is available at all frame rates from 24 fps to a maximum frame rate
of 3136 fps.
By knowing the max frame rate and the number of burst counts you calculate the burst period.
Using the Phantom v12.1 example from above and setting the camera’s frame rate to 1000 fps
results in a maximum burst count of six, (6273/1000 = 6). Thereby allowing the end-user to choose a
burst count value from 0 to 6. 0 will disable burst mode and there is no burst period. As the burst
count decreases the burst period increases.
The following figures, taken using an oscilloscope, show the effects of the parameters of burst mode:
· Resolution: 1280 x 800
· Frame Rate: 1000 fps
· Channel 1 is FSYNC
· Channel 2 is STROBE
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

50

0
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PERIOD
(µSEC)
N/A
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COMMENTS

Burst Mode Disabled using internal
frame rate generator
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

50

2

BURST
PERIOD
(µSEC)
200

COMMENTS

Two image burst using internal frame
rate generator. Each burst has a 50 µ
sec exposure and the burst images are
at an effective frame rate of 5000 fps.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

50

2
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BURST
PERIOD
(µSEC)
300
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COMMENTS

Two image burst using internal frame
rate generator. Each burst has a 50 µ
sec exposure and the burst images are
at an effective frame rate of 3333 fps.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

50

3

BURST
PERIOD
(µSEC)
200

COMMENTS

Two image burst using internal frame
rate generator. Each burst has a 50 µ
sec exposure and the burst images are
at an effective frame rate of 5000 fps.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

50

6
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PERIOD
(µSEC)
159.41
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COMMENTS

Six image burst using internal frame
rate generator. Each burst has a 50 µ
sec exposure and the burst images are
at an effective frame rate of 6273 fps.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 6273
l

50

0

BURST
PERIOD
(µSEC)
0

COMMENTS

Burst Mode Disabled using internal
frame rate generator at a frame rate of
6273 fps.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

PIV

0
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BURST
PERIOD
(µSEC)
N/A
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COMMENTS

Burst Mode Disabled in PIV mode
using internal frame rate generator.
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SYNC FRAME RATEEXPOSURE BURST
(FPS)
(µSEC)
COUNT
Interna 1000
l

PIV

3

BURST
PERIOD
(µSEC)
200

COMMENTS

Three image burst using internal frame
rate generator, Camera is in PIV mode
and burst images are at an effective
frame rate of 5000 fps.
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Firmware Ordered Recording and Minimal GUI Refresh
The ability to Continuously Record events that occur in short burst, such as lightening strikes, to a
Phantom camera with MultiCine partitions defined has been greatly enhanced with the addition of the
Firmware Ordered Recording and Minimal GUI Refresh features, by significantly increasing the
speed at which these events can be recorded and saved to a user-specified hard-drive.
The Firmware Ordered Recording feature reduces the time between takes by instructing a Phantom
camera to erase a MultiCine segment upon completion saving its stored image data to a specified
hard-drive then making it available for recording again.
The Minimal GUI Refresh feature accelerating the cine save process by disabling the save progress
indicators from being displayed in the Graphical User Interface. Enabling this command also instructs
the Phantom software to stop displaying live images in the Preview Panel during the save cine
procedure.
When a Phantom camera utilizes the MultiCine and Continuous Recording features simultaneously
and the camera has finished recording image data to a MultiCine partition, the camera will look for
the next empty cine segment to start recording into. The camera will not erase any cine from the
camera’s DRAM by itself, unless the Continuous Recoding with Auto Save to Flash are enabled, or
you instructed the camera to restart recording to a cine segment that already contained a stored cine.
Assuming there are twelve MultiCine partitions and Continuous Recording is enabled;
When the camera is placed into the capture mode the camera will start recording into the first
available cine partition, Cine 1. Once the camera is triggered, and the post-trigger frame requirement
has been met, the camera will stop recording to that cine partition and immediately start recording
into the next available partition, Cine 2, and so on until all MultiCine segments have been written into.
As long as at least one cine segment is empty, the camera will jump to the next available unused
partition. After it finishes recording, and all MultiCine partitions are full, the camera will jump to
Preview mode and stay in the Preview mode until the camera is told to do something else or the save
process for the last MultiCine partition has completed.
With Firmware Ordered Recording enabled, the software polls the cine partitions, and when it finds
one that has recorded image data in it, it will save that image data to the specified hard-drive then
deletes it from the camera. Once it is deleted, the camera will re-use that partition automatically,
unless the camera has already gone into Preview mode, (then it will need to be told to jump to the
cine).
Whenever the camera has an empty cine segment at the end of a recording, jumping to it should
take about the same time (20-30ms). it doesn't matter if it's the first jump or the 1000-th.
When the camera looks for a cine to start recording into it always starts from Cine 1 and searches
upward, so if the camera receives three quickly triggers, Cine 1, Cine 2, and Cine 3 are filled, and the
camera will then start recording into Cine 4. If Cine 1 is saved and deleted, by the software, after
Cine 4 is triggered and the post-trigger frame requirements are met, the camera will jump to the first
available MultiCine partition, which is Cine 1. As a result, if the saves are fast enough, you may never
reach the last MultiCine partition.
Without Firmware Ordered Recording enabled, the software saves segments in order 1, 2, 3, etc.
The way the software does this is that does not erase segments after saving until the last segment is
in the capture mode . The camera would ignores all other triggers) until the last segment is in the
capture mode, when then erases segments all MultiCine partitions except the last, which is still in the
capture mode.
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Frame Rate Tables
NOTE
· Each value has to be truncated to an integer when selected in the Live Control Panel.
· Each camera works on a reduced interval of frame rates ,(e.g., the v7 is from 100 to
160,000fps).
· The tables shown are for the Ethernet cameras based on 4MHz internal clock.
Following are two tables of possible frame rates, (in frames per second), for the Phantom camera
family:

Lock to IRIG Mode Table
100.00
1000.00
4000.00
12500.00
40000.00
125000.00
500000.00

200.00
1600.00
5000.00
16000.00
50000.00
160000.00
800000.00

400.00
2000.00
6400.00
20000.00
62500.00
200000.00
1000000.00

500.00
2500.00
8000.00
25000.00
80000.00
250000.00
2000000.00

800.00
3200.00
10000.00
32000.00
100000.00
400000.00
4000000.00

Sync to Internal Clock Mode Table
Below are the possible frame rates, (in frame per second), for the Phantom V-Series camera family
when clocked via the camera's internal oscillator:
1.00
7.00
13.00
19.00
25.00
31.00
37.00
43.00
49.00
55.00
61.00
67.00
73.00
79.00
85.00
91.00
97.00
103.00
109.00
115.00
121.00
127.00
133.00
139.00
145.00
151.00

2.00
8.00
14.00
20.00
26.00
32.00
38.00
44.00
50.00
56.00
62.00
68.00
74.00
80.00
86.00
92.00
98.00
104.00
110.00
116.00
122.00
128.00
134.00
140.00
146.00
152.00

3.00
9.00
15.00
21.00
27.00
33.00
39.00
45.00
51.00
57.00
63.00
69.00
75.00
81.00
87.00
93.00
99.00
105.00
111.00
117.00
123.00
129.00
135.00
141.00
147.00
153.00

4.00
10.00
16.00
22.00
28.00
34.00
40.00
46.00
52.00
58.00
64.00
70.00
76.00
82.00
88.00
94.00
100.00
106.00
112.00
118.00
124.00
130.00
136.00
142.00
148.00
154.00

5.00
11.00
17.00
23.00
29.00
35.00
41.00
47.00
53.00
59.00
65.00
71.00
77.00
63.00
89.00
95.00
101.00
107.00
113.00
119.00
125.00
131.00
137.00
143.00
149.00
155.00

6.00
12.00
18.00
24.00
30.00
36.00
42.00
48.00
54.00
60.00
66.00
72.00
78.00
84.00
90.00
96.00
102.00
108.00
114.00
120.00
126.00
132.00
138.00
144.00
150.00
156.00
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157.00
163.01
169.00
175.00
181.00
187.00
193.00
199.00
205.00
211.00
217.00
223.00
229.00
235.00
241.01
247.00
253.00
259.00
265.01
271.00
277.01
283.01
289.02
295.01
301.00
307.01
313.01
319.00
325.02
331.02
337.01
343.02
349.01
355.02
361.01
367.01
373.03
379.00
385.02
391.01
397.02
403.02
409.04
415.02
421.01
427.03
433.04
439.03
445.04
451.01
457.04
463.02
469.04
475.00
481.00
487.03

158.00
164.00
170.00
176.00
182.00
188.01
194.01
200.00
206.01
212.01
218.01
224.00
230.00
236.00
242.01
248.00
254.00
260.01
266.01
272.02
278.01
284.01
290.00
296.01
302.00
308.00
314.02
320.00
326.02
332.01
338.01
344.03
350.02
356.03
362.02
368.02
374.01
380.01
386.03
392.00
398.01
404.04
410.00
416.02
422.03
428.04
434.03
440.04
446.03
452.03
458.03
464.04
470.04
476.02
482.04
488.04

159.00
165.00
171.01
177.01
183.01
189.00
195.01
201.01
207.01
213.00
219.01
225.01
231.00
237.01
243.01
249.00
255.00
261.01
267.00
273.00
279.02
285.00
291.01
297.00
303.01
309.02
315.01
321.00
327.01
333.00
339.01
345.01
351.00
357.02
363.01
369.00
375.02
381.02
387.03
393.00
399.00
405.02
411.02
417.01
423.01
429.00
435.02
441.01
447.03
453.00
459.03
465.01
471.03
477.04
483.03
489.06
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160.00
166.00
172.01
178.01
184.00
190.01
196.00
202.01
208.01
214.01
220.01
226.00
232.01
238.01
244.01
250.00
256.00
262.00
268.01
274.01
280.01
286.00
292.01
298.02
304.02
310.00
316.01
322.01
328.00
334.00
340.02
346.02
352.02
358.01
364.00
370.03
376.01
382.01
388.01
394.01
400.00
406.01
412.03
418.02
424.04
430.02
436.01
442.04
448.03
454.03
460.03
466.04
472.03
478.01
484.03
490.02

161.00
167.00
173.00
179.00
185.01
191.00
197.01
203.00
209.01
215.01
221.01
227.00
233.01
239.01
245.01
251.00
257.00
263.00
269.02
275.01
281.02
287.01
293.02
299.02
305.02
311.02
317.01
323.02
329.00
335.01
341.01
347.01
353.01
359.00
365.03
371.02
377.00
363.03
389.03
395.02
401.00
407.00
413.01
419.02
425.03
431.03
437.02
443.02
449.03
455.01
461.04
467.02
473.04
479.04
485.02
491.04

237

162.00
168.00
174.00
180.00
186.00
192.00
198.00
204.01
210.01
216.01
222.00
228.01
234.00
240.01
246.00
252.00
258.01
264.01
270.01
276.01
282.01
288.02
294.01
300.01
306.02
312.01
318.02
324.02
330.01
336.02
342.03
348.01
354.01
360.00
366.03
372.02
378.00
384.02
390.02
396.00
402.01
408.04
414.04
420.04
426.03
432.01
438.02
444.00
450.05
456.05
462.00
468.00
474.05
480.02
486.03
492.00
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493.04
499.00
505.05
511.05
517.06
523.01
529.03
535.05
541.05
547.05
553.02
559.05
565.05
571.02
577.03
583.01
589.01
595.06
601.05
607.07
613.03
619.00
625.00
631.01
637.04
643.09
649.03
655.09
661.05
667.00
673.06
679.00
685.05
691.09
697.11
703.11
709.09
715.05
721.11
727.01
733.00
739.10
745.02
751.03
757.00
763.07
769.08
775.04
781.10
787.09
793.02
799.04
805.15
811.03
817.16
823.05

494.01
500.00
506.01
512.03
518.00
524.04
530.01
536.05
542.01
548.02
554.02
560.07
566.01
572.00
578.03
584.03
590.06
596.04
602.05
608.09
614.06
620.06
626.08
632.01
638.06
644.02
650.09
656.06
662.03
668.00
674.08
680.04
686.11
692.04
698.08
704.10
710.10
716.08
722.02
728.07
734.08
740.06
746.13
752.02
758.01
764.09
770.12
776.10
782.01
788.02
794.12
800.00
806.13
812.02
818.16
824.06

495.05
501.00
507.04
513.02
519.01
525.00
531.07
537.06
543.04
549.07
555.02
561.01
567.05
573.07
579.04
585.05
591.02
597.01
603.05
609.01
615.01
621.02
627.06
633.01
639.08
645.06
651.04
657.03
663.02
669.01
675.11
681.08
687.05
693.00
699.06
705.09
711.11
717.10
723.07
729.13
735.02
741.02
747.10
753.01
759.01
765.11
771.01
777.00
783.09
789.11
795.07
801.12
807.10
813.01
819.00
825.08

496.03
502.01
508.00
514.01
520.02
526.04
532.06
538.07
544.07
550.06
556.02
562.03
568.02
574.05
580.05
586.08
592.07
598.09
604.05
610.04
616.05
622.08
628.04
634.01
640.00
646.10
652.10
658.00
664.01
670.02
676.02
682.01
688.11
694.08
700.04
706.09
712.12
718.00
724.11
730.06
736.11
742.12
748.08
754.01
760.02
766.14
772.05
778.06
784.01
790.05
796.02
802.09
808.08
814.00
820.01
826.10

497.02
503.02
509.04
515.07
521.04
527.01
533.05
539.01
545.03
551.04
557.03
563.06
569.07
575.04
581.06
587.03
593.03
599.07
605.05
611.06
617.09
623.05
629.03
635.02
641.03
647.04
653.06
659.09
665.00
671.03
677.05
683.06
689.06
695.05
701.02
707.09
713.01
719.04
725.03
731.13
737.06
743.08
749.06
755.00
761.04
767.02
773.10
779.12
785.08
791.14
797.13
803.05
809.06
815.16
821.02
827.13

498.01
504.03
510.01
516.06
522.06
528.05
534.05
540.03
546.00
552.03
558.04
564.02
570.04
576.04
582.07
588.06
594.00
600.06
606.06
612.09
618.05
624.02
630.02
636.03
642.05
648.09
654.02
660.07
666.00
672.04
678.08
684.11
690.01
696.02
702.00
708.09
714.03
720.07
726.08
732.06
738.01
744.05
750.05
756.00
762.05
768.05
774.14
780.03
786.01
792.08
798.08
804.02
810.04
816.16
822.03
828.16
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829.02
835.07
841.04
847.10
853.06
859.11
865.05
871.08
877.00
883.00
889.09
895.05
901.10
907.03
913.03
919.12
925.07
931.10
937.21
943.17
949.22
955.11
961.08
967.12
973.24
979.19
985.22
991.08
997.01
1003.01
1009.08
1015.23
1021.19
1027.22
1033.06
1039.23
1045.21
1051.25
1057.08
1063.26
1069.23
1075.27
1081.08
1087.25
1093.19
1099.20
1105.28
1111.11
1117.01
1123.28
1129.31
1135.07
1141.23
1147.12
1153.07
1159.08

830.05
836.12
842.11
848.18
854.15
860.03
866.18
872.03
878.16
884.17
890.08
896.06
902.12
908.06
914.08
920.17
926.14
932.18
938.09
944.06
950.12
956.02
962.00
968.05
974.18
980.15
986.19
992.06
998.00
1004.02
1010.10
1016.00
1022.23
1028.01
1034.13
1040.04
1046.03
1052.08
1058.20
1064.11
1070.09
1076.14
1082.25
1088.14
1094.09
1100.11
1106.19
1112.04
1118.26
1124.23
1130.26
1136.04
1142.20
1148.11
1154.07
1160.09

831.08
837.17
843.17
849.08
855.07
861.14
867.11
873.17
879.12
885.15
891.07
897.06
903.14
909.09
915.12
921.02
927.21
933.05
939.19
945.18
951.02
957.17
963.16
969.23
975.13
981.11
987.17
993.05
999.00
1005.03
1011.12
1017.04
1023.02
1029.07
1035.20
1041.12
1047.12
1053.19
1059.04
1065.25
1071.24
1077.01
1083.13
1089.03
1095.29
1101.02
1107.11
1113.28
1119.19
1125.18
1131.22
1137.01
1143.18
1149.10
1155.07
1161.10
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832.12
838.05
844.06
850.16
856.16
862.07
868.06
874.13
880.09
886.13
892.06
898.07
904.16
910.13
916.17
922.08
928.07
934.14
940.07
946.07
952.15
958.08
964.09
970.17
976.09
982.08
988.14
994.04
1000.00
1006.04
1012.15
1018.07
1024.07
1030.13
1036.00
1042.21
1048.22
1054.02
1060.16
1066.10
1072.10
1078.17
1084.01
1090.22
1096.19
1102.23
1108.03
1114.21
1120.13
1126.13
1132.18
1138.30
1144.16
1150.09
1156.07
1162.12

833.16
839.10
845.13
851.06
857.08
863.19
869.19
875.08
881.06
887.11
893.06
899.08
905.18
911.16
917.01
923.15
929.15
935.02
941.18
947.19
953.06
959.00
965.02
971.11
977.04
983.04
989.12
995.02
1001.00
1007.05
1013.17
1019.11
1025.12
1031.19
1037.08
1043.02
1049.04
1055.13
1061.01
1067.24
1073.25
1079.04
1085.19
1091.11
1097.09
1103.14
1109.26
1115.14
1121.08
1127.08
1133.14
1139.28
1145.15
1151.08
1157.07
1163.13
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834.03
840.16
846.02
852.15
858.00
864.12
870.13
876.04
882.03
888.10
894.05
900.09
906.00
912.20
918.06
924.00
930.02
936.11
942.06
948.09
954.20
960.15
966.18
972.05
978.23
984.01
990.10
996.02
1002.00
1008.06
1014.20
1020.15
1026.17
1032.26
1038.15
1044.11
1050.14
1056.25
1062.13
1068.09
1074.11
1080.21
1086.07
1092.00
1098.30
1104.06
1110.19
1116.07
1122.02
1128.03
1134.11
1140.25
1146.13
1152.07
1158.08
1164.14

240

Phantom Camera Control Help File

1165.16
1171.30
1177.16
1183.08
1189.06
1195.10
1201.20
1207.00
1213.22
1219.14
1225.11
1231.15
1237.24
1243.01
1249.22
1255.10
1261.03
1267.03
1273.07
1279.18
1285.35
1291.16
1297.02
1303.36
1309.33
1315.36
1321.00
1327.14
1333.33
1339.14
1345.44
1351.35
1357.31
1363.33
1369.39
1375.04
1381.22
1387.44
1393.24
1399.09
1405.48
1411.43
1417.43
1423.49
1429.08
1435.24
1441.44
1447.18
1453.49
1459.32
1465.20
1471.13
1477.10
1483.13
1489.20
1495.33

1166.18
1172.33
1178.20
1184.13
1190.12
1196.17
1202.28
1208.09
1214.33
1220.26
1226.24
1232.29
1238.01
1244.17
1250.00
1256.28
1262.23
1268.23
1274.29
1280.00
1286.17
1292.41
1298.28
1304.21
1310.19
1316.22
1322.31
1328.02
1334.22
1340.03
1346.35
1352.27
1358.23
1364.26
1370.33
1376.46
1382.17
1388.41
1394.21
1400.07
1406.47
1412.43
1418.44
1424.50
1430.10
1436.27
1442.48
1448.23
1454.02
1460.39
1466.28
1472.21
1478.20
1484.23
1490.31
1496.45

1167.20
1173.02
1179.25
1185.19
1191.19
1197.25
1203.01
1209.19
1215.07
1221.00
1227.37
1233.05
1239.16
1245.33
1251.17
1257.07
1263.02
1269.04
1275.10
1281.23
1287.00
1293.24
1299.12
1305.06
1311.05
1317.09
1323.19
1329.35
1335.11
1341.38
1347.25
1353.18
1359.16
1365.19
1371.27
1377.41
1383.13
1389.37
1395.19
1401.05
1407.46
1413.43
1419.45
1425.01
1431.13
1437.30
1443.00
1449.28
1455.07
1461.45
1467.35
1473.30
1479.29
1485.33
1491.42
1497.01

1168.22
1174.05
1180.29
1186.24
1192.25
1198.32
1204.09
1210.29
1216.18
1222.12
1228.12
1234.19
1240.31
1246.11
1252.35
1258.26
1264.22
1270.24
1276.32
1282.05
1288.24
1294.08
1300.39
1306.34
1312.34
1318.39
1324.06
1330.23
1336.01
1342.28
1348.16
1354.10
1360.08
1366.12
1372.21
1378.36
1384.08
1390.34
1396.16
1402.03
1408.45
1414.43
1420.45
1426.02
1432.15
1438.33
1444.04
1450.33
1456.13
1462.52
1468.43
1474.38
1480.38
1486.44
1492.54
1498.13

1169.25
1175.09
1181.33
1187.30
1193.32
1199.04
1205.18
1211.02
1217.29
1223.24
1229.26
1235.33
1241.08
1247.27
1253.13
1259.05
1265.02
1271.05
1277.14
1283.29
1289.08
1295.34
1301.24
1307.19
1313.20
1319.26
1325.38
1331.11
1337.35
1343.18
1349.07
1355.01
1361.01
1367.05
1373.15
1379.31
1385.04
1391.30
1397.14
1403.02
1409.44
1415.43
1421.46
1427.04
1433.18
1439.37
1445.09
1451.38
1457.19
1463.06
1469.51
1475.47
1481.48
1487.54
1493.09
1499.25

1170.28
1176.12
1182.03
1188.00
1194.03
1200.12
1206.27
1212.12
1218.03
1224.36
1230.01
1236.09
1242.24
1248.05
1254.31
1260.24
1266.22
1272.26
1278.36
1284.11
1290.32
1296.18
1302.08
1308.04
1314.06
1320.13
1326.26
1332.00
1338.24
1344.09
1350.44
1356.39
1362.40
1368.46
1374.10
1380.26
1386.00
1392.27
1398.11
1404.00
1410.44
1416.43
1422.48
1428.06
1434.21
1440.40
1446.13
1452.43
1458.26
1464.13
1470.05
1476.01
1482.03
1488.10
1494.21
1500.38
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1501.50
1507.16
1513.43
1519.18
1525.55
1531.39
1537.28
1543.21
1549.19
1555.21
1561.28
1567.40
1573.56
1579.16
1585.41
1591.09
1597.44
1603.21
1609.01
1615.51
1621.40
1627.34
1633.32
1639.34
1645.41
1651.53
1657.00
1663.20
1669.45
1675.04
1681.38
1687.05
1693.48
1699.24
1705.03
1711.60
1717.48
1723.40
1729.36
1735.36
1741.40
1747.49
1753.62
1759.01
1765.23
1771.48
1777.78
1783.33
1789.71
1795.33
1801.80
1807.50
1813.24
1819.01
1825.65
1831.50

1502.07
1508.30
1514.00
1520.33
1526.14
1532.57
1538.46
1544.40
1550.39
1556.42
1562.50
1568.01
1574.18
1580.40
1586.04
1592.36
1598.08
1604.49
1610.31
1616.16
1622.06
1628.00
1634.65
1640.02
1646.09
1652.21
1658.37
1664.59
1670.15
1676.45
1682.09
1688.48
1694.20
1700.68
1706.48
1712.33
1718.21
1724.14
1730.10
1736.11
1742.16
1748.25
1754.39
1760.56
1766.00
1772.26
1778.57
1784.12
1790.51
1796.14
1802.61
1808.32
1814.06
1820.66
1826.48
1832.34

1503.19
1509.43
1515.15
1521.49
1527.30
1533.15
1539.05
1545.60
1551.59
1557.03
1563.11
1569.24
1575.42
1581.03
1587.30
1593.63
1599.36
1605.14
1611.60
1617.47
1623.38
1629.33
1635.32
1641.36
1647.45
1653.58
1659.06
1665.28
1671.54
1677.15
1683.50
1689.19
1695.63
1701.40
1707.21
1713.06
1719.69
1725.63
1731.60
1737.62
1743.68
1749.02
1755.16
1761.34
1767.57
1773.05
1779.36
1785.71
1791.31
1797.75
1803.43
1809.14
1815.71
1821.49
1827.32
1833.18
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1504.32
1510.00
1516.30
1522.07
1528.47
1534.33
1540.24
1546.19
1552.19
1558.24
1564.33
1570.48
1576.04
1582.28
1588.56
1594.26
1600.00
1606.43
1612.25
1618.12
1624.04
1630.66
1636.66
1642.04
1648.13
1654.26
1660.44
1666.67
1672.24
1678.56
1684.21
1690.62
1696.35
1702.13
1708.67
1714.53
1720.43
1726.37
1732.35
1738.37
1744.44
1750.55
1756.70
1762.11
1768.35
1774.62
1780.15
1786.51
1792.11
1798.56
1804.24
1810.77
1816.53
1822.32
1828.15
1834.02

1505.46
1511.14
1517.45
1523.23
1529.05
1535.51
1541.43
1547.39
1553.40
1559.45
1565.56
1571.09
1577.29
1583.53
1589.19
1595.53
1601.28
1607.07
1613.55
1619.43
1625.36
1631.32
1637.33
1643.39
1649.48
1655.63
1661.13
1667.36
1673.64
1679.26
1685.63
1691.33
1697.07
1703.58
1709.40
1715.27
1721.17
1727.12
1733.10
1739.13
1745.20
1751.31
1757.47
1763.67
1769.13
1775.41
1781.74
1787.31
1793.72
1799.37
1805.05
1811.59
1817.36
1823.15
1829.83
1835.70
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1506.02
1512.29
1518.03
1524.39
1530.22
1536.10
1542.02
1548.59
1554.00
1560.06
1566.17
1572.33
1578.53
1584.16
1590.46
1596.17
1602.56
1608.36
1614.21
1620.09
1626.02
1632.65
1638.00
1644.06
1650.17
1656.31
1662.51
1668.06
1674.34
1680.67
1686.34
1692.05
1698.51
1704.30
1710.13
1716.00
1722.65
1728.61
1734.61
1740.64
1746.72
1752.08
1758.24
1764.45
1770.69
1776.20
1782.53
1788.11
1794.53
1800.18
1806.68
1812.42
1818.18
1824.82
1830.66
1836.55
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1837.39
1843.32
1849.28
1855.29
1861.33
1867.41
1873.54
1879.70
1885.01
1891.25
1897.53
1903.86
1909.31
1915.71
1921.23
1927.71
1933.30
1939.86
1945.53
1951.22
1957.91
1963.67
1969.47
1975.31
1981.18
1987.08
1993.02
1999.00
2005.01
2011.06
2017.15
2023.27
2029.43
2035.62
2041.86
2048.13
2054.44
2060.79
2067.18
2073.61
2080.08
2086.59
2093.14
2099.74
2106.37
2113.05
2119.77
2126.53
2133.33
2140.18
2147.07
2154.01
2160.99
2168.02
2175.10
2182.21

1838.24
1844.17
1850.14
1856.15
1862.20
1868.29
1874.41
1880.58
1886.79
1892.15
1898.43
1904.76
1910.22
1916.63
1922.15
1928.64
1934.24
1940.81
1946.47
1952.17
1958.86
1964.64
1970.44
1976.28
1982.16
1988.07
1994.02
2000.00
2006.02
2012.07
2018.16
2024.29
2030.46
2036.66
2042.90
2049.18
2055.50
2061.86
2068.25
2074.69
2081.17
2087.68
2094.24
2100.84
2107.48
2114.16
2120.89
2127.66
2134.47
2141.33
2148.23
2155.17
2162.16
2169.20
2176.28
2183.41

1839.08
1845.02
1851.85
1857.01
1863.06
1869.16
1875.29
1881.47
1887.68
1893.04
1899.34
1905.67
1911.13
1917.55
1923.08
1929.57
1935.17
1941.75
1947.42
1953.13
1959.82
1965.60
1971.41
1977.26
1983.14
1989.06
1995.01
2001.00
2007.02
2013.09
2019.18
2025.32
2031.49
2037.70
2043.94
2050.23
2056.56
2062.92
2069.32
2075.77
2082.25
2088.77
2095.34
2101.94
2108.59
2115.28
2122.02
2128.79
2135.61
2142.47
2149.38
2156.33
2163.33
2170.37
2177.46
2184.60

1840.77
1846.72
1852.71
1858.74
1864.80
1870.03
1876.17
1882.35
1888.57
1894.84
1900.24
1906.58
1912.05
1918.47
1924.00
1930.50
1936.11
1942.69
1948.37
1954.08
1960.78
1966.57
1972.39
1978.24
1984.13
1990.05
1996.01
2002.00
2008.03
2014.10
2020.20
2026.34
2032.52
2038.74
2044.99
2051.28
2057.61
2063.98
2070.39
2076.84
2083.33
2089.86
2096.44
2103.05
2109.70
2116.40
2123.14
2129.93
2136.75
2143.62
2150.54
2157.50
2164.50
2171.55
2178.65
2185.79

1841.62
1847.58
1853.57
1859.60
1865.67
1871.78
1877.05
1883.24
1889.47
1895.73
1901.14
1907.49
1913.88
1919.39
1925.85
1931.43
1937.05
1943.63
1949.32
1955.03
1961.75
1967.54
1973.36
1979.22
1985.11
1991.04
1997.00
2003.00
2009.04
2015.11
2021.22
2027.37
2033.55
2039.78
2046.04
2052.33
2058.67
2065.05
2071.47
2077.92
2084.42
2090.96
2097.54
2104.16
2110.82
2117.52
2124.27
2131.06
2137.89
2144.77
2151.69
2158.66
2165.67
2172.73
2179.84
2186.99

1842.47
1848.43
1854.43
1860.47
1866.54
1872.66
1878.82
1884.13
1890.36
1896.63
1902.04
1908.40
1914.79
1920.31
1926.78
1932.37
1938.92
1944.58
1950.27
1956.95
1962.71
1968.50
1974.33
1980.20
1986.10
1992.03
1998.00
2004.01
2010.05
2016.13
2022.24
2028.40
2034.59
2040.82
2047.08
2053.39
2059.73
2066.12
2072.54
2079.00
2085.51
2092.05
2098.64
2105.26
2111.93
2118.64
2125.40
2132.20
2139.04
2145.92
2152.85
2159.83
2166.85
2173.91
2181.03
2188.18
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2189.38
2196.60
2203.86
2211.17
2218.52
2225.93
2233.39
2240.90
2248.45
2256.06
2263.72
2271.44
2279.20
2287.02
2294.89
2302.82
2310.80
2318.84
2326.93
2335.08
2343.29
2351.56
2359.88
2368.27
2376.71
2385.21
2393.78
2402.40
2411.09
2419.84
2428.66
2437.54
2446.48
2455.49
2464.57
2473.72
2482.93
2492.21
2501.56
2510.99
2520.48
2530.04
2539.68
2549.39
2559.18
2569.04
2578.98
2589.00
2599.09
2609.26
2619.52
2629.85
2640.26
2650.76
2661.34
2672.01

2190.58
2197.80
2205.07
2212.39
2219.76
2227.17
2234.64
2242.15
2249.72
2257.34
2265.01
2272.73
2280.50
2288.33
2296.21
2304.15
2312.14
2320.19
2328.29
2336.45
2344.67
2352.94
2361.28
2369.67
2378.12
2386.63
2395.21
2403.85
2412.55
2421.31
2430.13
2439.02
2447.98
2457.00
2466.09
2475.25
2484.47
2493.77
2503.13
2512.56
2522.07
2531.65
2541.30
2551.02
2560.82
2570.69
2580.65
2590.67
2600.78
2610.97
2621.23
2631.58
2642.01
2652.52
2663.12
2673.80

2191.78
2199.01
2206.29
2213.61
2220.99
2228.41
2235.89
2243.41
2250.98
2258.61
2266.29
2274.02
2281.80
2289.64
2297.53
2305.48
2313.48
2321.53
2329.64
2337.81
2346.04
2354.33
2362.67
2371.07
2379.54
2388.06
2396.64
2405.29
2414.00
2422.77
2431.61
2440.51
2449.48
2458.51
2467.61
2476.78
2486.02
2495.32
2504.70
2514.14
2523.66
2533.25
2542.91
2552.65
2562.46
2572.35
2582.31
2592.35
2602.47
2612.67
2622.95
2633.31
2643.75
2654.28
2664.89
2675.59
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2192.98
2200.22
2207.51
2214.84
2222.22
2229.65
2237.14
2244.67
2252.25
2259.89
2267.57
2275.31
2283.11
2290.95
2298.85
2306.81
2314.81
2322.88
2331.00
2339.18
2347.42
2355.71
2364.07
2372.48
2380.95
2389.49
2398.08
2406.74
2415.46
2424.24
2433.09
2442.00
2450.98
2460.02
2469.14
2478.31
2487.56
2496.88
2506.27
2515.72
2525.25
2534.85
2544.53
2554.28
2564.10
2574.00
2583.98
2594.03
2604.17
2614.38
2624.67
2635.05
2645.50
2656.04
2666.67
2677.38

2194.19
2201.43
2208.72
2216.07
2223.46
2230.90
2238.39
2245.93
2253.52
2261.16
2268.86
2276.61
2284.41
2292.26
2300.17
2308.14
2316.16
2324.23
2332.36
2340.55
2348.80
2357.10
2365.46
2373.89
2382.37
2390.91
2399.52
2408.19
2416.92
2425.71
2434.57
2443.49
2452.48
2461.54
2470.66
2479.85
2489.11
2498.44
2507.84
2517.31
2526.85
2536.46
2546.15
2555.91
2565.75
2575.66
2585.65
2595.72
2605.86
2616.09
2626.40
2636.78
2647.25
2657.81
2668.45
2679.17
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2195.39
2202.64
2209.94
2217.29
2224.69
2232.14
2239.64
2247.19
2254.79
2262.44
2270.15
2277.90
2285.71
2293.58
2301.50
2309.47
2317.50
2325.58
2333.72
2341.92
2350.18
2358.49
2366.86
2375.30
2383.79
2392.34
2400.96
2409.64
2418.38
2427.18
2436.05
2444.99
2453.99
2463.05
2472.19
2481.39
2490.66
2500.00
2509.41
2518.89
2528.45
2538.07
2547.77
2557.54
2567.39
2577.32
2587.32
2597.40
2607.56
2617.80
2628.12
2638.52
2649.01
2659.57
2670.23
2680.97
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2682.76
2693.60
2704.53
2715.55
2726.65
2737.85
2749.14
2760.52
2772.00
2783.58
2795.25
2807.02
2818.89
2830.86
2842.93
2855.10
2867.38
2879.77
2892.26
2904.87
2917.58
2930.40
2943.34
2956.39
2969.56
2982.85
2996.25
3009.78
3023.43
3037.21
3051.11
3065.13
3079.29
3093.58
3108.00
3122.56
3137.25
3152.09
3167.06
3182.18
3197.44
3212.85
3228.41
3244.12
3259.98
3276.00
3292.18
3308.52
3325.02
3341.69
3358.52
3375.53
3392.71
3410.06
3427.59
3445.31

2684.56
2695.42
2706.36
2717.39
2728.51
2739.73
2751.03
2762.43
2773.93
2785.52
2797.20
2808.99
2820.87
2832.86
2844.95
2857.14
2869.44
2881.84
2894.36
2906.98
2919.71
2932.55
2945.51
2958.58
2971.77
2985.07
2998.50
3012.05
3025.72
3039.51
3053.44
3067.48
3081.66
3095.98
3110.42
3125.00
3139.72
3154.57
3169.57
3184.71
3200.00
3215.43
3231.02
3246.75
3262.64
3278.69
3294.89
3311.26
3327.79
3344.48
3361.34
3378.38
3395.59
3412.97
3430.53
3448.28

2686.37
2697.24
2708.19
2719.24
2730.38
2741.60
2752.92
2764.34
2775.85
2787.46
2799.16
2810.96
2822.87
2834.87
2846.98
2859.19
2871.50
2883.92
2896.45
2909.09
2921.84
2934.70
2947.68
2960.77
2973.98
2987.30
3000.75
3014.32
3028.01
3041.83
3055.77
3069.84
3084.04
3098.37
3112.84
3127.44
3142.18
3157.06
3172.09
3187.25
3202.56
3218.02
3233.63
3249.39
3265.31
3281.38
3297.61
3314.00
3330.56
3347.28
3364.17
3381.23
3398.47
3415.88
3433.48
3451.25

2688.17
2699.06
2710.03
2721.09
2732.24
2743.48
2754.82
2766.25
2777.78
2789.40
2801.12
2812.94
2824.86
2836.88
2849.00
2861.23
2873.56
2886.00
2898.55
2911.21
2923.98
2936.86
2949.85
2962.96
2976.19
2989.54
3003.00
3016.59
3030.30
3044.14
3058.10
3072.20
3086.42
3100.78
3115.26
3129.89
3144.65
3159.56
3174.60
3189.79
3205.13
3220.61
3236.25
3252.03
3267.97
3284.07
3300.33
3316.75
3333.33
3350.08
3367.00
3384.09
3401.36
3418.80
3436.43
3454.23

2689.98
2700.88
2711.86
2722.94
2734.11
2745.37
2756.72
2768.17
2779.71
2791.35
2803.08
2814.92
2826.86
2838.89
2851.03
2863.28
2875.63
2888.09
2900.65
2913.33
2926.12
2939.02
2952.03
2965.16
2978.41
2991.77
3005.26
301887
3032.60
3046.46
3060.44
3074.56
3088.80
3103.18
3117.69
3132.34
3147.13
3162.06
3177.12
3192.34
3207.70
3223.21
3238.87
3254.68
3270.65
3286.77
3303.06
3319.50
3336.11
3352.89
3369.84
3386.96
3404.26
3421.73
3439.38
3457.22

2691.79
2702.70
2713.70
2724.80
2735.98
2747.25
2758.62
2770.08
2781.64
2793.30
2805.05
2816.90
2828.85
2840.91
2853.07
2865.33
2877.70
2890.17
2902.76
2915.45
2928.26
2941.18
2954.21
2967.36
2980.63
2994.01
3007.52
3021.15
3034.90
3048.78
3062.79
3076.92
3091.19
3105.59
3120.12
3134.80
3149.61
3164.56
3179.65
3194.89
3210.27
3225.81
3241.49
3257.33
3273.32
3289.47
3305.79
3322.26
3338.90
3355.70
3372.68
3389.83
3407.16
3424.66
3442.34
3460.21
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3463.20
3481.29
3499.56
3518.03
3536.69
3555.56
3574.62
3593.89
3613.37
3633.06
3652.97
3673.09
3693.44
3714.02
3734.83
3755.87
3777.15
3798.67
3820.44
3842.46
3864.73
3887.27
3910.07
3933.14
3956.48
3980.10
4004.00
4028.20
4052.68
4077.47
4102.56
4127.97
4153.69
4179.73
4206.10
4232.80
4259.85
4287.25
4314.99
4343.11
4371.58
4400.44
4429.68
4459.31
4489.34
4519.77
4550.63
4581.90
4613.61
4645.76
4678.36
4711.43
4744.96
4778.97
4813.48
4848.48

3466.20
3484.32
3502.63
3521.13
3539.82
3558.72
3577.82
3597.12
3616.64
3636.36
3656.31
3676.47
3696.86
3717.47
3738.32
3759.40
3780.72
3802.28
3824.09
3846.15
3868.47
3891.05
3913.89
3937.01
3960.40
3984.06
4008.02
4032.26
4056.80
4081.63
4106.78
4132.23
4158.00
4184.10
4210.53
4237.29
4264.39
4291.85
4319.65
4347.83
4376.37
4405.29
4434.59
4464.29
4494.38
4524.89
4555.81
4587.16
4618.94
4651.16
4683.84
4716.98
4750.59
4784.69
4819.28
4854.37

3469.21
3487.36
3505.70
3524.23
3542.96
3561.89
3581.02
3600.36
3619.91
3639.67
3659.65
3679.85
3700.28
3720.93
3741.81
3762.94
3784.30
3805.90
3827.75
3849.86
3872.22
3894.84
3917.73
3940.89
3964.32
3988.04
4012.04
4036.33
4060.91
4085.80
4111.00
4136.50
4162.33
4188.48
4214.96
4241.78
4268.94
4296.46
4324.32
4352.56
4381.16
4410.14
4439.51
4469.27
4499.44
4530.01
4561.00
4592.42
4624.28
4656.58
4689.33
4722.55
4756.24
4790.42
4825.09
4860.27
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3472.22]
3490.40
3508.77
3527.34
3546.10
3565.06
3584.23
3603.60
3623.19
3642.99
3663.00
3683.24
3703.70
3724.39
3745.32
3766.48
3787.88
3809.52
3831.42
3853.56
3875.97
3898.64
3921.57
3944.77
3968.25
3992.02
4016.06
4040.40
4065.04
4089.98
4115.23
4140.79
4166.67
4192.87
4219.41
4246.28
4273.50
4301.08
4329.00
4357.30
4385.96
4415.01
4444.44
4474.27
4504.50
4535.15
4566.21
4597.70
4629.63
4662.00
4694.84
4728.13
4761.90
4796.16
4830.92
4866.18

3475.24
3493.45
3511.85
3530.45
3549.25
3568.24
3587.44
3606.85
3626.47
3646.31
3666.36
3686.64
3707.14
3727.87
3748.83
3770.03
3791.47
3813.16
3835.09
3857.28
3879.73
3902.44
3925.42
3948.67
3972.19
3996.00
4020.10
4044.49
4069.18
4094.17
4119.46
4145.08
4171.01
4197.27
4223.86
4250.80
4278.07
4305.71
4333.69
4362.05
4390.78
4419.89
4449.39
4479.28
4509.58
4540.30
4571.43
4602.99
4634.99
4667.44
4700.35
4733.73
4767.58
4801.92
4836.76
4872.11
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3478.26
3496.50
3514.94
3533.57
3552.40
3571.43
3590.66
3610.11
3629.76
3649.64
3669.72
3690.04
3710.58
3731.34
3752.35
3773.58
3795.07
3816.79
3838.77
3861.00
3883.50
3906.25
3929.27
3952.57
3976.14
4000.00
4024.14
4048.58
4073.32
4098.36
4123.71
4149.38
4175.37
4201.68
4228.33
4255.32
4282.66
4310.34
4338.39
4366.81
4395.60
4424.78
4454.34
4484.30
4514.67
4545.45
4576.66
4608.29
4640.37
4672.90
4705.88
4739.34
4773.27
4807.69
4842.62
4878.05
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4884.00
4920.05
4956.63
4993.76
5031.45
5069.71
5108.56
5148.01
5188.07
5228.76
5270.09
5312.08
5354.75
5398.11
5442.18
5486.97
5532.50
5578.80
5625.88
5673.76
5722.46
5772.01
5822.42
5873.72
5925.93
5979.07
6033.18
6088.28
6144.39
6201.55
6259.78
6319.12
6379.59
6441.22
6504.07
6568.14
6633.50
6700.17
6768.19
6837.61
6908.46
6980.80
7054.67
7130.12
7207.21
7285.97
7366.48
7448.79
7532.96
7619.05
7707.13
7797.27
7889.55
7984.03
8080.81
8179.96

4889.98
4926.11
4962.78
5000.00
5037.78
5076.14
5115.09
5154.64
5194.81
5235.60
5277.04
5319.15
5361.93
5405.41
5449.59
5494.51
5540.17
5586.59
5633.80
5681.82
5730.66
5780.35
5830.90
5882.35
5934.72
5988.02
6042.30
6097.56
6153.85
6211.18
6269.59
6329.11
6389.78
6451.61
6514.66
6578.95
6644.52
6711.41
6779.66
6849.32
6920.42
6993.01
7067.14
7142.86
7220.22
7299.27
7380.07
7462.69
7547.17
7633.59
7722.01
7812.50
7905.14
8000.00
8097.17
8196.72

4895.96
4932.18
4968.94
5006.26
5044.14
5082.59
5121.64
5161.29
5201.56
5242.46
5284.02
5326.23
5369.13
5412.72
5457.03
5502.06
5547.85
5594.41
5641.75
5689.90
5738.88
5788.71
5839.42
5891.02
5943.54
5997.00
6051.44
6106.87
6163.33
6220.84
6279.43
6339.14
6400.00
6462.04
6525.29
6589.79
6655.57
6722.69
6791.17
6861.06
6932.41
7005.25
7079.65
7155.64
7233.27
7312.61
7393.72
7476.64
7561.44
7648.18
7736.94
7827.79
7920.79
8016.03
8113.59
8213.55

4901.96
4938.27
4975.12
5012.53
5050.51
5089.06
5128.21
5167.96
5208.33
5249.34
5291.01
5333.33
5376.34
5420.05
5464.48
5509.64
5555.56
5602.24
5649.72
5698.01
5747.13
5797.10
5847.95
5899.71
5952.38
6006.01
6060.61
6116.21
6172.84
6230.53
6289.31
6349.21
6410.26
6472.49
6535.95
6600.66
6666.67
6734.01
6802.72
6872.85
6944.44
7017.54
7092.20
7168.46
7246.38
7326.01
7407.41
7490.64
7575.76
7662.84
7751.94
7843.14
7936.51
8032.13
8130.08
8230.45

4907.98
4944.38
4981.32
5018.82
5056.89
5095.54
5134.79
5174.64
5215.12
5256.24
5298.01
5340.45
5383.58
5427.41
5471.96
5517.24
5563.28
5610.10
5657.71
5706.13
5755.40
5805.52
5856.52
5908.42
5961.25
6015.04
6069.80
6125.57
6182.38
6240.25
6299.21
6359.30
6420.55
6482.98
6546.64
6611.57
6677.80
6745.36
6814.31
6884.68
6956.52
7029.88
7104.80
7181.33
7259.53
7339.45
7421.15
7504.69
7590.13
7677.54
7766.99
7858.55
7952.29
8048.29
8146.64
8247.42

4914.00
4950.50
4987.53
5025.13
5063.29
5102.04
5141.39
5181.35
5221.93
5263.16
5305.04
5347.59
5390.84
5434.78
5479.45
5524.86
5571.03
5617.98
5665.72
5714.29
5763.69
5813.95
5865.10
5917.16
5970.15
6024.10
6079.03
6134.97
6191.95
6250.00
6309.15
6369.43
6430.87
6493.51
6557.38
6622.52
6688.96
6756.76
6825.94
6896.55
6968.64
7042.25
7117.44
7194.24
7272.73
7352.94
7434.94
7518.80
7604.56
7692.31
7782.10
7874.02
7968.13
8064.52
8163.27
8264.46
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8281.57
8385.74
8492.57
8602.15
8714.60
8830.02
8948.55
9070.29
9195.40
9324.01
9456.26
9592.33
9732.36
9876.54
10025.06
10178.12
10335.92
10498.69
10666.67
10840.11
11019.28
11204.48
11396.01
11594.20
11799.41
12012.01
12232.42
12461.06
12698.41
12944.98
13201.32
13468.01
13745.70
14035.09
14336.92
14652.01
14981.27
15325.67
15686.27
16064.26
16460.91
16877.64
17316.02
17777.78
18264.84
18779.34
19323.67
19900.50
20512.82
21164.02
21857.92
22598.87
23391.81
24242.42
25157.23
26143.79

8298.76
8403.36
8510.64
8620.69
8733.62
8849.56
8968.61
9090.91
9216.59
9345.79
9478.67
9615.38
9756.10
9900.99
10050.25
10204.08
10362.69
10526.32
10695.19
10869.57
11049.72
11235.96
11428.57
11627.91
11834.32
12048.19
12269.94
12500.00
12738.85
12987.01
13245.03
13513.51
13793.10
14084.51
14388.49
14705.88
15037.59
15384.62
15748.03
16129.03
16528.93
16949.15
17391.30
17857.14
18348.62
18867.92
19417.48
20000.00
20618.56
21276.60
21978.02
22727.27
23529.41
24390.24
25316.46
26315.79

8316.01
8421.05
8528.78
8639.31
8752.74
8869.18
8988.76
9111.62
9237.88
9367.68
9501.19
9638.55
9779.95
9925.56
10075.57
10230.18
10389.61
10554.09
10723.86
10899.18
11080.33
11267.61
11461.32
11661.81
11869.44
12084.59
12307.69
12539.18
12779.55
13029.32
13289.04
13559.32
13840.83
14134.28
14440.43
14760.15
15094.34
15444.02
15810.28
16194.33
16597.51
17021.28
17467.25
17937.22
18433.18
18957.35
19512.20
20100.50
20725.39
21390.37
22099.45
22857.14
23668.64
24539.88
25477.71
26490.07
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8333.33
8438.82
8547.01
8658.01
8771.93
8888.89
9009.01
9132.42
9259.26
9389.67
9523.81
9661.84
9803.92
9950.25
10101.01
10256.41
10416.67
10582.01
10752.69
10928.96
11111.11
11299.44
11494.25
11695.91
11904.76
12121.21
12345.68
12578.62
12820.51
13071.90
13333.33
13605.44
13888.89
14184.40
14492.75
14814.81
15151.52
15503.88
15873.02
16260.16
16666.67
17094.02
17543.86
18018.02
18518.52
19047.62
19607.84
20202.02
20833.33
21505.38
22222.22
22988.51
23809.52
24691.36
25641.03
26666.67

8350.73
8456.66
8565.31
8676.79
8791.21
8908.69
9029.35
9153.32
9280.74
9411.76
9546.54
9685.23
9828.01
9975.06
10126.58
10282.78
10443.86
10610.08
10781.67
10958.90
11142.06
11331.44
11527.38
11730.21
11940.30
12158.05
12383.90
12618.30
12861.74
13114.75
13377.93
13651.88
13937.28
14234.88
14545.45
14869.89
15209.13
15564.20
15936.25
16326.53
16736.40
17167.38
17621.15
18099.55
18604.65
19138.76
19704.43
20304.57
20942.41
21621.62
22346.37
23121.39
23952.10
24844.72
25806.45
26845.64
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8368.20
8474.58
8583.69
8695.65
8810.57
8928.57
9049.77
9174.31
9302.33
9433.96
9569.38
9708.74
9852.22
10000.00
10152.28
10309.28
10471.20
10638.30
10810.81
10989.01
11173.18
11363.64
11560.69
11764.71
11976.05
12195.12
12422.36
12658.23
1903.23
13157.89
13422.82
13698.63
13986.01
14285.71
14598.54
14925.37
15267.18
15625.00
16000.00
16393.44
16806.72
17241.38
17699.12
18181.82
18691.59
19230.77
19801.98
20408.16
21052.63
21739.13
22471.91
23255.81
24096.39
25000.00
25974.03
27027.03
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27210.88
28368.79
29629.63
31007.75
32520.33
34188.03
36036.04
38095.24
40404.04
43010.75
45977.01
49382.72
53333.33
57971.01
63492.06
70175.44
78431.37
88888.89
102564.10
121212.12
148148.15
190476.19
266666.67
444444.44
1333333.33

27397.26
28571.43
29850.75
31250.00
32786.89
34482.76
36363.64
38461.54
40816.33
43478.26
46511.63
50000.00
54054.05
58823.53
64516.13
71428.57
80000.00
90909.09
105263.16
125000.00
153846.15
200000.00
285714.29
500000.00
2000000.00

27586.21
28776.98
30075.19
31496.06
33057.85
34782.61
36697.25
38834.95
41237.11
43956.04
47058.82
50632.91
54794.52
59701.49
65573.77
72727.27
81632.65
93023.26
108108.11
129032.26
160000.00
210526.32
307692.31
571428.57
4000000.00

27777.78
28985.51
30303.03
31746.03
33333.33
35087.72
37037.04
39215.69
41666.67
44444.44
47619.05
51282.05
55555.56
60606.06
66666.67
74074.07
83333.33
95238.10
111111.11
133333.33
166666.67
222222.22
333333.33
666666.67

27972.03
29197.08
30534.35
32000.00
33613.45
35398.23
37383.18
39603.96
42105.26
44943.82
48192.77
51948.05
56338.03
61538.46
67796.61
75471.70
85106.38
97560.98
114285.71
137931.03
173913.04
235294.12
363636.36
800000.00

28169.01
29411.76
30769.23
32258.06
33898.31
35714.29
37735.85
40000.00
42553.19
45454.55
48780.49
52631.58
57142.86
62500.00
68965.52
76923.08
86956.52
100000.00
117647.06
142857.14
181818.18
250000.00
400000.00
1000000.00
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Image-Based Auto-Trigger
The Image-Based Auto-Trigger feature allows selected Phantom camera models, (Miro eX 2
(optional), Miro eX 4, and soon the “newer” v-Series cameras, to trigger themselves when the image
changes in a selectable region of the frame. For the v-Series implementation, there will also be a
mode which allows this feature to generate a hardware trigger signal for multi-camera installations.
A few user definable parameters allow the auto-trigger behavior to be adjusted to operating
conditions, filtering out unintended triggers due to vibration, changes in illumination, slow-moving
shadows, etc.
The Auto-Trigger operation begins by the user selecting a rectangular area within the image, similar
to the region used for auto-exposure, the Auto-Trigger region.
As each frame is captured, the image in the Auto-Trigger region is compared to an earlier copy of the
same region that has been stored in a dedicated memory. After the comparison is made, the image
in memory is updated to the current image, to be used in the future.
The result of the comparison determines if a trigger is generated. A pixel being compared is
considered “active" if its level has changed, (brightened or darkened), by more than a preset
threshold. The number of active pixels for a given frame is counted, and if it exceeds a set number, a
trigger is generated. The required number of active pixels is specified as a percentage of the area of
the Auto-Trigger region.
When an Auto-Trigger condition is detected, the Auto-Trigger signal of the camera is pulled low. The
Auto-Trigger signal is available on Pin-N of the Capture connector.

IMAGE-BASED AUTO-TRIGGER OPERATING MODES
Several operating modes are possible for the Image-Based Auto-Trigger system:
MODE

FUNCTIONAL DESCRIPTION

Mode 0

Image-Based Auto-Trigger is disabled.

Mode 1

Camera will drive both the auto-trigger and trigger itself when an auto-trigger is
detected. If the auto-trigger signal is pulled low by an external device, the camera
will be triggered.

Mode 2

The image changes are analyzed, and when an auto-trigger condition has been
detected, the auto-trigger signal will be pulled low, as in Mode 1. However, the
camera will not trigger itself. An external device pulling the auto-trigger signal low will
not trigger the camera either.
Mode 2 is useful when external control of the auto-trigger is desired, for instance, it
is required that the auto-trigger feature is disabled for some known transient event.
The auto-trigger signal from the camera will be routed through some external device
and back into the trigger input of the camera.
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MULTI-CAMERA IMAGE-BASED AUTO-TRIGGER
When multiple cameras are used to capture an event, it is usually desirable to trigger all cameras
simultaneously. This can be achieved in two basic ways:
OPTION
Option 1

Option 2

DESCRIPTION

SETUP

All the cameras will be triggered when
either of the cameras detects an
auto-trigger event.

1. Set all cameras to Mode 1.

Only when the primary camera detects
an auto-trigger event it will trigger itself
and simultaneously trigger all the
secondary cameras.

1. Set Primary camera to Mode 1.

2. Connect the auto-trigger signal of all
cameras together.

2. Set all secondary cameras to Mode 0,
(auto-trigger disabled).
3. Connect the auto-trigger signal of the
primary camera to the trigger inputs of
the secondary cameras.
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Image Processing Effects and Filters
Histogram
When the Image Tools dialogue window appears, an image histogram will be displayed in the
window. The image histogram is a graphical representation of the distribution of RGB and/or
luminance values in an image. Each of the values appear on the horizontal axis from dark to light,
(left to right), as shown in the Histogram graphics below. The vertical axis indicates the number of
pixels of that value at each point. At a point where there are many pixels of a value, the
corresponding line spikes; where there are no pixels, it lies at the bottom of the graph.

gray scale values (All pixels)
Color Camera

Red pixel values
Color Camera

Blue pixel values
Color Camera

All color values (All pixels)
Color Camera

Green pixel value
Color Camera

gray scale values (All pixels)
Monochrome Camera

Adjustments (Image Processing Effects)
Move the appropriate slider, to apply the desired image processing adjustment to the images being
displayed in the active Preview or Playback Panel. The sliders can be used to adjust the following
image processing adjustments:
Brightness
This slide bar is used to adjust the brightness of monochrome or color images. The factory
default value is set to 0 (zero). Moving the slide bar to the left, in the negative direction from 0,
results in the images being displayed darker, while moving the slide bar to the right or in a
positive direction from 0 results in the images being displayed lighter.
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Image above set to: (0 - Default)

(-33)

(33)

Selectable Range: -100 to 100
Contrast
This slide bar is used to adjust the contrast of monochrome or color images. The factory
default value is set to 1. Moving the slide bar to the left from 1, results in the images being
displayed with less contrast, while moving the slide bar to the right from 1 result in the images
being displayed with greater contrast.

Image above set to: (1.00 - Default)

(0.50)

(50.00)

Selectable Range: 0 to Infinite
NOTE
By increasing the contrast setting the noise level will increase as well, so only increase as
much as necessary to get a satisfactory image. Being a subjective setting only the user can
determine what satisfactory is.
Gamma
This slide bar is used to adjust the gamma correction of monochrome or color images. The
factory default value is set to q.22. Moving the slide bar to the left from 2.22, results in the
images being displayed with fewer gamma corrections, while moving the slide bar to the right
from 2.22 results in the images being displayed with greater gamma correction.

Image above set to: (2.22 - Default)

(0.25)

(5.01)

© 2015 Vision Research - AMETEK Material Analysis Division

Functional Descriptions

253

Selectable Range: 0.10 to 10.0
Saturation (Color Cameras Only)
This slide bar is used to adjust the color saturation of the images being displayed. The factory
default value is set to 0 (zero). Moving the slide bar to the left, in the negative direction from 0,
results in the images being displayed with less brilliant color, while moving the slide bar to the
right or in a positive direction from 0 results in the images being displayed with more brilliant
color.

Image above set to: (0 - Default)

(-100)

(100)

Selectable Range: -100 to 100
Hue (Color Cameras Only)
This slide bar is used to adjust the color hue of the images being displayed. The factory default
value is set to 0 (zero). Moving the slide bar to the left, in the negative direction from 0, results
in the images being displayed with fewer color hues, while moving the slide bar to the right or
in a positive direction from 0 results in the images being displayed with more color hue.

Image above set to: (0 - Default)

(-100)

(100)

Selectable Range: -180 to 180

White Balance
Move the appropriate slider manually to apply the desired white balance adjustment to the images
displayed in the active Preview or Playback Panel. These slide bars are used to perform a manual
white balance to obtain a white color on an area you know should be white, or, simply to vary the
values of red and blue in the image.
Selectable Range: 0.10 to 10.0
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Above:
Red set to: (1.00 - Default)
Blue set to: (1.00 - Default)

(0.10)
(0.10)

(0.10)
(1.00)

Above:
Red set to: (0.10)
Blue set to: (10.0)

(1.00)
(0.01)

(1.00)
(10.0)

Above:
Red set to: (10.0)
Blue set to: (0.10)

(10.0)
(1.00)

(10.0)
(10.0)

Selectable Range: 0.100 to 10.00
For an instruction on how to perform a White Balance Adjustment automatically, see: Step-byStep Procedures>Preview/Playback Panel Procedures/Performing a White Balance Adjustment.

Sensitivity
This slider is used to select the dynamic range of the image, (the desired number of bits per
pixel), to be displayed on-screen by moving the slider.
· To select the low order, the least significant, bits slide the slider to the left.
· To select the high order, most significant bits, slide the slider to the right.
· To select a range somewhere in the middle simply adjust the slider to the desired gray
scale range.
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Rotate Image
Placing a check mark in this enable box will rotate the image as follows:
Flip H
Displays the image as a mirrored image, the image flips horizontally.

Original

Flip H

Flip V
Displays the image upside-down, the image flips vertically.

Original

Flip V

Rotate
Rotates and displays the image 90° counter-clockwise from the original image.

Original

Flip H

Clockwise
Rotates and displays the image 90° clockwise from the original image.
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Original

Flip H

Filter
Select the desired filter, to be applied to the image or cine file in the active Preview/Playback
Panel, from the Filter pull-down selection list. The Phantom Camera Control application provides
the following image filtering algorithms:
None
Used to display the images as they were originally recorded, prior to applying any of the other
filtering techniques to the images.
Smooth Gauss 3x3 or 5x5
Used to blur or “smooth” the images based on a 3-by-3-, or 5-by-5-pixel Gaussian filter.
Sharpen
Used to emphasize the edges within an image. The result is that the image appears to have
increased sharpness.
Edge Hipass 3x3 or 5x5
Used to enhance or isolate 3-by-3-, or 5-by-5-pixel transition areas, or "edges," in an image
by enhancing the high-frequency detail.

Applied filter: None

Edge Hipass 3x3

Edge Hipass 5x5

Edge Laplacian 3x3 of 5x5
The 5x5 Laplacian used is a convoluted mask to approximate the second derivative, unlike
the Sobel method which approximates the gradient. And instead of two 3x3 Sobel masks, one
for the x and y directions, Laplace uses one 5x5 mask for the 2nd derivative in both the x and
y directions. However, because these masks are approximating a second derivative
measurement on the image, they are very sensitive to noise.
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Applied filter: None

Edge Laplacian 3x3
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Edge Laplacian 5x5

Edge Prewitt Horizontal or Vertical
Prewitt is a method of edge detection in computer graphics, which calculates the maximum
response of a set of convolution kernels to find the local edge orientation for each pixel.
Various kernels can be used for this operation. The whole set of 8 kernels is produced by
taking one of the kernels and rotating its coefficients circularly. Each of the resulting kernels is
sensitive to an edge orientation ranging from 0° to 315° in steps of 45°, where 0° corresponds
to a vertical edge.

Applied filter: None

Edge Prewitt Horizontal

Edge Prewitt Vertical

The maximum response for each pixel is the value of the corresponding pixel in the output
magnitude image. The values for the output orientation image lie between 1 and 8, depending
on which of the 8 kernels produced the maximum response.
This edge detection method is also called edge template matching, because a set of edge
templates is matched to the image, each representing an edge in a certain orientation. The
edge magnitude and orientation of a pixel are then determined by the template that matches
the local area of the pixel the best.
The Prewitt edge detector is an appropriate way to estimate the magnitude and orientation of
an edge. Although differential gradient edge detection needs a rather time-consuming
calculation to estimate the orientation from the magnitudes in the x- and y-directions, the
Prewitt edge detection obtains the orientation directly from the kernel with the maximum
response. The set of kernels is limited to 8 possible orientations. However, experience shows
that most direct orientation estimates are not much more accurate. On the other hand, the set
of kernels needs 8 convolutions for each pixel, whereas the set of the kernel in gradient
method needs only 2, one kernel being sensitive to edges in the vertical direction and one to
the horizontal direction. The result for the edge magnitude image is very similar with both
methods, provided the same convolving kernel is used.
Edge Sobel Horizontal or Vertical
The Sobel operator is an operator used in image processing, particularly within edge
detection algorithms. Technically, it is a discrete differentiation operator, computing an
approximation of the gradient of the image intensity function. At each point in the image, the
result of the Sobel operator is either the corresponding gradient vector or the norm of this
vector.
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Applied filter: None

Edge Sobel Horizontal

Edge Sobel Vertical

In simple terms, the operator calculates the gradient of the image intensity at each point,
giving the direction of the largest possible increase from light to dark and the rate of change in
that direction. The result, therefore, shows how "abruptly" or "smoothly" the image changes at
that point, and therefore, how likely it is that part of the image represents an edge, as well as
how that edge is likely to be oriented. In practice, the magnitude (likelihood of an edge)
calculation is more reliable and easier to interpret than the direction calculation.
Mathematically, the gradient of a two-variable function (here the image intensity function) is at
each image point a 2D vector with the components given by the derivatives in the horizontal
and vertical directions. At each image point, the gradient vector points in the direction of the
largest possible intensity increase, and the length of the gradient vector corresponds to the
rate of change in that direction. This implies that the result of the Sobel operator at an image
point which is in a region of constant image intensity is a zero vector and at a point on an
edge is a vector which points across the edge, from darker to brighter values.
User Filter
Presently disabled.

Grid
Enable, (check), the Grid enable box to super-impose 7 horizontal lines and 7 vertical line,
evenly spaced over the Preview or Playback Panels to form an 8-row; 8-column grid.

Cross
Enable, (check), the Cross enable box to super-impose a horizontal line in the middle, and a
vertical line in the center, of the Preview or Playback Panels.

Default Button
Click the Default button to reset all the image processing Tools back to factory default settings.

© 2015 Vision Research - AMETEK Material Analysis Division

Functional Descriptions

5.7

259

Phantom Camera Control Application Polling Process
The Phantom Camera Control application uses a broadcast message mechanism to detect
connected cameras and their IP addresses automatically. In some earlier version of the software only
the networked cameras that responded to the broadcast message would be available for use by the
Phantom Control Unit. This broadcast mechanism utilizes UDP, (User Datagram Protocol), packets
to deliver the broadcasting messages. However, some encrypting systems will not support the
transfer of UDP packets.
Furthermore, some networking environments prohibit UDP, (User Datagram Protocol), packets from
being transmitted across the network. When Phantom cameras are placed in these types of
networking environments the Camera Visibility - All Network Cameras List will not be able to populate
the list with the camera name, serial number, and IP address of each of the cameras in the camera
network. With these types of networking environments the end-user will need to essentially build a
static IP address list of the cameras within the network and add them to the "Visible Cameras List".
In networking environments that allow UDP, (User Datagram Protocol), packets to be broadcast
across the network the Camera Visibility - All Network Cameras List should automatically populate
the list with the camera name, serial number, and IP address, of each of the cameras in the network.
This version of the software has been designed to:
· Allow access to Phantom cameras, without using the UDP broadcast mechanism, by utilizing an
"Add to Visible List" button in the Camera Visibility dialogue window, and
· Manage the list of Visible Cameras for each Phantom Control Unit computer, especially when
there are multiple computers and cameras in the network, and you want to dedicate them. We
will use the term “connect” referring to the logically connected cameras (visible) and not to the
physically connected cameras.
When multiple controller units are networked together to control multiple Phantom cameras, each
controller unit will display, in its' All Network Cameras List, all the Phantom cameras that replied to
the broadcast poll process, even if a camera has been added to the Visible Cameras List of another
Phantom Controller Unit.
NOTE
The software will not provide any indication that another Phantom Controller Unit has already
added the camera to its Visible Cameras List. Therefore, multiple Phantom Control Units could
essentially add the same camera to their own Visible Cameras List.
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Phantom CineMag Operational Modes
Phantom cameras that support a Phantom CineMag can operate in one of two operational mode,
including:
Loop
When the camera is in the Loop Mode, the Phantom camera stores the recorded image data into
the camera's DRAM buffer. In this mode, the Phantom CineMag operates like any other Flash
card, after a cine file, (image data), is recorded into the camera's DRAM frame buffer, the enduser manually saves the image data it into the Phantom CineMag by initiating the Save to Flash
command window, which can be accessed via the Cine Pull-down Menu.
NOTE
This mode supports recording up to the maximum Sample rate.
R/S (Run/Stop)
In Run/Stop Mode the image data is recorded directly into the Phantom CineMag. For example, a
Phantom HD will store the image data at a rate up to 450fps at the HD resolution of 2048 x 1080.
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Phantom File Naming Convention
Even a relatively short movie result in a very large number of image files that later ought to be
individually retrievable; naming these files by hand is impractical. The unique file naming in the
Phantom camera is automatic. In order to provide this function in the Phantom software it was
necessary for Vision Research to develop a small "language" for specifying file names using a few
special characters that are legal for filenames but seldom used. The Phantom software recognizes
these characters and substitutes them with different counters from the software.

Insert the Cine File Number into the Path and/or File Name(s)
Description
Used to insert the cine file number to the path and/or file names. The single digit number
specifies the number of digit places appended to the root file name.
The @ character can be used within both path names and file names. The cine number
counter is initialized to zero each time the software is started and incremented by 1 each time
a cine is saved to a drive.
Syntax
@ followed by a single digit
Single Digit Range
1 through 8

Denote a Session Number into the Path and/or File Name(s)
Description
Used to denote a session number, if desired, in the path and/or file names. The single digit
number specifies the number of digit places appended.
Syntax
$ followed by a single digit
Single Digit Range
1 through 8
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Insert the Current Date and Time within the File Name(s) Only
Description
The ~ character previously use to insert the current date and time within the file names has
been enhanced as follows:
– Placing the ~ character, followed by anything else other than the number 8, after the root
file name, will append the cine full trigger time string which includes the day of the week,
year, month, day, hour, minute, seconds and fractions of seconds.
Example: test~5 where test is the root file name, ~ is the special file naming convention
character, and 5 is a required variable other than 8 .
Result: testMon Dec 13 2010 18 46 59.814 133.125.cine.
– Placing the ~ character, followed by the number 8 only, after the root file name, will
append part of the cine full trigger time string including the first two character from the
months name, the day, the hour, and the minute.
Example: test~8 (where test is the root file name, ~ is the special file naming convention
character and 8 is the required variable.
Result: testDE131847.cine

Inserts an Image Number into the File Name (Starting from One)
Description
Used to inserts the image number in the file name. The single digit number specifies the
number of digit places appended to the root file name.
Use a separate folder for each recording sequence to prevent the single images of future
recording from overwriting your stored images because of duplicate file names.
CAUTION
When saving your files as a series of still images, you must follow this naming convention
or the individual images will be overwritten every time the camera stores additional Images.
Syntax
+ followed by a single digit
Single Digit Range
1 through 8
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Insert an Image Number in the File Name (Starting with the First Frame’s Image
Number)
Description
Used to insert the image number in the file name, starting from the first frame’s number. The
single digit number specifies the number of digit places appended to the root file name.
Remember to consider the minus sign in the image number, too.
Syntax
! followed by a single digit
Single Digit Range
1 through 8

Automatically Group Individual Still Image Series into Individual Folders with
Unique Folder Names
Description
Use this procedure to automatically group your individual still image series in individual folders
with unique names. Using a separate folder for each recording sequence prevents the single
images of future recording from overwriting your stored images because of duplicate file
names.
CAUTION
When saving your files as a series of still images, you must follow this naming convention
or individual images will be overwritten every time the camera stores additional Images.
Syntax
+ followed by a single digit
Single Digit Range
1 through 8
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Phantom File Naming Convention Examples
Create a Directory to Hold Individual Images Extracted from the Original Cine
If the file name pattern is C:\NewDir\Img+5.tif
Upon execution of this routine, this simple file name entry will create a new directory on your C:\
drive named "NewDir" to hold the individual .tif images that will be extracted from the original
cine file. You may change the name "NewDir" to any name you like.
NOTE
Multiple cine file may be selected.
The Img+5.tif portion of the naming structure will instruct the Phantom software to save the files
in the order, they were taken adding a number starting at 1. "Img" in the name is the root
designator for the images. You may change "Img" to Pic for picture, Frm for frame or any other
characters that fit your needs. The "+5" instructs the application to append 5 character places to
each image.
Upon completion of this routine, you will find a directory on your C:\ drive named "NewDir" and
the files in that directory will look as follows:
Img00001.tif
Img00002.tif
Img00003.tif

Automatically Name a New and Unique Directory, and Sequentially Number
Individual Image Files Stored Inside
A file name using this "+" method could use the "@" symbol to automatically name a new and
unique directory, and the "+" sign to sequentially number the individual image files that will be
stored inside.
Example: C:\Phantom\yourdirname@2\PIC+4.BMP
Result in: C:\Phantom\yourdirname01\PIC0001.BMP (Directory with the following image file
stored inside)
C:\Phantom\yourdirname01\PIC0000.BMP
C:\Phantom\yourdirname01\PIC0001.BMP
C:\Phantom\yourdirname01\PIC0002.BMP
In this example, the first file will be saved to drive "C" in the "Phantom" directory. The first
recording will create a folder in this Phantom directory named "yourdirname" (or whatever legal
name you choose before the "@" symbol), and the number "00" will be added. Individual single
image files with the filename plus an image number from 0000 to the final number in the
sequence plus the file extension (in this case BMP), will be stored in this sub directory. The next
trigger will start the process again, and the next save to drive C:\Phantom will create a sub
directory "yourdirname" and append the name with the number 01. Individual images will be
saved as described above.
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Create Multiple Image Files from a Cine (Starting with the First Frame's Image
Number)
To create multiple images from a cine file – let’s say cine1.cine – containing a range of frames
from -10 to 2, you can specify the generic file name like this:
Example: imag!4
The images will be saved in the same folder with the one in which the cine file "cine1.cine" is in:
imag-0010
imag-0009
imag-0008
…
imag0000
imag0001
imag0002

Create Multiple Image Files (Starting with the First Frame's Image Number) into
Sub-folders within the Original Folder Location
You can indicate, not only file names, but also a new directory or the full path name, using the
language described. For example, when converting several file formats from files within a single
folder – cine1.cin, avi1.avi – containing a range of frames from –10 to 2, you can specify the
following Files in the Multiple Convert Destination dialog box:
Example: c:\cines\imag!4
Phantom will create a cines file folder if it does not already exist, and images will be saved like
this:
c:\cines\cine1\imag-010
c:\cines\cine1\imag-009
…
c:\cines\cine1\imag0001
c:\cines\cine1\imag0002
c:\cines\avi1\imag-010
c:\cines\avi1\imag-009
…
c:\cines\avi1\imag0001
c:\cines\avi1\imag0002
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Create Multiple Cine Files into Sub-folders within the Original Folder Location
You can also introduce a counter of cine files, using the @ sign. Using the same convention as
the one just mentioned, if you specify:
Example: c:\cine@2\imag!4
Results in:
c:\cine00\cine1\imag-010
c:\cine00\cine1\imag-009
…
c:\cine00\cine1\imag0001
c:\cine00\cine1\imag0002
c:\cine01\avi1\imag-010
c:\cine01\avi1\imag-009
…
c:\cine01\avi1\imag0001
c:\cine01\avi1\imag0002

Create Multiple Image Files (Starting from One)
If you prefer a counting of images starting from 1, here is an example for converting the file
cine1.cine with the frame range from –10 to 2:
Example: c:\cines\imag+4, and you will get:
c:\cines\imag0001
c:\cines\imag0002
…
c:\cines\imag0012
c:\cines\imag0013
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Phantom .stg (Serial Tag Number) File
Phantom cameras have been categorized into two types; ph16 and ph7 cameras.
The ph16 camera models include the Phantom v160, v1210, and Miro M-Series cameras, while the
ph7 camera models include all other Phantom cameras.
ph16 Camera Models
With the introduction of ph16 cameras, the Phantom .stg (Serial Tag Number) file is no longer
required for these cameras to operate. Therefore, there will be no Phantom .stg files associated
with ph16 camera models. All of the factory settings, calibrations and all important system
operating settings will be stored into both an active non-volatile memory area of the camera, and
a backup non-volatile memory area.
ph7 Camera Models
The ph7 Phantom camera model still require a unique serial tag number file to operate. This file
is known as the camera's '.stg' file. The .stg file contains factory calibrations and settings
essential for the proper operation of your Phantom camera. The Phantom installation CD,
supplied with each new or newly serviced camera, includes the '.stg' file for your camera.
Serial Tag Files use the file extension .stg and reside in the Phantom directory on the controlling
computer's hard drive. These files are specific to each camera manufactured and store the
factory settings and various lookup tables for the image sensor based on the 4-Digit Camera ID
number. The information in this file is also stored (duplicated) in the camera's non-volatile flash
memory. Under normal camera operation, this information is read by the Phantom application
each time the software is started or each time a camera is accessed over the network. When
started, the application first tries to read the factory settings from the computer .stg file. If it
doesn't find the appropriate .stg file on the computer, it reads the settings from the camera.
On the flip side, if the Phantom application is started or if the camera is accessed over the
network and no .stg file resides on the hard drive, the Phantom application will automatically
create the .stg file on the controlling computer's hard drive using the information residing in the
camera flash memory.
If for any reason the Phantom application cannot read the .stg information from the camera flash
or from a file in the Phantom directory on the hard drive then the software will prompt the user for
intervention. If the proper .stg file is not available the application can load a default set of
information. If the default information is written to the flash the camera will still operate but the
image quality will be less than optimum.
CAUTION
Never use an outdated .stg file. Never mix .st files. Using ,stg files from other cameras may
cause serious damage.
Vision Research keeps copies of .stg files on record and if needed a copy can be obtained via
email by contacting us.
Vision Research recommends making a backup copy of your camera's ,stg file to store in a safe
place. We also recommend placing a copy of this file in a temporary folder somewhere on your
hard drive in the event you need to restore the camera's factory calibration settings quickly .
When the camera is first connected to the controller, it will automatically download the '.stg' file to
a default .stg file path, used by the Phantom Camera Control software. This path matches the
path used in by the Phantom (PCC) Camera Control application, CommonApplicationData, (see
the table below).
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WINDOWS OS

.STG AND PHCON.LOG
COMMONAPPLICATIONDATA

USER SETTINGS
LOCALAPPLICATIONDATA

Windows 7

ProgramData\Phantom\Phantom
version

Users\Current user
name\AppData\Local\Phantom

Windows Vista

ProgramData\Phantom\Phantom
version

Users\Current user
name\AppData\Local\Phantom

Windows XP

C:\Documents and Settings\All
Users\Application
Data\Phantom\Phantom version

C:\Documents and Settings\User
name\Local Settings\Application
Data\Phantom

Therefore, you should copy the file from the CD, and use Windows Properties to disable the
READ ONLY attribute of the ,stg file after it's copied to the hard drive.
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SMPTE Time Code in Phantom Cameras
Introduction
The widely used SMPTE time code is deeply rooted in a broadcast environment where the frame
rates are ever constant. The standard ways in which \normal" cameras use time code does not
have an obvious correspondent in the high-speed camera world, so a somewhat different way of
using time code is required.
The implementation of SMPTE time code support in Phantom cameras tries to balance the
\high-speed" characteristics of the cameras with the common use of time code, by working towards
the following goals:
1. When the camera is used at a standard frame rate, the time code should work as expected from
a "normal" camera;
2. The resolution and precision of the camera's time stamps are retained for high-speed
applications;
3. Even when the camera is used at high-speed, it will generate sequential time code on playback;
the playback time code can be correlated back to the images in the files the camera saves.
Time System Structure
The time system of the camera consists of the following parts: a time code receiver that can accept
SMPTE or IRIG time codes; a high-resolution internal time base, that can lock to the incoming time
code; a time stamp system for recording the exact time, according to the internal time base, when
each frame is captured; an output section.
The time code receiver accepts IRIG B (modulated or unmodulated), or SMPTE linear time code.
The linear time code can be at 23.97, 24, 25, 29.97 or 30 fps, drop or non-drop. The receiver will
automatically detect the type of time code that it sees at the input, and switch to the proper
decoder.
When a proper time code, incrementing in the correct sequence is received, the internal time base
of the camera will lock to the true "wall clock" time implied by that time code, and follow that true
time uniformly and with sub-microsecond precision.
When SMPTE time code is received, the "true time" is calculated in the following way: for the given
time code, the number of frames from the start of the day is calculated (taking drop frames into
account of needed), then the number of frames is divided by the exact TC frame rate (23.97, 24,
25, 29.97 or 30 Hz). The resulting time is used as the reference to which the time base locks.
For "round" frame rates, the time base will lock to the exact same time received (for instance, the
reference moment of the frame with time code "01:00:00:00" will occur at the 01:00:00.000000 "true
time").
When the fractional rates 29.97 and 23.97 are used, this correlation cannot exist, and the true time
will lead the applied time code by 3.6 seconds every hour.
When a 29.97 drop time code is applied, the internal time is closer to the applied time code (within
about 84ms / day), but will still wander from the applied time code, as it has to run uniformly, without
the drop frame jumps.
The internal time base completely separates the input and output sides of the time system, so the
camera can output SMPTE time while reading IRIG time or vice-versa. Furthermore, the input TC
rate can be independent of the video system or frame rate - the camera is always "gear-boxing"
using "wall clock" time as a bridge between input and output.
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Time Code Outputs
The camera has an analog time code output that can generate either un-modulated IRIG, or
SMPTE linear time code. When the time code output is set to IRIG, that output always follows the
internal time base (as the IRIGout of all phantom cameras has always done).
In addition, the camera embeds SMPTE time code in the ancillary data of the HDSDI outputs. The
same time code is replicated in the LTC, VITC1 and VITC2 areas. The embedded SMPTE time
code is generated even when the TC output is set to IRIG. When the TC output is set to SMPTE,
the time code that is output there and the one embedded in the HDSDI are always identical (both
rate and content).
When the camera is showing a live picture, the SMPTE outputs contain a SMPTE representation of
the "true time" of the internal time base. The method used to convert SMPTE time code to true time
in the receiver is used in reverse for this conversion.
The SMPTE time code output always runs at the same rate as the video output, and always in
non-drop mode. The reference moment of the LTC is aligned with the vertical sync of the video
signal, as specified by SMPTE12M. Since the internal time base runs independently of the video
signal generator (and the latter can also be genlocked), there can be a difference of up to 1 frame
between the internal time base, and the SMPTE output even when the two are supposed to output
the same data.
Time Code Output in Playback
When playing back recorded images, the SMPTE time code output is generated based on a
reference moment of each recorded cine. A particular time code is assigned to frame #0 (the trigger
frame) of each cine when the respective recording ends. This "trigger time code" is calculated
based on the true time of that frame, the playback rate (determined by the video mode), and the
camera's capture frame rate.
When the capture frame rate equals the playback rate, the assigned time code is the equivalent of
the true time of the trigger frame (rounded to the nearest frame number). This makes the camera
output the same time code that was input at the time of the recording if running at a standard rate.
When the capture rate is different from the capture frame rate (i.e. there is a speedup or slow down
on playback), the time code of the trigger frame is more or less arbitrary (see the calculation
method below).
Whenever a cine is played back, the time code outputs will be at N frames from the trigger time
code, where N is the frame number being played back). A playback a "1x" speed, i.e. one which
outputs recorded frames sequentially will result in sequential time code being output. Any "trick
mode" play back (reverse, reduced speed, stop frame, etc) will generally show non-sequential time
code, as the time code will follow the displayed image number. If a cine is played back several
times, even if from a different in point, or from a different device (say, from a cinestation), then as a
given frame is output, the time code will be the same as on the other playbacks.
The trigger time code follows the cine in the cinemag recording and in the file metadata, so a
recording of the camera's output that included the SMPTE time code can be correlated back to
frame numbers in the cine files.
The trigger time code is calculated as follows: from the true time (the time stamp) of the trigger
frame, the number of frames from the start of the current day, at the camera's capture frame rate is
calculated. This number of frames is converted to a time code at the video output rate, modulo 1
day. So if, for instance, is the camera is capturing at 120fps and playing back at 30, and the time of
the trigger frame is 01:00:00.000000, the assigned trigger time code will be 04:00:00.00.
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Supported File Formats
A cine file, or movie, may contain hundreds of pictures, while an image file contains a single picture
extracted from a cine file. Vision Research recommends that you use the Cine RAW format, unless
there is a real need to use one of the other formats. Following are brief descriptions of the
advantages and disadvantages of the various supported file formats.

IMPORTANT DEFINITIONS
Color interpolation (Demosaicing)
Color images usually contain three color components for each pixel (Red, Green, Blue). In order to
produce color images, digital cameras should be able to measure color levels for all three
components in each pixel of the image. Hence, three different sensors would be required.
Since this approach is expensive and very complicated to implement, most cameras use only one
sensor plus a Color Filter Array (CFA). The CFA is a grid that selectively filters the light by
wavelength range. The image below contains such a filter, called the Bayer CFA.

Bayer Color Filter Array

Thus, the camera sensor will produce an array on values with one value per pixel. Each value
represents a specific color level (red, green or blue). Such an image is usually called uniterpolated
or RAW image.
In order to obtain a full color image from the RAW image, a special processing is required, called
color interpolation or demosaicing. Analyzing each pixel and its neighbors, a color interpolation
algorithm basically reconstructs the missing color components and produces the desired color
image.

Raw
The term “RAW” generally refers to something unprocessed, unrefined. In digital video and digital
photography, there are two contexts RAW is most often used:
· When referring to how data is stored in an image file.
In this context, a RAW file generally stores an image as a stream of bytes without using any
compression or special technique. By default, the file contains no additional data. However,
some RAW files may support adding a header with minimal information such as image size or
bit depth. Vision Research .RAW format is an example for this category.
· When referring to what kind of data is stored in an image file.
A RAW file format may also refer to a file format that contains the original, unprocessed data
from the image sensor of a digital camera. A RAW file is not immediately ready for use, but it
contains all additional information for processing it and further using the captured image. DNG
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is an example of a RAW file format.
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SUPPORTED FILE FORMATS
Cine (*.cine)
Advantage:
The Cine format is a Vision Research proprietary file format very similar to the Cine RAW format
except that the colors are interpolated and every pixel holds all three color components RGB. It
will store 8 or 16-bit images. The playback speeds are faster than Cine RAW because the colors
are already interpolated.
Disadvantage:
It is usually about three times the size of Cine RAW file and takes a bit longer to save.

Cine JPEG (*.cci)
Advantage:
The Cine JPEG format uses a lossy compression routine to compress the images from the cine
file while retaining the timing and other information within the file. It will store only 8 bit images. It
results in the smallest file size but there is a loss in the image quality, depending on the quality
factor you chose at save.
Disadvantage:
It takes a bit more time to save the cine file as the JPEG compression is performed. Not all third
party software analysis packages will work with this format, image is altered and some details
can be lost.

Cine RAW (*.cine)
Advantage:
The Cine RAW format is a Vision Research proprietary file format that has all the settings and
timing information stored within the file. It will store 8 or 16-bit images. The images stored on 16
bits can have a smaller number of used bits: 10, 12 or 14. The images are saved as read from a
sensor and the format is very compact. The save time is the best of all the formats offered in the
Phantom application. Cine RAW files are uninterpolated, every pixel stores information about
one color.
Disadvantage:
Each image needs to be interpolated on the fly during playback, that is, the missing two colors
are computed by interpolating the neighbor colors, so the playback speed is slightly slower than
some of the other formats and is dependent on the configuration of your computer system.
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Cine RAW Packed
The packed cine files are smaller and faster to save. Packed files can be converted in unpacked
RAW cine files or in DNG format (packed or unpacked).
NOTE
You can save a packed RAW cine file can only be saved from a Phantom CineMag by
checking the Packed option in the Save Cine dialog box.

AVI (*.avi)
Advantage:
The Audio Video Interleaved (AVI) format uses the AVI CODECS to save the file in a universal
format used by several video playback packages. This universal format makes it easy to pass
along to the end user for viewing since almost every PC has a viewer built into the operating
system. The timing and setting information (“metadata”) is stored in a separate file known as the
cine header file (.chd) or in a XML file. The AVI file can be played back within the Phantom
application with the information intact.
Disadvantage:
Files saved in the AVI format are converted to 8-bit.

Multipage TIFF (*.tif)
Advantage:
Some branches of the military use primarily the multipage TIFF format, and there are third party
software packages that use this format for image analysis. The timing and setting information is
stored in a cine header file (.chd) or in a XML file and the TIFF file can be played back within the
Phantom application with the information intact. The file size is the same as the Phantom Cine
format.
Disadvantage:
The Multipage TIFF format has a 2 gigabyte file size limit, so on large memory cameras the
customer will need to save the large cine files in segments. Files saved in the multipage TIFF
format are converted to 8 bits.
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MXF (*.mxf)
Advantage:
The MXF format, both NTSC and PAL, are used to save the camera cine images in a format that
several common video editing suites use. This allows the camera images to be easily edited into
standard video productions. The images are lossy compressed. Care must be taken to set the
aspect ratio to that of the video display that the images will be viewed on. The timing and setting
information is stored in a cine header file (.chd) or in a XML file.
Disadvantage:
Files are converted to 8 bits. The MXF format will not playback in the Phantom application. The
resulting files have the extension of .mxf and there is no distinction in the filename between
NTSC and PAL.

QuickTime (*.mov)
Advantage:
This is a universal file format that can be played back in several third party software packages
that are commonly used by the Apple computers end users. The file size is the same as the Cine
format. Only the uncompressed version of this format was implemented. The timing and setting
information is stored in a cine header file (.chd) or in a XML file.
Disadvantage:
Files are converted to 8-bit. The MOV format will not play back in the Phantom application.

Windows BMP (*.bmp)OS/2 BMP (*.bmp) - one image per file
Advantage:
All still or video cameras produce raster images. Bitmap (or raster) images are made up of pixels
in a grid. Each pixel is assigned a color value. All these tiny dots of color come together to form
the images you see. Bitmap images are literally maps of the grid of pixels and their color
assignments. Bitmap files easily convert to other formats. BMP is the built-in format of Windows
operating system.
Disadvantage:
BMP supports only 8 bits per pixel (24 bits per pixel on color images).
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PCX (*.pcx)
Advantage:
The PCX image format is one of the oldest raster formats. It was originally designed by ZSoft to
be used by PC Paintbrush for MS-DOS. Microsoft later acquired the right to use the PCX format
for Microsoft Paintbrush for Windows indirectly increasing the format's popularity. PCX can be
used for graphic data operations.
Disadvantage:
PCX does not compress images very effectively, but it retains all image information. As such,
PCX files are usually very large and are unsuitable for very large details. Due to its inefficient
compression scheme and the advent of other image formats, PCX has lost some of its
popularity.

TGA (*.tga)
Advantage:
This format (Targa or TGA) supports any image dimensions and color depth of 1 to 32 bits. As
the image format's popularity increased, this format, TGA (Targa), has been migrated to many
other platforms and applications. The Targa format is used by several high-end paint and CAD
programs.
The TGA format is a format for defining raster or bitmap images. Targa supports color maps,
alpha channel, gamma value, postage stamp image, textual information and developer-definable
data. Unlike other image formats, there are relatively few variations. Various compression
models are supported. Targa images exist in both compressed and uncompressed formats.
The TGA format is probably the most universally supported 24-bit and 32-bit file format for PC
applications. The 32-bit Targa format contains 24 bits of color data and 8-bits of transparency
data. Color support ranges from black and white, indexed and RGB color.
Disadvantage:
Since Windows does not recognize 16-bit and 32-bit depths, some applications may treat them
as 24- bit images. A 16-bit image will be up-graded to a 24-bit image while a 32-bit image will be
downgraded to a 24-bit image.
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TIFF (*.tif)
Advantage:
TIFF (Tagged Image File Format) is one of the most popular and flexible of the current public
domain raster file formats. TIFF is primarily designed for raster data interchange. TIFF's main
strengths are a highly flexible and platform-independent format that is supported by numerous
image processing applications. Since developers of printers, scanners and monitors designed it,
it has a very rich space of information elements for colorimetry calibration, gamut tables, etc.
Such information is also very useful for remote sensing and multi-spectral applications.
Another feature of TIFF that is also useful is the ability to decompose an image by tile rather
than scan lines. This permits much more efficient access to very large imagery, which has been
compressed (since one does not have to decompress an entire scan line).
Disadvantage:
There is no provisions in TIFF for storing vector graphics, text annotation, etc. (although such
items could be easily constructed using TIFF extensions TIFF.). TIFF is based on file-offsets, so
that it is not easily "streamable" in the way JPEG JFIF streams are.
A common complaint of TIFF is rooted in its flexibility. TIFF uses a 4-byte integer file offset to
store image data, with the consequence that a TIFF file cannot have more than 4 Gigabytes of
raster data (and some files have begun to approach this boundary).

LEAD (*.cmp)
The LEAD CMP format was created by LEAD Technologies, Inc., and it utilizes the patented
CMP compression. CMP compression delivers a much smaller file size and better image quality
than other compression techniques.

LEAD JTIF (*.jtf)
Refer to LEAD and JTIF.

LEAD JFIF (*jff)
Refer to LEAD.
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JPEG (*.jpg)
Advantage:
The Joint Photographic Experts Group Format (JPEG) format allows for control on the
compression quality. This means that you can opt for a smaller image with less detail or a larger
image with more detail. JPEG handles gradients well and is useful for images with subtle color
borders such as photographs.
Disadvantage:
JPEG files are typically large files, and the JPEG formatted images lose quality rapidly as they
are compressed, usually introducing ‘noise’ and distortion into the image. The loss of image
quality is usually not worth the reduction of file size.

JTIF (*.jpg)
JTIF ( JPEG File Interchange Format) is just a file format for a compressed JPEG image. TIFF
can actually store its pels compressed in a wider variety of ways, including JPEG. JTIF is the
common JPEG file format seen in *.jpg files.

RAW (*.RAW)
RAW is a file format used in Vision Research applications for storing an interpolated image as
an array of bytes. For each pixel, three values are written to the file in ASCII or Binary format,
depending on the user option.
Usually, a RAW file contains just the array of bytes without any additional information.
Nevertheless, both image size and color depth can optionally be included in the file header.
Because of its simplicity, RAW files are rather suitable for in house post processing applications
where acquisition parameters are well known and controlled values.
This format is a Vision Research proprietary format that contains only pixel values. The file
exists for developers of custom software.

DNG (*.dng)
DNG (Digital Negative) is a non-proprietary file format developed by Adobe Systems and used
for storing RAW images. DNG is TIFF/EP standard compatible.
A DNG file contains unprocessed, uninterpolated data. Additional information about acquisition
and processing parameters is stored separately in the file as metadata.
One great advantage of the DNG file format is its flexibility: the end-user has access to the
original sensor data and can modify a wide range of parameters such as color interpolation,
white balance, black level, contrast, saturation, etc.
On the other hand, each DNG needs to be processed before being used, which not only that is
time consuming, but also requires specialized software tools for handling DNG files.
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DPX (*.dpx)
Digital Picture Exchange (DPX) is a common file format for digital film work and is an
ANSI/SMPTE standard (268M-2003). The file format is most commonly used to represent the
density of each color channel of a scanned negative in a 10-bit log format where the gamma of
the original camera negative is preserved as taken by a film scanner. Other common video
formats are also supported. DPX provides a great deal of flexibility in storing color and other
information for exchange between production facilities. Multiple forms of packing and alignment
are possible.
The DPX file format was originally derived from the output file format (.cin) of the Kodak Cineon
'FIDO' film scanner, and has been published by SMPTE as ANSI/SMPTE 268M-2003 (originally
was version 1 268M-1994).

Packed
Packed cine files are smaller and faster to save. You can save a packed RAW cine file only from
a Phantom CineMag. Packed files can be converted as unpacked RAW cine files or in DNG
format,(packed or unpacked).
A new type of Cine RAW file – Packed cine raw – can be saved from a Phantom CineMag.
When playing back a Packed cine file, the Play>Cine Info>Bits per color value will be displayed
with a “P” appended to it, (for example, 10 P).
NOTE
In order to get packed cine files compatible with previous versions of the Phantom Camera
Control application, convert the packed cines and uncheck the Packed option in Save cine
dialog box.
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Supported Video System Formats
The types of video signal formats Phantom camera's will transmit to a monitor, include:

Analog NTSC
When selected the camera will transmit the NTSC (National Television System Committee)
video signal format; 59.94 half frames (called fields) per second and 525 lines per field, (480
lines in each field are the image, and the last 45 are the "vertical blanking interval" (VBI),
designed to give the electron gun time to reposition itself from the bottom of the last field to the
top of the next), to an attach compatible monitor.
NOTE
NTSC is the analog television system in use in Canada, Japan, South Korea, the United
States, and some other places, mostly in the Americas.

Analog PAL
When selected the camera will transmit the PAL (Phase Alternating Line) video signal format; 25
fields per second and 625 lines per field, to an attached compatible monitor.
NOTE
PAL is the analog television system used in most of Western Europe, Australia and other
countries.

HDTV 720p60
When selected the camera will transmit 720 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1280 lines and a frame resolution of 1280 × 720 or about 0.92 million pixels; progressively
scanned, (non-interlaced); at a frame rate of 60Hz to an attached HD compatible monitor.

HDTV 720p59.9
When selected the camera will transmit 720 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1of 1280 lines and a frame resolution of 1280 × 720 or about 0.92 million pixels; progressively
scanned, (non-interlaced); at a frame rate of 59.94Hz to an attached HD compatible monitor.

HDTV 720p50
When selected the camera will transmit 720 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1280 lines and a frame resolution of 1280 × 720 or about 0.92 million pixels; progressively
scanned, (non-interlaced); at a frame rate of 50Hz to an attached HD compatible monitor.
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HDTV 1080p30
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a frame resolution of 1920 × 1080 or over two million pixels; progressively
scanned, (no-interlaced); at a frame rate of 30Hz to an attached HD compatible monitor.

HDTV 1080p29.9
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a frame resolution of 1920 × 1080 or over two million pixels; progressively
scanned, (non-interlaced); at a frame rate of 29.97Hz to an attached HD compatible monitor.

HDTV 1080p25
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a frame resolution of 1920 × 1080 or over two million pixels; progressively
scanned, (non-interlaced); at a frame rate of 25Hz to an attached HD compatible monitor.

HDTV 1080p24
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a frame resolution of 1920 × 1080 or over two million pixels; progressively
scanned, (non-interlaced); at a frame rate of 24Hz to an attached HD compatible monitor.

HDTV 1080p23.9
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a frame resolution of 1920 × 1080 or over two million pixels; progressively
scanned, (non-interlaced); at a frame rate of 23.976Hz to an attached HD compatible monitor.
NOTE
1080p is currently the digital standard for filming digital motion pictures.

HDTV 1080i30
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a field resolution of 1920 × 1080 or over two million pixels; interlaced
scanned, at a field rate of 30Hz to an attached HD compatible monitor.
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HDTV 1080i29.9
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a field resolution of 1920 × 1080 or over two million pixels, interlaced
scanned at a field rate of 29.97Hz to an attached HD compatible monitor.

HDTV 1080i25
When selected the camera will transmit 1080 lines of vertical resolution, with a horizontal
resolution of 1280 pixels and an aspect ratio of 16:9, implying a horizontal (display) resolution of
1920 dots across and a field resolution of 1920 × 1080 or over two million pixels, interlaced
scanned at a field rate of 25Hz to an attached HD compatible monitor.
NOTE
Progressive segmented Frame (PSF) is a High Definition video format used to store
progressive content on interlaced media.
Each progressive frame is segmented into two interlaced fields without inter-field motion, or
"combing". PSF is an alternative to 3:2 pull-down, wherein certain frames are "pulled down"
across multiple fields, resulting in output with an irregular frame rate.
Motion picture film cameras produce progressive images, usually at 24 frames per second. In
order to display those images on NTSC television, whose frame rate is 29.97 frames per
second interlaced (59.94 fields per second), each frame must be split into alternating groups of
3 and 2 fields. This is known as 3:2 pull-down.
Certain high definition tape formats, such as HDCAM allow frame rates other than 29.97.
Therefore, it's possible when using PSF to store "true" 24 frames per second progressive
images without pull-down, which then play back at the original frame rate. Thus the 24psf and
23.976psf (for compatibility with NTSC) formats were devised, which exist on tape as 48 (or
47.952) fields per second interlaced. When set up correctly, a progressive scan monitor will
read these interlaced fields two at a time, and display each pair as a single progressive frame,
temporally identical to the source. PSF content can also be played back on interlaced displays,
but the image will flicker.

HDTV 1080psf30
Will scan at a frame rate of 30Hz.

HDTV 1080psf29.9
Will scan at a frame rate of 29.9Hz.

HDTV 1080psf25
Will scan at a frame rate of 25Hz.
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Versatile Dual HD-SDI
The Video Outputs parameters, in the Phantom Video Player Settings dialogue window, are used to
define the video feed mode. Presently there are four feed modes supported, including:
· Single-Feed (4:2:2)
· Single-Feed Mode with Dual Link 4:4:4
· Dual Feed Mode (4:2:2)
· Dual-Feed with 4:4:4
The Versatile Dual HD-SDI feature allows maintaining a live video feed while simultaneously playing
back recorded images from the camera memory. The feature has also improved the handling of
active metadata, or video image adjustments, to allow proper handling during pipelined recording/
playback operations.
NOTE
Presently only the Phantom v740, v640, v310, and v12.1 Camera supports this feature.
Also, the handling of video adjustments has changed. Previously, when changing any of the values,
they would apply to the video image, both live and playback. Now, changing a video adjustment
value will only apply to the live image out of the camera, in either single-feed or dual-feed mode. For
playback, the values that were active when the cine was recorded will be used.
Below is a description of each of the video feed operational modes:

Single-Feed Mode (4:2:2)
This mode provides both the live and playback feeds, from the RAM, over the video memory channel.
This is exactly how the video feeds were handled previously. The high-speed channel is used as the
recording source for the Phantom CineMag, if fitted.
Only one video pipeline is used at a time.

Routing of image data when outputting images from the camera's RAM
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Routing of image data when outputting images from Phantom CineMag

When the camera is placed into the Single-Feed (4:2:2) Mode images can be read from the camera's
RAM over two totally independent channels, the:
· Video Memory Channel
· High-Speed Memory Channel
The camera has two identical video pipelines used to handle image debayering, and all color
adjustments. The video output of these pipelines can be routed to three outputs:
· One analog/component
· SDI-1, (Serial Digital Interface)
· SDI-2, (Serial Digital Interface)
On-screen annotations can be inserted on the signal going to the analog/component output and/or
SDI-2. There is no OSD, (On-Screen Display), for SDI-1.
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Single-Feed Mode with Dual Link 4:4:4
In this mode the SDI, (Serial Digital Interface), Outputs are used together as a dual-link output,
allowing 4:4:4 image sampling.

Routing of image data when outputting images from the camera's RAM

Routing of image data when outputting images from Phantom CineMag

When the camera is placed into the Single-Feed with Dual Link (4:4:4) Mode images can be read
from the camera's RAM over two totally independent channels, the:
· Video Memory Channel
· High-Speed Memory Channel
The camera has two identical video pipelines used to handle image debayering, and all color
adjustments. The video output of these pipelines can be routed to three outputs:
· One analog/component
· SDI-1, (Serial Digital Interface)
· SDI-2, (Serial Digital Interface)
On-screen, (OSD - On-Screen Display), annotations can only be inserted into the analog/component
signal.
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Dual-Feed Mode (4:2:2)
When the camera is placed into the Dual-Feed Mode the two video pipelines are used
simultaneously. The video memory channel is used to source a live video feed, while either the highspeed memory channel or the Phantom CineMag is used to source the playback feed.
Both the analog/component output and the SDI-2, (Serial Digital Interface-2 ), outputs always carry
the uninterrupted live feed. OSD, (On-Screen Display), information can be inserted on either of these
outputs. SDI-1 is reserved for the playback feed.
NOTE
If no playback is taking place, a black image is outputted.

Routing of image data when outputting images from the camera's RAM

Routing of image data when outputting images from Phantom CineMag
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Dual-Feed Mode with 4:4:4
In the Dual-Feed Mode with 4:4:4 the two SDI, (Serial Digital Interface), outputs are used together as
a dual-link output allowing 4:4:4 image sampling. The live feed, and optional On-screen Display,
(OSD), annotations are sent to the analog/component output, while the playback feed uses the dualSDI outputs.

Routing of image data when outputting images from the camera's RAM

Routing of image data when outputting images from Phantom CineMag
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Important System Interactions
Various interactions between the functional block depicted in the video feed operational mode
descriptions require the following rules to be put into place:
· All outputs are set to the same video format.
· Test bars are sent on all outputs at the same time.
· OSD, (On-Screen Display), information can be inserted only on the analog/component out and
SDI-2, (Serial Digital Interface-2).
· In dual-feed modes, only one of the following operations can take place at any given time:
· A Playback from RAM
· A playback from the Phantom CineMag
· Recording or Saving to the Phantom CineMag
· Downloading from the Phantom CineMag via Ethernet

Video-Feed Mode Selection Table
Video-Feed Mode definition is performed in the Phantom Video Play>Pvp Settings dialogue
window.
VIDEO OUTPUTS
VIDEO- FEED MODE
4:4:4

Single-Feed Mode (4:2:2)

SDI2 PLAYS SELECTED
ALL OUTPUTS PLAY
CINE
SELECTED CINE
ANALOG AND SDI1
PLAY LIVE

Disabled

Enabled

Disabled

Single Feed Mode with Dual-Link 4:4:4 Enabled

Enabled

Disabled

Dual-Feed Mode

Disabled

Disabled

Enabled

Dual-Feed Mode with 4:4:4

Enabled

Disabled

Enabled
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Service & Support

AMECARE Service Offerings
Maintenance, Support and Education that delivers ultimate satisfaction and operational
confidence for the user
Product and operator performance directly impact your goals and objectives. To ensure maximum
product uptime and operator success, Vision Research offers a complete line of service programs,
extended warranties and training classes to meet your specific product or operational needs. Our
professional, factory trained service engineers and educators will deliver this training and support
through a network of service centers, on-line/self-serve content and user community forums that will
help you achieve the results you need.
Customer Service – General inquires, technical troubleshooting or ‘how to’ questions? We’re here to
help. Our support centers are staffed from 8:00 AM to 5:00 PM Local Time.
· Professional Repair Services – Fast, accurate and competitively priced repairs for all of your
product needs
· Extended Warranties – Designed to add peace of mind and extend the factory warranty coverage
that eliminates unexpected out of pocket expenses
· Customer Training – Delivered in a Basic and Advanced format designed to get you quickly using
our cameras or to explore the depths of our comprehensive feature set
· On-Site Predictive Support and Training – is designed for customers who have 5 or more
cameras. This optional service program offers our customers the opportunity to receive a 1 day
visit for refresher training, camera inspection, firmware upgrades and general maintenance
· Loaner Product – Minimizes lost productivity by minimizing project downtime. Should an
unexpected camera failure occur, a loaner camera will be dispatched to a customer’s site to
restore business continuity while your product is in for servicing
View a list of AMECare documents available for download

© 2015 Vision Research - AMETEK Material Analysis Division

Service & Support

6.1

291

Service Centers

Updated: 11/08/2013

Contacting Vision Research Service Centers
GLOBAL HEADQUARTERS

LIVE CUSTOMER AND TECHNICAL SUPPORT

Vision Research, Inc. - Wayne, New Jersey

Serving the Americas and Asia Pacific:

100 Dey Road

M-F 8:00 AM to 5:00 PM EST (GMT-4:00)

Wayne, New Jersey 07470 USA

Vision Research, Inc. - Stuart, Florida

T: +1.973.696.4500

1002 Monterey Commons, Suite 200

F: +1.973.696.0560

Stuart, Florida 34996 USA

For answers to most questions, please visit
us at:

T: +1.973.696.4500

www.visionresearch.com

Customer Support, extension 4002

For general product, account, order/RMA
status inquires and other non-technical
questions please e-mail us at:

Technical Support, extension 4003

customer.support@visionresearch.com
For technical product support, product
operation or applications support please
e-mail us at:
technical.support@visionresearch.com
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F: +1.973.696.0560

Serving Europe, the Middle East and
Africa:
M-F 9:00 AM to 6:00 PM GMT +3:00
Vision Research, Inc. - Bucharest,
Romania
Str. Eugen Botez Nr. 1
Bucharest, Romania, 020232
T: +40 21 210 8587
F: +40 21 210 8587
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Phantom Certification Program
Vision Research proudly offers a new program that delivers a comprehensive training solution for
users of Phantom cameras. The Phantom v-Series Camera Certification Training Program is a twotiered training program that can reduce in-house training expenses and enhance your workforces’
productivity.Phantom v-Series Camera Certification Training Program
Our Phantom v-Series Camera Certification
Training Program helps engineers and
technicians better understand Phantom
cameras, as well as the use of Phantom
software, accessories, and applications for
high-speed imaging; that will deliver high quality
technical and product education you require.
Our instructors provide an in-depth customerfocused hands-on learning experience for our
Phantom products as well as the basics in
photography through a combination of lectures;
exercises, labs, and training solutions. Class
size is limited to eight students per session to
ensure that each student receives the individual
attention he or she may need.

"Our Phantom v-Series Camera Certification Training Program helps engineers and technicians
better understand Phantom implementations, use of Phantom software and hardware, and
applications," says Frank Mazella, Chief Instructor for Vision Research," and delivers high quality
technical and product education our customers' require. We believe this will allow them to maximize
the use of our products and the effectiveness of their personnel."
If you are interested in attending, or have any question regarding the training, please contact your
local Vision Research sales representative; or, use our “Contact Us” form (http://www.
visionresearch.com/Contact-Us/Contact-Form/) to request more information.
For a schedule of our training classes go to: http://www.visionresearch.com/News--Events/Events/
Training/
If you are in need of training for television or motion picture production applications, please contact
AbelCine if you are in the US or Canada, or your local Phantom sales representatives worldwide.
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